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Preface

Preface

This book is about circuit simulation using the simulation program LTspice. It is intended as an in-
troduction to LTspice and to simulation of CMOS integrated circuits with LTspice. It may serve as a
supplementary textbook for an introductory course in analog integrated circuit design. The first tutorials
can also be used as a general introduction to circuit simulation in an introductory course in electronic
circuits. The book can be used for classroom teaching, and it can also be used for self-study. It is based
on LTspice for Windows.

The book is organized as a number of tutorials, each comprising several simulation examples and a
selection of end-of-chapter problems. You are highly encouraged to complete the examples yourself and
to try to solve the end-of-chapter problems. ‘Learning by doing’ is the only efficient way of learning to
use a program like LTspice.

This is the second edition of the book. The writing of a new edition was triggered by a major revision
of LTspice being launched in 2016. New in this edition are descriptions of many of the new features
included in the most recent version of LTspice, LTspice XVII. Also, more examples and end-of-chapter
problems have been added as well as a new Appendix B with BSIM transistor model files.

Tutorials 1 and 2 introduce the fundamental concept of the circuit simulator demonstrated on circuits
using passive devices (resistors, capacitors and inductors) and ideal voltage sources and current sources,
both independent sources and controlled sources.

Tutorial 3 is about MOS transistor models and gives an introduction to the standard Shichman-Hodges
transistor model often used for hand calculations when analyzing CMOS circuits. Also, it provides
an introduction to more advanced transistor models and a comparison between the advanced transistor
models and the simple Shichman-Hodges model.

Tutorial 4 gives examples of basic CMOS amplifier stages, i.e. the common-source stage, the common-
drain stage, the common-gate stage and the differential pair. Both analysis and design approaches using
LTspice are shown.

Tutorial 5 shows how the basic stages can be defined as subcircuits and combined into a multistage
operational amplifier. Also given in this tutorial is a design example of a two-stage opamp for a feedback
amplifier, generic filter blocks and a mixed analog/digital circuit. The tutorial is an introduction to
hierarchical design.

Tutorial 6 is about the simulation of process and parameter variations in a circuit. In integrated circuit
design, process variations pose a major challenge to the designer. Often technology files are supplied for
typical process parameters and a selection of worst-case process parameters. The tutorial gives an intro-
duction to simulation with technology files including process variations. Also supply-voltage variations
and temperature variations are considered. Together, these variations are termed PVT variations.

7
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Preface

Tutorial 7 is about import of netlist files and export of output files from LTspice. The netlist files are
the primary descriptive files for a circuit to be simulated by Spice. There are minor differences between
netlist files originating from LTspice and other versions of Spice, but in general, it is rather straight-
forward to modify a netlist file to be compatible with LTspice. Several textbooks provide examples of
netlist files which may be used for simulation with LTspice. A schematic is not needed. The simulation
commands in LTspice can be executed directly from the netlist files.

End-of-chapter problems are provided for all tutorials to further illustrate the subject of the tutorials and
a solutions manual for the problems is also available from bookboon.com:
E. Bruun 2016, CMOS Integrated Circuit Simulation: Solutions, Second Edition.

Finally, two appendices are included. Appendix A is a beginner’s guide which may facilitate quick and
easy learning of LTspice for the reader or student who is new to LTspice. Appendix B provides a number
of BSIM transistor model files for use in LTspice.

I hope you find this book useful. If you find typos or errors, I would appreciate your feedback. Sugges-
tions for improvement are also welcome. You may send them to me by email, eb@elektro.dtu.dk.

Acknowledgements: The author would like to acknowledge the many students who have contributed
with comments and suggestion for the book. Also, a particular acknowledgement goes to my colleague
Dennis Øland Larsen who reviewed the entire manuscript for the first edition of the book and to my
colleague Ivan Jørgensen who reviewed the entire manuscript for the second edition of the book. They
both provided many useful comments and corrections during the final phases of writing.

Erik Bruun
Department of Electrical Engineering, Technical University of Denmark
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Getting started

The program LTspice is freely available from Linear Technology,
http://www.linear.com/designtools/software/.
Just click ‘Download LTspice’ and follow the instructions. You may register for an account with Linear
Technology, but you do not have to. You may just click ‘No thanks, just download the software’ and
choose ‘Run’ in the dialogue box which appears.

This book is addressing the simulation of integrated circuits, in particular CMOS circuits, so we will not
go into detail with the simulation of circuits with standard components but refer the reader to the many
examples of demo circuits using standard components which are found on the LTspice website. Here
you will also find a blog with several hints and video clips on how to use LTspice. However, Tutorials
1 and 2 may serve as a general introduction to LTspice. Also, a ‘Getting started guide’ is available from
http://cds.linear.com/docs/en/software-and-simulation/LTspiceGettingStartedGuide.pdf.

In addition, comprehensive books and guides about Spice can be found, (Tuinenga 1995) and (Vladimi-
rescu 1994), and a manual dedicated to LTspice is also available (Brocard 2013). However, the program
is fairly easy and intuitive and once the installation is complete, you may go directly to the first tutorial,
providing you with examples of circuits using resistors, voltage sources and current sources. A ‘learning
by doing’ approach is perfectly feasible with LTspice.

9

Download free eBooks at bookboon.com Click on the ad to read moreClick on the ad to read more

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 
© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

http://www.deloitte.ca/careers


CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

10

Getting started

The program also includes a ‘Help’ function with detailed descriptions of the commands and options
in the program. The keyboard shortcut to ‘Help’ is ‘F1’ in the windows version and ‘ ?’ in the Mac
version. If you want a paper manual for the program, you can get it using the ‘Help’ function: Just open
‘Help’ (type ‘F1’), select the tab ‘Contents’, click on the ‘Print’ symbol and select ‘Print the selected
heading and all subtopics’ in the dialogue box which opens. Your printer should be ready for printing
about 110 pages.

This book is based on the Windows version of LTspice. The program is also available for Mac. There
are some differences in the user interface of the two versions. This might be somewhat confusing for
first-time users. As a guide to Mac users, the following page provides a list of some of the differences
which may initially cause confusion.

10
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– The toolbar shown in Fig. 1.2 on page 14 is not available in the Mac version. Instead, a right-
click on the drawing sheet will open a menu with several sub-menus. The ‘Draft’ sub-menu
allows you to insert ‘Components’, ‘Wires’, ‘Net Names’, ‘SPICE directives’, etc. In particular,
you should notice that the ground symbol is not available via ‘Components’, but it can be
inserted using the keyboard shortcut (hotkey) ‘G’ or using ‘Net Names’ as explained on page 15.

– The editing commands (‘Move’, ‘Drag’, ‘Duplicate’, etc.) are found in the ‘Edit’ sub-menu.
The rotate and mirror operations are available via ‘ R’ and ‘ E’.

– The ‘Simulate’ command shown in Fig. 1.2 on page 14 and described on page 16 is not available
in the Mac version. Instead, use ‘SPICE directives’ from the ‘Draft’ sub-menu and type in the
appropriate simulation command. The help function provided by the window shown in Fig. 1.5
on page 17 with different tabs for the different simulation commands can be opened by right-
clicking in the ‘SPICE directives’ dialogue box. This opens a ‘Help me Edit’ option where
you can select ‘Analysis Cmd’. A similar help function is available for several other SPICE
directives.

– The result of a ‘DC operating point’ simulation (‘.op’) is not automatically displayed in a win-
dow like shown in Fig. 1.6 on page 18. Instead, a plot window opens, and you can select
the currents and voltages to be displayed by pointing to relevant components and nodes in the
schematic as described on page 23. If you want the simulation result in a format as shown in
Fig. 1.6, open the ‘Spice Error Log’ from the ‘View’ sub-menu or by ‘ L’.

– The results of a ‘DC Transfer’ simulation (‘.tf’) are not displayed in a window like shown in
Fig. 1.25 on page 31. Instead, a plot window opens, and using ‘Add Traces’ from the plot
window, you can select the transfer function, the input resistance and the output resistance.

– When selecting a new ‘Simulate’ command, previous simulation commands are not automati-
cally changed into comments as described on page 23.

– For transistors, the small-signal parameters calculated by a ‘DC operating point’ simulation
(‘.op’) are listed in the ‘Spice Error Log’ together with the bias values of voltages and currents.
Also for an ‘AC Analysis’, the small-signal transistor parameters for the bias point are listed in
the ‘Spice Error Log’.

– Not only in the schematics sheet but also in waveform plots, a right-click opens a menu with
several sub-menus.

– The commands for copying schematics and waveform plots to the clipboard are found in the
submenu ‘View → Paste Bitmap’.

11
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Tutorial 1 – Resistive Circuits

Tutorial 1 – Resistive Circuits

This tutorial is an introduction to the basics of LTspice simulation of resistive circuits with voltage
sources and current sources. After having completed the tutorial, you should be able to

– draw circuits using the schematic editor in LTspice.

– specify resistors, independent sources and controlled sources in LTspice.

– recognize the basic netlist structure for simple circuits in LTspice.

– run simulations of operating points, dc sweeps and small-signal transfer functions.

– run simulations with parameter sweeps.

– plot simulation results using the waveform viewer of LTspice.

Example 1.1: A resistor circuit.

The first example is a simple circuit with four resistors and a voltage source as shown in Fig. 1.1:

Figure 1.1: Circuit for first simulation.

Drawing the circuit: Start by opening a new file in LTspice (‘File → New Schematic’ or the leftmost
symbol in the Editor toolbar). Next, you should draw the schematic shown in Fig. 1.1. Click (left-
click) with the mouse on the resistor symbol shown in the toolbar (symbol ) and place the four resistors.
You may rotate a resistor by clicking on the ‘rotate’ symbol on the toolbar or by typing ‘Ctrl-R’
when placing the resistor. Right-click on the mouse (or type ‘Esc’) to leave the insertion command. As
an alternative to picking the resistor from the toolbar, you may use the command ‘Edit → Resistor’, or
you may simply type ‘R’. The resistors may now be edited to the correct values and numbers shown in
Fig. 1.1. Move the cursor to the resistor name (the reference designator, e.g. ‘ ’). If you have inserted
a resistor without rotating or mirroring the symbol, the name is the upper text appearing to the right of
the symbol. On the status bar at the bottom of the LTspice program window, a message will appear,

13
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Figure 1.2: Some toolbar symbols.

telling you that with a right-click, you can edit the name of the resistor. The right-click opens a dialogue
box where you can enter the new reference designator. Likewise, the value of the resistor is edited by
right-clicking ‘ ’. This is the lower text appearing to the right of the symbol when a resistor is inserted
without rotation or mirroring. If you rotate or mirror your symbol, the name (device designator) and
value will move. You can always see on the status bar at the bottom of the LTspice program window if
you have placed the cursor on the name of a component or on the value. Do not confuse name and value!
It will lead to errors in the simulation.

A figure pointing out some of the toolbar symbols is shown in Fig. 1.2.

The voltage source VS is inserted by selecting the ‘Component’ symbol on the toolbar, symbol .
Click on the symbol (left-click) and a selection box will appear with a large selection of components, see
Fig. 1.3. Select ‘voltage’. This results in the symbol for a voltage source. The value and the name are

14
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Figure 1.3: Component selection box.

edited in the same way as for the resistors. Also for the voltage source, you may use the ‘Edit’ command
instead of picking the symbol from the toolbar (‘Edit → Component’), or you may simply type ‘F2’
which will bring you to the component selection box.

The components are connected together by wires inserted with the ‘wire’-symbol (symbol ) or the
keyboard shortcut (hotkey) ‘F3’.

Also remember to insert a ground symbol (symbol or keyboard shortcut (hotkey) ‘G’) to indicate the
reference voltage of 0 V. If the ground is missing in the schematic, LTspice will not execute a simulation.

It is a good idea to give names to important nodes in the circuit, e.g. V1 and V2, using the symbol ‘Label
Net’ from the toolbar or the hotkey ‘F4’. Alternatively, point to a node and right-click. This opens
a dialogue box where you can select ‘Label Net’ and type in a name. You can also insert the ground
symbol in this way by ticking ‘GND(global node 0)’ in the dialogue box for ‘Net Name’.

If you wish to make adjustments to your schematic, you can move or drag symbols using the hotkeys ‘F7’
or ‘F8’, respectively (or symbols and on the toolbar, or the ‘Edit → Move’ and ‘Edit → Drag’
commands). Also, you can delete a symbol or a wire using ‘F5’, toolbar symbol or ‘Edit → Delete’,
and you can duplicate symbols using ‘F6’, toolbar symbol or ‘Edit → Duplicate’. These commands
work not only on single symbols: When you have activated one of the commands, you can define a box
by clicking and dragging using the left mouse button, and the command will work on the entire contents
of the box.

The assignment of hotkeys can be seen (and edited) using the command ‘Tools → Control Panel →
Drafting Options → Hotkeys’.

15
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Figure 1.4: Schematic from LTspice.

The resulting schematic may look like the schematic shown in Fig. 1.4. When the schematic has been
completed, you should save it (using ‘File → Save as’) in an appropriate folder for your circuits and
using a suitable file name. You can also export the schematic to other programs. A very simple method
is to use the command ‘Tools → Copy bitmap to Clipboard’ and then paste the schematic into another
program (e.g. Microsoft Word) from the clipboard (using ‘Ctrl-V’).

Simulating the circuit: Now the circuit is ready to be simulated. For this, we need a simulation
command. When selecting the command ‘Simulate → Edit Simulation Cmd’, a window opens with a
number of tabs as shown in Fig. 1.5. This is a ‘Help me Edit’ function for the SPICE directives used to
specify simulations. Each tab provides help for the basic simulation modes in LTspice. These are:

Transient: Perform a nonlinear time domain simulation. This is used for finding voltages and currents
as function of time, e.g., charging and discharging of a capacitor.

AC Analysis: Compute the small-signal ac behavior of the circuit linearized about its dc operating point.
This is used for finding the frequency response of a circuit, e.g., the Bode plot of a gain function.

DC sweep: Compute the dc operating point of a circuit while stepping independent sources and treating
capacitances as open circuits and inductances as short circuits. This is used for finding voltages
and currents as functions of one (or more) signals varying in magnitude, e.g., the output voltage of
an amplifier as a function of the input voltage.

Noise: Perform a stochastic noise analysis of the circuit linearized about its dc operating point. This is
used for analyzing the noise performance of a circuit, e.g., finding thermal noise and flicker noise
in a gain stage with MOS transistors.

DC Transfer: Find the dc small-signal transfer function. This is used for finding small-signal input
resistance, output resistance and transfer function for a circuit at dc, i.e., the frequency of the input
signal source is 0.

DC op pnt: Compute the dc operating point treating capacitances as open circuits and inductances as
short circuits. This is used for finding dc voltages and currents in a bias point for a circuit. It is
also used for finding small-signal parameters of transistors in the bias point.
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Figure 1.5: Help window for editing the simulation commands.

For the first simulation of the circuit in Fig. 1.4, we just need to find some dc voltages and currents in
some devices. This is done using the simulation command ‘DC operating point’ (DC op pnt). You open
the tab ‘DC op pnt’ and select the command ‘.op’ by clicking ‘OK’. This opens a command line (SPICE
directive) which can now be placed on the schematic by the cursor. Insert the command by a left-click
on the mouse or by pressing ‘Return’.
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Tutorial 1 – Resistive Circuits

Output from DC op pnt simulation

--- Operating Point ---

V(v2): 2.4 voltage
V(v1):  20 voltage
I(R1): -0.00044 device_current
I(R4): 0.00012 device_current
I(R2): 0.00024 device_current
I(R3): 8e-005 device_current
I(Vs): -0.00044 device_current

Figure 1.6: Simulation result for circuit example from Fig. 1.4.

Next, the simulation is run by the command ‘Simulate → Run’ or by using the ‘Run’-symbol on the
toolbar. If there are no errors in the schematic, the simulation opens a new window with a list of all node
voltages and device currents, see Fig. 1.6.

Once you have closed the window, you can re-open it by the command ‘View → Visible Traces’, toolbar
symbol .

Notice that LTspice inherently specifies a direction of current flow for each of the components. For
the voltage source ‘ ’, the positive direction of current flow is into the positive terminal of the voltage
source. In our case, the current is flowing out of the positive terminal of the voltage source, so in Fig. 1.6,
the current ‘ ’ appears with a negative value. Also the current flow in a resistor is defined with a
sign. Unfortunately, you cannot from the symbol see which end of the resistor is the positive end. When
you insert a resistor without rotating it or mirroring it, the positive terminal is the upper terminal, so
the positive direction of current flow is downwards. If you rotate the resistor once in order to have a
horizontal resistor symbol, the positive current flow is from right to left.

If your schematic contains errors, a window will open giving suggestions concerning what can be wrong.
For instance, the ground symbol may be missing or a resistor value has not been specified. A slightly
more tricky error has to do with the specification of component values. Be aware that a space between
the value and the suffix is not allowed. If there is a space, the suffix will be ignored and the simulation
will run with some unintended component values. A result window like shown in Fig. 1.6 will still be
shown but when you close this, a new window with an error log will appear. Also note that the suffix
for ‘Mega’ is Meg (or meg – LTspice is case insensitive) while the suffix for ‘milli’ is m (and if you
insert M, LTspice will change it into m to warn you that M does not mean Mega). Another common
error is a value specification using a wrong syntax. Note that a 10 kΩ resistor cannot be specified as
‘10 10ˆ3’. LTspice does not accept this notation. It has to be specified as ‘10k’ or ‘10e3’ (or ‘1e4’).
If you use the wrong specification (‘10 10ˆ3’), the ‘.op’ simulation will still run and an output file will
be shown, but when you close the output file, an error log file will automatically open, telling you that
there is an error in the resistor specification (Unknown parameter " 10ˆ3"). Examining the output file,
you will note that the ‘.op’ simulation has been executed with a resistor value of 10 Ω.

When you have successfully completed the ‘.op’ simulation and closed the window with the results, you
can see currents and voltages in the circuit by moving the cursor to a component or a node and reading
currents and voltages on the status bar at the bottom of the LTspice program window.

18
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LTspice netlist

* M:\LTspice\Tutorial01\Fig1_04.asc
R3 V2 0 30k
R2 V2 0 10k
R4 V2 0 20k
R1 V2 V1 40k
VS V1 0 20
.op
.backanno
.end

* M:\LTspice\Tutorial01\Fig1_04.asc
R2 V2 0 10k
R3 V2 0 30k
R4 V2 0 20k
R1 V2 V1 40k
VS V1 0 20
.op
.backanno
.end

* M:\LTspice\Tutorial01\Fig1_04.asc
R2 V2 0 10k
R3 V2 0 30k
R4 V2 0 20k
R1 V2 V1 40k
VS V1 0 20
.op
.backanno
.end

Figure 1.7: LTspice netlist for circuit example from Fig. 1.4.

It may be useful to know at least the basics about the circuit description used by LTspice. The circuit is
described by a netlist, and you can see the netlist using the command ‘View → SPICE Netlist’. Figure 1.7
shows the netlist corresponding to the circuit from Fig. 1.4. You would notice the syntax for a resistor,
for instance R1: ‘ ’. Here you will recognize that the first node specified for the resistor (in
this example ‘ ’) is the positive terminal of the resistor. Also, you may notice that the netlist file starts
with the circuit description where the lines in the netlist appear in the sequence in which you inserted the
components. Following the circuit description are SPICE directives. For the netlist shown in Fig. 1.7,
we just have the simulation command ‘.op’, an autogenerated LTspice command ‘.backanno’ (linking
the schematic and the netlist) and an autogenerated ‘.end’ directive (to mark the end of the netlist file).

Figure 1.8: Thévenin equivalent (left) and Norton equivalent (right).

Thévenin – Norton equivalent circuits: For the circuit shown in Fig. 1.1, you may define a Thévenin
equivalent and a Norton equivalent as shown in Fig. 1.8 (Hambley 2014). The Thévenin voltage Vt is
the open-circuit voltage between the two rightmost terminals of the circuit in Fig. 1.1 and the Norton
current In is the short-circuit current between the two terminals. The Thévenin resistance Rt is the ratio
between the Thévenin voltage and the Norton current, i.e. Rt =Vt/In. Also, the Thévenin resistance can
be found as the resistance between the circuit terminals when the independent sources in the circuit are
reset, i.e. with VS = 0 V. The Thévenin voltage has already been found by the simulation of the circuit
in Fig. 1.4, and the result is given as the voltage ‘ ’ in Fig. 1.6, i.e. Vt = 2.4 V. The short-circuit
current is found by placing a short circuit between the two rightmost terminals in the circuit. The short
circuit could simply be a wire, but in this case, the current in the wire is not listed in the output file from
the ‘.op’ simulation. You may also try to insert a resistor with the value 0, but running the simulation,
you will find that the output file does not show the value of the current in this resistor. You may change
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the resistor value to a very small value (e.g. 1e-6), and in this case, the output file will show the current in
the short-circuit resistor. A better approach is to model the short circuit by a voltage source with a value
of 0 V as shown in Fig. 1.9. In this case, the output file will show the current into the voltage source,
and the voltage between the two terminals is 0 V, corresponding to a short circuit. When running this
simulation, you will find In = = 0.5 mA, and you can calculate Rt from Rt =Vt/In = 4.8 kΩ.

Figure 1.9: Schematic for simulating the Norton current.

Alternatively, Rt can be found by simulation: Insert a current source I1 between the two rightmost ter-
minals as shown in Fig. 1.10 and simulate the voltage V2 across the current source with VS = 0 V. The
current source is inserted as a component where you select ‘current’ in the component selection window.
With the current flowing into the V2 terminal (rotate the current source symbol twice), the resistance is
found as V2/I1, so if the value of I1 is selected to be 1, the value of the voltage V2 is directly the value of
the resistance between the terminals, i.e. Rt .

Figure 1.10: Schematic for simulating the Thévenin resistance.

In Figs. 1.9 and 1.10, the background color has been changed to white using the command ‘Tools →
Color Preferences’ which opens a ‘Color Palette Editor’ for specifying the colors being used for schemat-
ics, netlists and waveforms. Also, the grid has been turned off using the command ‘Ctrl-G’ (or ‘View →
Show Grid’).

Annotating simulation results on the schematic: After having run a ‘.op’ simulation, you may wish
to display the simulation results directly on the schematic. Consider the circuit from Fig. 1.4. For this
circuit, we found the results shown in Fig. 1.6. A very simple way to show these results on the schematic
is to use the ‘Edit → Text’ command (toolbar symbol , hotkey ‘T’) and just use normal copy and paste
(‘Ctrl-C’, ‘Ctrl-V’) from the output file to the input window for the ‘Edit → Text’ command. The result
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Figure 1.11: The circuit from Fig. 1.4 with the results of the ‘.op’ simulation shown as text.

of doing so may look like shown in Fig. 1.11. Notice that in this figure, the font size has been specified
to 1.0 when inserting the text (the default is 1.5).

An alternative way to display specific simulation results is as follows: After having run the simulation,
point to a net (wire) and right-click. This opens a command selection menu, see Fig. 1.12(a). Select
the command ‘Place .op Data Label’. This places a text box showing the voltage of the net. When you
right-click on the voltage, the dialogue box shown in Fig. 1.12(b) opens, allowing you to select another
quantity to display.

Suppose that we are interested in displaying the current in R2 and the power dissipated in R2. The current
is specified in the dialogue box, Fig. 1.12(b), by replacing the $-sign in the bottom line with ‘ ’.
You can also move the text box to an appropriate position by using the move command (hotkey ‘F7’).
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(a) (b)

Figure 1.12: Command selection menu (a) and dialogue box (b) for entering simulation results on the schematic.

Adding a new text box in the same way (i.e. by pointing to a net and right-clicking) lets you specify the
expression ‘ ’ which will calculate the power in R2. When the text boxes have been moved,
the resulting schematic may look like shown in Fig. 1.13(a). You may find that the current and power
need rounding off to integer µA and µW. This can be achieved by using the function ‘round(x)’ in the
specification window. Thus, for the current specify ‘ ’ and for the power specify
‘ ’. Then the resulting schematic looks like shown in Fig. 1.13(b).

(a) (b)

Figure 1.13: The circuit from Fig. 1.4 with the current and the power for R2 shown on the schematic.

Sweeping dc voltages and currents: The simulations just shown give you values of voltages and
currents in a specific operating point, i.e. for fixed values of all components in the system. You can
calculate the voltages and currents for other values of components simply by modifying your schematic
and running the ‘.op’ simulation again. However, there is also the possibility to sweep voltage sources
and current sources over a range of voltages or currents. Assume that we would like to find currents
and voltages in the circuit from Fig. 1.1 for VS varying between 10 V and 30 V. This is achieved by
running a dc sweep simulation. Use the command ‘Simulate → Edit Simulation Cmd’ and open the
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Figure 1.14: Plot of dc sweep simulation for circuit example from Fig. 1.4 using the LTspice default setup of colors.

tab ‘DC sweep’. This opens a dialogue box where you can specify your signal source and the sweep
range. Also the increment must be specified. Select for instance an increment of 1 V. When you have
completed the specification for VS, you click ‘OK’. This opens a command line which can now be placed
on the schematic by the cursor. Insert the command by a left-click on the mouse or by pressing ‘Return’.
The command is shown in the schematic as ‘ ’. You may observe that your previous
simulation command, ‘.op’, is now modified to ‘;op’. This modification turns it into a comment, and
only the new simulation command is executed when you run the simulation. Next, the simulation is run
by the command ‘Simulate → Run’ or by using the ‘Run’-symbol on the toolbar.

If there are no errors in the circuit and in the simulation command, a new window opens for showing
plots of currents and/or voltages. The x-axis shows the voltage range specified for VS, but initially the
plot window is empty. The voltages and/or currents to be shown in the plot window can be selected in
different ways: With the plot window active, you can use the command ‘Plot Settings → Add trace’ or
the command ‘Plot Settings → Visible Traces’. The command ‘Visible Traces’ is also available with the
schematic window active (’View → Visible Traces’) and on the toolbar, symbol . You may notice that
the ‘Add trace’ command works in a different way than the ‘Visible Traces’ command. With the ‘Add
trace’ command, you left-click on the traces that you want to see, and they are all listed in the window
in the bottom of the dialogue box. With the ‘Visible Traces’ command, you select only one trace with a
left-click. If you want more than one variable, use ‘Ctrl-left-click’ to turn on and off the traces to display.
The ‘Add trace’ command is also available by the hotkey ‘Ctrl-A’.

An alternative method for selecting traces is to point at nodes in the schematic for voltages and at com-
ponents for currents. This turns the cursor into a red pointer, , an oscilloscope probe, for the voltages
and a current probe for the currents, . Note that a red arrow in the current probe also shows the posi-
tive direction of current flow. Just left-click at the trace to be added and it will appear in the plot window.
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A double-click implies that only the selected trace is shown. Also, you may note that by pointing to
a wire and pressing the ‘Alt’ key, you select the current in a wire. The voltage difference between two
nodes can also be displayed using the voltage probe: Left-click and hold on one node and drag the mouse
to another node. A red voltage probe will appear at the first node and a black probe at the second node.
Finally, when you hold down the ‘Alt’ key while pointing to a device (e.g. a resistor), the cursor turns
into a thermometer and the resulting plot traces the power dissipated in the device.

The waveform plot can be copied to the clipboard in the same way as the schematic: Use the command
‘Tools → Copy bitmap to Clipboard’ and then paste the waveform plot into another program. The
resulting plot showing the voltage V2 and the current through R1 may look like shown in Fig. 1.14. You
may find that the blue trace (’ ’) is difficult to see on the black background. You can change the
color of the trace by pointing to the trace name above the plot and right-clicking. This opens a window
where you can select another color. Alternatively, you may change the background color of the plot pane
by the command ‘Tools → Color Preferences’ which opens a dialogue window where you can specify
colors for waveforms, schematics and netlists. Also note that if you left-click instead of right-click on
the trace name, a cursor appears which will follow the trace when you move it around by the mouse.
This is useful for finding values of the trace for specific values of the voltage VS.

Once you have closed the plot window, you can re-open it by the command ‘View → Visible Traces’,
toolbar symbol . If you have applied the command ‘Plot Settings → Save Plot Settings’ before closing
the plot window, it will re-open showing the selected traces, otherwise just with an empty plot window.
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Exported file with selected traces from dc sweep simulation

Figure 1.15: Table with results of dc sweep simulation for circuit example from Fig. 1.4.

Another way of finding values of the currents and voltages for specific values of VS is to use the command
‘File → Export’ from the plot window. This opens a window for selecting waveforms to export, and when
you have selected the desired waveforms and click ‘OK’, a ‘.txt’ file is generated with the waveforms
given in tabular form. This file can also be opened by LTspice. Use ‘File → Open’ (or on the toolbar)
and select ‘Files of type: all files’. In the file list, open the ‘.txt’ file with the name corresponding to your
circuit. The resulting table may look like shown in Fig. 1.15.

Sweeping resistor values: Instead of showing variations in the circuit of Fig. 1.1 when sweeping the
voltage source VS, you might be interested in analyzing the circuit when sweeping a resistor value, e.g.
the value of R1. This can be achieved by specifying the value of R1 as a variable parameter. To do so,
the specification for R1 should be changed on the resistor symbol. Instead of specifying the value ‘ ’,
the value must be specified to be ‘ ’ (remember to include the curly brackets ‘ ’). Now you can
specify a sweep range for the parameter ‘ ’ by inserting a ‘.step’ command: Click ‘Edit → SPICE
Directive’ (or on the toolbar), and a dialogue window appears in which you can type a command.
Alternatively, a right-click in the dialogue window opens a ‘Help me Edit’ option where you can select
‘.step Command’. If you prefer to type in the command directly in the ‘Edit’ dialogue window, you can
close the ‘Help’ window by a left-click on ‘Cancel’ or by pressing ‘Escape’. This will bring you back to
the ‘Edit’ dialogue window. Insert the command ‘ ’. This will sweep the
value of R1 from 30 kΩ to 50 kΩ in steps of 2 kΩ. Finally, run a ‘.op’ simulation.

If there are no errors in your circuit, the simulation will open a plot window with the resistance range of
30 kΩ to 50 kΩ as the horizontal axis. You may select voltages and currents to be displayed in the same
way as for the dc sweep simulations. Figure 1.16 shows the schematic from Fig. 1.4 with the ‘.step’
directive inserted, and it shows the resulting waveform plot of V2. Here, the color preferences of both
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Figure 1.16: Simulation of sweep of resistor R1 from Fig. 1.1.

the waveform plot and the schematic have been modified to get a white background and black axes on
the waveform plot. Also, rather than using the autorange scaling of the vertical axis, the axis has been
modified to the range from 0 V to 3.5 V. This can be done by the command ‘Plot Settings → Manual
Limits’ or by moving the mouse cursor over the axis and left-clicking. In Fig. 1.16 (and in subsequent
figures showing simulation plots), the font size of the labels on the axes has been increased using the
command ‘Tools → Control Panel’ and the tab ‘Waveforms’ where the font has been changed to Arial
and the fontsize to 18 points.

In a waveform plot, you can insert text and other annotations (e.g. cursor position) using the command
‘Plot Settings → Notes & Annotations’.

In the plot window, you can also zoom in on details simply by clicking and dragging to define a box
using the left mouse button.

If you want to run a simulation with just one value for a variable parameter (‘ ’ in Fig. 1.16), then
instead of the ‘.step’ directive, you can specify the value of ‘ ’ using a ‘.param’ directive: Insert the
SPICE directive ‘ ’ to run a simulation with R1 = 40 kΩ and delete the ‘.step’ directive
or edit it into a comment by inserting an asterix ( ) as the first character or by ticking ‘Comment’ in
the editing window (after having closed the ‘Help me Edit’ window by a left-click on ‘Cancel’). If
you do not disable the ‘.step’ directive, the simulation will run this command regardless of the ‘.param’
specification.

The ‘.step’ directive is a very useful command for design iterations. By defining relevant design para-
meters as variable parameters and stepping the values over a suitable range, you can quickly examine the
influence of a parameter on the circuit characteristics. Problems 1.2 on page 42, 1.5 on page 43 and 1.9
on page 45 are examples of this.

Example 1.2: A transconductance amplifier.

The next example is a circuit containing a voltage-controlled current source as shown in Fig. 1.17. Essen-
tially, this is an inverting transconductance amplifier with an input resistance Rin, an output resistance Ro

and a transconductance gm. In Fig. 1.17, a load resistor RL and a signal source VS with a source resistance
RS is connected to the amplifier.
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Figure 1.17: An inverting transconductance amplifier.

Figure 1.18: LTspice schematic for the inverting transconductance amplifier.

In this circuit, there is a new type of component, the voltage-controlled current source. LTspice has,
like other Spice programs (Tuinenga 1995; Vladimirescu 1994), a voltage-controlled current source
as a standard component with the circuit designator ‘G’. The schematic drawn in LTspice is shown
in Fig. 1.18.
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The LTspice symbol for the voltage-controlled current source explicitly shows the controlling voltage
as input terminals to the component symbol. In the component selection box (Fig. 1.3), you may select
either ‘g’ or ‘g2’, the only difference being the polarity of the controlling voltage. The controlled current
source is edited by right-clicking on the symbol. This opens a ‘Component Attribute Editor’ as shown
in Fig. 1.19. By double-clicking on the values for ‘InstName’ and ‘Value’, the values can be changed to
the values shown in Fig. 1.18. Alternatively, just right-click on the device name (e.g. ‘ ’) and the value
‘ ’ to edit them to the desired values in the same way as editing the value of a resistor or a dc current
source. After inserting a simulation command, you may now run a dc sweep simulation, e.g., sweeping
vS from −2 V to +2 V. The resulting plot of vO versus vS may look like shown in Fig. 1.20.

Figure 1.19: The window for editing the specifications of the voltage-controlled current source.

Figure 1.20: Plot of vO versus vS for the inverting amplifier.

For plotting vO versus vIN , you just move the cursor in the plot window to the x-axis and apply a right-
click on the mouse. This opens a specification window for the x-axis as shown in Fig. 1.21 where you
can change the ‘Quantity Plotted’ from ‘ ’ to ‘ ’, resulting in a plot of vO versus vIN .

The arbitrary behavioral source: LTspice also provides an alternative to the voltage-controlled cur-
rent source. This is an ‘Arbitrary behavioral current source’, device type ‘bi’ in the component selection.
The same device can be used for both a voltage-controlled current source and a current-controlled current
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Figure 1.21: Specification window for the horizontal axis and plot of vO versus vIN for the inverting amplifier.

source. Figure 1.22 shows the circuit from Fig. 1.17 redrawn with the ‘bi’ symbol. Notice the definition
line for the current source: ‘ ’. You need to specify the controlling voltage as ‘ ’,
not just ‘ ’, otherwise you will receive an error message. Also note that the asterix ( ) is the character
indicating multiplication.

Figure 1.22: LTspice schematic for the inverting transconductance amplifier using an arbitrary behavioral current source.

In Fig. 1.22, the symbol for the controlled current source is a circle, exactly like the symbol for an
independent current source. Often in the literature, controlled sources are represented by a diamond-
shaped symbol to distinguish them from the independent sources (Hambley 2014; Sedra & Smith 2016).
You may actually edit the symbol for the controlled current source using the symbol editor in LTspice.
When you are in the ‘Component Attribute Editor’ (Fig. 1.19), you click ‘Open Symbol’ to enter the
symbol editor where you can redraw the shape of the symbol. It is a good idea to save your own symbols
in a dedicated folder for this, rather than just saving the modified symbol in the default symbol library
which is updated every time the LTspice installation is updated. You can define a path to your own
symbol folder (e.g. ‘My symbols’) using the command ‘Tools → Control Panel → Sym. & Lib. Search
Paths’, see Fig. 3.11 on page 87. When inserting a symbol from your own symbol folder, select this folder
in the selection window for ‘Top Directory’ in the component selection box, see Fig. 1.3 on page 15.

In Fig. 1.23, the transconductance amplifier is redrawn with a diamond-shaped symbol, and the load
resistor RL and source resistor RS are omitted. The circuit shown has only linear components, and it is
easy to see that the input resistance is Rin = 10 kΩ and the output resistance is Ro = 80 kΩ. The open
circuit voltage gain Avoc can be calculated from Avoc =−gm Ro =−40 V/V, where gm = 0.5 mA/V is the
transconductance of the voltage-controlled current source. These values can also be found by simulation:
With an input voltage of vS = vIN = 1 V, the output voltage is vO = Avoc ×1 V, so the simulated value of
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Figure 1.23: The inverting amplifier with a diamond-shaped symbol for the arbitrary behavioral current source.

the output voltage directly gives the value of Avoc. By changing the input signal to a current source of
1 A, the value of the input voltage is Rin ×1 A, so the simulated value of the input voltage directly gives
the value of Rin. By resetting the input voltage (vS = vIN = 0) and applying a current source of 1 A to the
output, the value of the output voltage is Ro ×1 A, so the simulated value of the output voltage directly
gives the value of Ro.

Nonlinear controlled current source: Next, we assume that the voltage-controlled current source is
given by a nonlinear relation, I = 0.5 mA/V2 × v2

IN for vIN ≥ 0 V. The specification for ‘ ’ in Fig. 1.23
must then be modified to ‘ ’. Observe the double asterix ( ) for raising to power
of 2. With vIN = 1 V, the ‘.op’ simulation still results in vO =−40 V, but a dc sweep of vIN from 0 V to
2 V shows the nonlinear relation between vO and vIN , see the green curve in Fig. 1.24.
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For this amplifier, the voltage gain is not just vO/vIN . Rather, the voltage gain is defined as the small-
signal gain Avoc = ∂vO/∂vIN calculated in the bias point of the amplifier. For an input bias voltage of
VIN = 1 V, we find Avoc = ∂vO/∂vIN = −Ro × 2× 0.5 mA/V2 ×VIN = −80 V/V. Clearly, the gain de-
pends on the bias value of the input voltage. The voltage gain is also seen as the slope of the nonlinear
relation between vO and vIN . This slope can be displayed directly in the plot window: When you click
on the command ‘Plot Settings → Add trace’ (or hotkey ‘Ctrl-A’), a window opens for specifying traces
to plot. The bottom line in this window lets you enter an expression to add. A large selection of math-
ematical operations is available (see the ‘Help’ menu, ‘Waveform Arithmetic’), including the derivative
of a variable with respect to the x-axis variable. The function ‘ ’ will give you the derivative of
the output voltage with respect to the input voltage. The resulting plot is the blue line in Fig. 1.24 from
which you can see that Avoc = −80 V/V as expected for VIN = 1 V. Actually, ‘ ’ is calculated
as a difference-based derivative, so in order to obtain a smooth curve as shown in Fig. 1.24, you have to
use a small step size for vS. For the plot in Fig. 1.24, a step size of 0.01 V has been applied. Using a step
size of 0.1 V instead will give a staircase curve for ‘ ’.

Figure 1.24: Plot of vO versus vS for the inverting amplifier with a nonlinear voltage-controlled current source.

LTspice has another simulation command which directly gives you the small-signal transfer function at
dc, the ‘DC Transfer’ simulation. Use the command ‘Simulate → Edit Simulation Command’ and choose
the tab ‘DC Transfer’. Here you specify the output and the source. For the circuit of Fig. 1.23, the output
is ‘ ’ (not just ‘ ’) and the source is ‘ ’. The resulting simulation command is ‘ ’,
and after running the simulation (with ‘ ’), a window opens with the information
shown in Fig. 1.25.

Output from dc transfer simulation

--- Transfer Function ---

Transfer_function: -80 transfer
vs#Input_impedance: 10000 impedance
output_impedance_at_V(vo):  80000  impedance

--- Transfer Function ---

Transfer_function: -80 transfer
vs#Input_impedance: 10000 impedance
output_impedance_at_V(vo):    80000 impedance

--- Transfer Function ---

Transfer_function:   -80 transfer
vs#Input_impedance: 10000 impedance
output_impedance_at_V(vo): 80000 impedance

Figure 1.25: Output from ‘.tf’ simulation of the inverting amplifier with a nonlinear voltage controlled current source.
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Example 1.3: A current amplifier.

The next example in this tutorial is a current amplifier as shown in Fig. 1.26. The gain element in this
circuit is a current-controlled current source. The current amplifier has an input resistance Rin, a short-
circuit current gain Aisc and an output resistance Ro.

A simple examination of the circuit shows an inverting current gain from the input signal iS to the current
iL in the load resistor of Aisc multiplied by the current-divider ratios at the input side and the output side.
With the values shown in Fig. 1.26, we find iL/iS = −89.1 A/A. For iS = 100 µA, we get an output
current iL =−8.91 mA and an output voltage of vO =−8.91 V.

Figure 1.26: An inverting current amplifier.

Figure 1.27: LTspice schematic for the inverting current amplifier.

In LTspice, the current-controlled current source is described either by the device type ‘F’ or by the ‘Ar-
bitrary behavioral current source’, device type ‘bi’ in the component selection. Figure 1.27 shows the
schematic drawn with the arbitrary behavioral current source (using a diamond-shaped symbol). Obvi-
ously, when examining Fig. 1.26, the current is controlled by the current through Rin, so an immediate
specification for B1 would be ‘ ’ as shown in Fig. 1.27. Running a ‘.op’ simulation indeed
also results in the expected values of iL and vO.

But running a ‘.tf’ simulation (see page 31) with ‘ ’ as the source and ‘ ’ as the output gives a
transfer function of 0 which is obviously not correct. The value to expect is vO/iS = −8910 V/A. The
input resistance and the output resistance from the ‘.tf’ simulation are shown as 900 and 990, respectively,
which is as expected since the input side is a parallel connection of 1 kΩ and 9 kΩ and the output side
is a parallel connection of 1 kΩ and 99 kΩ. Trying a ‘.tf’ simulation with ‘ ’ as the output also
results in a transfer function of 0. The reason for these errors is that some of the analyses in LTspice (e.g.
‘.tf’ and ‘.ac’ (see Tutorial 2)) require that a current is specified as a current through a voltage source as
described on page 20.
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Figure 1.28 shows the circuit from Fig. 1.27 redrawn with dc voltage sources of 0 V in series with Rin

and RL and B1 specified as ‘ ’. The ‘.op’ simulation still provides the correct result, and
now also both ‘.tf’ simulations with ‘ ’ and ‘ ’ as the output show the expected gain. The
input resistance is found from both ‘.tf’ simulations, but the output resistance is found only from the
simulation with ‘ ’ as the output.

Figure 1.28: LTspice schematic for the inverting current amplifier with voltage sources in series with Rin and RL and altered
specification for B1.

Now, let us connect a feedback resistor R f of 15 kΩ between output and input as shown in Fig. 1.29,
shunt - shunt feedback (Sedra & Smith 2016). With this feedback resistor, the amplifier is turned into a
transresistance amplifier. With a very large current gain Aisc, we would expect a transresistance equal to
−R f and small values of input and output resistance. The ‘.tf’ simulation with vO as the output shows
a gain (transresistance) of −12.6 kΩ, an input resistance of 136 Ω and an output resistance of 149 Ω
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Figure 1.29: LTspice schematic for the inverting current amplifier with a feedback resistor R f .

(including Rs and RL). Increasing Aisc to 1000, we find a gain very close to −15 kΩ and input and output
resistances in the range of 1 to 2 Ω.

Next, let us see what happens if we change the specification of the current-controlled current source to
‘ ’. Then we find that neither the ‘.op’ simulation, nor the ‘.tf’ simulations will run. They
both return the error message ‘Analysis failed: Iteration limit reached’. This shows that LTspice is unable
to find the bias point from the ‘.op’ simulation when the current is not specified as the current through
a voltage source. In other examples, the operating point may be found but with reduced precision if
the current is specified as the current in a resistor. The circuit shown in Problem P1.3 on page 42 is an
example of such a circuit.

The lesson learned from this example is: The controlling current for a current-controlled voltage source
or a current-controlled current source must be the current through an independent voltage source. Insert
a dc voltage source of 0 V in series with the device carrying the controlling current and use the current
in this voltage source as the controlling current.

This is also the way to specify a controlling current when using the current-controlled current source with
circuit designator ‘F’. Figure 1.30 shows the circuit from Fig. 1.29 redrawn with the device ‘f’ instead

Figure 1.30: Circuit from Fig. 1.29 redrawn with a current-controlled current source instead of an arbitrary-controlled current
source.
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of ‘bi’ and also shows the specification window for ‘f’. In this window, the name of the dc voltage source
for the controlling current must be specified in the line ‘Value’, and the current gain must be specified in
the line ‘Value2’. In order to make the current gain visible on the schematic, an X has been inserted in
the rightmost column (‘Vis.’) in the specification line for ‘Value2’.

Example 1.4: Debugging a schematic.

Although LTspice is easy to use and you quickly learn how to draw schematics and simulate circuits, you
cannot expect to get everything correct every time you try a new circuit. Some errors in the schematic are
fatal in the sense that they prevent the simulation from running. Somehow, these are not the worst errors
because they are so obvious. Other errors may not prevent the simulation from running but they will
lead to incorrect simulation results. Unless you notice such errors, they can be even more detrimental
that the fatal errors preventing the simulation. Sometimes warnings appear in the error log file after the
simulation, and it is always a good idea to examine the error log file after your simulations.

Also, it is always a good idea to consider whether your simulation results seem reasonable, or if some
values are way off from what you expected. If so, it may be caused by incorrect inputs to your simulation,
e.g. incorrect component values, or as we have seen in Example 1.3, it may be caused by an error such
as using a current through a resistor rather than through an independent voltage source to control another
voltage or current. This is an error which does not generate a warning in the error log file.

In this example, we show an LTspice schematic with a number of different kinds of errors and we show
how the errors are identified and corrected by examining the output files and error log files. Typically,
you would not find all these kinds of errors in one schematic. They are shown to illustrate how they
are reported in the error log file. The starting point is the inverting transconductance amplifier shown in
Fig. 1.17 on page 27. Figure 1.31 shows this amplifier drawn in LTspice but with a number of errors.

Figure 1.31: LTspice schematic WITH ERRORS for the inverting transconductance amplifier from Fig. 1.17.

Compared to the correct version shown in Fig. 1.18 on page 27, an obvious difference is that the symbol
for the controlled current source now has the arrow pointing downwards, just as in Fig. 1.17. This is
achieved by selecting the component symbol ‘g2’ when inserting the controlled current source. It has
to be rotated twice and mirrored when inserted in order to have the arrow pointing downwards and the
input side to the left. The simulation specified is the same dc sweep as in Fig. 1.18.
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LTspice Error LogCircuit: * M:\LTspice\Tutorial01\Fig1_31.asc

Error on line 2 : rin vin 0 10^4
Unknown parameter "^4"

Error on line 4 : vs vs 0 v
Unknown parameter "v"

Error on line 5 : rl vo n001 .1 mohm
Unknown parameter "mohm"

Error on line 6 : ro vo n001 80 k
Unknown parameter "k"

Error on line 7 : g§0.5m vo n001 vin 0 g
Unknown parameter "g"

Fatal Error: Missing value of transconductance for "0.5m"

(a) (b)

Figure 1.32: Error messages from the simulation of the circuit in Fig. 1.31.

Now, let us try to run the simulation. This just opens the window shown in Fig. 1.32(a), and the simulation
does not run. When closing the window, a new window opens with the error log file, see Fig. 1.32(b).
From this, we see that a fatal error is ‘Missing value of transconductance for "0.5m"’. Apparently,
LTspice does not accept the way, the controlled current source has been specified. What went wrong is
that the rotations and the mirroring of the symbol ‘g2’ have swapped the position of the name and the
value of the device. In Fig. 1.18, the name appears above the value, but here, it is the opposite. When you
have inserted the component, you can actually see which is the name and which is the value: The name
by default always has a number, the value does not. Also, you can see on the status bar at the bottom of
the LTspice program window if you have placed the cursor on the name of a component or on the value.
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Figure 1.33: Plot of vO versus vS for the inverting amplifier with errors in the schematic.

As you can see from Fig. 1.32(b), there are some other errors as well, but before considering these, let
us correct the fatal error. We simply swap the name and the value of the controlled current source and
run the simulation again. This time, the simulation runs and opens a window for plotting the simulation
results. But also the error log file opens. However, since the simulation actually did run, we may use the
plot window for plotting vO versus vS in the same way as in Fig. 1.20 on page 28. The resulting plot is
shown in Fig. 1.33.

When comparing this plot to Fig. 1.20, it is quite evident that something is still very wrong. The y-axis
scaling is very different, so it is a good idea to re-open the error log file. This is done by the command
‘View → SPICE Error Log’ or by typing ‘Ctrl-L’, and the error file shown in Fig. 1.34 appears.

LTspice Error Log

Error on line 2 : rin vin 0 10^4
Unknown parameter "^4"

Error on line 4 : vs vs 0 v
Unknown parameter "v"

Error on line 5 : rl vo n001 .1 mohm
Unknown parameter "mohm"

Error on line 6 : ro vo n001 80 k
Unknown parameter "k"

WARNING: Node N001 is floating.

Vs: Missing value, assumed 0V @ DC

Figure 1.34: Error messages from the simulation of the circuit in Fig. 1.31 after having corrected the specification of the controlled
current source.

All the errors listed in the error log file shown in Fig. 1.32(b) are still there. Obviously, they have to do
with the specification of the voltage source vS and the resistors Rin, Ro and RL. For vS, the specification of
the voltage has been forgotten. It is still just the ‘ ’ which appeared when the voltage source symbol was
inserted in the schematic. LTspice runs the simulation anyway, assuming a specification of 0 V, and the
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value does not really matter for the simulation specified because vS is swept from −2 V to 2 V. However,
if you forget the specification of a resistor value, it is considered a fatal error and the simulation does not
run.

For the resistors, the error log file reports unknown parameters. Looking in detail at each resistor, we
see that for Rin, the problem is the notation ‘10ˆ4’. This is treated by LTspice as a value of 10 Ω and the
following ‘ˆ4’ is considered an unknown parameter. The correct way of specifying a value of ‘10ˆ4’ is
‘1e4’. For the resistor Ro, the error in the specification is the space between ‘80’ and ‘k’. This causes
LTspice to assume a resistor value of 80 Ω and the suffix ‘k’ is just neglected as an unknown parameter.
For RL, there is also a space between the value and the suffix, causing LTspice to assume a value of 0.1 Ω.
Notice that it is acceptable to omit the ‘0’ before the decimal point. If you try to correct the value of RL

just by deleting the space before the suffix, you will observe that LTspice changes ‘Mohm’ into ‘mohm’,
implying that instead of specifying ‘0.1 Megaohm’, you have specified ‘0.1 milliohm’. The suffix must
be changed to ‘Meg’ in order to obtain the desired value.

With all the resistors corrected, you may now run a simulation and it will give you a plot of vo versus
vS looking exactly like the plot in Fig. 1.20, and the error log file is not automatically opened. However,
looking in detail at the error log file in Fig. 1.34, you also have a warning that node N001 is floating. It
does not prevent LTspice from running the simulation, and since the output voltage appears in the plot
window to be the same as in Fig. 1.20, LTspice must have assumed a reasonable value for the floating
node. Looking in detail at the schematic in Fig. 1.31, you may identify the problem with the floating
node: there is no connection between ground on the input side of the amplifier and ground on the output
side of the amplifier.

The impact of the missing ground connection may be analyzed by plotting the voltage of the node N001,
ground on the output side. This plot is shown in Fig. 1.35, and you can see that the node is not really at

Figure 1.35: Plot of the floating output ground voltage versus vS for the inverting amplifier with errors in the schematic.
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ground but shows some fluctuations. Using ‘Ctrl-L’ to open the error log file, you would also note that
the warning about a floating node is still there, so the final step in the debugging of the circuit is to insert
the missing connection to ground on the output side, and the resulting schematic is shown in Fig. 1.36.

Figure 1.36: LTspice schematic with all errors from Fig. 1.31 corrected.

Finally, we show here the netlists both for the circuit from Fig. 1.31 and the circuit from Fig. 1.36.
You will observe that the differences in the two netlists can all be related to the error messages shown
in Figs. 1.32 and 1.34.

LTspice netlist

* M:\LTspice\Tutorial01\Fig1_31.asc
Rin Vin 0 10^4
RS Vin VS 40k
VS VS 0 V
RL Vo N001 .1 Mohm
Ro Vo N001 80 k
G§0.5m Vo N001 Vin 0 G
.dc VS -2 2 0.1
.backanno
.end

LTspice netlist

* M:\LTspice\Tutorial01\Fig1_36.asc
Rin Vin 0 1e4
RS Vin VS 40k
VS VS 0 0
RL Vo 0 .1Meg
Ro Vo 0 80k
G Vo 0 Vin 0 0.5m
.dc VS -2 2 0.1
.backanno
.end

Figure 1.37: LTspice netlists for circuits from Fig. 1.31 (left) and Fig. 1.36 (right).
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Hints and pitfalls

– The suffix for ‘milli’ is ‘m’. The suffix for ‘Mega’ is ‘meg’. After the suffix, you may insert the
unit (e.g. A for ampere). An alternative suffix is ‘e’ followed by the power of 10, e.g. ‘e-3’ for
‘milli’. You cannot use ‘ 10ˆ-3’ as a suffix for ‘milli’.

– Do NOT insert a space between a component value and the suffix or unit.

– Always define a ground node in your circuit.

– Many commands can be selected either via a command and subcommand (e.g. ‘Edit → Resis-
tor’), a toolbar symbol (e.g. ), or a hotkey (e.g. R). The assignment of hotkeys can be seen
using the command ‘Tools → Control Panel → Drafting Options → Hotkeys’.

– A right-click on the schematic drawing opens a menu with several sub-menus. The ‘Draft’
sub-menu allows you to insert ‘Components’, ‘Wires’, ‘Net Names’, ‘SPICE directives’, etc.

– A right-click in the window for entering a SPICE directive opens a ‘Help me Edit’ option.

– The commands ’Drag’, ’Move’, ’Duplicate’ and ’Delete’ work not only on single symbols.
When you have activated one of the commands, you can define a box by clicking and dragging
using the left mouse button. The command works on the entire contents of the box.

– When you have several identical components in your circuit, it is convenient to edit just one
instance of the component to the correct value and then use the ’Duplicate’ command (F6),
rather than inserting and editing each component individually.

– See Problem 1.8 on page 45 for more hints on drawing schematics.

– When you move the mouse cursor to a component symbol or text, the status bar at the bottom
of the LTspice program window gives information about editing options.

– Color preferences can be edited for both schematics and waveforms using the command
‘Tools → Color Preferences’.

– Font sizes on schematics and waveform plots can be modified using the command ‘Tools →
Control Panel’ and the appropriate tab (e.g. ‘Drafting Options’ or ‘Waveforms’).

– If you have closed a window with results (e.g., from a ‘.op’ simulation or a waveform plot), you
can re-open it by the command ‘View → Visible Traces’, toolbar symbol .

– In a waveform plot, you can zoom in on details by clicking and dragging to define a box using
the left mouse button.

– Schematics and waveform plots can be copied to the clipboard with the command ‘Tools →
Copy bitmap to Clipboard’ and then pasted into another program (e.g. Microsoft Word).

– The controlling current for a current-controlled voltage source or a current-controlled current
source must be the current through an independent voltage source. Insert a dc voltage source
of 0 V in series with the device carrying the controlling current and use the current through this
voltage source as the controlling current.

40

Download free eBooks at bookboon.com



CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

41

Tutorial 1 – Resistive Circuits

41

References

Hambley, AR. 2014, Electrical Engineering, Principles and Applications, Sixth Edition, Pearson Edu-
cation Ltd., Harlow, UK.

Sedra, AS. & Smith, KC. 2016, Microelectronic Circuits, International Seventh Edition, Oxford Univer-
sity Press, New York, USA.

Tuinenga, PW. 1995, Spice: A Guide to Circuit Simulation and Analysis Using PSpice, Third Edition,
Prentice Hall, Upper Saddle River, USA.

Vladimirescu, A. 1994, The SPICE book, First Edition, John Wiley & Sons, Hoboken, USA.

41
Download free eBooks at bookboon.com Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

www.mastersopenday.nl

Visit us and find out why we are the best!
Master’s Open Day: 22 February 2014

Join the best at
the Maastricht University
School of Business and
Economics!

Top master’s programmes
•	 �33rd place Financial Times worldwide ranking: MSc 
International Business

•	 1st place: MSc International Business
•	 1st place: MSc Financial Economics
•	 2nd place: MSc Management of Learning
•	 2nd place: MSc Economics
•	 �2nd place: MSc Econometrics and Operations Research
•	 �2nd place: MSc Global Supply Chain Management and 
Change

Sources: Keuzegids Master ranking 2013; Elsevier ‘Beste Studies’ ranking 2012; 
Financial Times Global Masters in Management ranking 2012

Maastricht
University is

the best specialist
university in the

Netherlands
(Elsevier)

http://www.mastersopenday.nl


CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

42

Tutorial 1 – Resistive Circuits

Problems

1.1

Figure P1.1

For the circuit shown in Fig. P1.1,
find the Thévenin voltage Vt and the
Thévenin resistance Rt . A load resis-
tor of RL = 3 kΩ is now connected be-
tween the terminals a and b. Find the
power dissipated in RL.

1.2

Figure P1.2

For the circuit shown in Fig. P1.2, de-
termine the value of resistor Rx so that
the current im in the 10 kΩ resistor is
30 µA.

1.3

Figure P1.3

For the circuit shown in Fig. P1.3, de-
termine the value of the voltages v1 and
v2 and the current ix.

1.4

Figure P1.4

For the circuit shown in Fig. P1.4, find
the equivalent resistance looking into
terminals a – b.
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1.5

Figure P1.5

For the circuit shown in Fig. P1.5, find
the value of the gain Avoc which gives
an output power in RL of 1 W when
the signal voltage vs is 50 mV. With
this value of Avoc, plot the output power
versus the signal voltage vs for vs in the
range from 0 mV to 100 mV.
Also plot the output power versus the
input voltage vin for vs in the range
from 0 mV to 100 mV.
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1.6

Figure P1.6

The circuit shown in Fig. P1.6 is a
transresistance amplifier built from an
inverting voltage amplifier with an in-
put resistance of 10 kΩ, an output resis-
tance of 1 kΩ and an open circuit volt-
age gain of −50 V/V and a feedback
resistor with a value of 40 kΩ. Find the
open circuit transresistance Rmoc, the
input resistance Rin and the output re-
sistance Ro of the resulting transresis-
tance amplifier.

1.7

Figure P1.7

Figure P1.7 shows a nonlinear trans-
conductance amplifier. Find the val-
ues of bias voltages and currents for an
input bias voltage (quiescent voltage)
of VIN = 1.0 V. Plot the output voltage
vO for the input voltage in the range
from 0.5 V to 1.8 V. Find the small-
signal voltage gain vo/vin for an input
bias voltage of VIN = 1.0 V and plot the
small-signal voltage gain as a function
of the input bias voltage for the input
bias voltage in the range from 0.5 V to
1.8 V.
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1.8

Figure P1.8

Figure P1.8 shows a series connection
of three resistors and a voltage source.
Try three different ways of drawing the
schematic:
(1): Insert the components and draw
the connections between them.
(2): Insert the components (includ-
ing the ground symbols) and draw
an unbroken wire (hotkey ‘F3’) from
the leftmost ground symbol across the
components to the rightmost ground
symbol.
(3): Insert the ground symbols, draw an
unbroken wire between them, and then
insert the component directly on top of
the wire.
Observe how LTspice ‘cleans up’ the
wiring.
Find the voltages VA, VB and VC.

1.9

Figure P1.9

Figure P1.9 shows a simple resistive
circuit with five resistors where only
three of the resistor values are known.
However, the voltage of node A is VA =

3 V, and the current IS supplied by the
dc voltage source VS is IS = 4.25 mA.
Use LTspice to find the values of the
two resistors Rx and Ry.
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Answers

1.1: Vt = 9 V; Rt = 6 kΩ; PRL = 3 mW.

1.2: Rx = 3.31 kΩ.

1.3: v1 = 6 V; v2 = 4 V; ix = 0.4 mA.

1.4: Rab = 3.387 kΩ.

1.5: Avoc = 70 V/V.

1.6: Rmoc =−36.28 kΩ; Rin = 744 Ω; Ro = 90.7 Ω.

1.7: Bias point: ID = 0.125 mA; IC = 0.417 mA; IL = 0.292 mA; VO = 5.83 V.
Small-signal voltage gain with VIN = 1.0 V: vo/vin =−3.33 V/V.

1.8: VA = 3.0000 V; VB = 2.997 mV; VC = 2.997 nV.

1.9: Rx = 5 kΩ; Ry = 14 kΩ.
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Tutorial 2 – Circuits with Capacitors and Inductors

This tutorial introduces the fundamentals of transient simulations and ac simulations. After having com-
pleted the tutorial, you should be able to

– specify a transient simulation in LTspice.

– specify an ac simulation in LTspice.

– use the simulation plots for finding circuit properties such as time constants and −3 dB
frequencies.

– use simple components specified by a ‘.model’ directive.

– specify initial conditions for capacitors and inductors.

– use the ‘.measure’ directive for finding circuit properties such as time constants.

– simulate complex impedances.

Example 2.1: An RC network.

The first example is a simple RC network with two resistors and a capacitor as shown in Fig. 2.1:

(a) (b)

Figure 2.1: RC network (a) and input voltage vS to the network (b).

Transient response: Let us assume that the voltage source vS is a time-varying voltage as shown
in Fig. 2.1(b). The voltage jumps from 0 V to a value of 5 V at the time t = 0 s and returns to 0 V
at the time t = 2 ms. This will cause the capacitor to charge and discharge. For a simulation of the
charging and discharging, we will run a transient simulation and specify the voltage source vS as a
time-varying voltage. The circuit is drawn in LTspice using the selection of editing commands as in
Tutorial 1. The capacitor is available both as a command, ‘Edit → Capacitor’, as a toolbar symbol ,
and as a hotkey ‘C’.

47

Download free eBooks at bookboon.com



CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

48

Tutorial 2 – Circuits with Capacitors and Inductors

When specifying the voltage source vS, you point to the centre of the symbol. This turns the cursor into
a hand . A right-click opens a window for specifying the voltage source. In this window, left-click
on ‘Advanced’. This opens a dialogue box as shown in Fig. 2.2 where you may select time-varying
functions, e.g. PWL, piecewise linear. A series of boxes for entering times and values will appear. No-
tice that the voltage cannot be changed abruptly, so the vertical edges shown in Fig. 2.1(b) must have
a certain slope. Corresponding to the timing in Fig. 2.1(b), you may enter time 1 = 0s, value 1 = 0V,
time 2 = 0.1us, value 2 = 5V, time 3 = 2ms, value 3 = 5V, time 4 = 2.0001ms, value 4 = 0V. In this way,
the voltage changes between 0 V and 5 V in 0.1 µs. An alternative to specifying time 4 as 2.0001ms
is to specify time 4 = 2ms+0.1us . Remember to include the curly brackets ‘ ’, otherwise you will
receive an error message and the simulation will not run. Also note that you may include the units (’s’
for seconds and ‘V’ for volts). This makes it easier to read the specification shown on the schematic. The
specification is shown unless you untick the box for ‘Make this information visible on schematic’. This
is not recommended. The specification does take up some space on the schematic, but you may move
this information to a convenient place in the schematic using the ‘Move’ or ‘Drag’ command.

Figure 2.2: Specification window for the voltage source vS.

Next, you should specify the simulation. Use the command ‘Simulate → Edit Simulation Cmd’ and open
the tab ‘Transient’. For a simulation of the charging and discharging of the capacitor, you can run the
simulation starting at time t = 0 and stopping at the time specified in the box for ‘Stop Time’. When
inserting a stop time of 4 ms, the transient simulation will show both the charging and the discharging.
The circuit is now ready for simulation. If there are no errors, the simulation opens a plot window with
a time axis, and by pointing to ‘ ’ on the schematic (the red pointer, ), the capacitor voltage vC is
shown in the plot window. Figure 2.3 shows both the LTspice schematic and the resulting plot window.
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Figure 2.3: LTspice schematic and simulation results for the circuit in Fig. 2.1.

It is evident that the charging and discharging takes place with the same time constant. For the charging,
a simple analysis of the circuit gives

vC = V0 (1− exp(−t/τ)) (2.1)

V0 = Vs
R2

R1 +R2
= 3 V (2.2)

τ =
1

(R1 ‖ R2)C
= 240 µs (2.3)

The time constant can also be found from the simulation of the charging. From vC =V0 (1− exp(−t/τ)),
we find that at t = τ , the voltage is V0 (1 − 1/e). Therefore, if we scale the output by a factor of
[V0 (1−1/e)]−1, the scaled voltage is 1 V when t = τ . By using the command ‘Plot Settings → Add
trace’ (or the hotkey ‘Ctrl-A’), you can open a window for selecting traces. In the bottom line, you can
enter ‘Expression(s) to add’. In this case, enter ‘ ’ and click ‘OK’. Notice that the
waveform editor in LTspice recognizes ‘ ’ (or ‘ ’) as the base for the natural logarithm. This generates
a new trace in the plot, scaled so that the voltage is 1 V for t = τ . You can find this time by left-clicking
on the trace name above the plot to activate a cursor which follows the trace when you move it around by
the mouse. Also, a window opens showing the position of the cursor, so you just move the cursor until
the vertical position is 1 V and read the horizontal position of the cursor as the value of τ .

Figure 2.4 shows the plot window with the scaled capacitor voltage. In this figure, the x-axis has been
scaled to show only the interval from 0 to 2 ms. Also, the grid has been turned off by the command
‘Plot Settings → Grid’ (or ‘Ctrl-G’) in order to make the cursor more visible. The figure also shows
the window with the coordinates for the position of the cursor. If this window is moved to be inside
the simulation plot window, it is copied together with the plot window using ‘Tools → Copy bitmap to
Clipboard’. Alternatively, it can be copied separately to the clipboard using the standard ‘Print screen’
function (‘Alt-PrtScn’). Using the command ‘Plot Settings → Notes & Annotations → Label Curs. Pos.’,
you can also directly insert the cursor position in the plot as shown in Fig. 2.4.
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Figure 2.4: Plot window with scaled output for finding the time constant.

Next, we introduce a small change to the circuit: Instead of switching the voltage source vS between 0 V
and 5 V, we insert a switch as shown in Fig. 2.5. The switch is open for t < 0, closes when t = 0 s,
and re-opens at t = 2 ms. This will cause the capacitor to charge as before, but the discharge will be
only through R2. In LTspice, the switch can be modeled by the component ‘sw’ from the component
selection . This is a voltage-controlled switch, so it requires a control voltage to specify the state of
the switch.
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Figure 2.5: The RC network from Fig. 2.1 with a switch between the voltage source and the resistor R1.

Unlike a resistor or a capacitor, the switch cannot be specified simply by a value. The properties of the
switch are given in a ‘.model’ specification in LTspice. You can find the detailed syntax for the required
‘.model’ specification using the ‘Help’ function in LTspice.

When you insert the switch in the schematic, it appears with a reference to a default switch model ‘SW’.
You may use the default model without inserting a ‘.model’ specification. If you wish to change some
parameters of the switch, you must include a ‘.model’ specification and it is a good idea to use another
name for the model, rather than the default ‘SW’.

Figure 2.6: LTspice schematic and simulation results for the circuit in Fig. 2.5.

Figure 2.6 shows the LTspice schematic including a ‘.model’ specification which is inserted using the
command ‘Edit → SPICE Directive’ (or the toolbar symbol ). The ‘.model’ specification first spec-
ifies that the device to be modeled is the device using the model name ‘ ’ in the schematic. Next,
the model used is the standard LTspice model ‘ ’ which is specified by some parameters given in the
brackets. In this case, only the threshold of the switch is changed from the default value of 0 V, so that
we can use the signal specification from Fig. 2.3 for the control signal to the switch. Also note that the
model is named ‘ ’ to distinguish it from the default name.

The ‘.model’ specification is shown on the schematic with a smaller font size than otherwise used in the
schematic. The font size is selected when inserting the specification (or when editing the specification).
You can also make a ‘global’ change of the font size on schematics using the command ‘Tools → Control
Panel’ and the tab ‘Drafting Options’.
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In this schematic, the voltage VS is specified as a dc voltage, and the time-varying signal to control the
switch is the voltage source ‘ ’ which is specified as a piecewise-linear voltage source with the
same specification as the input voltage for the circuit in Fig. 2.3. Also shown in Fig. 2.6 is the simulation
result for vC, compare Fig. 2.3.

It is clear from the simulation that the time constant for discharging the capacitor is now larger than the
time constant for charging. The time constant for charging is the same as before, i.e. 240 µs. The time
constant for discharging is now τ = R2C = 600 µs. By scaling the voltage vC in the same way as in
Fig. 2.4, you can use the cursors in the plot window to find the time constants. Note that two cursors
are available, so by placing one cursor at the start time for the discharge (2 ms) and the other so that the
vertical difference between the two cursors is 1 V, you can estimate the time constant to be the horizontal
difference between the two cursors, see Fig. 2.7.

Figure 2.7: Plot window with scaled output for finding the time constant.

Ac response: The circuit shown in Fig. 2.1 is a first-order lowpass filter with the transfer function
Vc( jω)/Vs( jω) = G0/(1+ j(ω/ω 0)) where G0 = R2/(R1 +R2) = 0.6 (or −4.44 dB) is the low fre-
quency gain and ω 0 = 1/τ = 1/((R1 ‖ R2)C) = 4.17×103 s−1 (or 663 Hz) is the −3 dB frequency. This
frequency response is normally shown in a Bode plot. In LTspice, the transfer function is simulated using
the ‘.ac’ simulation command. Use ‘Simulate → Edit Simulation Cmd’ and select the tab ‘AC Analysis’.
Here you can specify the type of sweep, start frequency, stop frequency and number of points. For a
Bode plot of the frequency response, it would be reasonable to select the type of sweep to be ‘Octave’ or
‘Decade’ starting at 10 Hz and ending at 100 kHz. The number of points per octave or decade may be
selected to 10. When you click ‘OK’, the simulation command can be placed on the schematic. If you
still have the transient simulation command in your schematic, it is changed into a comment.

Also the voltage source Vs must be specified. Right-click on the symbol, and in the window with ‘Ad-
vanced’ settings, set the ac amplitude for ac small-signal analysis to 1. In this way, when plotting the
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Figure 2.8: LTspice schematic and ac simulation results for the lowpass filter from Fig. 2.1.

output voltage Vc, the plot will directly show the transfer function. The dc bias point used for the ‘.ac’
simulation is the bias point calculated with the value of VS set to the initial value of the transient specifi-
cation, in this example 0 V. If you need to specify a different dc bias value, you may set the time-varying
function to ‘(none)’ in order to open the specification box for a dc value. Sometimes it can be advanta-
geous to split the voltage source vS into two separate, series connected voltage sources so that you do not
have to change or remove the time-varying signal specification but can set the desired bias value for the
‘.ac’ simulation as the sum of the initial transient value and a series connected dc value.

Running the simulation opens a plot window with a horizontal frequency axis. When selecting ‘ ’
as the trace to show, both an amplitude plot and a phase plot appear as shown in Fig. 2.8. In this plot, the
color of the curves has been changed from green to red to make the curves more visible and the vertical
scales have been modified to the range 0 dB to −50 dB and 0◦ to −100◦.

The −3 dB frequency is found using the cursors in a way similar to what was done for finding time
constants: You may either place one cursor at a very low frequency and move the second cursor until it
is 3 dB below the first cursor and then read the position of the second cursor. Alternatively, just move a
cursor to the frequency where the phase is −45◦. For a first order lowpass filter, this corresponds to the
−3 dB frequency.

Be aware that the ac analysis is a small-signal analysis calculated from the bias point of the circuit. For
the circuit shown here with only linear components, the bias point is not important, but for circuits with
nonlinear components (e.g. MOS transistors), it is important to run the ac analysis from the correct bias
point.

Example 2.2: A half-wave rectifier with a smoothing filter.

The next example is a half-wave rectifier as shown in Fig. 2.9. When drawing the schematic, the diode
symbol is selected from the component selection box ( ). Like the switch in Fig. 2.6, the diode is
modeled by a ‘.model’ specification. If you omit the ‘.model’ specification, the diode defaults to the
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Figure 2.9: A half-wave rectifier with a smoothing filter.

standard Shockley model iD = IS [exp(vD/(nVT ))− 1] (Hambley 2014) where the default value of the
saturation current is IS = 10−14 A and the default value of the emission coefficient is n = 1. VT is the
thermal voltage (26 mV at room temperature).

Several models for different commercially available discrete type diodes are included with LTspice and
are contained in a library file. When selecting the diode, you point to the centre of the diode symbol. This
turns the cursor into a hand . A right-click on the mouse opens a window as shown in Fig. 2.10. By
clicking ‘Pick New Diode’, you open a window with a selection of standard component diodes. Selecting
a diode and clicking ‘OK’ will insert the diode name on the schematic and insert a link to the appropriate
‘.model’ statement in the LTspice netlist file. If the selected diode is a Zener diode (or another type of
diode), the symbol is also changed into the appropriate diode symbol.
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Figure 2.10: Window for selecting diode model.

Alternatively, you can specify your own diode model. You can find a description of the parameters
for the diode model using LTspice ‘Help’. In addition to the Shockley diode model, LTspice provides
the option of using a piecewise-linear diode model in which you can specify the resistance in forward
direction and in reverse direction and a forward threshold voltage to enter conduction. You may also
specify the reverse breakdown region (particularly useful for a Zener-diode), see the ‘Help’ function in
LTspice where you can also find the default values of the parameters. If you specify just one of the
parameters for the piecewise-linear model, this model will be used rather than the Shockley model.

Figure 2.11: LTspice schematic and transient simulation results for the half-wave rectifier from Fig. 2.9.

Figure 2.11 shows the LTspice schematic and the simulation of the rectified voltage and the current
through the diode, using an ideal diode model. Notice that the name of the diode model has been changed
from the default ‘D’ to ‘IdealDiode’ by right-clicking on ‘D’ in the diode symbol and modifying it to
the new name of the diode model. In the simulation plot window, using the cursors, you may find the
ripple voltage Vr (in this case 1.38 V) and the peak current iDmax after the transient start-up phase (in this
case 1.9 A). Notice that the start-up phase leads to a substantially higher value of iD. As an exercise, you
may compare these values to the approximated analytical expressions found in (Sedra and Smith 2016,
pp. 212-213): Vr =Vp/( fCR) and iDmax = (Vp/R)(1+2π

√
2 fCR) where Vp and f are the amplitude and

the frequency of the sinusoidal input voltage, respectively.

Also see what happens if the diode model is replaced by the Shockley default model.
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Example 2.3: An amplifier with a capacitive feedback network.

The third example is a non-inverting amplifier with capacitive feedback, see Fig. 2.12. The amplifier
is assumed to be an ideal voltage-controlled voltage source with infinite input resistance, zero output
resistance and a gain of A = 100 V/V. A simple ac analysis results in

Vo( jω)/Vs( jω) =
1+C1/C2

1+(1+C1/C2)/A
for ω > 0. (2.4)

Be aware that ω has to be positive. For ω = 0, the impedance of the capacitors is infinite and the gain
is not defined. Figure 2.13 shows the circuit drawn with LTspice and with a simulation command for an
ac analysis from 10 kHz to 10 MHz. This simulation results in a simulated gain of 9.286 dB or 2.913
V/V as expected from (2.4). For the ac simulation, you cannot specify the start frequency to be 0. It
has to be positive. Analytically, at dc (i.e. ω = 0), the gain cannot be found and the input node to the
inverting input of the amplifier is floating. Since at dc, no current can flow from this node, the capacitors
C1 and C2 may be charged to some arbitrary dc voltages. For the ac simulation, LTspice must calculate
a bias point, and for the circuit shown in Fig. 2.13, LTspice assumes a bias value of 0 V for vF . After
running the simulation, you may view the error log by using the command ‘View → SPICE Error Log’
(or ‘Ctrl-L’) and you will see that you get a warning: ‘Node VF is floating’. In Fig. 2.13, the dc value of
vS has been specified to 0 V, and running an operating point simulation (’.op’) on the circuit results in all
voltages in the circuit being 0.

If we change the dc value of vS to 1 V and run an operating point analysis, we find that the simulated
value of the output voltage is now 100 V, i.e. the amplifier just provides the open loop gain A. This
may not be a realistic situation for a practical circuit, and again an examination of the error log gives a
warning: ‘Node VF is floating’. One possible solution to the problem of a floating node is to establish a
dc path to the node. For the circuit in Fig. 2.13, a very large resistor (many gigaohms) may be connected
in parallel with one of the capacitors. If connected in parallel with C1, the dc gain is the open loop
gain of the amplifier, i.e. A = 100 V/V. If connected in parallel with C2, the dc gain of the amplifier is
A/(1+A) = 0.9901 V/V.

Figure 2.12: An amplifier with capacitive feedback.
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Figure 2.13: LTspice schematic for the circuit shown in Fig. 2.12.

There is an alternative way of handling a floating node: The initial value of the node voltage may be
specified using a ‘.ic’ SPICE directive. Assume for instance that the circuit of Fig. 2.12 has an initial
value of the feedback voltage vF of 0.05 V. With an input voltage of vS = 0 V, this gives an initial value of
the output voltage of vO =−AvF =−5 V. Assume also that the input voltage vS is a periodic triangular
voltage with a period of 40 µs, an amplitude of 1 V, a mean value of 0 V, and a start value of 0 V at
time t = 0. Figure 2.14 shows the schematic with this specification of vS, and the initial value of vF

is set by the SPICE directive (command ‘Edit → SPICE Directive’) ‘ ’. Also shown
in Fig. 2.14 is the result of the transient simulation, showing the input voltage and the output voltage.
It is evident that the gain of the circuit is about 3 V/V as expected and that the output voltage is offset
by −5 V.
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Figure 2.14: LTspice schematic for the circuit shown in Fig. 2.12 with specifications for an initial value of vF and the simulation
result for a transient simulation.

Example 2.4: An ideal inductor.

Consider an inductor L1 connected directly to a voltage source vS as shown in Fig. 2.15. The relation
between current iL(t) and voltage vL(t) for the inductor is given by the equation shown in Fig. 2.15 where
iL(t0) is the current in the inductor at time t = t0. For an ideal inductor with vS = 0 (i.e. a short-circuited
inductor), a constant current may flow in the inductor. When vS changes value from an initial value of
0 V, the current in the inductor changes. As an example, assume that vS is a square-wave signal with an
amplitude of 1 V, a duty cycle of 50% and a period of 2 ms (corresponding to a frequency of 500 Hz).
Also assume that the rise time and fall time of the square wave is 100 µs and that the mean value of vS(t)
is 0. If the mean value of vS(t) is different from 0, the integral of vS(t) will be infinite for t → ∞ which
is clearly not acceptable.

iL(t) =
1
L

∫ t

t0
vL(t)dt + iL(t0)

Figure 2.15: An ideal inductor connected to a voltage source.

Even though the circuit is very simple, it does present some challenges to the simulation. First, you
may notice that a dc solution only makes sense for vS = 0 V. If vS is a dc voltage with a value different
from 0 V, the current in the inductor is infinite. For vS = 0 V, the dc value of the current in L1 is iL(t0).
Running a simple ‘.op’ simulation, you will find that LTspice calculates a value of 0 for vL and iL when
vS is specified as a dc voltage with a value of 0 V. But if you change the dc value of vS to some other
value (e.g. 4 V), the ‘.op’ simulation will still run but it will not give a meaningful result for iL, and the
error log does not give any warnings.
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You may specify the value of iL(t0) using the ‘.ic’ SPICE directive. For the ‘.op’ simulation, this turns
the inductor into a dc current source with the specified value of iL(t0), and the ‘.op’ simulation gives the
correct result for iL(t0).

Figure 2.16: LTspice schematic for the circuit shown in Fig. 2.15 with specifications for an initial value of iL1 and the simulation
result for a transient simulation with a pulse input.

Next, we will consider a transient simulation with the square-wave voltage signal defined above. We
assume that the square wave is defined for all values of t (starts at −∞ and continues to +∞). For the
transient simulation, we may use the ‘Pulse’ function to specify the square wave. Figure 2.16 shows the
LTspice schematic with a ‘Pulse’ specification for vS. The syntax for the ‘Pulse’ specification is given in
the dialogue box for specifying vS. For the transient simulation, LTspice starts by calculating the dc point
for t = 0. With the ‘Pulse’ specification shown, the value of vS for t = 0 is −1 V, so LTspice computes a
wrong dc value for iL. Hence, a ‘.ic’ directive is necessary to specify the initial value of iL, also when this
initial value is 0. Also note in the ‘Pulse’ specification that the ‘Ton’ time is specified as ‘ ’
in order to ensure that the average value of vS is 0. Also shown in Fig. 2.16 is a plot of the simulation
result. Both the voltage vL and the current iL is shown.

As an exercise you may run the same simulation with a different initial value of iL. Also, see what
happens if you forget the ‘.ic’ directive.

Example 2.5: Revisiting the capacitor charging and discharging.

Example 2.1 showed how the charging and discharging of a capacitor via an RC network could be
analyzed using voltage sources defined as time-varying voltages or using voltage-controlled switches.
However, as we have learned in Example 2.3, an initial voltage can be defined for a capacitor for a
transient analysis. This makes it possible to analyze charging and discharging without introducing the
time-varying voltage sources or controlled switches. Thus, the charging of the capacitor in the circuit
from Fig. 2.3 on page 49 can be simulated with a dc value of 5 V for vS and an initial value of 0 V for
the capacitor voltage vC as shown in Fig. 2.17.
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Figure 2.17: Simulation of capacitor charging using a dc voltage source and a specification of the initial capacitor voltage.

Likewise, the discharge can be simulated with a dc value of 0 V for vS and an initial value of 3 V for the
capacitor voltage vC, see Fig. 2.18.

Also the circuit from Fig. 2.6 on page 51 can be simulated without the switch. The simulation of the
charging of C is the same as shown in Fig. 2.17. For the simulation of the discharging, simply remove
the voltage source vS and specify an initial value of 3 V for the capacitor voltage vC, see Fig. 2.19.

Of course, a similar approach can be used for analyzing the magnetization and demagnetization of an
inductor using a specification of the initial value of the current in the inductor.
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Figure 2.18: Simulation of capacitor discharging using a dc voltage source of 0 V and a specification of the initial capacitor
voltage.

Figure 2.19: Simulation of capacitor discharging in the circuit from Fig. 2.6 on page 51.

As an alternative to the simple inspection of the charge and discharge using the waveform plot and the
cursor as shown in Fig. 2.4, you can use the SPICE directive ‘.meas’ or ‘.measure’. With this directive,
you can find the time for which the value of a variable reaches a specified value. For measuring the time
constant for charging, you need the time for which vC is equal to the final value multiplied by (1−1/e).
For the circuit in Fig. 2.17, this is achieved by the SPICE directive:

‘ ’.

Here, ‘ ’ is the time constant to be evaluated. By default, the time measurement starts at t = 0 and the
time for stopping the time measurement is specified by the condition ‘ ’. After
having run the simulation, the result of the ‘.meas’ directive is found in the error log file (‘Ctrl-L’).

For the circuit in Fig. 2.17, the result is given in the error log file as ‘
’.

Likewise, for the discharge time constant in Figs. 2.18 and 2.19 you can use the directive:

‘ ’.
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For Fig. 2.18, the error log file reports ‘ ’ and for Fig. 2.19,
the error log file reports ‘ ’.

The SPICE directive ‘.meas’ provides a very versatile possibility for post-processing of the simulation
results. For details concerning the syntax of ‘.meas’, use the ‘Help’ function in LTspice or see (Brocard
2013). Also, the ‘Help me Edit’ function available by a right-click in the dialogue box for entering a
SPICE directive provides a guide to the syntax of the ‘.meas’ directive.

The command is particularly useful when several identical post-processing operations are to be per-
formed. Examples of this are demonstrated in Tutorials 3 and 6.

Example 2.6: Determining capacitances and resistances in RC networks.

In Tutorial 1 we saw how a simple ‘.op’ simulation can be used to determine the resistance of a network
with two terminals, for instance a Thévenin resistance, see Fig. 1.10 on page 20. For a circuit with both
capacitors and resistors, a ‘.op’ simulation cannot be used to find the impedance. However, often the
basic structure of an impedance is known. This may be the case for the input impedance or the output
impedance of an amplifier, and using an ‘a priori’ knowledge about the topology of the impedance, a ‘.ac’
simulation can be used to find the values of equivalent capacitances and resistances. In this example, we
show how the values of resistors and capacitors can be simulated in a few simple topologies: a series
connection of a resistor and a capacitor, a parallel connection of a resistor and a capacitor, and an RC
network like shown in Example 2.1 on page 47, and we also apply the simulation methods to an amplifier
configuration with capacitive feedback.

RC series connection: For the RC series connection shown in Fig. 2.20, the relation between the
voltage v( jω) and the current i( jω) applied to the series connection is given by

v = i(R+
1

jω C
) (2.5)

Assuming that the current i is real, i.e. Re(i) = i and Im(i) = 0, we find

Re(v)+ j Im(v) = i(R+
1

jω C
) = i(R− j

ω C
) (2.6)

⇒ R =
Re(v)

i
∧ C =

−i
ω Im(v)

=
−i

2π f Im(v)
(2.7)

In LTspice, we can just define an ac value of 1 for the current source and plot ‘ ’ in order to
find R and ‘ ’ in order to find C after having run a ‘.ac’ simulation
over a suitable frequency range. Notice that the value of π is simply defined as ‘ ’ in the waveform
arithmetic and the frequency f is defined as ‘ ’. In Fig. 2.20, the component values are taken
from Fig. 2.1, so a reasonable frequency range would be from 10 Hz to 100 kHz as for the ‘.ac’ analysis
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(a) (b)

Figure 2.20: RC series network connected to a current source (a) and the corresponding LTspice schematic with a ‘.ac’ simulation
command (b).

shown in Fig. 2.8 on page 53. By default, LTspice opens the plot windows with a logarithmic y-axis.
This can be changed to a linear axis by moving the cursor over the y-axis and right-clicking. Figure 2.21
shows the plots corresponding to R and C, and using the cursors, you verify that the simulated values
correspond to the actual values for the components. In Fig. 2.21, the plots of R and C have been shown
in two different plot panes. This is achieved by using the command ‘Plot Settings → Add Plot Pane’.

Figure 2.21: Plot of R (top) and C (bottom) as found from the simulation specified in Fig. 2.20.

RC parallel connection: For an RC parallel connection, we may find the current i( jω) as a function
of an applied voltage v( jω) as shown in Fig. 2.22. Here, i( jω) is given by

i = v(
1
R
+ jω C) (2.8)

Assuming that the voltage v is real, i.e. Re(v) = v and Im(v) = 0, we find

Re(i)+ j Im(i) = v(
1
R
+ jω C) (2.9)

⇒ R =
v

Re(i)
∧ C =

Im(i)
ω v

=
Im(i)
2π f v

(2.10)
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(a) (b)

Figure 2.22: RC parallel network connected to a voltage source (a) and the corresponding LTspice schematic with a ‘.ac’ simula-
tion command (b).

In LTspice, we can just define an ac value of 1 for the voltage and plot ‘ ’ in order to find
R and ‘ ’ in order to find C after having run a ‘.ac’ simulation over a
suitable frequency range. The minus signs are because ‘ ’ is defined positive into the voltage source,
and this is the opposite direction compared to Fig. 2.22(a). In Fig. 2.22, the component values are taken
from Fig. 2.1, so a reasonable frequency range would be from 10 Hz to 100 kHz as for the ‘.ac’ analysis
shown in Fig. 2.8 on page 53.

64
Download free eBooks at bookboon.com Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

PDF components for PHP developers

www.setasign.com

SETASIGN
This e-book  
is made with 
SetaPDF

http://s.bookboon.com/Setasign


CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

65

Tutorial 2 – Circuits with Capacitors and Inductors

Figure 2.23 shows the plots corresponding to R and C (with linear y-axes), and using the cursors, you
verify that the simulated values correspond to the actual values for the components. In Fig. 2.23, the
plots of R and C have been shown in two different plot panes in the same way as for Fig. 2.21.

Figure 2.23: Plot of R (top) and C (bottom) as found from the simulation specified in Fig. 2.22.

Alternatively, we may apply a current source i( jω) and find R and C from a simulation of the voltage
across the RC parallel connection. Using (2.8) with Re(i) = i and Im(i) = 0, we find

i = (Re(v)+ j Im(v))(
1
R
+ jω C) =

Re(v)
R

−ω C Im(v)+ j(
Im(v)

R
+ω C Re(v)) (2.11)

Considering the real part and the imaginary part separately, we obtain

Ri = Re(v)−ω CR Im(v) (2.12)

ω CR = − Im(v)
Re(v)

(2.13)

Inserting (2.13) in (2.12), we find

Ri = Re(v)+
(Im(v))2

Re(v)
=

(Re(v))2

Re(v)
+

(Im(v))2

Re(v)
=

|v|2

Re(v)
(2.14)

⇒ R =
|v|2

iRe(v)
(2.15)

Inserting (2.15) in (2.13), we find

C =− i Im(v)
ω |v|2

(2.16)

In LTspice, we define an ac value of 1 for the current and plot ‘ ’ in order to
find R and ‘ ’ in order to find C.
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Figure 2.24 shows the plots corresponding to R and C (with linear y-axes) for the circuit from Fig. 2.22
with the voltage source replaced by a current source. Evidently, this simulation returns the same values
of R and C as the simulation with a voltage source as the input.

Figure 2.24: Plot of R (top) and C (bottom) for the circuit in Fig. 2.22 with the voltage source replaced by a current source.

The RC network from figure 2.1: Also for an RC network as shown in Fig. 2.1 with two resistors and
a capacitor, the values of the capacitor and the resistors can be found from a simulation of the relation
between current and voltage at the input of the network. Figure 2.25 shows the circuit redrawn with a
current source i( jω) connected to the network.

(a) (b)

Figure 2.25: RC network from Fig. 2.1 connected to a current source (a) and the corresponding LTspice schematic with a ‘.ac’
simulation command (b).

Again we assume that i( jω) is real. For this circuit, we find

v( jω) = i
(

R1 +
R2

1+ jωR2C

)
= i

(
R1 +

R2(1− jω R2C)

1+(ω R2C)2

)
(2.17)

Equating the real parts and the imaginary parts, we find for i = 1

Re(v) = R1 +
R2

1+(ω R2C)2 (2.18)

Im(v) =
−ω (R2)

2C
1+(ω R2C)2 (2.19)
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From (2.18), we find that for ω → ∞, Re(v) → R1 and for ω → 0, Re(v) → R1 + R2. This means
that R1 and R1+R2 can be found from a plot of ‘ ’, provided the ‘.ac’ simulation sweeps over a
frequency range showing both very high frequencies and very low frequencies. This is not surprising: By
inspecting the circuit, you see that at high frequencies where the capacitor approaches a short circuit, the
impedance is R1, and at low frequencies where the capacitor approaches an open circuit, the impedance
is R1 +R2.

From (2.19), we find that for ω →∞, Im(v)→−1/(ωC), implying that C can be found as −1/(Im(v)ω).
So from a plot of ‘ ’, C is found at a frequency high enough that the
curve saturates.

Figure 2.26 shows these plots from which we verify that the simulated values correspond to the actual
values for the components. Notice that the frequency sweep has been extended to start at 1 Hz in order to
show the low frequency saturation of Re(v), corresponding to R1 +R2. In Fig. 2.26, the phase plots are
not shown. They are disabled by moving the cursor to the right-hand y-axis, right-clicking and selecting
‘Don’t plot phase’.

Figure 2.26: Plot of R1 and R1 +R2 (top) and C (bottom) as found from the simulation specified in Fig. 2.25.

Input impedance of an inverting amplifier: For the previous circuits shown in this example, it was
easy to recognize the values of resistors and capacitors because they were inserted directly in the LTspice
schematics. This is not always the case. Consider the inverting amplifier shown in Fig. 2.27.

This amplifier has a feedback path with a capacitor C so we must expect the input impedance to have both
a capacitive element from the feedback capacitor C and a resistive element from the input resistor Rin.

67
Download free eBooks at bookboon.com



CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

68

Tutorial 2 – Circuits with Capacitors and Inductors

68

(a) (b)

Figure 2.27: An inverting amplifier with capacitive feedback (a) and the corresponding LTspice schematic with a ‘.ac’ simulation
command (b).

Let us assume that the capacitive element appears as an input capacitance in parallel with Rin. In this
case, the input impedance can be found using the approach from Figs. 2.22 and 2.23. So after running
the ‘.ac’ simulation specified in the LTspice schematic in Fig. 2.27, we should plot ‘ ’
in order to find the input resistance and ‘ ’ in order to find the input
capacitance.

Figure 2.28 shows these plots. From the plots, we find an input resistance of 10 kΩ as expected, and
we see that the input capacitance is 210 pF. You may recognize this value of the input capacitance as
(1+ |A|)C where A = −20 V/V is the gain of the inverting amplifier. The large input capacitance is
caused by the Miller effect on the capacitor C (Sedra & Smith 2016).
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Figure 2.28: Plot of input resistance (top) and input capacitance (bottom) as found from the simulation specified in Fig. 2.27.
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Hints and pitfalls

– Capacitors may give rise to floating nodes for dc voltages.

– The voltage of a floating node may be controlled by connecting a very large resistor from a non-
floating node to the floating node.

– Alternatively, the initial value of a floating node may be specified using a ‘.ic’ SPICE directive.

– Likewise, the initial value of the current in an inductor can be specified by a ‘.ic’ SPICE
directive.

– You cannot independently specify a dc voltage and a time-varying signal for a voltage source
or current source.

– It can be a good idea to insert a signal source (voltage or current) as a combination of a dc bias
source and a time-varying signal source so that the dc bias value and the time-varying waveform
can be specified separately.

– In many textbooks, including (Hambley 2014) and (Sedra & Smith 2016), dc values, time-
varying signals and small-signal values are distinguished by appropriate combinations of
uppercase and lowercase letters and subscripts. LTspice is case insensitive. Thus, in LTspice,
you cannot use uppercase and lowercase letters and subscripts to distinguish between dc values,
time-varying signals and small-signal values.

– The SPICE Error Log (‘Ctrl-L’) provides warnings about floating nodes.

– When specifying component values in the schematic, ‘e’ (or ‘E’) is used for specifying the
suffix, e.g. ‘e6’ for ‘Mega’.

– When specifying mathematical expressions in the waveform viewer, ‘e’ (or ‘E’) is the base of
the natural logarithm.

– Text (comments) can be placed in a schematic using the command ‘Edit → Text’, toolbar sym-
bol or hotkey ‘T’.

– Text and other annotations (e.g. cursor position) can be placed in a simulation plot using the
command ‘Plot Settings → Notes & Annotations’.

– In a simulation plot, additional plot panes can be opened using the command ‘Plot Settings →
Add Plot Pane’.

– Curly brackets can be used to indicate expressions to be calculated by LTspice when
specifying values, for instance, ‘ ’ is equivalent to ‘ ’.

– The SPICE directive ‘.measure’ is very useful for calculating design parameters from
simulations.

– The results of a ‘.measure’ SPICE directive are found in the error log file (‘Ctrl-L’).
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Problems

2.1

Figure P2.1

For the circuit shown in Fig. P2.1, as-
sume that the switch is closed at time
t = 0 and re-opened at time t = 100 ms.
Find the value of the voltage vR2 imme-
diately after the switch is closed. Find
the value of vR2 immediately before the
switch is re-opened. Find the value of
vR2 immediately after the switch is re-
opened. Plot vR2 versus time for 0 ≤
t ≤ 200 ms. Plot the capacitor voltage
versus time and find the time constants
for the charging and discharging of the
capacitor C.

2.2

Figure P2.2

For the circuit shown in Fig. P2.2, plot
the output voltage vo versus time t for
0 ≤ t ≤ 5 µs. You may assume that the
amplifier has infinite input resistance
and zero output resistance. Also, as-
sume that the initial value of the in-
put and output voltage at t = 0 is 0 V.
Which initial value of the input voltage
vin will result in a mean value of 0 V
for the output voltage vo?
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2.3

Figure P2.3

For the circuit shown in Fig. P2.3,
find the midband gain, the upper and
lower half-power (−3 dB) frequencies
and the 3-dB bandwidth. Plot the out-
put voltage Vo versus frequency in a
Bode plot covering a frequency range
which extends from approximately one
decade below the lower half-power fre-
quency to approximately one decade
above the upper half-power frequency.
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2.4

Figure P2.4

For the notch filter shown in Fig. P2.4,
plot Vo versus frequency in a frequency
range showing the notch and the 3-dB
bandwidth. Assume L = 1 µH, C =

5 pF and R = 10 kΩ. From the plot,
find the notch frequency, the bandwidth
and the quality factor Q.

2.5

Figure P2.5

The circuit shown in Fig. P2.5 is a
dc-dc converter which converts a dc
voltage of 4 V into a high voltage
VO. The switch is an electronic switch
which opens and closes with a fre-
quency of 5 kHz and a duty cycle of
50%, starting at time t = 0. The diode
can be assumed to be modeled by the
default Shockley diode model. Ini-
tially, the current in the inductor is 0
and the output voltage VO is 0. Find the
dc output voltage for t → ∞ and find
the time required for VO to reach 90%
of the final value.
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2.6

Figure P2.6

For the circuit shown in Fig. P2.6, as-
sume that the voltage vS is real and has
an ac amplitude of 1. Derive expres-
sions for finding R1, R2 and C from a
‘.ac’ simulation over a suitable range
of the frequency f , using asymptotic
values for f → 0 and f → ∞. Verify
your results by simulating the circuit
with R1 = 300 kΩ, R2 = 200 kΩ and
C = 2 nF.

2.7

Figure P2.7

Figure P2.7 shows an inverting am-
plifier similar to the amplifier from
Fig. 2.27 on page 68 but with a finite
output resistance Ro = 25 kΩ for the
controlled voltage source. Assuming
that the input impedance has a topology
as shown in Fig. P2.6, find the values of
R1, R2 and C in the input impedance.

2.8 For the amplifier shown in Fig. P2.7,
use a ‘.ac’ simulation to find the output
impedance by resetting the input volt-
age and replacing the load resistor RL

with an ac voltage source. Assume that
the output impedance is a parallel con-
nection of a resistor and a capacitor.

75
Download free eBooks at bookboon.com



CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

76

Tutorial 2 – Circuits with Capacitors and Inductors

76

Answers

2.1: vR2(t=0) = 10 V; vR2(t=100 ms−) = 6.5 V; vR2(t=100 ms+) = 0 V; τ+ = 48 ms; τ− = 80 ms.

2.2: vin =−2.5 mV.

2.3: Midband gain: 38 dB. Lower half-power frequency: 1.59 kHz. Upper half-power frequency: 199 kHz.
3-dB bandwidth: 197.4 kHz.

2.4: Notch frequency: 71.2 MHz, bandwidth: 3.18 MHz, quality factor Q = 22.4.

2.5: VO(t → ∞) = 51 V. Rise time: 7.5 ms.

2.6: R1 =Vs/Re(i) = for f → 0.
Req = R1 ‖ R2 =Vs/Re(i) = for f → ∞. From this, R2 = R1 Req/(R1 −Req).
C = Im(i)/(ωVs) = for f → 0.

2.7: R1 = 10 kΩ; R2 = 1.17 kΩ; C = 170 pF.

2.8: Ro = 25 kΩ; Co = 10 pF.
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Tutorial 3 – MOS Transistors

This tutorial introduces the fundamentals of MOS transistor modeling in LTspice. After having com-
pleted the tutorial, you should be able to

– specify MOS transistors using the basic Shichman-Hodges transistor model.

– use advanced transistor models obtained from textbooks or process foundries.

– simulate transistor input characteristics and output characteristics.

– find transistor small-signal parameters from a dc operating point analysis.

– estimate basic transistor parameters from a dc operating point analysis.

– simulate transistor small-signal parameters using a dc transfer (‘.tf’) simulation.

– simulate transistor small-signal parameters using an ac (‘.ac’) simulation.

Example 3.1: Different MOS transistor symbols and models in LTspice.

In LTspice, several symbols are available for a MOS transistor. They are all inserted using the command
‘Edit → Component’ (or toolbar symbol or hotkey ‘F2’) which opens the component selection box.
Here you find the components ‘nmos’, ‘nmos4’, ‘pmos’ and ‘pmos4’ which are shown in Fig. 3.1. The
MOS transistor is a device requiring a ‘.model’ statement for the specification.

Figure 3.1: MOS transistor symbols and specification windows in LTspice.
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Models for different discrete type MOS transistors are included with LTspice and are contained in a
library file. Discrete type MOS transistors normally have their source and bulk contact connected, and for
these components, you use the symbols ‘nmos’ and ‘pmos’ with only three terminals. When specifying
the component, you point to the centre of the transistor symbol. This turns the cursor into a hand .
A right-click opens a window as shown in the top left part of Fig. 3.1. By clicking ‘Pick New MOSFET’,
you open a window with a selection of standard component MOS transistors. Selecting a transistor and
clicking ‘OK’ will insert the transistor name on the schematic and insert a link to the appropriate ‘.model’
statement in the LTspice netlist file.

Models for MOS transistors in integrated circuits are not included with LTspice. For MOS transistors in
integrated circuit design there is flexibility with respect to the bulk connection, so here you should use the
symbols ‘nmos4’ and ‘pmos4’ with four terminals. When right-clicking on these symbols, a specification
window as shown in the top right part of Fig. 3.1 opens. Notice that the specification window explicitly
defines a ‘Monolithic MOSFET’. The specification window contains entries for a model name and for
the layout parameters of the MOSFET. LTspice has possibilities for specifying MOS models of different
complexity, including the most basic Shichman-Hodges model (Shichman & Hodges 1968) and several
advanced models such as the BSIM models (Sheu et al. 1987) and the EKV model (Enz & Vittoz 2006).
The ‘Help’ function in LTspice provides an overview of the models. A shortcut (hotkey) to the ‘Help’
function is ‘F1’ which opens the ‘LTspiceHelp’. Look for ‘M. MOSFET’ in the index and click ‘Display’
to find the description of MOS transistors.

78
Download free eBooks at bookboon.com Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  

www.discovermitas.com

http://s.bookboon.com/mitas


CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

79

Tutorial 3 – MOS Transistors

(a) (b)

Figure 3.2: Normal textbook definitions of sign conventions for transistor currents and voltages. (a) NMOS transistor. (b) PMOS
transistor.

Notice the netlist syntax for a MOS transistor:
‘ ’.
This syntax is generated from the specifications entered in the schematic using the specification window
for a ‘Monolithic MOSFET’. A ‘.model’ statement must also be included with the parameters for the
specific MOS transistor model to be used for the simulation.

We will start by considering the very simple circuits shown in Fig. 3.2. This is just to illustrate the sign
conventions for voltages and currents and to illustrate how the ‘.model’ statements can be included.

Standard textbook conventions: Most textbooks use the sign conventions for the transistor currents
shown in Fig. 3.2. This assures that all currents are positive (or zero) in the normal operating regions
of the transistors for both n-channel transistors and p-channel transistors. Using the Shichman-Hodges
model for an n-channel transistor, we find

ID = 0; VGS ≤Vt (3.1)

ID = µnCox

(
W
L

)
[(VGS −Vt)VDS −V 2

DS/2](1+λVDS); 0 ≤VDS ≤VGS −Vt (3.2)

ID =
µnCox

2

(
W
L

)
(VGS −Vt)

2(1+λVDS); 0 ≤VGS −Vt ≤VDS (3.3)

where µn is the electron mobility, Cox is the gate oxide capacitance per unit area, W and L are the channel
width and length, respectively, VGS is the gate-source voltage, VDS is the drain-source voltage, Vt is the
threshold voltage and λ is the channel-length modulation parameter. The threshold voltage Vt depends
on the source-bulk voltage VSB and is found from

Vt =Vto + γ(
√

VSB + |2ΦF |−
√
|2ΦF |) (3.4)

where Vto is the threshold voltage with VSB = 0, γ is the bulk threshold parameter (or body effect constant)
and |ΦF | is the Fermi potential of the body.
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Figure 3.3: LTspice schematic for the circuits from Fig. 3.2.

For this simple model, the process parameters specifying the transistor model are µnCox, Vto, λ , γ and
|2ΦF |. The lay-out parameters required for the transistor model are channel length L and width W .

The three regions of operation are termed cut-off (VGS ≤ Vt), triode region (0 ≤ VDS ≤ VGS −Vt) and
active region (0 ≤ VGS −Vt ≤ VDS), and for the n-channel transistor (NMOS transistor), both VGS, VDS

and Vt (assuming an enhancement NMOS transistor) are positive in the triode region and in the active
region. The active region is also called the saturation region, and the minimum value of VDS for which
the transistor is in the saturation region is called VDSsat.

For a PMOS transistor, the voltages VGS, VDS and Vt and the three regions are defined as follows:

Cut-off region: Vt ≤VGS (or |VGS| ≤ |Vt |). (3.5)

Triode region: VGS −Vt ≤VDS ≤ 0 (or 0 ≤ |VDS| ≤ |VGS −Vt |). (3.6)

Active region: VDS ≤VGS −Vt ≤ 0 (or 0 ≤ |VGS −Vt | ≤ |VDS|). (3.7)

With the sign conventions for current given in Fig. 3.2, the equations given above for the currents can be
used for both NMOS transistors and PMOS transistors provided the numeric values of VGS, VDS and Vt

are used.

LTspice conventions: Figure 3.3 shows the transistors from Fig. 3.2 redrawn in LTspice with the sym-
bols ‘nmos4’ and ‘pmos4’. Also shown in the figure are model statements specifying the process pa-
rameters for each of the transistors. The model used is the simple Shichman-Hodges model and only the
parameters corresponding to µnCox, Vto, λ , γ and |2ΦF | are specified. In LTspice, they are named ‘ ’,
‘ ’, ‘ ’, ‘ ’ and ‘ ’, respectively. These names are used for both NMOS transistors and
PMOS transistors as shown in Fig. 3.3. The models are named NMOS-SH and PMOS-SH, respectively,
and the parameters are representative for a 0.35 µm CMOS process (Chan Carusone, Johns & Martin
2012). The value of λ has been calculated for L = 1 µm. For the Shichman-Hodges model, λ is assumed
to be inversely proportional to the channel length L. A dc operating point analysis is specified by the
‘.op’ directive. The transistor geometries are specified using the specification window shown in Fig. 3.1,
and for both transistors, L is 1 µm and W is 10 µm. This specification is not visible on the schematic.
To see this specification, use the command ‘View → SPICE Netlist’ which brings up the window shown
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SPICE Netlist

* M:\LTspice\MyCircuits\Tutorial03\Fig3_03.asc
M1 VDN VGN 0 0 NMOS-SH l=1um w=10um
V1 VGN 0 1.5V
V2 VDN 0 2V
V3 VGP 0 -1.5V
M2 VDP VGP 0 0 PMOS-SH l=1u w=10u
V4 VDP 0 -2V
.model NMOS NMOS
.model PMOS PMOS
.lib \\dtu-storage\erbr\Documents\LTspiceXVII\lib\cmp\standard.mos
.model NMOS-SH nmos (Kp=190u Vto=0.57 Lambda=0.16 Gamma=0.50 Phi=0.7)
.op
.model PMOS-SH pmos (Kp=55u Vto=-0.71 Lambda=0.16 Gamma=0.75 Phi=0.7)
.backanno
.end

Output file

--- Operating Point ---

V(vdn):  2 voltage
V(vgn):  1.5 voltage
V(vgp): -1.5 voltage
V(vdp): -2 voltage
Id(M2): -0.000226548  device_current
Ig(M2): -0 device_current
Ib(M2): 2.01e-012 device_current
Is(M2):  0.000226548  device_current
Id(M1):  0.00108458  device_current
Ig(M1):  0 device_current
Ib(M1): -2.01e-012  device_current
Is(M1): -0.00108458  device_current
I(V4):  0.000226548  device_current
I(V3):  0 device_current
I(V2): -0.00108458  device_current
I(V1):  0 device_current

Figure 3.4: Netlist file and output file for the circuit from Fig. 3.3.

in the left part of Fig. 3.4. Notice that in addition to the circuit specification, the netlist includes refer-
ences to the standard LTspice MOS models and the library file for standard MOS transistors. This file
(‘standard.mos’) has been placed in a default folder during the installation of LTspice.

Running the ‘.op’ simulation produces the output file shown in right part of Fig. 3.4. From this, you see
that the drain current is positive for the NMOS transistor and negative for the PMOS transistor. Also, the
source current is negative for the NMOS transistor and positive for the PMOS transistor. The reason for
this is that LTspice uses the convention that the positive direction of current flow is into the transistor,
regardless of transistor type and transistor terminal.

81

Download free eBooks at bookboon.com Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

MASTER IN  MANAGEMENT

mim.admissions@ie.edu Follow us on IE MIM Experiencewww.ie.edu/master-management

#10 WORLDWIDE
MASTER IN MANAGEMENT 

FINANCIAL TIMES

55 Nationalities
in class

5 Specializations
Personalize your program 

Length: 1O MONTHS
Av. Experience: 1 YEAR
Language: ENGLISH / SPANISH
Format: FULL-TIME
Intakes: SEPT / FEB

• STUDY IN THE CENTER OF MADRID AND TAKE ADVANTAGE OF THE UNIQUE OPPORTUNITIES
  THAT THE CAPITAL OF SPAIN OFFERS
• PROPEL YOUR EDUCATION BY EARNING A DOUBLE DEGREE THAT BEST SUITS YOUR
  PROFESSIONAL GOALS
• STUDY A SEMESTER ABROAD AND BECOME A GLOBAL CITIZEN WITH THE BEYOND BORDERS
  EXPERIENCE

93%
OF MIM STUDENTS ARE

WORKING IN THEIR SECTOR 3 MONTHS
FOLLOWING GRADUATION

http://s.bookboon.com/MIMEnglish


CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

82

Tutorial 3 – MOS Transistors

Small-signal transistor parameters: Very important in the design of analog CMOS circuits are the
small-signal properties of the transistors. At low frequencies, a small-signal transistor model can be
derived from the nonlinear large-signal model by differentiation. For the Shichman-Hodges model for the
NMOS transistor in the active region, see (3.3) and (3.4), we find the following small-signal parameters:

gm =
∂ iD

∂vGS
= µnCox

(
W
L

)
(VGS −Vt)(1+λVDS) =

2 ID

VGS −Vt

=

√
2µnCox

(
W
L

)
ID(1+λVDS)�

√
2µnCox

(
W
L

)
ID (3.8)

gds = 1/rds =
∂ iD

∂vDS
= λ

µnCox

2

(
W
L

)
(VGS −Vt)

2 =
λ ID

1+λVDS
� λ ID (3.9)

gmb =
∂ iD
∂vBS

=
∂ iD
∂Vt

∂Vt

∂vBS
=

γgm

2
√

VSB + |2ΦF |
= χgm (3.10)

Corresponding to (3.8) - (3.10), we have the small-signal model shown in Fig. 3.5. This model also
applies to PMOS transistors, and gm, gds and gmb are positive for both NMOS transistors and PMOS
transistors.

The small-signal parameters are always calculated assuming a specific bias point (operating point) for
the transistor. In Spice, a calculation of the small-signal parameters is carried out with an operating
point analysis, the ‘.op’ simulation. LTspice does not show the small-signal parameters in the output file.
However, the ‘SPICE Error Log’ provides the small-signal parameters. So using the command ‘View →
SPICE Error Log’ or the hotkey ‘Ctrl-L’, you can open the error log with the small-signal parameters.
Doing so for the circuit from Fig. 3.3 results in the error log shown in Fig. 3.6. Notice that the error log
gives both the values of bias voltages and currents for the transistors and the values of the small-signal
parameters. Also note that the error log provides warnings that the transistor dimensions are smaller
than what is recommended for the Spice transistor models used for the simulation. This is an indication
that the simple Shichman-Hodges model is a rather inaccurate transistor model for sub-micron transistor
technologies. The main reason for using it here is its simplicity and also the fact that it is a transistor
model often used for initial manual analysis of transistor circuits.

Figure 3.5: Low frequency small-signal MOS transistor model.
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SPICE Error Log

Circuit: * M:\LTspice\Tutorial03\Fig3_03.asc

Instance "m2": Length shorter than recommended for a level 1 MOSFET.
Instance "m2": Width narrower than recommended for a level 1 MOSFET.
Instance "m1": Length shorter than recommended for a level 1 MOSFET.
Instance "m1": Width narrower than recommended for a level 1 MOSFET.
Direct Newton iteration for .op point succeeded.
Semiconductor Device Operating Points:

--- MOSFET Transistors ---
Name: m2 m1
Model: pmos-sh     nmos-sh
Id: -2.27e-04    1.08e-03
Vgs: -1.50e+00    1.50e+00
Vds: -2.00e+00    2.00e+00
Vbs: 0.00e+00    0.00e+00
Vth: -7.10e-01    5.70e-01
Vdsat: -7.90e-01    9.30e-01
Gm: 5.74e-04    2.33e-03
Gds: 2.75e-05    1.31e-04
Gmb: 2.57e-04    6.97e-04
Cbd: 0.00e+00    0.00e+00
Cbs: 0.00e+00    0.00e+00
Cgsov:       0.00e+00    0.00e+00
Cgdov:       0.00e+00    0.00e+00
Cgbov:       0.00e+00    0.00e+00
Cgs: 0.00e+00    0.00e+00
Cgd: 0.00e+00    0.00e+00
Cgb: 0.00e+00    0.00e+00

Date: Thu Aug 04 13:03:13 2016
Total elapsed time: 0.045 seconds.

tnom = 27
temp = 27
method = trap
totiter = 5
traniter = 0
tranpoints = 0
accept = 0
rejected = 0
matrix size = 8
fillins = 0
solver = Normal
Matrix Compiler1: 246 bytes object code size
Matrix Compiler2: 428 bytes object code size

Figure 3.6: SPICE Error Log with bias point values and small-signal parameters from the simulation of the circuit from Fig. 3.3.

Figure 3.7: High frequency small-signal MOS transistor model.

At high frequencies, the small-signal model must be augmented with the internal capacitors of the transis-
tor as shown in Fig. 3.7. The size of the capacitors is calculated from the transistor dimensions, including
the channel length, the channel width and the dimensions of source diffusion and drain diffusion. Also
gate overlap is considered. You will see that in Fig. 3.6, all the capacitors have a value of 0. In order
to make it possible for LTspice to calculate the capacitances, the transistor models must include param-
eters describing junction capacitances and oxide capacitance per unit area and also overlap capacitances
per unit length. The parameters are defined as shown in the ‘LTspiceHelp’, and Fig. 3.8 shows Fig. 3.3
redrawn with ‘.model’ specifications for the capacitances. The ‘.model’ specifications extend over more
than one line with a ‘ ’ to indicate that a line is a continuation of the specification. The specifications are
adapted from (Chan Carusone, Johns & Martin 2012, chapter 1.5).
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Figure 3.8: LTspice schematic including model parameters for capacitances for the circuits from Fig. 3.2.

Also, the transistor specification must include areas and perimeters of source and drain diffusions. This
is done using the specification window shown in Fig. 3.8. The areas of source and drain diffusion will
typically have a minimum dimension of approximately W times 2.75 times the minimum length which
is 0.35 µm for the process assumed for Fig. 3.8. The perimeter of the drain and source diffusion will
typically have a minimum dimension of W plus 5.5 times the minimum length (Sedra & Smith 2016,
Appendix B). The multiplier M in the specification window is used to specify multiple devices in parallel.

The capacitance from well to substrate (Cbsub in Fig. 3.7) is not part of the transistor model in LTspice
since a well may be common to several transistors, so Cbsub must be inserted separately if it is needed in
the circuit analysis.
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SPICE Netlist

* M:\LTspice\Tutorial03\Fig3_08.asc
M1 VDN VGN 0 0 NMOS-SH l=1um w=10um ad=10e-12 as=10e-12 pd=12u ps=12u m=1
V1 VGN 0 1.5V
V2 VDN 0 2V
V3 VGP 0 -1.5V
M2 VDP VGP 0 0 PMOS-SH l=1u w=10u ad=10e-12 as=10e-12 pd=12u ps=12u m=1
V4 VDP 0 -2V
.model NMOS NMOS
.model PMOS PMOS
.lib \\dtu-storage\erbr\Documents\LTspiceXVII\lib\cmp\standard.mos
.model NMOS-SH nmos (Kp=190u Vto=0.57 Lambda=0.16 Gamma=0.50 Phi=0.7
+TOX=8n CGSO=0.28n CGBO=1p CGDO=0.28n CJ=1m CJSW=0.4n)
.op
.model PMOS-SH pmos (Kp=55u Vto=-0.71 Lambda=0.16 Gamma=0.75 Phi=0.7
+TOX=8n CGSO=0.21n CGBO=1p CGDO=0.21n CJ=1.5m CJSW=0.5n)
.backanno
.end

Spice Error Log

Circuit: * M:\LTspice\Tutorial03\Fig3_08.asc

Model "pmos-sh": Oxide thickness thinner than recommended for a level 1 MOSFET.
Instance "m2": Length shorter than recommended for a level 1 MOSFET.
Instance "m2": Width narrower than recommended for a level 1 MOSFET.
Model "nmos-sh": Oxide thickness thinner than recommended for a level 1 MOSFET.
Instance "m1": Length shorter than recommended for a level 1 MOSFET.
Instance "m1": Width narrower than recommended for a level 1 MOSFET.
Direct Newton iteration for .op point succeeded.
Semiconductor Device Operating Points:

--- MOSFET Transistors ---
Name: m2 m1
Model:       pmos-sh     nmos-sh
Id: -2.27e-04    1.08e-03
Vgs: -1.50e+00 1.50e+00
Vds: -2.00e+00    2.00e+00
Vbs: 0.00e+00    0.00e+00
Vth: -7.10e-01    5.70e-01
Vdsat: -7.90e-01    9.30e-01
Gm: 5.74e-04    2.33e-03
Gds: 2.75e-05    1.31e-04
Gmb: 2.57e-04    6.97e-04
Cbd: 1.12e-14    7.91e-15
Cbs: 2.10e-14    1.48e-14
Cgsov:       2.10e-15    2.80e-15
Cgdov:       2.10e-15    2.80e-15
Cgbov:       1.00e-18    1.00e-18
Cgs: 2.88e-14    2.88e-14
Cgd: 0.00e+00    0.00e+00
Cgb: 0.00e+00    0.00e+00

Figure 3.9: Netlist file and error log file for the circuit from Fig. 3.8.

The netlist corresponding to Fig. 3.8 and the error log with the operating point information and small-
signal parameters are shown in Fig. 3.9. Comparing to Fig. 3.6, it is seen that gm, gds and gmb remain
unchanged, but now the small-signal capacitances are computed. Note that each of these capacitances
may have an overlap component (e.g. ‘ ’) and a junction capacitance or gate oxide capacitance
component (e.g. ‘ ’).

Example 3.2: Advanced transistor models.

The basic Shichman-Hodges model presented in the previous example is primarily used for manual cal-
culations and for establishing simple overviews of the relation between transistor parameters and circuit
performance. For simulations required to provide accurate results, more complex transistor models must
be applied. Generic models are available together with several textbooks such as (Sedra & Smith 2016),
(Chan Carusone, Johns & Martin 2012) and (Baker 2010). For submicron processes, BSIM3 or BSIM4
models are often the preferred choice.
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Models for specific CMOS processes can be obtained from foundries or from MPW (Multi-Project
Wafer) service providers such as MOSIS (MPW) Integrated Circuit (IC) Fabrication Service Provider
(The MOSIS Service 2014). However, most foundries require non-disclosure agreements in order to
provide detailed design information.

Generic BSIM3 model for 0.35 µm CMOS process. Adapted from (Carusone, Johns & Martin 2014).

*BSIM3_035.lib
.MODEL NMOS-BSIM NMOS LEVEL = 49
+VERSION = 3.1 TNOM = 27 TOX = 7.8E-9 
+XJ = 1E-07 NCH = 2.18E+17 VTH0 = 0.48
+K1 = 6.07E-01 K2 = 1.24E-03 K3 = 9.68E+01
+K3B = -9.84E+00 W0 = 2.02E-05 NLX = 1.62E-07
+DVT0W = 0 DVT1W = 0 DVT2W = 0
+DVT0 = 2.87E+00 DVT1 = 5.86E-01 DVT2 = -1.26E-01
+U0 = 360 UA = -8.48E-10 UB = 2.27E-18
+UC = 3.27E-11 VSAT = 1.87E+05 A0 = 1.22E+00
+AGS = 2.06E-01 B0 = 9.60E-07 B1 = 4.95E-06
+KETA = -1.67E-04 A1 = 0 A2 = 3.49E-01
+RDSW = 8.18E+02 PRWG = 2.35E-02 PRWB = -8.12E-02
+WR = 9.98E-01 WINT = 1.55E-07 LINT = 4.51E-10
+DWG = -4.27E-09
+DWB = 4.07E-09 VOFF = -4.14E-02 NFACTOR = 1.61E+00
+CIT = 0 CDSC = 2.39E-04 CDSCD = 0.00E+00
+CDSCB = 0 ETA0 = 1 ETAB = -1.99E-01
+DSUB = 1 PCLM = 1.32E+00 PDIBLC1 = 2.42E-04
+PDIBLC2 = 8.27E-03 PDIBLCB = -9.99E-04 DROUT = 9.72E-04
+PSCBE1 = 7.24E+08 PSCBE2 = 9.96E-04 PVAG = 1.00E-02
+DELTA = 1.01E-02 RSH = 3.33E+00 MOBMOD = 1
+PRT = 0 UTE = -1.5 KT1 = -1.11E-01
+KT1L = 0 KT2 = 2.22E-02 UA1 = 4.34E-09
+UB1 = -7.56E-18 UC1 = -5.62E-11 AT = 3.31E+04
+WL = 0 WLN = 9.95E-01 WW = 0
+WWN = 1.00E+00 WWL = 0 LL = 0
+LLN = 1 LW = 0 LWN = 1
+LWL = 0 CAPMOD = 2 XPART = 0.5
+CGDO = 2.76E-10 CGSO = 2.76E-10 CGBO = 1.00E-12
+CJ = 9e-4 PB = 7.95E-01 MJ = 3.53E-01
+CJSW = 2.8e-10 PBSW = 7.98E-01 MJSW = 1.73E-01
+CJSWG = 1.81E-10 PBSWG = 7.96E-01 MJSWG = 1.74E-01
+CF = 0 PVTH0 = -1.80E-02 PRDSW = -7.56E+01
+PK2 = 4.48E-05 WKETA = -1.33E-03 LKETA = -8.91E-03

.MODEL PMOS-BSIM PMOS LEVEL = 49
+VERSION = 3.1 TNOM = 2.69E+01 TOX = 7.8E-9 
+XJ = 1.00E-07 NCH = 8.44E+16 VTH0 = -0.6
+K1 = 4.82E-01 K2 = -2.13E-02 K3 = 8.27E+01
+K3B = -5 W0 = 5.24E-06 NLX = 2.49E-07
+DVT0W = 0.00E+00 DVT1W = 0 DVT2W = 0
+DVT0 = 3.54E-01 DVT1 = 7.52E-01 DVT2 = -2.98E-01
+U0 = 150 UA = 1E-10 UB = 1.75E-18
+UC = -2.27E-11 VSAT = 2.01E+05 A0 = 1.04E+00
+AGS = 2.90E-01 B0 = 1.94E-06 B1 = 5.01E-06
+KETA = -3.85E-03 A1 = 4.20E-03 A2 = 1.00E+00
+RDSW = 4000 PRWG = -9.54E-02 PRWB = -1.92E-03
+WR = 1 WINT = 1.47E-07 LINT = 1.04E-10
+DWG = -1.09E-08
+DWB = 1.14E-08 VOFF = -1.29E-01 NFACTOR = 2.01E+00
+CIT = 0 CDSC = 2.40E-04 CDSCD = 0
+CDSCB = 0 ETA0 = 4.07E-02 ETAB = 6.84E-03
+DSUB = 3.21E-01 PCLM = 5.96E+00 PDIBLC1 = 2.89E-03
+PDIBLC2 = -1.45E-06 PDIBLCB = -1E-03 DROUT = 9.93E-04
+PSCBE1 = 7.88E+10 PSCBE2 = 5E-10 PVAG = 15
+DELTA = 9.96E-03 RSH = 2.6 MOBMOD = 1
+PRT = 0 UTE = -1.5 KT1 = -1.09E-01
+KT1L = 0 KT2 = 2.19E-02 UA1 = 4.34E-09
+UB1 = -7.62E-18 UC1 = -5.63E-11 AT = 3.28E+04
+WL = 0 WLN = 1 WW = 0
+WWN = 1.00E+00 WWL = 0 LL = 0
+LLN = 1 LW = 0 LWN = 1
+LWL = 0 CAPMOD = 2.01E+00 XPART = 0.5
+CGDO = 2.10E-10 CGSO = 2.12E-10 CGBO = 1.00E-12
+CJ = 14e-4 PB = 9.83E-01 MJ = 5.79E-01
+CJSW = 3.2e-10 PBSW = 9.92E-01 MJSW = 3.60E-01
+CJSWG = 4.41E-11 PBSWG = 9.85E-01 MJSWG = 3.58E-01
+CF = 0 PVTH0 = 2.58E-02 PRDSW = -3.98E+01
+PK2 = 2.02E-03 WKETA = 2.72E-03 LKETA = -7.14E-03

Figure 3.10: Library file with BSIM3 models for a generic 0.35 µm CMOS process, adapted from (Chan Carusone, Johns & Martin
2014).

As an example, Fig. 3.10 shows BSIM3 models derived from (Chan Carusone, Johns & Martin 2014) for
a generic 0.35 µm process. The two models NMOS-BSIM and PMOS-BSIM are contained in a single file
named BSIM3_035.lib. This makes it possible to include the models in the schematic simply by giving a
reference to this file. The SPICE directive for including the library file is ‘ ’
(or ‘ ’). The library file should be placed in the same folder as the circuit schematic
file or in a folder dedicated specifically for library files. If the file is placed in a folder dedicated to library
files (e.g. ‘MOS models’), you must define a search path to this folder using the command ‘Tools →
Control Panel → Sym. & Lib. Search Paths’, see Fig. 3.11. Alternatively, the full path to the file may be
specified.
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Figure 3.11: Window for defining search paths to symbol folders and library folders.

87
Download free eBooks at bookboon.com Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

“The perfect start 
of a successful, 
international career.”

CLICK HERE 
to discover why both socially 

and academically the University 

of Groningen is one of the best 

places for a student to be 
www.rug.nl/feb/education

Excellent Economics and Business programmes at:

http://www.rug.nl/feb/bookboon?utm_source=AdBookboon&utm_medium=Bookboon&utm_campaign=130215Bookboon


CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

88

Tutorial 3 – MOS Transistors

SPICE Netlist

* M:\LTspice\Tutorial03\Fig3_12.asc
M1 VDN VGN 0 0 NMOS-BSIM l=1um w=10um ad=10e-12 as=10e-12 pd=12u ps=12u m=1
V1 VGN 0 1.5V
V2 VDN 0 2V
V3 VGP 0 -1.5V
M2 VDP VGP 0 0 PMOS-BSIM l=1u w=10u ad=10e-12 as=10e-12 pd=12u ps=12u m=1
V4 VDP 0 -2V
.model NMOS NMOS
.model PMOS PMOS
.lib \\dtu-storage\erbr\Documents\LTspiceXVII\lib\cmp\standard.mos
.op
.include BSIM3_035.lib
.backanno
.end

Spice Error Log

Circuit: * M:\LTspice\Tutorial03\Fig3_12.asc

Direct Newton iteration for .op point succeeded.
Semiconductor Device Operating Points:

--- BSIM3 MOSFETS ---
Name:        m2          m1
Model:    pmos-bsim   nmos-bsim
Id: -1.60e-04    5.48e-04
Vgs: -1.50e+00    1.50e+00
Vds: -2.00e+00    2.00e+00
Vbs:       0.00e+00    0.00e+00
Vth: -6.79e-01    5.43e-01
Vdsat: -6.96e-01    6.21e-01
Gm:        3.39e-04    9.92e-04
Gds:       7.31e-06    1.03e-05
Gmb        7.54e-05    2.63e-04
Cbd:       8.14e-15    7.70e-15
Cbs:       1.52e-14    1.14e-14
Cgsov:     2.06e-15    2.67e-15
Cgdov:     2.04e-15    2.67e-15
Cgbov:     1.00e-18    9.99e-19
dQgdVgb:   3.81e-14    3.99e-14
dQgdVdb: -1.99e-15 -2.68e-15
dQgdVsb: -3.43e-14 -3.59e-14
dQddVgb: -1.64e-14 -1.70e-14
dQddVdb:   1.02e-14    1.04e-14
dQddVsb:   1.79e-14    1.90e-14
dQbdVgb: -5.36e-15 -6.01e-15
dQbdVdb: -8.14e-15 -7.71e-15
dQbdVsb: -1.88e-14 -1.62e-14

Figure 3.12: Netlist file and error log file for the circuit from Fig. 3.8 simulated with the device models included in BSIM3_035.lib.

The file shown in Fig. 3.10 is adapted from (Chan Carusone, Johns & Martin 2014). You may get the
input to the file BSIM3_035.lib from this reference. You can open (and edit) simple text files such
as BSIM3_035.lib in LTspice using the command ‘Files → Open’ and specify ‘Files of type → All
Files’. Appendix B shows how to generate LTspice-compatible library files from the BSIM files in
(Chan Carusone, Johns & Martin 2014).

Using more advanced models will generally give more precise simulation results, and often it is useful to
compare the results obtained from a simple model with the results from an advanced model in order to ex-
plain deviations in circuit behavior from the manual calculations based on the Shichman-Hodges model.
As a very simple example illustrating the differences, the circuit from Fig. 3.8 may be re-simulated with
the models from the library file shown in Fig. 3.10. This results in the netlist and error log file shown
in Fig. 3.12 which can be compared to Fig. 3.9 on page 85.
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You may observe that there are quite significant differences between the small-signal parameters shown
in Figs. 3.9 and 3.12, and it can be difficult to reach a reasonable degree of agreement between simulated
results and results based on a calculation from the Shichman-Hodges model. For comparison, (3.8) and
(3.9) gives gm = 2.33 mA/V and gds = 131 µA/V for the NMOS transistor and gm = 0.574 mA/V and
gds = 27.5 µA/V for the PMOS transistor, corresponding exactly to the simulation results from Fig. 3.9
but rather different from the values shown in Fig. 3.12.

This illustrates a need for deriving useful Shichman-Hodges parameters from a transistor simulation
based on advanced models in order to be able to calculate analytical results which are useful for circuit
design. Also note that the BSIM3 model does not result in values for the small-signal capacitances
in the same way as the Shichman-Hodges model. Rather, derivatives of charge with respect to signal
voltages are specified. For a definition of the corresponding capacitances, see for instance (Tsividis &
McAndrew 2010).

Example 3.3: MOS transistor input characteristics.

The input characteristics of a MOS transistor show the drain current versus the gate-source voltage for
fixed values of drain-source voltage and source-bulk voltage. Figure 3.13 shows an NMOS transistor
drawn with LTspice and with the relevant voltage sources connected to the transistor. The transistor
is defined by a simple Shichman-Hodges model for a 0.35 µm process with typical parameters, com-
pare Fig. 3.3. The transistor dimensions are shown in the figure in blue. They have been defined in
the specification window for transistor M1, compare Fig. 3.1 on page 77, but as this specification does
not by default appear on the schematic, it has been inserted using the command ‘Edit → Text’, toolbar
symbol or hotkey ‘T’.

Figure 3.13: LTspice schematic for simulation of transistor characteristics.

In the LTspice netlist, the text appears as a comment, i.e. a line starting with an asterix ( ). This is a
‘quick and dirty’ way of showing the transistor dimensions because there is nothing to ensure that the
comment matches the transistor specification, but it will do for now when we are considering just a single
transistor. In circuits with more transistors, it is highly advisable to show the transistor specification in a
way that annotates to the netlist. On page 117, it is explained how to do this.
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When simulating the transistor characteristics for a transistor to be applied in a circuit design, it is
important to use transistor dimensions, in particular channel length, corresponding to the dimensions
planned to be used for the circuit design, and when modifying the channel length, the value of λ should
also be re-calculated since λ is inversely proportional to the channel length L.

First, the drain current is simulated versus the gate-source voltage with VSB = 0 and with VDS varying
in steps of 0.5 V from 0 to 3 V. The simulation command for this is the ‘.dc’ directive with the voltage
source ‘ ’ as the first source and ‘ ’ as the second source. The voltage ‘ ’ is specified to sweep from
0 to 3 V with an increment of 0.01 V in order to obtain a reasonably smooth curve showing ID and the
derivative of ID with respect to VGS. The resulting plot of ID versus VGS is shown in Fig. 3.14.

Figure 3.14: Plot of ID versus VGS for different values of VDS and VSB = 0 V.

The plot shows seven curves corresponding to VDS = 0, 0.5, 1.0, 1.5, 2.0, 2.5 and 3.0 V, respectively.
In the plot, labels have been inserted for two of the curves using the command ‘Plot Settings → Notes &
Annotations → Place Text’. You may notice that the plot does not give specific information about which
quantity is used for the horizontal axis. By default, the horizontal axis is the first parameter stepped by
the ‘.dc’ directive, i.e. ‘ ’ (or VGS) for the plot in Fig. 3.14. If you wish to indicate this on the plot, you
may either insert the information using the command ‘Plot Settings → Notes & Annotations → Place
Text’, or you may change the ‘Quantity Plotted’ from ‘ ’ to ‘ ’ by moving the cursor to the x-axis
and applying a right-click on the mouse, compare Fig. 1.21 on page 29.

For the two curves corresponding to VDS = 2.5 V and 3.0 V, the transistor is in the active region for the
simulated range of VGS, and the curves show a parabolic relation between ID and VGS. For the other values
of VDS, the transistor is in the triode region for large values of VGS, leading to a linear relation between
ID and VGS.

As explained for Fig. 2.4 on page 50, a cursor can be activated by a left-click on the trace label above the
plot window. The cursor opens with a horizontal value in the middle of the plot (i.e. VGS = 1.5 V) and
is attached to the first trace, i.e. the trace corresponding to VDS = 0 V. The cursor may be moved to the
other traces by positioning the mouse over the cursor (a ‘1’ will appear on the plot) and entering the ‘up’
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arrow key on the keyboard. By using the arrow keys ‘up’ and ‘down’, the cursor can be moved between
the traces. A right-click when the mouse is positioned over the cursor opens a window with cursor
step information, i.e. information about the trace where the cursor is attached. Also, when a cursor is
included in the plot, a window is open with information about the position of the cursor, compare Fig. 2.4
(page 50).

Figure 3.15: Plot of ∂ iD/∂vGS versus VGS for different values of VDS and VSB = 0 V.

Next, Fig. 3.15 shows the derivative of ID with respect to VGS versus VGS. This is obtained from the
same simulation, just by editing the variable to be plotted: A right-click on the trace label above the plot
opens a window with the ‘Expression Editor’. The window shows the current expression being plotted.
For Fig. 3.14, this is ‘ ’. By modifying this to ‘ ’ and clicking ‘OK’, the plot window
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shown in Fig. 3.15 appears. The function ‘ ’ computes a difference-based derivative, see the LTspice
‘Help’ function (Waveform Arithmetic).

The derivative of ID with respect to VGS is the transconductance gm. In the active region, gm increases
linearly with VGS as found from (3.8), and in the triode region, gm is found from (3.2) as

gm = µnCox

(
W
L

)
VDS(1+λVDS) (3.11)

This relation shows that the Shichman-Hodges transistor model leads to a constant value of gm in the
triode region as also clearly seen in Fig. 3.15.

(a) (b)

Figure 3.16: Plot of ID (a) and ∂ iD/∂vGS (b) versus VGS for different values of VSB and VDS = 2 V.

Next, we may investigate the influence of the source-bulk voltage VSB. For the previous simulations, VSB

was equal to 0 but as indicated by (3.4), a positive value of VSB, reverse biasing the channel-bulk junction,
will lead to an increase in the threshold voltage Vt . Figure 3.16 shows a plot of ID and ∂ iD/∂vGS versus
VGS with a fixed value of 2 V for VDS and VSB swept from 0 to 3 V in steps of 0.5 V. The shift of the
curves caused by the increase of the threshold voltage is evident.

As indicated by (3.10), the bulk terminal may also be used as the input signal to the transistor instead of
the gate terminal. An increase in VSB causes a decrease in ID for a fixed value of VGS and VDS. The small-
signal parameter gmb is given by gmb = ∂ iD/∂vBS =−∂ iD/∂vSB, and you may find input characteristics
for the transistor with the bulk as the input terminal in a similar way as the input characteristics with
the gate as the input terminal. Figure 3.17 shows a plot of ID versus VSB for VGS = 1.5 V and VDS swept
from 0 to 3 V in steps of 0.5 V. Also shown is the bulk transconductance gmb as a plot of ‘ ’.
Notice that for VDS = 0 (the green traces), the transistor is off, and for VDS = 0.5 V (the blue traces), the
transistor is in the triode region for small values of VSB. Otherwise, the transistor is in the active region.

PMOS transistors: The input characteristics shown above were all simulated for an NMOS transistor.
Of course, similar input characteristics may be simulated for a PMOS transistor. Some care is needed
in order to avoid confusion of signs for the PMOS transistor currents and voltages. Recall that LTspice
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(a) (b)

Figure 3.17: Plot of ID (a) and ∂ iD/∂vBS (b) versus VSB for different values of VDS and VGS = 1.5 V.

assumes the positive direction of current to be into the transistor, so in LTspice notation, the drain current
of a PMOS transistor is negative as described earlier in this tutorial, see page 81.

Example 3.4: MOS transistor output characteristics.

The output characteristics of a MOS transistor show the drain current versus the drain-source voltage for
fixed values of gate-source voltage and source-bulk voltage. The output characteristics are obtained from
the circuit from Fig. 3.13 by a dc sweep with ‘ ’ as the first source (increment 0.01 V) and ‘ ’ as the
second source (increment 0.5 V). The resulting plot of ID versus VDS is shown in Fig. 3.18(a).

Notice that for the first two traces corresponding to VGS = 0 V and VGS = 0.5 V, respectively, the transistor
is off and ID = 0. The following five traces show the transistor in the triode region for small values of
VDS and in the active region for large values of VDS.

(a) (b)

Figure 3.18: Output characteristics: plot of ID (a) and ∂ iD/∂vDS (b) versus VDS for different values of VGS with VSB = 0 V.
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Observe the slope of the characteristics in the active region caused by the channel-length modulation
specified by the non-zero value of λ , see (3.3). This causes a non-zero value of gds which may be plotted
as ‘ ’, see Fig. 3.18(b). You will see that gds saturates at a constant level for the transistor in
the active region and that it increases with increasing value of VGS as expected from (3.9).

Figure 3.19: LTspice schematic for simulation of PMOS transistor characteristics.

PMOS transistors: As for the input characteristics, some care is needed in order to avoid confusion
of signs when simulation the characteristics for a PMOS transistor. Figure 3.19 shows the schematic
for simulating the characteristics of a PMOS transistor. Observe that the voltages have been reversed
compared to Fig. 3.13.
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(a) (b)

Figure 3.20: Plot ID (a) and ∂ iD/∂vSD (b) versus VSD for different values of VSG and VBS = 0 V for the PMOS transistor from
Fig. 3.19.

Figure 3.20 shows the output characteristics of the PMOS transistor. In order to comply with the normal
textbook sign definition for the drain current, the plot shows ‘ ’ and ‘ ’ rather than
‘ ’ and ‘ ’.

Example 3.5: Deriving transistor parameters from input and output characteristics.

The characteristics simulated in the previous examples were all based on the simple Shichman-Hodges
model. Using more accurate models may result in major discrepancies from the characteristics in the
previous examples. Replacing the Shichman-Hodges transistor models with the models from Fig. 3.10
results in input characteristics and output characteristics for the NMOS transistor as shown in Fig. 3.21.

Clearly, there are major differences between the curves in Fig. 3.21 and Figs. 3.14 and 3.18. Not only is
the scale of the y-axis different (by a factor of more than 3). Also the shape of the input characteristics

(a) (b)

Figure 3.21: Input characteristics, ID versus VGS, (a), and output characteristics, ID versus VDS, (b), simulated for an NMOS
transistor using the BSIM3 transistor model from Fig. 3.10.
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is different. The major reason for this difference is the mobility degradation, causing µn to decrease
for large values of VGS −Vt (Chan Carusone, Johns & Martin 2012). The mobility degradation causes
the drain current to increase almost linearly with VGS −Vt , rather than the square-law relation predicted
by (3.3), and this also implies that the transconductance in the active region does not increase linearly
with VGS −Vt but tends to saturate. The shape of output characteristics in Fig. 3.21 resembles the shape
in Fig. 3.18, but apparently with a significantly higher output resistance in the active region, correspond-
ing to a smaller value of the channel length parameter λ .

In this example, we will show how the LTspice model parameters for the Shichman-Hodges model can
be modified so that a somewhat better match of the input and output characteristics to those shown
in Fig. 3.21 is obtained, leading to somewhat better results when performing hand calculations using the
Shichman-Hodges model during a circuit design.

We will use a simple, heuristic approach. More advanced methods (e.g., using linear regression tech-
niques) can be found in the literature, e.g. (Allen & Holberg 2012, Appendix B), but with the large
discrepancies which cannot be avoided, a few simple methods may be sufficient in many cases.

In order to be able to compare the simulation results for the Shichman-Hodges model and an ad-
vanced model, it is useful to simulate the two models in parallel using the circuit configuration shown
in Fig. 3.22. This figure shows the circuit from Fig. 3.13 augmented with an extra transistor ‘ ’ con-
nected in parallel with ‘ ’ and specified with the model ‘ ’ from the library BSIM3_035.lib.
This parallel connection is achieved without drawing wires between the two transistor. The labels defin-
ing the names of the nodes is enough to establish the correct connections in the LTspice netlist.

Figure 3.22: LTspice schematic for simulation of transistor characteristics for two different transistor models.

Matching small-signal parameters: If the transistor is known to operate with small-signal variations
from a specific bias point, a simple approach to finding values for the Shichman-Hodges parameters is
to derive them from the information about the operating point and the small-signal parameters in the
operating point provided by a ‘.op’ simulation in LTspice. For the transistors in Fig. 3.22, the dc values
specified for ‘ ’, ‘ ’ and ‘ ’ define an operating point VGS = 1.5 V, VDS = 2.0 V and VSB = 0 V with
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Output file

--- Operating Point ---

V(vds):  2 voltage
V(vgs):  1.5 voltage
V(vsb):  0 voltage
Id(M2):  0.000548031  device_current
Ig(M2):  0 device_current
Ib(M2): -2.001e-012  device_current
Is(M2): -0.000548031  device_current
Id(M1):  0.00108458  device_current
Ig(M1):  0 device_current
Ib(M1): -2.01e-012  device_current
Is(M1): -0.00108458  device_current
I(V3): -4.011e-012  device_current
I(V2): -0.00163262  device_current
I(V1): 0 device_current

SPICE Error Log

Semiconductor Device Operating Points:

--- MOSFET Transistors ---
Name: m1
Model:       nmos-sh
Id: 1.08e-03
Vgs: 1.50e+00
Vds: 2.00e+00
Vbs: 0.00e+00
Vth: 5.70e-01
Vdsat:       9.30e-01
Gm: 2.33e-03
Gds: 1.31e-04
Gmb: 6.97e-04
Cbd: 7.91e-15
Cbs: 1.48e-14
Cgsov:       2.80e-15
Cgdov:       2.80e-15
Cgbov:       1.00e-18
Cgs: 2.88e-14
Cgd: 0.00e+00
Cgb: 0.00e+00

--- BSIM3 MOSFETS ---
Name:        m2
Model:    nmos-bsim
Id:        5.48e-04
Vgs:       1.50e+00
Vds:       2.00e+00
Vbs:       0.00e+00
Vth:       5.43e-01
Vdsat:     6.21e-01
Gm:        9.92e-04
Gds:       1.03e-05
Gmb        2.63e-04
Cbd:       7.70e-15
Cbs:       1.14e-14
Cgsov:     2.67e-15
Cgdov:     2.67e-15
Cgbov:     9.99e-19
dQgdVgb:   3.99e-14
dQgdVdb: -2.68e-15
dQgdVsb: -3.59e-14
dQddVgb: -1.70e-14
dQddVdb:   1.04e-14
dQddVsb:   1.90e-14
dQbdVgb: -6.01e-15
dQbdVdb: -7.71e-15
dQbdVsb: -1.62e-14

Figure 3.23: Operating point information from output file and from SPICE Error Log, Shichman-Hodges model (transistor M1) and
BSIM3 model (transistor M2) for the circuit from Fig. 3.22.

the transistor in the active region. Running a ‘.op’ simulation results in an output file with the operating
point information shown in Fig. 3.23, and the error log file displayed when entering ‘Ctrl-L’ provides the
information about the small-signal parameters also shown in Fig. 3.23.
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From the small-signal parameters, the transistor parameters may be calculated as follows, using (3.9),
(3.8) and (3.3):

λ =
gds

ID −gdsVDS
(3.12)

Vt = VGS −
2 ID

gm
(3.13)

Kp =
gm

(W/L)(VGS −Vt)(1+λVDS)
=

(
gm

ID

)2( ID −gdsVDS

2(W/L)

)
(3.14)

Assuming a value of 0.7 V for |2ΦF |, the bulk effect parameter γ may be calculated using (3.10) with
VSB = 0:

γ = 2
√

|2ΦF |
(

gmb

gm

)
= 1.67× gmb

gm
(3.15)

For the simulation results from Fig. 3.23, this results in λ = 0.0195 V−1, Vt = 0.395 V, Kp = 86.4 µA/V2

and γ = 0.44
√

V.

With these model parameters inserted for the model NMOS-SH, the ‘.op’ analysis gives the operating
point information shown in Fig. 3.24. Obviously, there is a close match between the bias point informa-
tion and small-signal parameters for ‘ ’ and ‘ ’.

Output file

--- Operating Point ---

V(vds):  2 voltage
V(vgs):  1.5 voltage
V(vsb):  0 voltage
Id(M2):  0.000548031  device_current
Ig(M2):  0 device_current
Ib(M2): -2.001e-012  device_current
Is(M2): -0.000548031  device_current
Id(M1):  0.000548055  device_current
Ig(M1):  0 device_current
Ib(M1): -2.01e-012  device_current
Is(M1): -0.000548055  device_current
I(V3): -4.011e-012  device_current
I(V2): -0.00109609  device_current
I(V1): 0 device_current

SPICE Error Log

Semiconductor Device Operating Points:

--- MOSFET Transistors ---
Name: m1
Model:       nmos035
Id: 5.48e-04
Vgs: 1.50e+00
Vds: 2.00e+00
Vbs: 0.00e+00
Vth: 3.95e-01
Vdsat:       1.11e+00
Gm: 9.92e-04
Gds: 1.03e-05
Gmb: 2.61e-04
Cbd: 7.91e-15
Cbs: 1.48e-14
Cgsov:       2.00e-21
Cgdov:       2.00e-21
Cgbov:       2.00e-22
Cgs: 2.88e-14
Cgd: 0.00e+00
Cgb: 0.00e+00

--- BSIM3 MOSFETS ---
Name:        m2
Model:    nmos-bsim
Id:        5.48e-04
Vgs:       1.50e+00
Vds:       2.00e+00
Vbs:       0.00e+00
Vth:       5.43e-01
Vdsat:     6.21e-01
Gm:        9.92e-04
Gds:       1.03e-05
Gmb        2.63e-04
Cbd:       7.70e-15
Cbs:       1.14e-14
Cgsov:     2.67e-15
Cgdov:     2.67e-15
Cgbov:     9.99e-19
dQgdVgb:   3.99e-14
dQgdVdb: -2.68e-15
dQgdVsb: -3.59e-14
dQddVgb: -1.70e-14
dQddVdb:   1.04e-14
dQddVsb:   1.90e-14
dQbdVgb: -6.01e-15
dQbdVdb: -7.71e-15
dQbdVsb: -1.62e-14

Figure 3.24: Operating point information from output file and from SPICE Error Log with adjusted model parameters for the
Shichman-Hodges model (transistor M1).
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(a) (b)

Figure 3.25: Input characteristics, ID versus VGS, (a), and output characteristics, ID versus VDS, (b), simulated for both Shichman-
Hodges model with adjusted parameters (green traces) and BSIM3 model (blue traces).

While the transistor parameters have been adjusted to match in the bias point, this does not necessarily
ensures a good match over a range of variations. This is illustrated in Fig. 3.25, showing simulated input
characteristics and output characteristics for both transistors in the same plot. For simplicity, the input
characteristics are shown only for VDS = 1.5, 2.0 and 2.5 V, and the output characteristics are shown
only for VGS = 1.0, 1.5, 2.0 and 2.5 V. Evidently, the match between the two transistors is reasonable for
variations around the bias point but is less good when the transistors operate in the triode region and for
large values of VGS and VDS where the mobility degradation is important.
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Example 3.6: Simulating small-signal parameters using the ‘.tf’ simulation.

In the previous examples, the small-signal parameters gm and gds have been simulated directly as deriva-
tives of the drain current, Figs. 3.15 and 3.18. However, when designing CMOS circuits, it may be useful
to have the small-signal parameters also versus the bias current and versus the layout parameters channel
width W and channel length L. For the Shichman-Hodges model, the small-signal parameters can be
expected to rescale according to (3.8) and (3.9), but for the BSIM models, these equations are only fairly
rough approximations. In this example, we show some simple circuits which make it possible to simulate
the small-signal parameters using the ‘.tf’ simulation. By defining a design variable as a parameter in
the circuit and sweeping the parameter using a ‘.step’ directive, the small-signal parameter can be plot-
ted versus the design variable. As a starting point, we consider a diode-connected transistor as shown
in Fig. 3.26. With VGS = VDS, the transistor is in the active region, and from the small-signal diagram,
we find an input resistance of (gm + gds)

−1. Simulating the small-signal transfer function vgs/id results
in both the transfer function, the input resistance and the output resistance being equal to (gm +gds)

−1.
With gds � gm, this can be used as an approximate value for 1/gm.

(a) (b)

Figure 3.26: Diode-connected NMOS transistor (a) and small-signal diagram for the diode-connected transistor (b).

Figure 3.27: NMOS current mirror for simulating both gds and gm +gds.

For finding gds, we may connect an additional transistor to form a current mirror. Figure 3.27 shows
the LTspice schematic with the current mirror output transistor ‘ ’. This is connected to a controlled
current source ensuring that ID1 = ID2. With identical transistors, this implies that VDS1 =VDS2, so from
this configuration both gm and gds can be found from a single ‘.tf’ simulation with ‘ ’ as the output
and ‘ ’ as the source. With this simulation, gm +gds is found as the reciprocal of the input impedance
and gds is the reciprocal of the output impedance.
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(a) (b)

Figure 3.28: Simulation of gm +gds (a) and gds (b) versus W for different levels of bias current.

For the circuit, you may specify several design variables as parameters and you may include mul-
tiple ‘.step’ directives. The ‘.step’ directives are executed in the sequence in which they appear in
the SPICE Netlist (‘View → SPICE Netlist’). They appear in the netlist in the same sequence as in-
serted in the schematic, and the first ‘.step’ directive determines the default x-axis in the plot window.
In Fig. 3.27, both transistor channel width W and bias current ID are specified as parameters, and the
‘.step’ directive for W is inserted first. Figure 3.28 shows the results of a ‘.tf’ simulation for finding
gm +gds and gds. The traces are added in the plot windows using ‘Plot Settings → Add trace’ where you
click on a parameter (e.g. ‘i1#Input_impedance’) and use the text box for editing to modify it (e.g. to
‘1/i1#Input_impedance’). We see that gds is indeed much smaller than gm, so it is reasonable to approx-
imate gm by gm + gds. If this had not been the case, we might have plotted the reciprocal of the input
impedance minus the reciprocal of the output impedance instead.

We may specify the value of ‘ ’ to be different from 0. In Fig. 3.27, a value of ‘ ’ larger than Vt

will bias the transistor in the triode region while a negative value will increase VDS and bias the transistor
deeper into the active region. However, in this circuit configuration, the drain bias voltage depends on
both the transistor layout parameters and on the drain bias current.

(a) (b)

Figure 3.29: Diode-connected NMOS transistor with a voltage buffer for the drain voltage (a) and small-signal diagram for the
diode-connected transistor (b).
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In order to obtain a constant drain voltage, the diode-connected transistor may be modified as shown
in Fig. 3.29. With the gain A of the voltage controlled voltage source � 1, the bias value of the drain
voltage is (almost) equal to the dc bias voltage VB used as input to the voltage controlled voltage source.
A small-signal analysis gives the small-signal input impedance vgs/id = (gm + gds/(1+A))−1 � 1/gm

for Agm � gds. Figure 3.30 shows the LTspice schematic corresponding to the schematic from Fig. 3.27
augmented with the voltage buffer shown in Fig. 3.29.

Figure 3.30: NMOS current mirror with voltage buffer for the drain voltage for simulating both gds and gm.

(a) (b)

Figure 3.31: Simulation of gm (a) and gds (b) versus W for different levels of bias current with the transistor in the triode region.

As an example, Fig. 3.31 shows a simulation of gm and gds with a small value of VB (VB = 0.2 V) for
which the transistors are in the triode region. Clearly, in this situation gds cannot be neglected compared
to gm, but for the configuration with the voltage buffer, we find gm directly as the reciprocal of the input
impedance (for A � 1).

Example 3.7: Simulating small-signal transistor capacitances using the ‘.ac’ simulation.

While the small-signal parameters gm and gds are easily simulated using the ‘.tf’ simulation, the small-
signal capacitances cannot be simulated by this command. They are listed in the error log resulting
from a ‘.op’ simulation as shown in Fig. 3.9, but in order to obtain the capacitances as functions of
design parameters such as bias current or bias voltages, a ‘.ac’ simulation may be used. Following
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the approach described in Tutorial 2, Example 2.6 (page 62), the capacitances can be found from C =

Im(i)/(ω v) = Im(i)/(2π f v) where v is the voltage applied to the capacitor and i is the current in the
capacitor, compare (2.10) on page 63.

Figure 3.32: LTspice schematic for simulating small-signal transistor capacitances for an NMOS transistor.

Figure 3.32 shows an LTspice schematic for simulating the small-signal capacitances for an NMOS
transistor with the same Shichman-Hodges model and the same dimensions and bias conditions as the
NMOS transistor shown in Fig. 3.8. A ‘.op’ simulation results in the capacitance values listed in the log
file shown in Fig. 3.9 on page 85. When applying an ac voltage with an amplitude of 1 to the gate, we
can find the gate-source capacitance from the current in the source terminal, i.e. the current in ‘ ’. Also,
we can find the gate-drain capacitance from the current in ‘ ’.
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Figure 3.33 shows the simulation plot (with a linear y-axis), and we find a gate-source capacitance of
31.6 fF and a gate-drain capacitance of 2.8 fF. This may be compared to the values from Fig. 3.9 where
we have Cgs = = 31.6 fF and Cgd = = 2.8 fF.

Figure 3.33: Simulation of Cgs and Cgd .

For finding the bulk-drain capacitance we may apply an ac amplitude of 1 to drain, gate and source
(‘ ’, ‘ ’ and ‘ ’) while the bulk (‘ ’) is reset to 0 V. The bulk-drain capacitance is the found from
the current in ‘ ’. The simulation plot is shown in Fig. 3.34, and we find a bulk-drain capacitance of
7.91 fF, i.e. the same as found from the ‘.op’ simulation.

Figure 3.34: Simulation of Cbd .

The bulk-drain capacitance is a junction capacitance, so it is dependent on the reverse bias voltage of the
junction, i.e. VDB. In order to investigate this, we define the dc value of ‘ ’ as a parameter ‘ ’ and
introduce a ‘.step’ directive in schematic in Fig. 3.32: ‘ ’. This causes VDB

to be stepped from 0 V to 3 V in increments of 0.3 V, so the resulting plot of the bulk-drain capacitance
has 11 curves as shown in Fig. 3.35. We see that the bulk-drain capacitance varies from 18.0 fF to 6.8 fF
when the bias voltage varies from 0 V to 3 V.
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Figure 3.35: Simulation of Cbd for different values of the bias voltage VDB.

Using a ‘.meas’ directive, the capacitance may be calculated and plotted versus the bias voltage: Insert
a ‘.meas’ directive as shown in Fig. 3.36 and run the ‘.ac’ simulation. Then open the error log file
(‘Ctrl-L’). In this file, the results of the ‘.meas’ directive are given. When right-clicking in the error log
file, a small dialogue box opens and you can select ‘Plot .step’ed .meas data’ which opens a window
in the waveform viewer showing Cbd as a function of the bias voltage VDB. Figure 3.37 shows this plot
where the (left) y-axis has been selected to be linear and the phase is not shown. The variation of Cbd

versus VDB is evident.
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Figure 3.36: LTspice schematic for simulating small-signal transistor capacitances for an NMOS transistor, including a ‘.meas’
directive for calculating Cbd .

Figure 3.37: Simulation of Cbd versus the bias voltage VDB.

In a similar way, the input capacitance to a transistor may be simulated. This is left as an exercise to the
reader, see Problem 3.8.
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Hints and pitfalls

– LTspice defines the positive direction of current flow into the transistor, so the drain current in
a PMOS transistor is normally negative (or zero).

– The output file from an operating point simulation (‘.op’) provides information about node
voltages and device currents.

– The SPICE Error Log (hotkey ‘Ctrl-L’) from an operating point simulation (‘.op’) provides
information about bias points and small-signal parameters for the transistors in a circuit.

– Simple transistor models may be entered directly in the schematic using a ‘.model’ SPICE
directive. Advanced transistor models are included using model files and a ‘.include’ SPICE
directive.

– A model file can be opened and viewed in LTspice using the command ‘Files → Open’ and
specifying ‘Files of type → All Files’.

– The default model names for ‘nmos4’ and ‘pmos4’ transistors are NMOS and PMOS. If your
‘.model’ directives or model file use model names different from this, remember to change
the model name when specifying the transistor parameters for each transistor (see Fig. 3.1 on
page 77). Otherwise, the simulation will run with a default Shichman-Hodges transistor model
with ‘ ’, ‘ ’, ‘ ’, ‘ ’, and ‘ ’.

– Remember to re-calculate the channel-length modulation parameter ‘ ’ in the Shichman-
Hodges transistor model when changing the channel length of a transistor. It is inversely pro-
portional to the channel length.

– When using the Shichman-Hodges model, separate transistor models are required for transistors
with different channel lengths in order to specify different values for ‘ ’.

– When having multiple traces in a simulation plot (e.g., output characteristics for different values
of VGS), one or two cursors may be attached to the traces and moved from one trace to another
by the up-arrow key and the down-arrow key.

– The information about a trace followed by a cursor is displayed by right-clicking on the cursor
number.

– When using two ‘.step’ directives in a schematic, the x-axis in the simulation plot is determined
by the ‘.step’ directive appearing first in the netlist. This is the command inserted first in the
schematic.

– When using ‘.measure’ directives in combination with ‘.step’ directives, the resulting tables in
the error log file can be presented in the waveform viewer by using a right-click on the mouse
and selecting ‘Plot .step’ed .meas data’.
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Problems

3.1

W = 10 µm, L = 1 µm,

Kp = 55 µA/V2, Vto =−0.71 V, λ = 0.16 V−1,

γ = 0.75
√

V, |2ΦF |= 0.7 V.

Figure P3.1

For the PMOS transistor shown in
Fig. P3.1, simulate and plot the in-
put characteristics ID versus VSG and
∂ iD/∂vSG for VSD = 0, 0.5, 1.0, 1.5,
2.0, 2.5 and 3.0 V. Use the model
parameters and transistor dimensions
shown in the figure. Find the bias cur-
rent ID and the small-signal parameters
gm, gmb and gds for the bias point of
VSG = 1.5 V and VSD = 2.0V.

3.2

.MODEL NMOS-BSIM NMOS LEVEL = 49
+VERSION = 3.1 TNOM = 27 TOX = 7.8E-9 
+XJ = 1E-07 NCH = 2.18E+17 VTH0 = 0.48
+K1 = 6.07E-01 K2 = 1.24E-03 K3 = 9.68E+01
+K3B = -9.84E+00 W0 = 2.02E-05 NLX = 1.62E-07
+DVT0W = 0 DVT1W = 0 DVT2W = 0
+DVT0 = 2.87E+00 DVT1 = 5.86E-01 DVT2 = -1.26E-01
+U0 = 360 UA = -8.48E-10 UB = 2.27E-18
+UC = 3.27E-11 VSAT = 1.87E+05 A0 = 1.22E+00
+AGS = 2.06E-01 B0 = 9.60E-07 B1 = 4.95E-06
+KETA = -1.67E-04 A1 = 0 A2 = 3.49E-01
+RDSW = 8.18E+02 PRWG = 2.35E-02 PRWB = -8.12E-02
+WR = 9.98E-01 WINT = 1.55E-07 LINT = 4.51E-10
+DWG = -4.27E-09
+DWB = 4.07E-09 VOFF = -4.14E-02 NFACTOR = 1.61E+00
+CIT = 0 CDSC = 2.39E-04 CDSCD = 0.00E+00
+CDSCB = 0 ETA0 = 1 ETAB = -1.99E-01
+DSUB = 1 PCLM = 1.32E+00 PDIBLC1 = 2.42E-04
+PDIBLC2 = 8.27E-03 PDIBLCB = -9.99E-04 DROUT = 9.72E-04
+PSCBE1 = 7.24E+08 PSCBE2 = 9.96E-04 PVAG = 1.00E-02
+DELTA = 1.01E-02 RSH = 3.33E+00 MOBMOD = 1
+PRT = 0 UTE = -1.5 KT1 = -1.11E-01
+KT1L = 0 KT2 = 2.22E-02 UA1 = 4.34E-09
+UB1 = -7.56E-18 UC1 = -5.62E-11 AT = 3.31E+04
+WL = 0 WLN = 9.95E-01 WW = 0
+WWN = 1.00E+00 WWL = 0 LL = 0
+LLN = 1 LW = 0 LWN = 1
+LWL = 0 CAPMOD = 2 XPART = 0.5
+CGDO = 2.76E-10 CGSO = 2.76E-10 CGBO = 1.00E-12
+CJ = 9e-4 PB = 7.95E-01 MJ = 3.53E-01
+CJSW = 2.8e-10 PBSW = 7.98E-01 MJSW = 1.73E-01
+CJSWG = 1.81E-10 PBSWG = 7.96E-01 MJSWG = 1.74E-01
+CF = 0 PVTH0 = -1.80E-02 PRDSW = -7.56E+01
+PK2 = 4.48E-05 WKETA = -1.33E-03 LKETA = -8.91E-03

Figure P3.2

For an NMOS transistor with the
transistor model shown in Fig. P3.2
(BSIM3 0.35 µm model, Fig. 3.10) and
channel width W = 10 µm, simulate
and plot ID versus the channel length
L in the interval 1 µm < L < 10 µm
for a bias point of VGS = 1.5 V, VDS =

2.0 V and VSB = 0 V. Find the bias cur-
rent ID and the small-signal parameters
gm, gmb and gds for L = 1 µm and for
L = 5 µm in the bias point.
Hint: Define L as a parameter, compare
page 26.
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3.3

.MODEL PMOS-BSIM PMOS LEVEL = 49
+VERSION = 3.1 TNOM = 2.69E+01 TOX = 7.8E-9 
+XJ = 1.00E-07 NCH = 8.44E+16 VTH0 = -0.6
+K1 = 4.82E-01 K2 = -2.13E-02 K3 = 8.27E+01
+K3B = -5 W0 = 5.24E-06 NLX = 2.49E-07
+DVT0W = 0.00E+00 DVT1W = 0 DVT2W = 0
+DVT0 = 3.54E-01 DVT1 = 7.52E-01 DVT2 = -2.98E-01
+U0 = 150 UA = 1E-10 UB = 1.75E-18
+UC = -2.27E-11 VSAT = 2.01E+05 A0 = 1.04E+00
+AGS = 2.90E-01 B0 = 1.94E-06 B1 = 5.01E-06
+KETA = -3.85E-03 A1 = 4.20E-03 A2 = 1.00E+00
+RDSW = 4000 PRWG = -9.54E-02 PRWB = -1.92E-03
+WR = 1 WINT = 1.47E-07 LINT = 1.04E-10
+DWG = -1.09E-08
+DWB = 1.14E-08 VOFF = -1.29E-01 NFACTOR = 2.01E+00
+CIT = 0 CDSC = 2.40E-04 CDSCD = 0
+CDSCB = 0 ETA0 = 4.07E-02 ETAB = 6.84E-03
+DSUB = 3.21E-01 PCLM = 5.96E+00 PDIBLC1 = 2.89E-03
+PDIBLC2 = -1.45E-06 PDIBLCB = -1E-03 DROUT = 9.93E-04
+PSCBE1 = 7.88E+10 PSCBE2 = 5E-10 PVAG = 15
+DELTA = 9.96E-03 RSH = 2.6 MOBMOD = 1
+PRT = 0 UTE = -1.5 KT1 = -1.09E-01
+KT1L = 0 KT2 = 2.19E-02 UA1 = 4.34E-09
+UB1 = -7.62E-18 UC1 = -5.63E-11 AT = 3.28E+04
+WL = 0 WLN = 1 WW = 0
+WWN = 1.00E+00 WWL = 0 LL = 0
+LLN = 1 LW = 0 LWN = 1
+LWL = 0 CAPMOD = 2.01E+00 XPART = 0.5
+CGDO = 2.10E-10 CGSO = 2.12E-10 CGBO = 1.00E-12
+CJ = 14e-4 PB = 9.83E-01 MJ = 5.79E-01
+CJSW = 3.2e-10 PBSW = 9.92E-01 MJSW = 3.60E-01
+CJSWG = 4.41E-11 PBSWG = 9.85E-01 MJSWG = 3.58E-01
+CF = 0 PVTH0 = 2.58E-02 PRDSW = -3.98E+01
+PK2 = 2.02E-03 WKETA = 2.72E-03 LKETA = -7.14E-03

Figure P3.3

For a PMOS transistor with the transis-
tor model shown in Fig. P3.3 (BSIM3
0.35 µm model, Fig. 3.10) and channel
width W = 10 µm and channel length
L = 1 µm, simulate and plot the input
characteristics ID versus VSG for VSD =

0, 0.5, 1.0, 1.5, 2.0, 2.5 and 3.0 V. As-
sume VBS = 0 V. Also simulate and plot
the output characteristics ID versus VSD

for VSG = 0, 0.5, 1.0, 1.5, 2.0, 2.5 and
3.0 V. Use the cursors to find ID and
∂ iD/∂vSD for VSG = 1.5 V, VBS = 0 V
and VSD = 2.0 V.
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3.4

.MODEL PMOS-BSIM PMOS LEVEL = 49
+VERSION = 3.1 TNOM = 2.69E+01 TOX = 7.8E-9 
+XJ = 1.00E-07 NCH = 8.44E+16 VTH0 = -0.6
+K1 = 4.82E-01 K2 = -2.13E-02 K3 = 8.27E+01
+K3B = -5 W0 = 5.24E-06 NLX = 2.49E-07
+DVT0W = 0.00E+00 DVT1W = 0 DVT2W = 0
+DVT0 = 3.54E-01 DVT1 = 7.52E-01 DVT2 = -2.98E-01
+U0 = 150 UA = 1E-10 UB = 1.75E-18
+UC = -2.27E-11 VSAT = 2.01E+05 A0 = 1.04E+00
+AGS = 2.90E-01 B0 = 1.94E-06 B1 = 5.01E-06
+KETA = -3.85E-03 A1 = 4.20E-03 A2 = 1.00E+00
+RDSW = 4000 PRWG = -9.54E-02 PRWB = -1.92E-03
+WR = 1 WINT = 1.47E-07 LINT = 1.04E-10
+DWG = -1.09E-08
+DWB = 1.14E-08 VOFF = -1.29E-01 NFACTOR = 2.01E+00
+CIT = 0 CDSC = 2.40E-04 CDSCD = 0
+CDSCB = 0 ETA0 = 4.07E-02 ETAB = 6.84E-03
+DSUB = 3.21E-01 PCLM = 5.96E+00 PDIBLC1 = 2.89E-03
+PDIBLC2 = -1.45E-06 PDIBLCB = -1E-03 DROUT = 9.93E-04
+PSCBE1 = 7.88E+10 PSCBE2 = 5E-10 PVAG = 15
+DELTA = 9.96E-03 RSH = 2.6 MOBMOD = 1
+PRT = 0 UTE = -1.5 KT1 = -1.09E-01
+KT1L = 0 KT2 = 2.19E-02 UA1 = 4.34E-09
+UB1 = -7.62E-18 UC1 = -5.63E-11 AT = 3.28E+04
+WL = 0 WLN = 1 WW = 0
+WWN = 1.00E+00 WWL = 0 LL = 0
+LLN = 1 LW = 0 LWN = 1
+LWL = 0 CAPMOD = 2.01E+00 XPART = 0.5
+CGDO = 2.10E-10 CGSO = 2.12E-10 CGBO = 1.00E-12
+CJ = 14e-4 PB = 9.83E-01 MJ = 5.79E-01
+CJSW = 3.2e-10 PBSW = 9.92E-01 MJSW = 3.60E-01
+CJSWG = 4.41E-11 PBSWG = 9.85E-01 MJSWG = 3.58E-01
+CF = 0 PVTH0 = 2.58E-02 PRDSW = -3.98E+01
+PK2 = 2.02E-03 WKETA = 2.72E-03 LKETA = -7.14E-03

Figure P3.4

For a PMOS transistor with the transis-
tor model shown in Fig. P3.4 (BSIM3
0.35 µm model, Fig. 3.10) and channel
width W = 10 µm and channel length
L = 1 µm, find the bias current ID and
the small-signal parameters gm, gmb

and gds in a bias point of VSG = 1.5 V,
VBS = 0 V and VSD = 2.0 V. From
these small-signal parameters and the
bias current, estimate parameters for a
Shichman-Hodges model for the tran-
sistor. Assume |2ΦF |= 0.7 V.
Simulate and plot the input character-
istics (ID versus VSG) and output char-
acteristics (ID versus VSD) using both
the BSIM model and the Shichman-
Hodges model with the parameters es-
timated from the simulation of small-
signal parameters in the bias point.
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3.5

.MODEL NMOS-BSIM NMOS LEVEL = 49
+VERSION = 3.1 TNOM = 27 TOX = 7.8E-9 
+XJ = 1E-07 NCH = 2.18E+17 VTH0 = 0.48
+K1 = 6.07E-01 K2 = 1.24E-03 K3 = 9.68E+01
+K3B = -9.84E+00 W0 = 2.02E-05 NLX = 1.62E-07
+DVT0W = 0 DVT1W = 0 DVT2W = 0
+DVT0 = 2.87E+00 DVT1 = 5.86E-01 DVT2 = -1.26E-01
+U0 = 360 UA = -8.48E-10 UB = 2.27E-18
+UC = 3.27E-11 VSAT = 1.87E+05 A0 = 1.22E+00
+AGS = 2.06E-01 B0 = 9.60E-07 B1 = 4.95E-06
+KETA = -1.67E-04 A1 = 0 A2 = 3.49E-01
+RDSW = 8.18E+02 PRWG = 2.35E-02 PRWB = -8.12E-02
+WR = 9.98E-01 WINT = 1.55E-07 LINT = 4.51E-10
+DWG = -4.27E-09
+DWB = 4.07E-09 VOFF = -4.14E-02 NFACTOR = 1.61E+00
+CIT = 0 CDSC = 2.39E-04 CDSCD = 0.00E+00
+CDSCB = 0 ETA0 = 1 ETAB = -1.99E-01
+DSUB = 1 PCLM = 1.32E+00 PDIBLC1 = 2.42E-04
+PDIBLC2 = 8.27E-03 PDIBLCB = -9.99E-04 DROUT = 9.72E-04
+PSCBE1 = 7.24E+08 PSCBE2 = 9.96E-04 PVAG = 1.00E-02
+DELTA = 1.01E-02 RSH = 3.33E+00 MOBMOD = 1
+PRT = 0 UTE = -1.5 KT1 = -1.11E-01
+KT1L = 0 KT2 = 2.22E-02 UA1 = 4.34E-09
+UB1 = -7.56E-18 UC1 = -5.62E-11 AT = 3.31E+04
+WL = 0 WLN = 9.95E-01 WW = 0
+WWN = 1.00E+00 WWL = 0 LL = 0
+LLN = 1 LW = 0 LWN = 1
+LWL = 0 CAPMOD = 2 XPART = 0.5
+CGDO = 2.76E-10 CGSO = 2.76E-10 CGBO = 1.00E-12
+CJ = 9e-4 PB = 7.95E-01 MJ = 3.53E-01
+CJSW = 2.8e-10 PBSW = 7.98E-01 MJSW = 1.73E-01
+CJSWG = 1.81E-10 PBSWG = 7.96E-01 MJSWG = 1.74E-01
+CF = 0 PVTH0 = -1.80E-02 PRDSW = -7.56E+01
+PK2 = 4.48E-05 WKETA = -1.33E-03 LKETA = -8.91E-03

Figure P3.5

For an NMOS transistor with the
transistor model shown in Fig. P3.5
(BSIM3 0.35 µm model, Fig. 3.10), a
channel width W = 10 µm and channel
length L = 1 µm, assume a bias point
specified by VGS =VDS, VSB = 0 V and
ID = 140 µA. Find gm, gmb and gds

from a ‘.op’ simulation and estimate
parameters Kp, Vto, λ and γ for a
Shichman-Hodges model for the tran-
sistor. Assume |2ΦF |= 0.7 V.

3.6

Kp = 190 µA/V2, Vto = 0.57 V, λ = 0.16 V−1,

γ = 0.5
√

V, |2ΦF |= 0.7 V.

Figure P3.6

For an NMOS transistor with the
Shichman-Hodges parameters shown
in Fig. P3.6 and a channel length L =

1 µm, simulate and plot gm and gds ver-
sus the drain current ID for W = 10 µm,
W = 30 µm and W = 50 µm, and 0 <

ID < 10 mA. Assume a drain-source
voltage of VDS = 1.2 V.
From the plots of gm and gds, find
the maximum drain current for which
the transistor is in the active region
for each of the three values of channel
width.
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3.7

Kp = 190 µA/V2, Vto = 0.57 V, λ = 0.16 V−1,

γ = 0.5
√

V, |2ΦF |= 0.7 V.

Figure P3.7

For an NMOS transistor with the
Shichman-Hodges parameters shown
in Fig. P3.7, a channel width W =

20 µm and a channel length L = 1 µm,
simulate and plot gm/gds versus the
drain current ID for 1 µA < ID <

100 µA. Assume a drain-source voltage
of VDS = 1.5 V.
Also plot gm/gds versus 1/

√
ID. Find

gm/gds for ID = 1 µA and ID = 100 µA.

3.8

W1 =W2 = 20 µm, L1 = L2 = 1 µm,

AD1 = AD2 = 20×10−12 m2,

PD1 = PD2 = 22 µm.

Figure P3.8

For the current mirror shown in
Fig. P3.8, use a ‘.ac’ simulation to
find the input resistance and the in-
put capacitance. Assume that the in-
put impedance can be approximated by
a parallel connection of a capacitance
and a resistance so that the equations
shown on page 65 - 65 can be used. As-
sume a dc value of 100 µA for the input
current and use the transistor dimen-
sions shown in the figure. Also, use
the BSIM3 transistor model shown in
Fig. P3.5 on page 112 (BSIM3 0.35 µm
model, Fig. 3.10).
Find the input resistance and input ca-
pacitance for two different values of the
load resistor:
RL = 0 Ω and RL = 10 kΩ.

113
Download free eBooks at bookboon.com



CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

114

Tutorial 3 – MOS Transistors

114

Answers

3.1: ID = 227 µA; gm = 0.574 mA/V; gmb = 0.257 mA/V; gds = 27.5 µA/V

3.2: L = 1 µm: ID = 0.548 mA; gm = 0.992 mA/V; gmb = 0.263 mA/V; gds = 10.3 µA/V.
L = 5 µm: ID = 0.127 mA; gm = 0.245 mA/V; gmb = 0.065 mA/V; gds = 1.94 µA/V.

3.3: ID = 0.16 mA; ∂ iD/∂vSD = 7.3 µA/V.

3.4: ID = 0.16 mA; gm = 0.339 mA/V; gmb = 0.0754 mA/V; gds = 7.31 µA/V;
λ = 0.05 V−1; Vto =−0.556 V; Kp = 32.6 µA/V2; γ = 0.37

√
V; |2ΦF |= 0.7 V.

3.5: gm = 0.584 mA/V; gmb = 0.167 mA/V; gds = 6.04 µA/V;
λ = 0.045 V−1; Vto = 0.520 V; Kp = 117 µA/V2; γ = 0.48

√
V; |2ΦF |= 0.7 V.

3.6: W = 10 µm: IDmax = 1.65 mA; W = 30 µm: IDmax = 4.95 mA; W = 50 µm: IDmax = 8.23 mA.

3.7: ID = 1 µA: gm/gds = 751; ID = 100 µA: gm/gds = 75.1.

3.8: RL = 0 Ω: Rin = 1.206 kΩ; Cin = 0.146 pF; RL = 10 kΩ: Rin = 1.206 kΩ; Cin = 0.190 pF.
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Tutorial 4 – Basic Gain Stages

This tutorial introduces the basic CMOS gain stages and some of the issues arising when simulating the
stages. The basic gain stages include the common-source stage, the common-drain stage, the common-
gate stage and the differential input pair. After having completed the tutorial, you should be able to

– find bias currents and voltages for the standard configurations of basic gain stages.

– simulate the low-frequency transfer function and the signal swings on the input and output of a
gain stage.

– find small-signal parameters for the transistors in a gain stage.

– simulate the frequency response of a gain stage.

– perform design iterations from simple Shichman-Hodges transistor models to advanced Spice
models.

– simulate common-mode rejection ratio and power-supply rejection ratio of a gain stage.

– simulate input impedances and output impedances of a gain stage.

– simulate the noise properties of a gain stage.

Example 4.1: The common-source amplifier (inverting amplifier).

The simplest form of a common-source stage is just an NMOS transistor with a resistor to provide the bias
current as shown in Fig. 4.1. This configuration is rarely used in integrated circuit design, but it provides
a good introduction to the common-source stage and to the steps in design iterations involving different
transistor models. Hence, we will start by analyzing this configuration and subsequently examine a
common-source configuration with an active load.

Figure 4.1: NMOS common-source amplifier with drain resistor.
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Common-source stage with a drain resistor: The design specification for such an amplifier stage may
comprise specifications of small-signal gain, output resistance, supply voltage, output-voltage range,
input-voltage range, supply current, frequency response, etc. For this example, we assume that the
supply voltage is specified to be VDD = 3 V and that the open-circuit small-signal gain should be Avoc =

−10 V/V, corresponding to 20 dB. The quiescent value of the output voltage (with no dc load connected
to the output) should be VDD/2 = 1.5 V in order to allow a large voltage swing at the output. Also, let
us assume that the −3 dB frequency f0 should be at least 10 MHz with a load capacitance of 1.5 pF
and that the current consumption should be as small as possible. The design parameters for this stage
are the value of RD and the transistor dimensions W and L. In order to have a starting point for the
simulation of the stage, we will calculate values for these parameters using the simple Shichman-Hodges
transistor model (Shichman & Hodges 1968). We are assuming a 0.35 µm CMOS process and use the
transistor parameters from Fig. 3.8 on page 84. For initial calculations by hand, it may be acceptable to
ignore the channel-length modulation (i.e. assume λ = 0), and with a load capacitance of 1.5 pF, it is
also reasonable to neglect the internal transistor capacitances.

The design equations corresponding to the design requirements are as follows:

Gain requirements:

Avoc =−RD gm =−RD
2 ID

VGS −Vto
(4.1)

With the bias current ID and the resistor RD selected to provide a bias value of the output voltage of half
the supply voltage VDD, this results in

Avoc =− VDD

VGS −Vto
⇒VGS =Vto +

VDD

|Avoc|
= 0.87 V (4.2)

Figure 4.2: LTspice schematic for simulating the common-source stage with the Shichman-Hodges transistor model and with λ =

0.16 V−1 and the corresponding value of input bias voltage, i.e. a dc value of 0.84 V for VIN .
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Frequency response requirements: With a minimum requirement for f0 and a requirement for small
current consumption, RD should be selected as large as possible while fulfilling f0 = 1/(2πRDCL) ≥
10 MHz. From this,

RD = 1/(2π f0CL) = 10.6 kΩ (4.3)

With this value of RD, the bias current ID is ID = VDD/(2RD) = 142 µA and the transistor transconduc-
tance is gm = 0.94 mA/V. The transistor dimensions can be calculated from

W
L

=
2 ID

µnCox(VGS −Vto)2 = 16.6 (4.4)

Selecting L = 1 µm, we find W = 16.6 µm.

These values are used in the following for simulating the circuit. Figure 4.2 shows the LTspice schematic
for the circuit where also the transistor drain and source areas and perimeters have been specified using
source and drain areas of 3 times W times the minimum length and perimeters of W plus 6 times the
minimum length, i.e. slightly larger than the minimum sizes indicated on page 84.

Specifying transistor parameters: At this point, it may be useful to demonstrate how the transistor
specifications can be shown in the schematic in a way that ensures back annotation from the schematic
to the netlist, rather than the ‘quick and dirty’ way used throughout Tutorial 3. Consider Fig. 4.3 with
three transistor symbols. The transistors have been specified to be identical by right-clicking on the
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Figure 4.3: LTspice transistor symbols with different numbers of visible transistor parameters.

transistor symbol and inserting the transistor parameters in the specification window as explained on
page 84, Fig. 3.8. For all three transistors, the following values have been entered: L = 1 µm, W = 5 µm,
AD = AS = 5×10−12 m2, PD = PS = 7 µm, M = 1. The topmost transistor (M1) shows only the name
(‘ ’) and the transistor model (‘ ’), and this is the LTspice default way of showing the transistor.
When you ‘Ctrl-right-click’ on the transistor symbol, the ‘Component Attribute Editor’ shown to the left
of the symbol opens. In this, you will see the model name (‘ ’) listed as ‘Value’ and the transistor
specification parameters listed as ‘Value2’. Notice the column heading ‘Vis.’ (Visible). It has an X in
the line for ‘InstName’ and ‘Value’ but not for ‘Value2’. This specifies that only the name (‘ ’) and the
transistor model (‘ ’) are visible in the schematic.
The middle transistor (M2) shows all the transistor parameters on the schematic. This is achieved by
inserting an X in the ‘Component Attribute Editor’ for the line with ‘Value2’ as shown to the left of the
transistor.
The bottom transistor (M3) shows only L and W in addition to the name (‘ ’) and the transistor model
(‘ ’). To the left of the transistor symbol is shown the ‘Component Attribute Editor’ for achieving
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this. The parameters which should be visible are remaining in the line ’Value2’ which is still marked
as visible, whereas the other parameters have been moved to the next line, ‘SpiceLine’, which is not
marked as visible. Also, the letters for channel length and width have been changed to capital letters.
You may notice that the transistor specification in the netlist is the same for the three transistors (’View
→ SPICE Netlist’).

Often in a CMOS circuit, you would use the same channel length for all transistor, so it may not be
necessary to show L in the schematic. If this is the case, L can just be moved to ‘SpiceLine’. The order
of the parameters has no influence on the simulation. Having only W visible saves some drawing space.

Actually, you may also use the ‘Component Attribute Editor’ for the transistor symbols ‘nmos’ and
‘pmos’ with direct connections between source and bulk. Rather than specifying the transistors as de-
scribed on page 78, you ‘Ctrl-right-click’ on the symbol and enter the transistor parameters directly in
the ‘Component Attribute Editor’ as shown in Fig. 4.3.

Clearly, this editing of the transistor is more involved than just the simple default specification. However,
you can specify just one NMOS transistor and one PMOS transistor to show the parameters of interest,
and then you can draw additional transistors using the duplicate command, ‘Edit → Duplicate’, ‘F6’, or
toolbar symbol . An additional advantage is that the visible parameters are then edited just by moving
the cursor over the text and right-clicking.

Iterativ design of the transistor channel width: In order to verify the calculations from (4.1) to (4.4),
the circuit of Fig. 4.2 may first be simulated using λ = 0. Running a dc sweep, you will find that an input
voltage of 0.87 V indeed results in an output voltage of 1.5 V, and from an ac analysis, you will find that
the gain is indeed 20 dB with a −3 dB frequency of 10 MHz.

Changing λ to 0.16 V−1, a re-simulation of the dc sweep shows that the input bias voltage must be
changed to 0.84 V as shown in Fig. 4.2 in order to get an output voltage of 1.5 V. With this value of input
bias voltage, a ‘.tf’ simulation shows a low-frequency gain of −9.35 V/V and an output impedance of
8.87 kΩ. Obviously, the small-signal output resistance rds of the transistor has some influence. Running
a ‘.op’ simulation and analyzing the transistor small-signal parameters (‘Ctrl-L’ for viewing the error
log), you find gds to be 18.4 µA/V, corresponding to rds = 54 kΩ. This is not quite negligible compared
to RD, and it will result in a smaller output resistance and a smaller gain. In order to obtain a larger
gain, the value of RD may be increased or the transistor width may be increased. Increasing RD increases
the output resistance and reduces the −3 dB frequency. Since λ is generally not a very well controlled
parameter, it is not advisable to increase RD as this may cause the output resistance to be too high to
fulfill the bandwidth requirement. Rather, the design may be modified by increasing the transistor width
which (for the same bias current ID) gives a larger value of gm and a larger value of Avoc. From (3.8), we
have

gm =

√
2µnCox

W
L

ID(1+λVDS) (4.5)

showing that gm is proportional to the square root of W/L.
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Thus, since gm needs to be increased by about 7%, the value of W/L should be increased by about 14%,
i.e. to about 19 µm. Again, a dc sweep is needed in order to find a new value for the input bias voltage.
It is now VGS = 0.82 V for an output voltage of 1.5 V. With this value of VGS, an ac analysis results in a
gain very close to 20 dB and a −3 dB frequency of 11.6 MHz which fulfills the specifications.

As we learned in Tutorial 3, there might be significant discrepancies between a simple Shichman-Hodges
model and a more realistic, advanced transistor model. The circuit of Fig. 4.2 may be re-simulated using
the BSIM3 transistor model from Fig. 3.10 on page 86. Running a dc sweep with this model (and W =

19 µm), you will find that the input bias voltage should be changed to 0.89 V in order to get an output
voltage of 1.5V, and a ‘.tf’ simulation results in a low-frequency gain of −9.05 V/V, i.e. about 9.5% too
small. The bandwidth may be found from a ‘.ac’ simulation to be 10.6 MHz. Hence, assuming that gm

follows (4.5), W should be increased by about 20%, giving a new value for W of 22.8 µm. With this value
of W, the input bias voltage should be changed to 0.84 V, and a ‘.tf’ simulation shows a low-frequency
gain of −10.3 V/V while a ‘.ac’ simulation shows a bandwidth of 10.5 MHz. Reducing W to 22 µm
results in a gain of −10 V/V and a bandwidth of 10.6 MHz, so with just a few simple iterations, we have
achieved an acceptable design.

Common-source stage with an active load: The common-source stage with resistive load is rarely
used in integrated circuit design, partly because resistors typically take up more silicon area than tran-
sistors, partly because the gain is limited by the value of RD. Instead, a standard configuration is the
common-source stage with an active load as shown in Fig. 4.4.
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Figure 4.4: NMOS common-source amplifier with PMOS load.

Here, a PMOS current mirror implements the load to the NMOS common-source transistor M1. In this
way, the bias current to the common-source transistor is controlled by the current mirror, and the small-
signal load to the common-source transistor is the parallel combination of rds for the NMOS common-
source transistor and rds for the PMOS active load operating as a current source.

Figure 4.5: LTspice schematic for simulating the common-source stage with a PMOS active load, drawn with correct polarity of
PMOS transistors.

Observe that the PMOS transistors have their source upwards and drain downwards. This means that
when drawing the schematic in LTspice, you need to rotate (‘Ctrl-R’) and mirror (‘Ctrl-E’) the transistor
symbols appropriately in order to get the correct schematic as shown in Fig. 4.5 where the connection to
the PMOS gates is at the upper end of the gate electrode. You may have realized that the MOS transistor
(with equal dimensions of drain and source diffusions) is a symmetrical device, so even if you do not
perform the rotation and mirroring as in Fig. 4.5, you would expect the same performance of the circuit.
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Figure 4.6: LTspice schematic for simulating the common-source stage with a PMOS active load, drawn with inverted polarity of
PMOS transistors.

Figure 4.6 shows the schematic drawn without rotation of the PMOS transistors. The simulation results
for the output voltage is the same for the two schematics, but with the inverted drain and source terminals
in Fig. 4.6, the output files from a ‘.op’ simulation will be somewhat confusing. Figure 4.7 shows the
error log files with the transistor bias voltages and currents and small-signal parameters corresponding
to both Fig. 4.5 and Fig. 4.6. The small-signal parameters are identical, but the gate-source voltages
and drain-source voltages are different since drain and source are interchanged. In general, the drawing
standard of Fig. 4.5 is recommended, even though it requires more manipulations in terms of rotation
and mirroring since it gives output results which are directly comparable to the results obtained from
standard hand calculations.

SPICE Error Log

Circuit: * M:\LTspice\Tutorial04\fig4_05.asc

Semiconductor Device Operating Points:
--- MOSFET Transistors ---

Name: m3 m2 m1
Model:       pmos-sh     pmos-sh     nmos-sh
Id: -1.40e-04 -1.46e-04    1.46e-04
Vgs: -1.17e+00 -1.17e+00    8.26e-01
Vds: -1.17e+00 -1.51e+00    1.49e+00
Vbs: 0.00e+00    0.00e+00    0.00e+00
Vth: -7.10e-01 -7.10e-01    5.70e-01
Vdsat: -4.63e-01 -4.63e-01    2.56e-01
Gm: 6.05e-04    6.33e-04    1.14e-03
Gds: 1.89e-05    1.89e-05    1.89e-05
Gmb: 2.71e-04    2.84e-04    3.42e-04
Cbd: 2.61e-14    2.41e-14    8.75e-15
Cbs: 4.10e-14    4.10e-14    1.48e-14
Cgsov:       4.20e-15    4.20e-15    5.32e-15
Cgdov:       4.20e-15    4.20e-15    5.32e-15
Cgbov:       1.00e-18    1.00e-18    1.00e-18
Cgs: 5.76e-14    5.76e-14    5.47e-14
Cgd: 0.00e+00    0.00e+00    0.00e+00
Cgb: 0.00e+00    0.00e+00    0.00e+00

SPICE Error Log

Circuit: * M:\LTspice\Tutorial04\fig4_06.asc

Semiconductor Device Operating Points:
--- MOSFET Transistors ---

Name: m3 m2 m1
Model:       pmos-sh     pmos-sh     nmos-sh
Id: 1.40e-04    1.46e-04    1.46e-04
Vgs: 0.00e+00    3.41e-01    8.26e-01
Vds: 1.17e+00    1.51e+00    1.49e+00
Vbs: 1.17e+00    1.51e+00    0.00e+00
Vth: -7.10e-01 -7.10e-01    5.70e-01
Vdsat: -4.63e-01 -4.63e-01    2.56e-01
Gm: 6.05e-04    6.33e-04    1.14e-03
Gds: 1.89e-05    1.89e-05    1.89e-05
Gmb: 2.71e-04 2.84e-04    3.42e-04
Cbd: 4.10e-14    4.10e-14    1.62e-14
Cbs: 2.61e-14    2.41e-14    2.74e-14
Cgsov:       4.20e-15    4.20e-15    5.32e-15
Cgdov:       4.20e-15    4.20e-15    5.32e-15
Cgbov:       1.00e-18    1.00e-18    1.00e-18
Cgs: 0.00e+00    0.00e+00    5.47e-14
Cgd: 5.76e-14    5.76e-14    0.00e+00
Cgb: 0.00e+00    0.00e+00    0.00e+00

(a): Correct polarity of PMOS transistors. (b): Inverted polarity of PMOS transistors.

Figure 4.7: Error log output files corresponding to Fig. 4.5 and Fig. 4.6, respectively.
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SPICE Netlist

M1 VD1 VGN 0 0 NMOS
M2 VD2 VGN 0 0 NMOS
M3 VD3 VGN 0 0 NMOS
M4 VD4 VGN 0 N002 NMOS
M6 VD6 VGP VDD VDD PMOS
M7 VD7 VGP VDD VDD PMOS
M8 VD8 VGP VDD VDD PMOS
M9 VD9 VGP VDD N001 PMOS
M5 VD5 VGN 0 NC_01 NMOS
M10 VD10 VGP VDD NC_02 PMOS

Figure 4.8: Drawing connections between bulk and source for NMOS and PMOS transistors.

You should also notice that for the ‘nmos4’ and ‘pmos4’ symbols just drawing a wire directly from the
bulk terminal of a transistor to the source terminal (the way it is done in Fig. 4.1 and Fig. 4.4) does not by
default establish a connection between bulk and source. This is why the bulk connections in Figs. 4.5 and
4.6 are drawn explicitly to ground and VDD. Figure 4.8 shows a few ways to draw connections between
bulk and source. Pay attention to the incorrect drawings of M4, M5, M9 and M10. Also see the resulting
netlist specification shown to the right in the figure. You can always check the connections by examining
the netlist (’View → SPICE Netlist’) where the syntax for a mos transistor is:
‘ ’.
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You may configure LTspice to accept the drawing of a direct connection between bulk and source by
using the command ‘Tools → Control Panel → Drafting Option.’ Here you can tick ‘Allow direct com-
ponent pin shorts’. However, using this option is not recommended. It implies that you cannot use the
fast way of drawing wires described in Problem 1.8 on page 45, and if you have inserted direct compo-
nent pin shorts, they disappear if you open your schematic in a version of LTspice where this option has
not been activated. By default, it is not activated.

For Fig. 4.5, the size of M1 has been selected to be 19 µm as for the configuration with a drain resistor
(and simulated with the Shichman-Hodges transistor model) in order to compare the performance of
the two circuits. Also, the bias current has been selected to be the same. The PMOS transistors have
(somewhat arbitrarily) been selected to have a width of 20 µm. A large value of W results in a small
overdrive voltage |VGS −Vto| giving a large output-voltage range for the gain stage. With W = 20 µm, the
overdrive voltage for M2 and M3 is (neglecting the channel-length modulation)

|VGS −Vto|=

√
2 IB

µpCox(W/L)
= 0.5 V (4.6)

giving a maximum output voltage of 2.5 V with M2 in saturation.

Comparing the simulation results of the circuit in Fig. 4.5 with the simulations results of the circuit in
Fig. 4.2 with W adjusted to 19 µm, you will recognize that now the gain is larger and the output resistance
is higher. The ‘.tf’ simulation results in Avoc =−30.3 V/V and ro = 26.5 kΩ. The reason for this is that
in the expression for the gain, RD is now replaced by the small-signal output resistance of M2, and the
total small-signal output resistance is the parallel combination of the output resistances of M1 and M2.
They are both caused by the transistor channel-length modulation which is not a well controlled transistor
parameter. This implies that for the common-source configuration with an active load, a design target for
the 3 dB bandwidth cannot be met with a reasonable precision. The ‘.ac’ simulation of Fig. 4.5 shows
a 3 dB bandwidth of 3.9 MHz rather than 11.6 MHz as found on page 120. Instead, it is the product of
gain and bandwidth, GBW, which is a relevant design target. It is given by 2π ·GBW = gm1/CL, and
both gm1 and CL are reasonably well controlled. For the common-source stage with a drain resistor as in
Fig. 4.2, the gain-bandwidth product is 10×11.6 MHz = 116 MHz. For the common-source stage with
an active load as in Fig. 4.5, the gain-bandwidth product is 30.3×3.9 MHz = 118 MHz, i.e. very close
to the value obtained for the circuit with a drain resistor.

Next, the circuit may be simulated using the BSIM3 transistor models. With the same transistor ge-
ometries, the simulations result in a gain of −60.3 V/V and a bandwidth of 1.57 MHz, giving a gain-
bandwidth product of 95 MHz which is somewhat smaller than with the Shichman-Hodges model. As for
the configuration with a drain resistor, the design may be modified by increasing W1, and using the same
value for W1 as for the configuration with a drain resistor (i.e. W1 = 22 µm), we find a gain of −65.2 V/V
and a bandwidth of 1.60 MHz with an input bias voltage of 843 mV, resulting in a gain-bandwidth product
of 104 MHz. For the configuration with resistive load and the same geometry for M1 (i.e. W1 = 22 µm),
we found a gain-bandwidth product of 10.0× 10.6 MHz = 106 MHz, so the gain-bandwidth product is
practically the same for the two designs.
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A word of caution: For the simulations described here, it is important to start with a dc sweep in order to
find the bias value for VIN resulting in an output voltage of 1.5 V. Due to the large gain of the common-
source configuration with an active load, even a very small error in the dc value specified for the bias
voltage VIN will result in an operating point which is way off from the desired operating point. Always
check the operating point by a ‘.op’ simulation to see that bias voltages and currents and small-signal
parameters have reasonable values before running ‘.ac’ simulations and ‘.tf’ simulations.

Also for a transient simulation, the input signal should be chosen to swing around the correct bias value.
As an example, Fig. 4.9 shows a transient simulation of the common source stage with active load driven
by an input signal which is a sinusoidal signal with an amplitude of 10 mV superimposed on a dc bias VIN

which is stepped from 823 mV to 863 mV in steps of 10 mV. The impact of the bias voltage is clearly
seen. For the correct bias value (VIN = 843 mV), the output signal (the red trace in Fig. 4.9) appears
undistorted whereas a severe distortion is observed with a shift of 20 mV for the bias voltage.

Figure 4.9: LTspice schematic for transient simulation of the common-source stage with a PMOS active load (top) and the resulting
simulation plot (bottom).
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Occasionally when running transient simulations with a small signal superimposed on a large signal, you
may encounter problems with the waveform plots due to the data compression used by LTspice (Brocard
2013). Figure 4.10 shows an example of this. The circuit is just the input voltage source from Fig. 4.9
connected to an NMOS transistor with the same geometry as M1 in Fig. 4.9, so the plot of the gate voltage
should show sinusoids. However, the simulation specified in Fig. 4.10(a) results in the waveforms shown
in Fig. 4.10(b), and clearly, this is not what you would expect. The problem can be solved by using the
command ‘Tools → Control Panel’ and select the tab ‘Compression’. Here you untick ‘Enable 1st Order
Compression’ and click ‘OK’. Alternatively, disable the data compression using the SPICE directive
‘ ’. Repeating the simulation then results in perfect sine waves.

(a) (b)

Figure 4.10: LTspice simulation showing data compression problems in a transient simulation. (a) Schematic. (b) Waveform plot.
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Example 4.2: The common-drain amplifier (source follower).

The common-drain stage (or source follower) is shown in fig 4.11 with an NMOS transistor as the
common-drain transistor and an NMOS current mirror to bias the common-drain stage. The source
follower is normally used as a buffer stage. It has a voltage gain close to one and a fairly small output
resistance, implying that it can drive a resistive load. For the source follower, it may not be possible
to connect the bulk to the source, so the bulk effect will have an impact on the performance, both the
small-signal gain, the output resistance and the output voltage swing. In this example, we will compare a
source follower with source and bulk connected, fig 4.11(a), to a source follower with the bulk connected
to the negative supply rail, fig 4.11(b).

(a) (b)

Figure 4.11: Common-drain stage. (a) Common-drain NMOS with source and bulk connected. (b) Common-drain NMOS with
bulk connected to negative supply rail.

For this design, we assume that we need a buffer capable of driving a resistive load of 5 kΩ with a
voltage swing from −1.0 V to + 0.5 V. The supply voltages are VDD =VSS = 1.5 V. The source follower
cannot drive the output very high (assuming a maximum input voltage equal to VDD) because a gate-
source voltage is needed between the input voltage and the output voltage. First, we design the buffer
shown in Fig. 4.11(a) assuming a Shichman-Hodges transistor model with the parameters from Fig. 3.8
on page 84. Next, we take the bulk effect into consideration (Fig. 4.11(b)), and finally we use the BSIM3
transistor model from Fig. 3.10 on page 86 for an extra design iteration.

The basic design requirements arise from the output swing. In order to have a negative output swing of
−1.0 V with a load resistor of 5 kΩ, we need a bias current in M2 of at least 1 V/5 kΩ = 0.2 mA. As
M2 is configured as a current source, it should be in the active area for this bias current, implying that
the overdrive voltage VGS2 −Vto must be at most 0.5 V in order ensure VDS2 ≥VGS2 −Vto. Neglecting the
channel-length modulation, we may calculate a minimum value of (W2/L2) from

W2

L2
=

2 ID2

µnCox(VGS2 −Vto)2 = 8.4 (4.7)

For an initial design, we select L2 = 1 µm and W2 = 10 µm. For M3, we may use a smaller width, scaling
down the current in M3 and RB compared to the current in M2 in order to reduce the current consumption
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of the bias circuit. Using a scale factor of 10, we select L3 = W3 = 1 µm. The resistor RB is calculated
from VGS3, the supply voltage and the current:

RB =
VDD +VSS −VGS3

ID3
=

VDD +VSS −Vto −
√

2 ID3
µnCox(W3/L3)

ID3
= 98.5 kΩ (4.8)

Finally, M1 must be designed so that it can supply 200 µA to M2 plus 100 µA to RL (giving an output
voltage of 0.5 V) when the gate voltage is the maximum input voltage which is assumed to be VDD. This
implies (compare (4.7))

W1

L1
=

2×300 µA
190 µA/V2(1.5 V−0.5 V−0.57 V)2

= 17 (4.9)

With L1 = 1 µA, we select W1 = 17 µm.

Figure 4.12 shows the schematic corresponding to fig 4.11(a) and with the Shichman-Hodges transistor
model for the specification of M1, M2 and M3. For an initial simulation, it may be a good idea to use
λ = 0 in the model description as shown in the figure. In this way, the hand calculations can be verified
directly. For verifying the lower output-voltage limit, a ‘.op’ simulation with the input at −1.5 V may be
run, and for verifying the upper output limit, a ‘.op’ simulation with the input at +1.5 V may be run.
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Figure 4.12: LTspice schematic for the common-drain stage without bulk effect and with a Shichman-Hodges transistor model
with λ = 0.

Figure 4.13 shows the output files and the error log files from these simulations. Notice that labels have
been placed on all the nodes in the schematic in Fig. 4.12, using the command ‘Edit → Label Net’ (or
toolbar symbol ). This makes it easier to read the output file from the simulation.

Figure 4.13(a) shows the simulation results for VIN =−1.5 V. From the output file, we find VO =−1.00 V
as required, and from the error log file, we find = 0.459 V < = 0.499 V for M2, so M2 is in
the active region as required.

Figure 4.13(b) shows the simulation results for VIN =+1.5 V. From the output file, we find VO = 0.499 V
which is sufficiently close to the calculated value to confirm the hand calculations.

For the schematic, you may also run a dc sweep with the input voltage swept from −1.5 V to +1.5 V.
The result of this is shown in Fig. 4.14, and it is evident that the source follower provides an output
voltage in the range −1 V to +0.5 V. The input voltage required to obtain an output voltage of 0 V is
found to be VIN = 0.92 V. With this value of the input bias voltage, also the result of a ‘.tf’ simulation is
shown in Fig. 4.14. The small-signal gain is found to be 0.85 V/V. Also an output resistance of 749 Ω
is listed, but this is not the output resistance of the source follower since the simulation has included
the load resistor RL. In order to find the output resistance ro and the open-circuit voltage gain Avoc, the
‘.tf’ simulation must be run without RL (or with RL set to a very high value, e.g. 5 GΩ). Running this
‘.tf’ simulation, you will find Avoc = 1 and ro = 880 Ω. Running a ‘.op’ simulation with VIN = 0.92 V
(and RL = 5 GΩ), the error log file yields gm1 = 1.14 mA/V, confirming that ro = 1/gm1 for the source
follower when the bulk effect and the channel-length modulation is not taken into account.

A re-simulation of the circuit, taking the channel-length modulation into account (using λ = 0.16 V−1)
shows that the circuit no longer quite fulfills the requirements concerning the minimum value of the
output voltage. This is hardly surprising since M2 has a smaller drain-source voltage than M3, so with
the channel-length modulation taken into account, the scaling of the current mirror M3− M2 is smaller
than 10. A simple way to compensate for this is to reduce the value of RB. A new value for RB may be
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Output file

--- Operating Point ---

V(vdd):  1.5 voltage
V(vin):  -1.5 voltage
V(vo):  -1.00053  voltage
V(vb):  -0.471047  voltage
V(-vss):  -1.5 voltage
Id(M3):  2.00106e-005  device_current
Ig(M3):  0 device_current
Ib(M3):  -1.03895e-012  device_current
Is(M3):  -2.00106e-005 device_current
Id(M2):  0.000200106 device_current
Ig(M2):  0 device_current
Ib(M2):  -5.09469e-013  device_current
Is(M2):  -0.000200106 device_current
Id(M1):  5.01106e-012 device_current
Ig(M1):  0 device_current
Ib(M1):  -2.51053e-012  device_current
Is(M1):  -2.50053e-012 device_current
I(Rl):  0.000200106 device_current
I(Rb):  2.00106e-005 device_current
I(Vin):  0 device_current
I(Vss):  -0.000220117  device_current
I(Vdd):  -2.00106e-005 device_current

SPICE Error Log

Semiconductor Device Operating Points:
--- MOSFET Transistors ---

Name: m3 m2 m1
Model:       nmos-sh     nmos-sh     nmos-sh
Id: 2.00e-05    2.00e-04    5.01e-12
Vgs: 1.03e+00    1.03e+00 -4.99e-01
Vds: 1.03e+00    4.99e-01    2.50e+00
Vbs: 0.00e+00    0.00e+00    0.00e+00
Vth: 5.70e-01    5.70e-01    5.70e-01
Vdsat:       4.59e-01    4.59e-01 0.00e+00
Gm: 8.72e-05    8.72e-04    0.00e+00
Gds: 0.00e+00    0.00e+00    0.00e+00
Gmb: 2.61e-05    2.61e-04    0.00e+00
Cbd: 1.46e-15    1.16e-14    1.21e-14
Cbs: 2.20e-15    1.48e-14    2.46e-14
Cgsov:       2.80e-16    2.80e-15    4.76e-15
Cgdov:       2.80e-16    2.80e-15    4.76e-15
Cgbov:       1.00e-18    1.00e-18    1.00e-18
Cgs: 2.88e-15    2.88e-14    0.00e+00
Cgd: 0.00e+00    0.00e+00    0.00e+00
Cgb: 0.00e+00    0.00e+00    7.34e-14

(a): output file and error log file with VIN =−1.5 V.

Output file

--- Operating Point ---

V(vdd):  1.5 voltage
V(vin):  1.5 voltage
V(vo):  0.499061  voltage
V(vb):  -0.471047  voltage
V(-vss):  -1.5 voltage
Id(M3):  2.00106e-005  device_current
Ig(M3):  0 device_current
Ib(M3):  -1.03895e-012  device_current
Is(M3):  -2.00106e-005 device_current
Id(M2):  0.000200106 device_current
Ig(M2):  0 device_current
Ib(M2):  -2.00906e-012  device_current
Is(M2):  -0.000200106 device_current
Id(M1):  0.000299919 device_current
Ig(M1):  0 device_current
Ib(M1):  -1.01094e-012  device_current
Is(M1):  -0.000299919 device_current
I(Rl):  -9.98123e-005 device_current
I(Rb):  2.00106e-005 device_current
I(Vin):  0 device_current
I(Vss):  -0.000220117  device_current
I(Vdd):  -0.000319929 device_current 

SPICE Error Log

Semiconductor Device Operating Points:
--- MOSFET Transistors ---

Name: m3 m2 m1
Model:       nmos-sh     nmos-sh     nmos-sh
Id: 2.00e-05    2.00e-04    3.00e-04
Vgs: 1.03e+00    1.03e+00    1.00e+00
Vds: 1.03e+00    2.00e+00    1.00e+00
Vbs: 0.00e+00    0.00e+00    0.00e+00
Vth: 5.70e-01    5.70e-01    5.70e-01
Vdsat:       4.59e-01    4.59e-01    4.31e-01
Gm: 8.72e-05    8.72e-04    1.39e-03
Gds: 0.00e+00    0.00e+00    0.00e+00
Gmb: 2.61e-05    2.61e-04    4.16e-04
Cbd: 1.46e-15    7.91e-15    1.64e-14
Cbs: 2.20e-15    1.48e-14    2.46e-14
Cgsov:       2.80e-16    2.80e-15    4.76e-15
Cgdov:       2.80e-16    2.80e-15    4.76e-15
Cgbov:       1.00e-18    1.00e-18    1.00e-18
Cgs: 2.88e-15    2.88e-14    4.89e-14
Cgd: 0.00e+00    0.00e+00    0.00e+00
Cgb: 0.00e+00    0.00e+00    0.00e+00

(b): output file and error log file with VIN =+1.5 V.

Figure 4.13: Output files and error log files for ‘.op’ simulations of the common-drain stage from Fig. 4.12.

found by a simple iteration or by running a simulation where the value of RB is swept over a suitable
range, e.g. 90 kΩ to 100 kΩ. A new value of RB = 92 kΩ gives an output-voltage range from −1 V to
+0.5 V with an input bias voltage of 0.9 V required for an output bias voltage of 0 V. A re-simulation to
find ro and Avoc results in Avoc = 0.96 V/V and ro = 705 Ω, so as expected, the channel-length modulation
affects both the gain and the output resistance (Chan Carusone, Johns & Martin 2012).

The next step is to include the bulk effect by connecting the bulk of M1 to the negative supply rail −VSS.
This results in an increased value of Vt for M1, and also the bulk transconductance gmb affects the gain
and the output resistance. The new value of Vt may be calculated from (3.4) on page 79, and gmb may be
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Output from DC Transfer simulation

--- Transfer Function ---

Transfer_function: 0.850299  transfer
vin#Input_impedance:  1e+020  impedance
output_impedance_at_V(vo):  748.505  impedance

Figure 4.14: Result from a dc sweep and from a ‘.tf’ simulation of the circuit from Fig. 4.12.

calculated from (3.10) on page 82. Inserting γ = 0.5
√

V and |2ΦF | = 0.7 V, we find that the threshold
voltage is increased by about 0.4 V for VSB = 2 V, so the bulk effect has a strong impact on the upper limit
of the output range. A dc sweep simulation shows that the output-voltage range is now from −1 V to
+0.2 V. The maximum output voltage can be increased by increasing the width of M1, but a few iterations
with larger values of W1 show that an output voltage of 0.5 V cannot be obtained with realistic values
of W1.

131
Download free eBooks at bookboon.com Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

We will turn your CV into 
an opportunity of a lifetime

Do you like cars? Would you like to be a part of a successful brand?
We will appreciate and reward both your enthusiasm and talent.
Send us your CV. You will be surprised where it can take you.

Send us your CV on
www.employerforlife.com

http://www.employerforlife.com


CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

132

Tutorial 4 – Basic Gain Stages

Figure 4.15: LTspice schematic for simulation of the common-drain output transistor and simulation plot for output current.

We can examine this situation in more detail by simulating the current in just a single NMOS transistor
with the appropriate voltages connected to drain, gate, source and bulk. Figure 4.15 shows the LTspice
schematic for this simulation. In the same way as in Fig. 3.22 on page 96, both a Shichman-Hodges
transistor (‘ ’) and BSIM transistors (‘ ’ and ‘ ’) are inserted in order to compare the transistors.
For the BSIM transistors, two transistors with different channel length are simulated. The reason for
this is that the threshold voltage decreases with decreasing channel length and increasing channel width
(Tsividis & McAndrew 2010). Also shown in Fig. 4.15 is the result of a ‘.dc’ simulation with the source
voltage swept from 0.4 V to 0.6 V in order to analyze the transistor output current for common-drain
stage output voltages in this range.

The simulation shows that the transistors with L = 1 µm cannot deliver any output current at an output
voltage of 0.5 V, whereas the threshold voltage reduction for the transistor with L = 0.35 µm does enable
‘ ’ to deliver an output current. In order to relax the requirements for output current, the bias current
in the source follower can be reduced to the minimum value required to provide the minimum output
voltage of −1 V, i.e. 200 µA. With the value of RB determined from the Shichman-Hodges model (with
λ = 0), the bias current is somewhat higher due to the finite output resistance of the transistors. Thus, to
match the design requirements, RB may be increased so that the current in M2 is reduced to 200 µA.
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Figure 4.16: LTspice schematic for the common-drain stage with bulk effect and with BSIM3 transistor models.

Figure 4.16 shows the source follower with a minimum channel length transistor for M1 and with com-
mands for sweeping RB and W1. When sweeping RB, we run a ‘.op’ simulation with a bias value of
the input voltage of −1.5 V. This simulation shows that RB = 120 kΩ results in an output voltage of
−1.0 V for an input voltage of −1.5 V. Subsequently, W1 may be swept over a suitable range for a ‘.op’
simulation with an input bias voltage of +1.5 V. This simulation shows that an output voltage of 0.5 V
is obtained with W1 = 125 µm. With these component values, a dc sweep shows the required output
range, and to get an output bias voltage of 0 V, an input bias of 0.9 V is required. With this input bias,
a ‘.tf’ simulation with RL infinite shows an open-circuit voltage gain of Avoc = 0.86 V/V and an output
resistance of ro = 201 Ω. Figure 4.17 shows the dc sweep with RL = 5 kΩ and the result of the ‘.tf’
simulation with RL = 5 GΩ.

You may notice that one of the reasons why a very wide source-follower transistor is needed for the
circuit of Fig. 4.16 is that it must be able to supply not only current to RL but also to the biasing transistor
M2. By designing a class AB source-follower buffer, the current to a bias transistor can be avoided,
see Problem 4.3 on page 154. Also the offset between input and output is avoided, and the small-signal
open-circuit voltage gain is 1, even in the presence of the bulk effect.

Output from DC Transfer simulation

--- Transfer Function ---

Transfer_function: 0.862102  transfer
vin#Input_impedance:  1e+020  impedance
output_impedance_at_V(vo):  201.313  impedance

Figure 4.17: Result from a dc sweep with RL = 5 kΩ and from a ‘.tf’ simulation with RL = 5 GΩ of the circuit from Fig. 4.16.
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Example 4.3: The common-gate amplifier.

The third basic configuration is the common-gate amplifier where the input is applied to the source and
the output is taken from the drain while the gate is connected to a fixed bias voltage (small-signal ground).
In this example, we show an NMOS transistor biased with ideal current sources and with an input signal
source with a source resistance RS and a resistive load RL at the output, see Fig. 4.18.

Figure 4.18: Common-gate stage biased from ideal dc current sources.

In the figure, source and bulk are connected, implying that there is no bulk effect. The common-gain stage
may be considered as a current buffer with a current gain of 1, a low input resistance and a high output
resistance. One of the tricky properties of the common-gate configuration is that it is not a unilateral
amplifier, not even at low frequencies. The load resistor affects the input resistance of the stage, and the
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source resistor affects the output resistance of the stage. From (Chan Carusone, Johns & Martin 2012,
p. 126) we have the following expressions for small-signal voltage gain, input resistance and output
resistance:

Av =
vo

vin
=

(gm +gds)RL

1+RLgds +(gm +gds)RS
(4.10)

rin =
1+RLgds

gm +gds
(4.11)

ro = 1/gds +RS(1+gm/gds) (4.12)

where gm is the transconductance and gds is the output conductance of the common-gate transistor. If
the common-gate transistor has its bulk contact connected to a fixed voltage (e.g −VSS), gm should be
replaced by gm +gmb in these equations.

With RL →∞, the input resistance approaches infinity, and with RS →∞, the output resistance approaches
infinity. The voltage gain approaches a maximum of 1+gm/gds � gm/gds for RS = 0 and RL → ∞.

Figure 4.19: LTspice schematic for the common-gate stage from Fig. 4.18.

These relations may be illustrated from a simulation of the circuit which is shown as an LTspice schematic
in Fig. 4.19. For the simulations, we are assuming a Shichman-Hodges transistor model and transistor
dimensions and bias currents as shown in the figure. In the schematic, both RL and RS are defined as
parameters which can be swept in order to find the input resistance and the output resistance as functions
of RL and RS. Default values for RL and RS have been defined. First, a dc sweep of ‘ ’ is required to
find the dc bias value for VIN which gives an output voltage of 0 V. The result is the dc value of ‘ ’
shown in Fig. 4.19. Next, a ‘.op’ simulation is run to verify that input and output voltages are as ex-
pected and to find the transistor small-signal parameters from the error log file (‘Ctrl-L’). This results in
gm = 290 µA/V and gds = 2.85 µA/V. Then, the input and output resistance can be simulated using a dc
transfer (‘.tf’) simulation with ‘ ’ as the output and ‘ ’ as the input. In order to find the input
resistance, RS is specified to a small value, e.g. 1 Ω, and RL is stepped over a suitable range, e.g., 1 kΩ
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(a) (b)

Figure 4.20: Simulations of input and output resistance of common-gate stage. (a) Input resistance versus load resistance. (b)
Output resistance versus source resistance.

to 1000 MΩ as shown in Fig. 4.19. In order to find the output resistance, RL is specified to a very large
value, e.g. 10 GΩ, and RS is stepped over a suitable range, e.g., 1 kΩ to 1 MΩ as shown in Fig. 4.19.
The results of these simulations are shown in Fig. 4.20. The traces to be plotted are selected using the
command ‘Plot Settings → Visible Traces’ in the plot window. From this figure, we find that the output
resistance is about 100RS and the input resistance is about RL/100. This is as expected from (4.11) and
(4.12) and gm/gds = 290/2.85 = 101.7. Also, the transfer function may be plotted from the simulation,
showing a value of 103 V/V for RS small (1 kΩ) and RL large (10 GΩ) as expected from (4.10).

The cascode stage: The fact that the common-gate stage transforms the resistance level from a com-
paratively low level at the input to a high level at the output is used in the frequently encountered cascode
stage, combining a common-source stage and a common-drain stage as shown in Fig. 4.21. Two versions
of the cascode are shown: the telescopic cascode using two transistors of the same type (Fig. 4.21(a)),

(a) (b)

Figure 4.21: Cascode stage. (a) Telescopic cascode. (b) Folded cascode.
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and the folded cascode using a combination of an NMOS transistor and a PMOS transistor (Fig. 4.21(b)).
Provided that the bias current source IB (IBN for the folded cascode) is an ideal current source (or a cur-
rent source with a very high output resistance), the resistance level at the output of the cascode is very
high, resulting in a very high small-signal voltage gain from input to output of the cascode. From (4.12),
the output resistance with an ideal bias current source IB is found as

ro = rds2 + rds1(1+(gm2 +gmb2)/gds2)� rds1(gm2 +gmb2)rds2 (4.13)

Assuming for instance the transistor parameters corresponding to the simple Shichman-Hodges model
from Fig. 3.3 on page 80 with L1 = L2 = 1 µm, W1 = W2 = 10 µm and IB = 20 µA, we find for the
telescopic cascode in Fig. 4.21(a) ro on the order of 40 MΩ, giving a small-signal gain v0/vin =−gm1 ro

on the order of 80 dB. This means that an input signal swing on the order of 100 µV results in an output-
voltage swing on the order of volts, so a dc sweep simulation over a small range of input voltage and
with an increment of, e.g., 10 µV is necessary to find a proper value for the dc bias value of VIN to ensure
an output bias voltage which is a reasonable fraction of VDD. Once a dc bias value for VIN is found, the
operating point and the small-signal transistor parameters in the operating point can be found from a
‘.op’ simulation, and gain and output resistance can be found from a ‘.tf’ simulation. Also the resistance
level in the intermediate node x can be found from a ‘.tf’ simulation with ‘ ’ defined as the output.
The detailed simulations for the circuits from Fig. 4.21 are left for the reader, see Problems 4.4 and 4.5
on page 155.
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Example 4.4: The differential pair.

The last configuration to be examined in this tutorial is the differential pair. Figure 4.22 shows a dif-
ferential pair with PMOS input transistors and an active load with NMOS transistors. Also shown is a
simple bias circuit consisting of RB, M5 and M6 which generates a constant bias current, ID5, for the
differential pair. We will use this circuit for showing how to configure different simulations and will not
go into details concerning the design of a differential stage. For simplicity, the stage is simulated with all
transistors having the same size: L = 1 µm, W = 10 µm, AD = AS = 10 (µm)2, PD = PS = 12 µm. The
transistor models used for the simulations are the BSIM3 models adapted from (Chan Carusone, Johns
& Martin 2014), see Fig. 3.10 on page 86. The bias current is set by the resistor RB to a level of about
20 µA for the current mirror M5 and M6 and 10 µA for the other transistors.

Figure 4.22: PMOS differential pair with NMOS active load.

For a differential stage, the input voltages are normally split into a differential input voltage and a
common-mode input voltage with vIN+ =VCM+vid/2 and vIN−=VCM−vid/2 where VCM is the common-
mode input voltage and vid is the differential input voltage. In LTspice, this may be achieved by connect-
ing a voltage controlled voltage source to each of the two inputs as shown in Fig. 4.23. Alternatively, the
connection shown in Problem 4.6 on page 156 can be used. Figure 4.23 includes most of the simulation
commands and SPICE directives described in the following.

Finding the correct bias point: As a starting point for all the small-signal simulations of the circuit,
a suitable bias point must be established. The circuit shown in Fig. 4.23 is designed to operate with
input gate voltages for M1 and M2 in a range extending from slightly below ground to an upper limit
determined by the supply voltage, the drain-source saturation voltage of M5 and the gate-source voltage
of M1 and M2, i.e. around 2 V. Thus, a reasonable common-mode input bias voltage would be 1 V. For
the differential input voltage, a reasonable bias value would be 0 V, and the offset voltage Voff is also
0 V since the circuit has been designed to be fully symmetrical and the transistors are assumed to match
perfectly. The expected output voltage for this input bias would be the same as the gate-source voltage of
M3 and M4. Running a ‘.op’ simulation actually confirms that these input bias conditions are reasonable
and provide an output voltage of 0.69 V. Moreover, the error log file shows that the current levels are as
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Figure 4.23: LTspice schematic for simulations of the circuit from Fig. 4.22.

expected, that all transistors are in saturation and that gm of the input transistors is slightly smaller than
0.1 mA/V.

Notice that in Fig. 4.23, the input common-mode voltage has been defined as a parameter ‘ ’ which
can be stepped in combination with other analyses, e.g. a ‘.tf’ simulation. The default value for ‘ ’
has been set to 1.0 V. The dc values for the differential input voltage and the offset voltage have both
been set to 0 V because the design is perfectly symmetrical, so there is no systematic offset. Had there
been a mismatch, e.g., between M1 and M2, a dc sweep of ‘ ’ can be used to find the offset voltage
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Figure 4.24: Plot of output voltage versus differential input voltage for a common-mode input voltage of 1 V for the circuit of
Fig. 4.23.

which would be needed to give the correct output voltage, see Problem 4.7 on page 157. Alternatively,
the offset voltage can be found from a ‘.op’ simulation with the output connected back to the inverting
input and the common-mode voltage specified to the desired output voltage. With ‘ ’ and ‘ ’ set
to 0, the feedback ensures that the voltage difference between the non-inverting input and the inverting
input is equal to the offset voltage of the differential stage.
Figure 4.24 shows a dc sweep of the differential input voltage from −100 mV to +100 mV. Obviously,
the output-voltage range extends from 0.2 V to 1.8 V. The output voltage for a differential input voltage
of 0 V is equal to the dc bias voltage of node ‘ ’.

Differential low-frequency gain: Once the bias point has been verified, a quick simulation of the low-
frequency gain can be obtained by a ‘.tf’ simulation with ‘ ’ as the output and ‘ ’ as the input.
This will show a gain of Avoc = 52 V/V or 34 dB. The ‘.tf’ simulation also shows an output resistance of
ro = 535 kΩ as expected from gds for M2 and M4 found from the ‘.op’ simulation.

Input common-mode voltage range: The input common-mode range is the voltage range for VCM

where the differential stage has all transistors operating in the active region so that the small-signal gain
is almost constant over this range of VCM. For the circuit of Fig. 4.22, the upper limit is defined by M5

which enters the triode region when VCM increases, implying that M5 can no longer supply the required
bias current to M1 and M2. The lower limit is defined by M1 which will enter the triode region when
VCM is so low that there is no longer headroom for the gate-source voltage of M3. From the error log file
from the ‘.op’ simulation, you may find |VGS|− |Vt | = |VDSsat| to be 0.25 V for M5 and 0.19 V for M1.
In order to check the voltage levels for the drain-source voltages of M5 and M1, we run a dc sweep from
−1 V to +3 V with VCM as the source.
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Figure 4.25: Plot of drain-source voltage for M1 (blue trace) and M5 (green trace) versus the common-mode input voltage for the
circuit of Fig. 4.23.

Figure 4.25 shows the plot of |VDS5| (green trace) and |VDS1| (blue trace), respectively. From this, we find
a common-mode input range from about −0.3 V to about +1.8 V. In this voltage range, the differential
gain is expected to remain around 34 dB as found from the ‘.tf’ simulation in the bias point.

Figure 4.26: Plot of low-frequency small-signal differential gain versus the common-mode input voltage for the circuit of Fig. 4.23.

This can be verified by a ‘.tf’ simulation where ‘ ’ is stepped from −0.5 V to +2.5 V. Figure 4.26
shows a plot of the transfer function. The gain falls off for small values of VCM. The reason for this is
that gds2 increases as M2 approaches the triode region, but still, the useful range extends down to the
negative rail with a drop in gain of less than 3 dB. You may introduce a small negative offset voltage
(e.g. −5 mV) to reduce the bias value of the output voltage, bringing M2 deeper into the active region.
With Voff = −5 mV, you will find a gain of more than 31 dB for a common-mode input voltage down
to −0.22 V.

For VCM in the range from 1.8 V to 2.5 V, the gain increases somewhat. The reason for this is that M5

enters the triode region, so the bias current for the differential pair is reduced, leading to smaller values
of gm and gds with gds being reduced more than gm (compare Problem P3.7 on page 113). This range of
operation is normally not considered as useful because the smaller bias current also means smaller slew
rate and smaller unity-gain frequency.
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Figure 4.27: Small-signal frequency response for the differential gain for the circuit of Fig. 4.23.

Differential frequency response: When the differential stage is loaded by a capacitance CL which
is much larger than the internal transistor capacitances, the frequency response is expected to have a
dominant pole at ωp = (roCL)

−1 and a gain-bandwidth product of 2π GBW = Avocωp = gm1/CL. From
the error log file from a ‘.op’ simulation, we see that the internal transistor capacitances are on the order
of 10−14 F, i.e. more than one order of magnitude smaller than CL, so the condition for a dominant pole
is fulfilled, but non-dominant poles can be expected at frequencies comparable to the gain-bandwidth
product. An ac simulation with Vid as the input signal results in a Bode plot for the output voltage as
shown in Fig. 4.27.
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The voltage Vid is defined as the input signal by specifying the ac amplitude of Vid to be 1 V, see page
52. From the magnitude plot, we find a unity-gain frequency of 30 MHz, i.e. close to the value expected
from the gm values found from the ‘.op’ simulation. Also, the Bode plot shows that at frequencies above
10 MHz, the phase response indicates the presence of higher order poles and zeros.

Common-mode gain: With a perfectly matched differential pair, the common-mode gain is expected
to be very small, ideally 0 at low frequencies, but at high frequencies, the common-mode rejection is
smaller due to differences in the capacitive loading in the two sides of the differential pair. The common-
mode gain can be simulated with VCM as the input signal for an ac simulation. Figure 4.28 shows the
simulation plot. With a mismatch in the differential pair, a significantly higher common-mode gain can
be expected, see Problem 4.7 on page 157.

Figure 4.28: Small-signal frequency response for the common-mode gain for the circuit of Fig. 4.23.

Power-supply rejection: Also the power-supply rejection can be simulated with an ac simulation. For
this, the supply voltage VDD must be specified with an ac amplitude of 1 V (as shown in Fig. 4.23) while
the other voltage sources should have ac amplitudes of 0. Figure 4.29 shows the simulation plot of the
power-supply rejection. The power-supply rejection ratio is found by dividing the differential small-
signal gain by the small-signal gain from VDD to vO (Sedra & Smith 2016).

Common-mode rejection ratio (CMRR) and power-supply rejection ratio (PSRR): Common-
mode gain and power-supply rejection are often characterized by the parameters CMRR and PSRR which
are defined as the ratio between the differential gain and the common-mode gain or power-supply rejec-
tion, respectively (Sedra & Smith 2016). For simulating CMRR and PSRR, we need both the differential
gain, the common-mode gain and the power-supply rejection in one simulation. We can achieve this
by defining a parameter M with a value of 1 for common-mode gain, 2 for differential gain and 3 for
power-supply rejection.
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Figure 4.29: Power-supply rejection for the circuit of Fig. 4.23.

When simulating the common-mode gain, the ac amplitude of VCM should be 1 while the ac amplitude
of Vid and VDD should be 0. Likewise, for simulating the differential gain, the ac amplitude of Vid should
be 1 while the ac amplitude of VCM and VDD should be 0, and for simulating the power-supply rejection,
the ac amplitude of VDD should be 1 while the ac amplitude of Vid and VCM should be 0. This can be
achieved by defining the amplitudes as parameters ‘ ’, ‘ ’ and ‘ ’, respectively, and
stepping through the three needed combinations using a ‘step’ parameter ‘ ’. The parameters ‘ ’,
‘ ’ and ‘ ’ are defined by table specifications as shown on the next page:
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.param VCM_AC = table(M,1,1,2,0,3,0) (4.14)

.param VID_AC = table(M,1,0,2,1,3,0) (4.15)

.param VDD_AC = table(M,1,0,2,0,3,1) (4.16)

In (4.14) - (4.16), the first table entry is the step number M, and this is followed by pairs of M-values
(counting from 1 to 3) and amplitude values.

Figure 4.30: LTspice schematic for simulating both common-mode gain, differential gain and power-supply rejection.

Figure 4.30 shows the LTspice schematic with these definitions of the ac amplitudes and the ‘.ac’ simula-
tion command. Also included is the ‘.step’ directive, stepping M through the values 1, 2 and 3 in order to
achieve the common-mode gain, the differential gain and the power-supply rejection in one simulation.
Figure 4.31 shows the resulting simulation plot. The green trace (trace 1) shows the common-mode gain,
the blue trace (trace 2) is the differential gain, and the red trace (trace 3) is the power-supply rejection.
You may compare the traces to Figs. 4.27, 4.28 and 4.29. Notice that the three traces are plotted as the
result of showing just one variable, ‘ ’. For finding CMRR and PSRR, we need to separate the

Figure 4.31: Common-mode gain, differential gain and power-supply rejection for the circuit of Fig. 4.23.
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three traces into different variables. This is achieved by adding the operand ‘@’ to the variable. Thus,
‘ ’ shows only the common-mode gain (trace 1), ‘ ’ shows only the differential gain
(trace 2), and ‘ ’ shows only the power-supply rejection (trace 3). Figure 4.32 shows the three
different traces in separate plot panes (achieved by the command ‘Plot Settings → Add Plot Pane’) so
that different scaling of the Y-axes can be used.
Finally, Fig. 4.33 shows CMRR and PSRR calculated as ‘ ’ and ‘ ’,
respectively.

Figure 4.32: Simulation traces from Fig. 4.32 separated into different variables.

Figure 4.33: Common-mode rejection ratio (CMRR) and power-supply rejection ratio PSRR for the circuit of Fig. 4.23.
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Slew rate: The slew rate SR of the output voltage is limited by the current I available to charge and
discharge the load capacitor CL. From SR = I/CL and with a maximum current I limited by M5, a slew
rate of about 40 V/µs can be expected. The slew rate can be simulated by a transient simulation with
square-wave pulses applied to the input, so that the output switches between the minimum and maximum
available output. Figure 4.34 shows the simulation plot from a transient simulation. The plot shows the
differential input voltage and the output voltage. From the slope of the output voltage, a slew rate of
about 40 V/µs is found as expected with I = 20 µA and CL = 0.5 pF.

Figure 4.34: Transient simulation of output voltage for finding the slew rate of the circuit of Fig. 4.23.

Noise: The final simulation considered here is a noise simulation. The specification of a noise simula-
tion is similar to the specification of an ac simulation. The noise simulation is selected by the command
‘Simulate → Edit Simulation Command’ which opens the window with tabs for the different simula-
tions (Fig. 1.5 on page 17). When selecting ‘Noise’, a tab opens for specifying the output voltage, input
voltage, frequency range and sweep characteristics. As an example, a noise simulation of the circuit
from Fig. 4.23 on page 139 is performed over a frequency range from 20 Hz to 10 MHz. After running
the simulation, the noise spectral density in V/

√
Hz of the output voltage can be plotted by pointing to

the output node in the schematic. Also, the noise contribution from each component can be plotted by
pointing to the component and left-clicking. The cursor turns into a red pointer ( ) when moved to a
component. Figure 4.35 shows a plot from the noise simulation with traces for the output noise spectral
density and for the noise contributions from transistors M1 to M4. Observe that a logarithmic scale is
applied to both axes. The traces for ‘ ’ and ‘ ’ (noise from M1 and M3) cannot be seen as
they are hidden beneath the identical noise contributions from M2 and M4. All the noise contributions
are noise at the specified output terminal. Evidently, for the circuit of Fig. 4.23, the active load (M3 and
M4) is the main noise contributor. It should be noted that the circuit of Fig. 4.23 is in no way optimized
for noise performance. For details on how to optimize this, the analysis from (Chan Carusone, Johns &
Martin 2012, pp. 392-394) may be applied.
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Figure 4.35: Noise simulation of the circuit from Fig. 4.23. The y-axis has been selected to show the noise spectral density
in V/

√
Hz in a logarithmic scale.

A useful feature is that by pointing to a trace label above the plot and using ‘Ctrl-left-click’, the total
noise voltage integrated over the specified frequency range is calculated and displayed in a separate
window. Thus, for the circuit of Fig. 4.23, a ‘Ctrl-left-click’ on the green trace label ‘ ’ shows
a total output noise RMS voltage of 1.33 mV.

Also the input referred noise spectral density may be plotted. It is selected from the schematic using the
command ‘View → Visible Traces’ or from the plot window using ‘Plot Settings → Visible Traces’ (or
using the toolbar, symbol ) and selecting ‘ ’.
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Note that the transistor models used for this simulation do not include flicker noise. This is apparent since
the noise spectral density is flat all the way down to very low frequencies. The noise parameters for a
transistor may be included in the transistor model, but for the models taken from (Chan Carusone, Johns
& Martin 2014), no flicker noise parameters are specified. The most important parameter describing the
flicker noise is the flicker noise coefficient KF (Baker 2010; Allen & Holberg 2012). The modeling of
flicker noise is beyond the scope of this tutorial. Problem 4.8 on page 157 illustrates the simulation of
flicker noise with noise parameters for a 0.35 µm CMOS process.
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Hints and pitfalls

– Show relevant transistor parameters in the schematic by using the ‘Component Attribute Editor’,
see page 117.

– Use the ‘.op’ (DC op pnt) analysis for checking voltages and currents in the bias point of your
circuit.

– Check small-signal parameters and operating region of transistors using the error log file
(‘Ctrl-L’) from the ‘.op’ simulation.

– Use the ‘.op’ analysis and the ‘.tf’ (DC Transfer) analysis for checking basic properties at low
frequencies of your circuit.

– Perform dc sweeps to find proper bias values for input signal sources.

– Define component values as variable parameters and run ‘.op’ and/or ‘.tf’ simulations with
parameter sweeps (‘.step parameter ...’) for the design of component values.

– Set parameters to proper default values and remove ‘.step’ directives before running
AC Analysis, DC sweep, Transient or Noise simulations (unless you really want simulation
results for several values of the parameters).

– For editing a SPICE directive, you right-click on the directive. This may open a ‘Help me Edit’
window. You can close this and revert to the standard editing window by pressing ‘Escape’ or
by clicking ‘Cancel’.

– If your schematic contains more than one SPICE directive specifying simulations (and not
converted into comments), LTspice will ask you which simulation to run when starting the
simulation.

– When using a ‘.step’ directive in combination with a simulation command, the plot of a variable
results in several traces, one for each step. You can extract the trace for a specific step by the
operand ‘@<step number>’ after the name of the variable when displaying plot traces, see
example on page 146.

– Assure correct bias voltages and currents before running DC Transfer, AC Analysis or Noise
simulations.

– If the results of a DC Transfer simulation, AC Analysis or Noise simulation are very differ-
ent from what you expected, check that your bias point is what you expected (using the ‘.op’
analysis and checking both the output file and the error log file from the ‘.op’ analysis.)

– If the results of an AC Analysis are very different from what you expected, also check that you
have only one ac source with an amplitude of 1 specified in your circuit.

– If the results of a Transient simulation are very different from what you expected, check that
your transient input signal looks correct. If it does not, it may be due to the data compression in
LTspice. This can be disabled by the SPICE directive ‘ ’.
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Problems

4.1

W2 =W3 = 25 µm, L1 = L2 = L3 = 1 µm

CL = 3.2 pF, VDD = 3 V, IB = 100 µA.

Figure P4.1

For the common-source amplifier
shown in Fig. P4.1, design M1 so that
the gain-bandwidth product of the
stage is 50 MHz. Assume transistor
models as specified in Fig. P3.2 on
page 109 and Fig. P3.3 on page
110 and use a channel length of
L1 = 1 µm. Use a channel width for
M1 which is a multiple of 1 µm.
Hint: Design M1 to have the re-
quired gm for the gain-bandwidth
product with ID = 100 µA. Find gm

versus ID using the method shown
in Example 3.5 on page 100.
Find the dc bias value of the input
voltage for which the output voltage is
1.5 V and find the small-signal voltage
gain Av at low frequencies.
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4.2

VDD =VSS = 1.5 V, L1 = L2 = 1 µm

CL = 0.5 pF, RL = 10 kΩ

Figure P4.2

For the inverting amplifier shown in
Fig. P4.2, design M1 and M2 so that
the dc bias value of the output volt-
age is within the range ±100 mV with
an input dc bias voltage of 0 V and
so that the low-frequency small-signal
gain with an input dc bias voltage of
0 V is −10 V/V. Assume transistor
models as specified in Fig. P3.2 on
page 109 and Fig. P3.3 on page 110
and use a channel length of L1 = L2 =

1 µm. Use channel widths for M1

and M2 which are multiples of 0.5 µm.
What is the low-frequency small-signal
gain if the load resistor RL is omitted?
What is the gain-bandwidth product of
the amplifier for RL = 10 kΩ and for
RL = ∞ ?
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4.3

L1 = L2 = L3 = L4 = L5 = L6 = L7 = L8 = 0.35 µm

RL = 10 kΩ, VDD =VSS = 1.5 V.

Figure P4.3

Figure P4.3 shows a class AB buffer
amplifier. Design the output transis-
tors M1 and M2 so that the amplifier
can deliver an output-voltage swing of
±0.5 V with a load resistor of 10 kΩ.
Assume that the gate voltage of M1 and
M2 can reach the positive and nega-
tive supply voltages, respectively. Se-
lect values of the channel widths which
are multiples of 10 µm. Use transis-
tor models as specified in Fig. P3.2 on
page 109 and Fig. P3.3 on page 110.
Design the bias network M3 − M8 and
RB to provide a bias current of 1 µA
for M3 − M8. M5 − M8 should be
designed to have a saturation voltage
|VDSsat| of less than 50 mV, and the
channel widths should be multiples of
10 µm. M3 and M4 should be scaled to
channel widths of 0.1 times the chan-
nel widths of M1 and M2, respectively.
Plot the output voltage versus the input
voltage for −1.5 V < vIN < 1.5 V. Find
the open-circuit voltage gain and the
output resistance of the buffer for an
input bias voltage of 0 V. Find the bias
current in M1 and M2 for an output bias
voltage of VO = 0 V. Why is the current
scaling in M1−M2 / M3−M4 different
from the channel width scaling?
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4.4

L1 = L2 = 1 µm, W1 =W2 = 10 µm
IB = 20 µA, VB = 1.5 V, VDD = 3 V.

.MODEL NMOS-SH nmos (Kp=190u Vto=0.57
+Lambda=0.16 Gamma=0.50 Phi=0.7 TOX=8n
+CGSO=0.28n CGBO=1p CGDO=0.28n CJ=1m
+CJSW=0.4n)

Figure P4.4

For the telescopic cascode shown in
Fig. P4.4, find the bias value of VIN re-
quired to give an output voltage of 2 V.
Also find the small-signal gain Avoc and
output resistance ro at low frequencies.
Find the small-signal resistance rx to
ground from the node x between the
source of M2 and the drain of M1. As-
sume a transistor model as shown in
Fig. P4.4.

4.5

L1 = L2 = 1 µm, W1 = 10 µm, W2 = 30 µm
IBP = 40 µA, IBN = 20 µA, VB = 1.5 V, VDD = 3 V.

.MODEL PMOS-SH pmos (Kp=55u Vto=-0.71
+Lambda=0.16 Gamma=0.75 Phi=0.7 TOX=8n
+CGSO=0.21n CGBO=1p CGDO=0.28n CJ=1.5m
+CJSW=0.4n)

Figure P4.5

For the folded cascode shown in
Fig. P4.5, find the bias value of VIN

required to give an output voltage of
1 V. Also find the small-signal gain
Avoc and output resistance ro at low fre-
quencies. Find the small-signal resis-
tance rx to ground from the node x be-
tween the source of M2 and the drain
of M1. Assume transistor models as
shown in Figs. P4.4 and P4.5.
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4.6

Figure P4.6

Figure P4.6 shows an alternative ver-
sion of the LTspice schematic from
Fig. 4.23 with a different arrange-
ment for the input voltages. Define
the ac amplitudes of ‘ ’, ‘ ’, ‘ ’
and ‘ ’ such that the ‘.ac’ simu-
lation shows the differential gain and
compare your simulation to Fig. 4.27.
Next, define the ac amplitudes of ‘ ’,
‘ ’, ‘ ’ and ‘ ’ such that the ‘.ac’
simulation shows the common-mode
gain and compare your simulation to
Fig. 4.28. Finally, define the ac am-
plitudes of ‘ ’, ‘ ’, ‘ ’ and ‘ ’
such that the ‘.ac’ simulation shows
the power-supply rejection and com-
pare your simulation to Fig. 4.29.
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4.7

L1 = L2 = L3 = L4 = L5 = 1 µm

W1 = 30 µm, W2 = 33 µm, W3 =W4 =W5 =W6 = 10 µm

AD1 = AS1 = AD2 = AS2 = 30 (µm)2

AD3 = AS3 = AD4 = AS4 = AD5 = AS5 = AD6 = AS6 = 10 (µm)2

PD1 = PS1 = PD2 = PS2 = 32 µm

PD3 = PS3 = PD4 = PS4 = PD5 = PS5 = PD6 = PS6 = 12 µm

RB = 100 kΩ, CL = 0.5 pF, VDD = 3.0 V, VCM = 1 V

Figure P4.7

For the differential pair shown in
Fig. P4.7, we assume that a layout er-
ror has resulted in a mismatch between
M1 and M2 such that W1 = 30 µm
and W2 = 33 µm. Find the input off-
set voltage caused by this error for a
common-mode input voltage of VCM =

1 V and an output voltage of 0.7 V. Use
the Shichman-Hodges transistor model
from Figs. P4.4 and P4.5. Next, plot
the differential gain and the common-
mode gain versus frequency. Find the
gain-bandwidth product and calculate
the common-mode rejection ratio at
low frequencies. Also plot the gain
from the power-supply to the output
and calculate the power-supply rejec-
tion ratio at low frequencies.

4.8
.MODEL PMOS-SH pmos (Kp=55u Vto=-0.71
+Lambda=0.16 Gamma=0.75 Phi=0.7 TOX=8n
+CGSO=0.21n CGBO=1p CGDO=0.21n CJ=1.5m
+CJSW=0.4n KF=5e-26)

.MODEL NMOS-SH nmos (Kp=190u Vto=0.57
+Lambda=0.16 Gamma=0.50 Phi=0.7 TOX=8n
+CGSO=0.28n CGBO=1p CGDO=0.28n CJ=1m
+CJSW=0.4n KF=1e-25)

Figure P4.8

For the differential pair shown in
Fig. P4.7 with W1 = W2 = 30 µm, as-
sume the transistor models shown in
Fig. P4.8 which include parameters for
the flicker noise modeling. Plot the
total noise spectral density of the out-
put voltage and the noise contributions
from M1 and M3 in the frequency range
20 kHz to 10 MHz, using logarithmic
axes. Find the total RMS output noise
voltage in this frequency range. Also
plot the input referred noise spectral
density and find the total RMS input re-
ferred noise voltage in this frequency
range.
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Answers

4.1: W1 = 28 µm; VIN = 0.7735 V; Av = 38 dB.

4.2: W1 = 6.5 µm; W2 = 21 µm; Avoc =−43 V/V; GBW(RL=10 kΩ) = GBW(RL=∞) = 400 MHz.

4.3: W1 = 30 µm; W2 = 240 µm; W3 = 3 µm; W4 = 24 µm; W5 =W6 = 30 µm; W7 =W8 = 10 µm;
RB = 1.84 MΩ; Avoc = 0.95 V/V; ro = 1005 Ω; ID1 = ID2 = 18.9 µA;
|VDS| larger for M1−M2 than for M3−M4 and |Vth| smaller for M1−M2 than for M3−M4.

4.4: VIN = 708.21 mV; Avoc = 83 dB, ro = 49 MΩ, rx = 344 kΩ.

4.5: VIN = 693.684 mV; Avoc = 84 dB, ro = 47 MΩ, rx = 430 kΩ.

4.6: Differential gain: ‘ ’ = 0, ‘ ’ = 0.5, ‘ ’ = 0.5 and ‘ ’ = 0;
Common-mode gain: ‘ ’ = 1, ‘ ’ = 0, ‘ ’ = 0 and ‘ ’ = 0;
Power-supply rejection: ‘ ’ = 0, ‘ ’ = 0, ‘ ’ = 0 and ‘ ’ = 1.

4.7: Voff =−4.2 mV; GBW = 60.3 MHz; CMRR = 66.4 dB; PSRR = 56.6 dB.

4.8: Von,RMS = 1.3 mV; Vin,RMS = 48 µV.
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Tutorial 5 – Hierarchical Design

This tutorial illustrates how complex circuits and systems can be built from basic circuit functions using a
hierarchical description. The hierarchical description is useful for creating a better overview of a system
design, and it is useful when specific circuit blocks are repeated several times in a system design. After
having completed the tutorial, you should be able to

– define a circuit as a subcircuit to be used in a hierarchical circuit description.

– create and edit a symbol for a subcircuit.

– use subcircuits in a higher level schematic.

– apply the hierarchical design to a simple two-stage CMOS opamp.

– apply more levels of hierarchy, e.g., in a design using digital gate functions.

Example 5.1: A two-stage operational amplifier.

A two-stage operational amplifier (opamp) is built from a differential-input stage followed by an inverting
gain stage as shown in Fig. 5.1. The differential-input stage may be a stage similar to the differential pair
described in Example 4.4 on page 138. The inverting gain stage may be a common-source gain stage as
described in Example 4.1 on page 115. Normally, the opamp will also include some biasing circuit as
shown in Fig. 4.4 on page 121 and Fig. 4.22 on page 138. The bias circuit may be common to the input
stage and the inverting gain stage, so in a block diagram, it can be shown as a separate block supplying
a bias voltage to both of the gain stages. Figure 5.1 shows a block diagram of a two-stage operational
amplifier. In addition to the blocks described here, the opamp will often include a compensation capacitor
Cc to control the frequency response in order to achieve stability in a feedback system using the opamp.

Figure 5.1: Schematic at block level of the two-stage operational amplifier.
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Figure 5.2: Transistor level schematic of two-stage operational amplifier.

Creating the subcircuits: Combining the schematics from Fig. 4.4 and Fig. 4.22, we can draw the
complete schematic at transistor level as shown in Fig. 5.2, and the resulting circuit is so simple that we
could easily perform simulations directly on the entire circuit. However, in this example, we will show
how the blocks defined in Fig. 5.1 can be defined as subcircuits in LTspice and how the block diagram
of Fig. 5.1 can be simulated.

We start with the differential pair. In Fig. 4.23 on page 139, this is shown as a schematic for LTspice.
Now we need only the five transistors M1 – M5, but we need to specify which nodes in the circuit are the
terminals corresponding to the six terminals shown in Fig. 5.1. The six terminals are the two inputs, the
output, the two supply voltages and the input for a bias voltage. This is done when labeling the nodes
using the command ‘Edit → Label Net’ (or hotkey ‘F4’). In the dialogue box for specifying the Net
Name, you select the ‘Port Type’ to be either ‘Input’, ‘Output’ or ‘Bi-Direct’.

The resulting schematic is shown in Fig. 5.3. For the transistors, the model references NMOS-BSIM and
PMOS-BSIM to the BSIM3 model from Fig. 3.10 on page 86 are used, since these models will be applied

Figure 5.3: LTspice schematic for differential pair subcircuit.
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for the design of the amplifier. The transistor channel lengths and widths are shown using the approach
described on page 117. The transistor drain and source areas are specified using areas of 3 times W
times the minimum length and the drain and source perimeters are specified using W plus 6 times the
minimum length, i.e. slightly larger than the minimum sizes indicated on page 84. The dimensions have
(arbitrarily) been chosen to the same as in Fig. 4.23.

(a) (b)

Figure 5.4: LTspice autogenerated symbol (a) and edited symbol (b) for the differential-input pair.

Now the subcircuit schematic is complete, and we need a symbol for it, so that it can be used at a block
level as in Fig. 5.1. This is achieved by the command ‘Hierarchy → Open this Sheet’s Symbol’. A
new window opens with a message from LTspice: ‘Couldn’t find this sheet’s symbol. Shall I try to
automatically generate one?’ Answering ‘Yes’ results in a new sheet being opened with a symbol as
shown in Fig. 5.4(a). It is just a box with the output terminal on the right side and the other terminals on
the left side. You may notice that the file name is the name of the circuit in Fig. 5.3 with a file extension
‘.asy’ to indicate that it is a symbol, and the sheet is open in the symbol editor mode of LTspice. You
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may wish to edit the symbol to resemble the triangular symbol shown in Fig. 5.1. This can be done using
the ‘Edit’ and ‘Draw’ commands in the symbol editor. By moving the terminals and drawing a triangular
shape instead of the rectangular box, the symbol may be modified to look like shown in Fig. 5.4(b).
When you click ‘File → Save’, the symbol is saved in the same folder as the subcircuit schematic file.
You may select to save the symbol in another folder by using ‘File → Save As’. Remember to specify a
path to this folder, compare page 29 and 87.

In the same way, you can create subcircuit schematics and a symbols for the common-source stage and
the bias circuit. For the common-source stage, the NMOS transistor is chosen to have a channel width of
20 µm (i.e. twice the width of the NMOS transistors in the differential stage) because the current in this
transistor is twice the current of the NMOS transistor in the differential stage.

The bias circuit is simply a diode-connected PMOS transistor, and the resistor RB (see Fig. 5.2) is con-
sidered as a separate component as shown in Fig. 5.1.

Figure 5.5 shows the common-source stage subcircuit and the symbol for the common-source stage.

Figure 5.6 shows the bias subcircuit and the symbol for the bias circuit.

(a) (b)

Figure 5.5: LTspice schematic (a) and symbol (b) for the common-source stage.

(a) (b)

Figure 5.6: LTspice schematic (a) and symbol (b) for the bias circuit.

Simulating at block level: Using the symbols just created, we can draw the schematic at block level as
shown in Fig. 5.7. When inserting the subcircuits, remember to select the folder (‘Top Directory’) with
your subcircuits in the component selection window, see Fig. 1.3 on page 15. Notice that the model ref-
erence (‘ ’) to the transistor models NMOS-BSIM and PMOS-BSIM is given
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Figure 5.7: LTspice schematic at block level of the two-stage operational amplifier.

in the block-level schematic, not in the separate subcircuit schematics. This ensures that the same tran-
sistor models are used for all subcircuits, so if the model specification is changed, for instance by using
a ‘.model’ specification from a specific vendor rather than the generic BSIM3 model from (Chan Caru-
sone, Johns & Martin 2014), this will automatically affect all the subcircuits. If the model definitions are
included as ‘.model’ specifications in the subcircuits, the specifications in the subcircuit schematic will
override the specifications at the block level.

Also, you may observe that when moving the mouse cursor over a subcircuit, the cursor turns into
a hand . A right-click opens a dialogue box from which you can open either the symbol or the
schematic for the subcircuit. Also, you can specify parameters for the subcircuit, see page 176.

In the schematic in Fig. 5.7 we have just specified a ‘.op’ simulation. Since the circuit has been designed
with matching transistor geometries, we do not expect any systematic offset, so the expected result from
the ‘.op’ simulation is a bias value of the output voltage which is within the useful output-voltage range
of the amplifier.

The output file from the simulation is shown in Fig. 5.8.

When you have completed the ‘.op’ simulation and closed the window with the output file, you can see
currents and voltages in the circuit at block level by moving the cursor to a component or a node and
reading currents and voltages on the status bar at the bottom of the LTspice program window. When
you open a subcircuit schematic, you can also in this schematic point to nodes and see the voltages on
the status bar but only for input and output nodes to the subcircuit. If you wish to see also internal
node voltages and currents in the subcircuits, you must set up LTspice to save the subcircuit voltages
and currents. This is done by the command ‘Tools → Control Panel’ where you select the tab ‘Save
Defaults’. Here you tick ‘Save Subcircuit Node Voltages’ and ‘Save Subcircuit Device Currents’.

After running a new ‘.op’ simulation, you will then be able to see also voltages and currents in the
subcircuits, and the output file from the ‘.op’ simulation will also include node voltages and device
currents in the subcircuits.
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Output file

--- Operating Point ---

V(vim): -0.81608 voltage
V(vi+): 0 voltage
V(vdd): 1.5 voltage
V(vi-): 0 voltage
V(vb): 0.55281 voltage
V(-vss): -1.5 voltage
V(vid): 0 voltage
V(vcm): 0 voltage
V(n001): 0 voltage
V(vo): -0.479621 voltage
I(B1): 0 device_current
I(B2): 0 device_current
I(Rb): 2.05281e-005  device_current
I(V2): -6.2341e-005  device_current
I(V1): 6.2341e-005  device_current
I(Voff):  0 device_current
I(Vcm):  0 device_current
I(Vid):  0 device_current
Ix(stage1:-VSS):  -1.9599e-005  subckt_current
Ix(stage1:VB):  0 subckt_current
Ix(stage1:VDD):  1.9599e-005  subckt_current
Ix(stage1:VIN1):  0 subckt_current
Ix(stage1:VIN2): 0 subckt_current
Ix(stage1:VO):  6.09864e-020  subckt_current
Ix(bias:VB): -2.05281e-005  subckt_current
Ix(bias:VDD):  2.05281e-005  subckt_current
Ix(stage2:-VSS):  -2.22139e-005  subckt_current
Ix(stage2:VB):  0 subckt_current
Ix(stage2:VDD):  2.22139e-005  subckt_current
Ix(stage2:VIN):  0 subckt_current
Ix(stage2:VO):  1.01644e-020  subckt_current

Figure 5.8: Output file from the ‘.op’ simulation of the circuit in fig 5.7.
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Output file

Semiconductor Device Operating Points:
--- BSIM3 MOSFETS ---

Name:    m:stage2:1  m:stage1:3  m:stage1:4  m:stage2:2   m:bias:1
Model:    nmos-bsim   nmos-bsim   nmos-bsim   pmos-bsim   pmos-bsim
Id:        2.22e-05    9.80e-06    9.80e-06 -2.22e-05 -2.05e-05
Vgs: 6.84e-01    6.84e-01    6.84e-01 -9.47e-01 -9.47e-01
Vds:       1.02e+00    6.84e-01    6.84e-01 -1.98e+00 -9.47e-01
Vbs:       0.00e+00    0.00e+00    0.00e+00    0.00e+00    0.00e+00
Vth:       5.39e-01    5.43e-01    5.43e-01 -6.79e-01 -6.81e-01
Vdsat:     1.11e-01    1.07e-01    1.07e-01 -2.52e-01 -2.51e-01
Gm:        3.52e-04    1.60e-04    1.60e-04    1.46e-04    1.36e-04
Gds:       1.98e-06    9.78e-07    9.78e-07    1.41e-06    1.98e-06
Gmb        1.04e-04    4.73e-05    4.73e-05 3.43e-05    3.21e-05
Cbd:       1.71e-14    9.38e-15    9.38e-15    8.17e-15    1.04e-14
Cbs:       2.22e-14    1.14e-14    1.14e-14    1.52e-14    1.52e-14
Cgsov:     5.43e-15    2.67e-15    2.67e-15    2.06e-15    2.06e-15
Cgdov:     5.43e-15    2.67e-15    2.67e-15    2.04e-15    2.04e-15
Cgbov:     9.99e-19    9.99e-19    9.99e-19    1.00e-18    1.00e-18
dQgdVgb:   8.01e-14    3.94e-14    3.94e-14    3.82e-14    3.82e-14
dQgdVdb: -5.44e-15 -2.68e-15 -2.68e-15 -1.99e-15 -2.00e-15
dQgdVsb: -6.89e-14 -3.39e-14 -3.39e-14 -3.35e-14 -3.35e-14
dQddVgb: -3.38e-14 -1.66e-14 -1.66e-14 -1.64e-14 -1.64e-14
dQddVdb:   2.25e-14    1.21e-14    1.21e-14    1.02e-14    1.24e-14
dQddVsb:   3.77e-14    1.85e-14    1.85e-14    1.79e-14    1.79e-14
dQbdVgb: -1.26e-14 -6.25e-15 -6.25e-15 -5.44e-15 -5.43e-15
dQbdVdb: -1.71e-14 -9.39e-15 -9.39e-15 -8.17e-15 -1.04e-14
dQbdVsb: -3.42e-14 -1.72e-14 -1.72e-14 -1.96e-14 -1.96e-14

Name:    m:stage1:5  m:stage1:1  m:stage1:2
Model:    pmos-bsim   pmos-bsim   pmos-bsim
Id: -1.96e-05 -9.80e-06 -9.80e-06
Vgs: -9.47e-01 -9.59e-01 -9.59e-01
Vds: -5.41e-01 -1.78e+00 -1.78e+00
Vbs:       0.00e+00 5.41e-01    5.41e-01
Vth: -6.82e-01 -7.96e-01 -7.96e-01
Vdsat: -2.50e-01 -1.81e-01 -1.81e-01
Gm:        1.30e-04    9.62e-05    9.62e-05
Gds:       2.72e-06    7.66e-07    7.66e-07
Gmb        3.06e-05    1.78e-05    1.78e-05
Cbd: 1.19e-14    7.70e-15    7.70e-15
Cbs:       1.52e-14    1.19e-14    1.19e-14
Cgsov:     2.06e-15    2.06e-15    2.06e-15
Cgdov:     2.04e-15    2.04e-15    2.04e-15
Cgbov:     1.00e-18    1.00e-18    1.00e-18
dQgdVgb:   3.82e-14    3.74e-14    3.74e-14
dQgdVdb: -2.04e-15 -1.99e-15 -1.99e-15
dQgdVsb: -3.35e-14 -3.28e-14 -3.28e-14
dQddVgb: -1.64e-14 -1.62e-14 -1.62e-14
dQddVdb:   1.39e-14    9.71e-15    9.71e-15
dQddVsb:   1.79e-14    1.69e-14    1.69e-14
dQbdVgb: -5.40e-15 -4.85e-15 -4.85e-15
dQbdVdb: -1.19e-14 -7.69e-15 -7.69e-15
dQbdVsb: -1.96e-14 -1.49e-14 -1.49e-14

Figure 5.9: Error log file from the ‘.op’ simulation of the circuit in fig 5.7.

In the error log file (‘Ctrl-L’), you can see device currents and small-signal parameters for all transistors
in the circuit, even if you have not selected to save subcircuit node voltages and device currents. For the
circuit from Fig. 5.7, all transistors are in the subcircuits, and the error log file identifies the transistors
by subcircuit name and device number in the subcircuit as shown in Fig. 5.9.

Example 5.2: Designing the two-stage opamp for an inverting feedback amplifier.

In this example, we show how the two-stage opamp can be designed to a specific set of design require-
ments. The example is included to illustrate the combination of an analytical design methodology based
on the Shichman-Hodges transistor models and LTspice simulations using more realistic BSIM3 models.
For the design example, we assume the following requirements: The opamp is to be used in an inverting
amplifier configuration with a capacitive feedback network as shown in Fig. 5.10. With a high gain of
the opamp at low frequencies, the midband gain of the amplifier is Av =Vo/Vin �−C1/C2.
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The specifications to be met are the following:

Midband gain: 14 dB
Bandwidth: 20 MHz
Input capacitance: 1 pF
Load capacitance: 1.5 pF
Slew rate: ≥ 30 V/µms
Phase margin: ≥ 65◦

Positive supply voltage: 1.5 V
Negative supply voltage: −1.5 V
Technology: 0.35 µm CMOS process with BSIM3 transistor models,

see Fig. 3.10 on page 86

Figure 5.10: Inverting opamp configuration with capacitive feedback.

For the design, the starting point is the schematic shown in Fig. 5.2. The design parameters are all
transistor dimensions, the compensation capacitor Cc, and the bias current set by RB. Obviously, this is a
large number of design variables, and some analytical design methodology is needed. There is no way to
find a reasonable set of transistor dimensions and bias currents simply through iterative simulation with
sweeping of the transistor parameters.

We note that the requirement concerning the input capacitance and the midband gain leads to C1 = 1 pF
and C2 = 0.2 pF. The other design requirements determine the design as follows:

– The bandwidth specification, BW, puts a constraint on the transconductance of the differential-
input transistors and the compensation capacitor Cc which determine the unity-gain bandwidth
of the opamp.

– The specification for the phase margin, PM, puts constraints on the location of non-dominant
poles and zeros in the opamp.

– The slew-rate specification, SR, puts constraints on the bias current for M5 and M6 in Fig. 5.2.
The bias currents must be large enough to slew the voltages on the load capacitance, the feed-
back capacitors and the compensation capacitor.
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Figure 5.11: Open loop circuit for finding the loop gain L(s) =Vr(s)/Vt(s).

For the analytical approach, we base the design on the analysis of the two-stage opamp presented in
(Chan Carusone, Johns & Martin 2012, chapter 6). Examining the feedback configuration, we find
that the loop gain L(s) is determined from the schematic shown in Fig. 5.11 as L(s) = Vr(s)/Vt(s) =
Av(s)C2/(C1 +C2). We also find that the total capacitive load at the output of the amplifier is the load
capacitor CL in parallel with the feedback network which is a series connection of C1 and C2, i.e. the total
capacitive load is C′

L =CL +C1C2/(C1 +C2).

Assuming that the transfer function Av(s) of the opamp has a low-frequency gain A0, a dominant pole at
the frequency ωp1, a non-dominant pole at the frequency ωp2 and a right half-plane zero at the frequency
ω z, the loop gain is given by

L(s) =
(

C2

C1 +C2

)(
A0(1− s/ω z)

(1+ s/ωp1)(1+ s/ωp2)

)
(5.1)
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In this expression, all higher-order poles and zeros are neglected. With ωp2 � ωp1, the loop gain can be
approximated by

L(s) =
(

C2

C1 +C2

)(
A0ωp1(1− s/ω z)

s(1+ s/ωp2)

)
(5.2)

for frequencies ω � ωp1.

From (Chan Carusone, Johns & Martin 2012) we find approximate expressions for A0, ωp1, ωp2 and ω z

as follows:

A0 �
(

gm1

gds2 +gds4

)(
gm7

gds6 +gds7

)
(5.3)

ωp1 � (gds2 +gds4)(gds6 +gds7)

gm7Cc
(5.4)

ωp2 � gm7

C′
L

(5.5)

ω z � gm7

Cc
(5.6)

where the numbering of the transistor small-signal parameters refers to the transistor numbering shown
in Fig. 5.2.

The bandwidth BW of the amplifier (with feedback) can be estimated by 2π ·BW=ωp1(1+L0)�ωp1L0

where L0 = AoC2/(C1 +C2) is the loop gain at low frequencies. From this, we find

2π ·BW =

(
gm1

Cc

)(
C2

C1 +C2

)
(5.7)

With the loop-gain expression given by (5.2), we find a phase margin PM of

PM = 180◦ −90◦ − arctan(ω t/ω z)− arctan(ω t/ωp2) = 180◦+ � L( jω t) (5.8)

where ω t is the unity-gain frequency for the loop gain, i.e. |L( jω t)|= 1.

We may start by selecting ω z � ω t to reduce the influence of the zero. With ω z � 10ω t , the phase shift
from the zero is about 6◦. Also, additional high order poles will contribute to the phase shift. Assuming
(somewhat arbitrarily) an additional phase shift from higher-order poles of 4◦, this leaves a phase shift
of about 15◦ from the second pole for a phase margin of 65◦. From this, we get

arctan(ω t/ωp2) = 15◦ ⇒ ωp2 = 3.8ω t (5.9)

With the non-dominant pole and the zero well above the unity-gain frequency ω t of the loop gain, ω t is
approximately given by the gain-bandwidth product of the loop gain, i.e.

ω t = L0 ωp1 =

(
gm1

Cc

)(
C2

C1 +C2

)
= 2π ×20 MHz (5.10)
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Note that the unity-gain frequency of the opamp is

ω ta = A0 ωp1 = (1+C1/C2)L0ωp1 = 2π ×120 MHz (5.11)

Using ω z = 10ω t = 2π ×200 MHz in combination with (5.6) and (5.10), we find

gm7

Cc
= 10

(
gm1

Cc

)(
C2

C1 +C2

)
⇒ gm7 =

10C2

C1 +C2
gm1 = 1.67gm1 (5.12)

From (5.5), (5.9), (5.10) and (5.12) we find

gm7

C′
L
= 3.8

(
gm1

Cc

)(
C2

C1 +C2

)
⇒Cc = 0.38C′

L = 0.63 pF (5.13)

Then, using (5.7) and (5.12) we find

gm1 = 2π ·BW ·Cc(1+C1/C2) = 0.48 mA/V (5.14)

gm7 = 1.67gm1 = 0.80 mA/V (5.15)

Next, we consider the slew-rate specification. The bias current for M5 is the maximum current available
for charging and discharging of Cc, and the bias current for M6 is the maximum current for charging the
output node when vIN+− vIN− is positive. In this situation, ID6 charges Cc, CL and the series connection
of C1 and C2. From this, we find

SR =
ID5

Cc
⇒ ID5 ≥ SR ·Cc = 19 µA (5.16)

SR =
ID6

Cc +CL +C1C2/(C1 +C2)

⇒ ID6 ≥ SR · (Cc +CL +C1C2/(C1 +C2)) = 70 µA (5.17)

These values of bias current are minimum values, and it may be a good idea to select somewhat larger
bias-current values in order to leave room for design iterations with increased values of Cc.

The bias current for M1 and M2 is obviously ID5/2, and the bias current for M7 is ID7 = ID6, so for M1,
M2 and M7 we have found both the transconductances and the minimum bias currents, and using (3.8) on
page 82, the ratio W/L may be found from the Shichman-Hodges transistor model. However, we noticed
in Tutorial 3 that it is not easy to obtain a good match over a wide range of variation in gm between
the Shichman-Hodges model and the BSIM3 transistor models specified for the opamp. So, rather than
trying to adapt the Shichman-Hodges parameters to fit the BSIM model, we may use LTspice to find the
transconductance gm versus channel width W for the desired values of bias current. First, we need to
select a value for the channel length, and for this design, we chose (somewhat arbitrarily) L to be about
three times the minimum dimensions specified for the process, i.e. L = 1 µm for all transistors in the
circuit.
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Figure 5.12: Simulation showing gm versus W for an NMOS transistor with L = 1 µm using the BSIM3 transistor model.

In order to simulate gm versus W, we use the approach described in Example 3.6, page 100. As we need
only approximate results, and as gm is much larger than gds for the BSIM3 transistors with L = 1 µm
in the active region, we may just run a ‘.tf’ simulation on a single diode-connected transistor as shown
in Fig. 5.12. For the diode-connected transistor, the input resistance is (gm +gds)

−1 � 1/gm, so stepping
W and plotting ‘ ’ directly shows gm versus W .

In Fig. 5.12, also the drain current is defined as a parameter, and gm is shown versus W for three different
values of the bias current ID. For the design, we select ID7 = 100 µA in order to have some margin for
the slew rate and for design iterations. With this value of ID7, we select W7 = 20 µm.
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Figure 5.13: Simulation showing gm versus W for a PMOS transistor with L = 1 µm using the BSIM3 transistor model.

Figure 5.13 shows a similar simulation for a PMOS transistor. From this, we see that the required value
for gm1 cannot be obtained with reasonable transistor geometries with a bias current of 10 µA. Instead,
we select a bias current of 30 µA, and with this bias current, we can select the channel width for M1 and
M2 to be 130 µm.

In order to avoid systematic offset errors, the same current density ID/(W/L) should be selected for M3,
M4 and M7, so W3 =W4 =W7(ID3/ID7) = 6 µm.

Figure 5.14: Simulation showing |VGS| versus W for a PMOS transistor with L = 1 µm and ID = 30 µm using the BSIM3 transistor
model.

Also, M8, M5 and M6 must have the same current density in order to avoid systematic offset errors.
Thus, W6 = W5(ID6/ID5) = W5 (100/60). Selecting the bias current in RB and M8 to be the same as
the bias current in M1 and M2 (i.e. half the current in M5), we find W8 = W5/2. For these transistors,
a small value of |VGS −Vt | will give a large output-voltage range and input-voltage range, and a large
value of |VGS −Vt | will improve the matching between the transistors. A reasonable compromise may
be |VGS −Vt | � 200 mV. Figure 5.14 shows a simulation of |VGS| versus W8 for ID8 = 30 µA, and from
this, we select W8 = 21 µm. The value of |VGS −Vt | is verified by a ‘.op’ simulation with W8 = 21 µm.
From the error log file, we find |VGS −Vt | = 211 mV which is acceptable. With W8 = 21 µm, we find
W5 = 42 µm and W6 = 70 µm.
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With all transistor dimensions in place, the complete opamp is now ready for simulation. The transistor
channel widths are summarized in the table below which also shows the calculated bias current for each
transistor and values of gm for the transistors where gm is included in the design equations.

Transistor number 1 2 3 4 5 6 7 8

Channel width 130 µm 130 µm 6 µm 6µm 42 µm 70 µm 20 µm 21 µm

Bias current 30 µA 30 µA 30 µA 30 µA 60 µA 100 µA 100 µA 30 µA

Transconductance 0.48 mA/V 0.48 mA/V 0.80 mA/V

Table 5.1: Calculated transistor parameters for initial simulations.

Both the closed-loop performance and the loop gain must be simulated for a verification of the design
requirements. In order to be able to modify the design, all transistor channel widths are defined as
parameters at the top level schematic so that relations between the widths can be used when defining
the parameters, and assuming that the input capacitance of the opamp is much smaller than C1 and C2,
two different test benches for the simulation of loop gain and closed-loop gain can be defined as shown
in Figs. 5.15 and 5.16.

Figure 5.15: Test bench for simulation of loop gain.

Also the drain and source areas and perimeters are calculated using the channel width as the input pa-
rameter. For the drain and source regions, we assume an area of W×1 µm and a perimeter of W+2 µm,
compare page 84. Rather than specifying a value of the resistor RB, the bias current is directly set by
a current source IB. For both schematics, a dc offset voltage is inserted in series with the input, and a
dc sweep of the offset voltage is the first simulation to run in order to find an offset voltage resulting
in an output voltage close to 0 V. This is important not only for the loop-gain simulation but also for
the closed-loop simulations since there is no dc feedback to ensure a proper bias point. Subsequently, a
‘.op’ simulation is run in order to verify the bias points of all transistors. The error log file from the ‘.op’
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Figure 5.16: Test bench for simulations of closed-loop response.

simulation provides information about transistor bias currents and small-signal parameters. The error log
file also gives a warning that the common node for C1 and C2 is floating, but since the voltage calculated
for this node is 0, the warning may be neglected, compare Example 2.3 on page 56.
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Transistor number 1 2 3 4 5 6 7 8

Channel width 130 µm 130 µm 6 µm 6 µm 42 µm 70 µm 20 µm 21 µm

Bias current 31.80 µA 31.8 µA 31.8 µA 31.8 µA 63.5 µA 119 µA 119 µA 30 µA

Transconductance 0.51 mA/V 0.51 mA/V 0.89 mA/V

Table 5.2: Simulated transistor parameters from the initial ‘.op’ simulation of Fig. 5.15.

(a) (b)

Figure 5.17: Simulated loop gain showing the phase margin, Cc = 0.63 pF. (a) shows the loop gain L( jω). (b) shows −L( jω)

where the phase is equal to the phase margin for the frequency where the amplitude is 0 dB.

Table 5.2 shows the simulated transistor parameters. Comparing to the values from Table 5.1, we find
a reasonable match between calculated and simulated parameters. From the error log file, you can also
find the parasitic transistor capacitances calculated on basis of the transistor dimensions. They are all
much smaller than C1, C2 and Cc but some of them – on the order of 0.1pF – can be expected to affect
the position of the zero and the second pole and also introduce additional pole(s) from the input stage.
This will cause an additional phase shift of the loop gain.

After having verified the bias point, a ‘.ac’ simulation is run to find the loop gain and the phase mar-
gin. Figure 5.17(a) shows the resulting gain and phase response of the loop gain L( jω) or ‘ ’
while Fig. 5.17(b) shows a plot of −L( jω) or ‘ ’. Since � (−L( jω)) = 180◦+� L( jω) = PM for
ω = ω t , this plot directly shows the phase margin at the frequency where the amplitude is 0 dB. From
these plots, we find a phase margin of 61◦ which is slightly smaller than the design specification. Before
modifying the design, we also run a ‘.ac’ simulation and a ‘.tran’ simulation of the closed-loop circuit
shown in Fig. 5.16 in order to find the bandwidth and the slew rate of the amplifier with feedback. The
results of these simulations are shown in Fig. 5.18, and we notice a bandwidth of 26.8 MHz and a slew
rate well above the minimum specification of 30 V/µs. Also, we see that the rising-edge slew rate is
smaller than the falling-edge slew rate. This is not surprising since the rising-edge slew rate is limited by
ID6 and the falling-edge slew rate is limited by ID5. In the design, the relative increase of the bias current
over the calculated minimum levels is larger for ID5 than for ID6.

With the values found for bandwidth and slew rate, an obvious modification of the design is an increase
of the compensation capacitor Cc. This decreases the bandwidth and the slew rate. The bandwidth is
approximate inversely proportional to Cc, so a new value of Cc should be about 0.84 pF in order to obtain
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Figure 5.18: Simulated frequency response and transient response for the opamp with feedback, Cc = 0.63 pF.

Figure 5.19: Simulated frequency response and transient response for the opamp with feedback, Cc = 0.80 pF.

a −3 dB frequency of 20 MHz. A few simulations with different values of Cc show that with Cc = 0.80 pF,
we achieve the frequency response and transient response shown in Fig. 5.19. A re-simulation of the loop
gain with Cc = 0.80 pF results in the loop-gain response shown in Fig. 5.20. From Figs. 5.19 and 5.20,
we find that the design requirements for the opamp listed on page 166 are met, so this concludes the
design of the opamp.

(a) (b)

Figure 5.20: Simulated loop gain showing the phase margin, Cc = 0.80 pF. (a) shows the loop gain L( jω). (b) shows −L( jω)

where the phase is equal to the phase margin for the frequency where the amplitude is 0 dB.
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Example 5.3: Generic filter blocks.

In this example, we show a few generic filter blocks which can be used for simulation of filter responses.
The blocks are designed so that the filter characteristics can be defined by specifying parameters for each
filter block. The blocks are shown in Table 5.3 where the transfer function in the frequency domain is
specified for each block. Also, the schematic and the symbol for each block is shown. The schematics
and the symbols are saved in a folder created specifically for filter blocks, so a path to this folder is
defined using the command ‘Tools → Control Panel → Sym. & Lib. Search Paths’, see Fig. 3.11 on
page 87.

The resistor at the output in each of the filter blocks does not affect the transfer function but it prevents
LTspice from producing a warning in the error log file (‘WARNING: Less than two connections ...’)
concerning connections to the output node of a filter when no load is connected at the output. When
using the block ‘ ’, you cannot avoid a warning that the node connecting the output of ‘ ’ to
the capacitor ‘ ’ is floating. However, with dc values of 0 for all independent sources in a filter design,
LTspice assumes a bias voltage of 0 V for this node, and the simulations are not compromised. The
error log file also gives messages about empty pin currents for the input pins of the filter blocks. These
messages can also just be ignored.

When using the filter blocks, you can obviously encounter situations with multiple use of the same
subcircuit. In this case, you must be able to specify different parameter values for the different in-
stances of the subcircuit. This is done by a right-click on the subcircuit symbol. This opens a win-
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Transfer
function

Schematic Symbol Parameter

Zero in 0

T ( j f ) = j f/ ft

Unity-gain
frequency ft

Real zero

T ( j f ) =

1+ j f/ fz

Zero
frequency fz

Pole in 0

T ( j f ) = ft/( j f )

Unity-gain
frequency ft

Real pole

T ( j f ) =
1

1+ j f/ fp

Pole
frequency fp

Biquad

T ( j f ) =
1

( j f )2+( j f ) f0/Q+ f 2
0

Resonance
frequency f0
and quality
factor Q

Table 5.3: Generic filter blocks defined as subcircuits.

Figure 5.21: Window for parameter specification for subcircuit.

dow as shown in Fig. 5.21 where you can specify parameters for the subcircuit in the line ‘ ’.
Also tick the box next to the specification line in order to make the parameters visible on the schematic.
In the specification window shown in Fig. 5.21, the parameter fp (pole frequency) has been specified for
a subcircuit ‘ ’ (low pass filter with a single, real pole). From the specification window, you can
also open the schematic and the symbol for the subcircuit.
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Figure 5.22: Audio amplifer (schematic and frequency response).

When you design a circuit using the filter blocks, you may have your circuit in another folder than the
folder created for filter blocks. In this case, you must copy the schematics for the filter blocks being used
in your circuit to the folder with your circuit. Otherwise, LTspice cannot generate a netlist and reports
‘Missing schematic(s) of the hierarchy’ when you try to view the SPICE netlist or run a simulation.

A simple example of a circuit using subcircuits from Table 5.3 is the audio amplifier shown in Fig. 5.22.
This schematic has been saved in a folder for the circuits from Tutorial 5, and the schematics for the filter
blocks ‘ ’ and ‘ ’ have been copied from the filter symbol folder to the folder with the
circuits for Tutorial 5, M:\LTspice\Tutorial05\Fig5_22.asc.

The overall transfer function is

T ( j f ) =
Vo( j f )
Vin( j f )

=
j f/ ft

(1+ j f/ fp1)(1+ j f/ fp2)
(5.18)

where fp1 = 20 Hz is the lower −3 dB frequency and fp2 = 20 kHz is the upper −3 dB frequency. The
midband gain is A = fp1/ ft , so with ft = 2 Hz, the amplifier has a midband gain of 10 V/V (or 20 dB).
Figure 5.22 also shows the resulting frequency response from a ‘.ac’ simulation.

The filter blocks shown in Table 5.3 are also very suitable for the investigation of a feedback amplifier
as designed in Example 5.2 (page 165). From (5.2), we find that the transfer function of the amplifier is
given by

Av( j f ) =
A0 fp1(1− j f/ fz)

j f (1+ j f/ fp2)
=

fta(1− j f/ fz)

j f (1+ j f/ fp2)
(5.19)

where fta = 120 MHz, fz = 200 MHz and fp2 = 3.8× 20 MHz = 76 MHz. In order to model the right
half-plane zero, we just use a negative value of the zero frequency for a filter block of type HP1.asc,
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Figure 5.23: Resistor string D/A converter. The converter has the binary inputs i0, i1 and i2 and the analog output voltage vO. It
is shown with a binary input value of 001.

see Table 5.3. Using the circuits from Figs. 5.10 and 5.11, we can then find closed-loop gain and loop
gain with the approximate loop-gain transfer function given by (5.2). This is an exercise left for the
reader (Problem 5.2 on page 186).

Example 5.4: A mixed analog/digital circuit.

The final example in this tutorial is a 3-bit resistor string D/A converter (Chan Carusone, Johns & Martin
2012) with a decoder as shown in Fig. 5.23. The circuit requires a digital 3 to 1-of-8 decoder, a resistor
string and 8 analog switches. The decoder is built from inverters and NAND gates while the analog
switches require transistors and inverters.

Thus, at transistor level we need a 3-input NAND gate and an inverter as subcircuits. These are shown
in Figs. 5.24 and 5.25 together with the associated symbols. The circuits have been designed like the gain
stages in Example 5.1 (page 160), only the ‘Port Type’ definition for VDD (the supply voltage) has been
left empty. This implies that VDD does not appear as a terminal in the symbols for the subcircuits, and at
the top level of the circuit hierarchy, VDD must be declared as a global node using the SPICE directive
‘.global VDD’.

Also, for the digital subcircuits, the symbols have been edited to the conventional digital gate symbols,
and the names of inputs (‘ ’ – ‘ ’) and output (‘ ’) are not shown in the symbol. This is achieved
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Figure 5.24: Three-input NAND gate, schematic and symbol.

by right-clicking on the pin in the symbol editor and selecting ‘Not Visible’ in the ‘Pin/Port Properties’
window. For the transistor dimensions, we have used the dimensions shown in the schematics. Note
that the channel length is specified as a parameter ‘ ’ which must be defined at the top level of the
circuit hierarchy, and so must the transistor model file for ‘ ’ and ‘ ’. With this
approach, the same subcircuits can be used for different technologies with different minimum dimen-
sions, e.g., a 0.35 µm process (‘ ’), a 0.18 µm process (‘ ’) or a 45 nm process
(‘ ’), for which BSIM models are also provided in (Chan Carusone, Johns & Martin 2014),
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Figure 5.25: Inverter, schematic and symbol.

see Appendix B on page 247. Additionally, transistor widths have been scaled for PMOS and NMOS
transistors to compensate for the difference in hole mobility µp and electron mobility µn.

For the inverter, an additional parameter ‘ ’ has been used. With this parameter, the transistor
dimensions in the inverter can be scaled when the inverter is used as a buffer driving a large number of
inputs or a large capacitive load. The default parameter ‘ ’ is defined in the inverter subcircuit.
When a different value of ‘ ’ is required, it is specified when inserting the inverter in the higher
level schematic using the specification window shown in Fig. 5.21 on page 177. This specification will
override the specification given in Fig. 5.25.

With these subcircuits defined, the decoder and the analog switch are easily designed as shown in Figs. 5.26
and 5.27. As the decoder has an active low output, the analog switch has been designed to have an active
low input, indicated by a small circle in the symbols.

Figure 5.26: Analog switch, schematic and symbol.

Finally, the complete D/A converter is shown in Fig. 5.28. The circuit has three levels of hierarchy. The
supply voltage is inserted as shown at the top level of the hierarchy with the directive ‘.global VDD’,
defining it as a common node to all subcircuits in the hierarchy, and also the transistor model specification
is given at the top level. Observe that in this figure, the outputs from the decoder have been connected
to the analog switch inputs using a bus wire. First, the bus wire is drawn as a normal wire, ‘Edit →
Draw Wire’ (or ‘F3’). Then bus taps are inserted using ‘Edit → Place BUS tap’, and the wires going to
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Figure 5.27: 1 to 1-of-8 decoder, schematic and symbol.

the bus are given the appropriate labels as shown in Fig. 5.28 using ‘Edit → Label Net’ (or ‘F4’). This
labeling of the wires going to the bus is what ensures the correct netlist for the schematic.
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Figure 5.28: Complete D/A converter.

Finally, the bus wire can be labeled using ‘Edit → Label Net’. The bus label must indicate the number of
the first and last wire, separated by a colon ( ) and using square brackets ( and ) which are also used
for the individual wires. The specification of the bus wire turns the wire into a thick line to indicate that
it is a bus.

Figure 5.29: Simulation of the D/A converter from Fig. 5.28.

As an example of a simulation of the D/A converter, Fig. 5.29 shows the output from a transient simu-
lation where the input signals are defined to switch through all 8 input combinations using the ‘ ’
specifications of the input signals shown in Fig. 5.28.
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Hints and pitfalls

– The easiest way to ensure correct correspondence between a subcircuit schematic and a subcir-
cuit symbol is to let LTspice create the symbol from the schematic, see page 161.

– Define inputs and outputs in the subcircuit by using the ‘Port Type’ definition when labeling the
inputs and output.

– A global node which should not be shown as a terminal in the subcircuit symbol must be de-
clared as a global node by the SPICE directive ‘.global <net label>’ or must be specified by
a net label beginning with the characters ‘ ’.

– After the symbol has been created by LTspice, you can modify the graphic appearance using
the symbol editor.

– Save your subcircuits and symbols in an appropriate folder and define a path to this folder using
‘Tools → Control Panel → Sym. & Lib. Search Paths’.

– Also save your subcircuits in the folder used for your circuits. Otherwise, LTspice cannot
generate the netlist required to run a simulation.

– Alternatively, save all circuits, subcircuits and symbols in the same folder and select this folder
in the selection window for ‘Top Directory’ in the component selection box, see Fig. 1.3 on
page 15, when inserting subcircuits.

– Do not use the same filename for a subcircuit and a circuit at a higher level in the circuit
hierarchy.

– Parameters for subcircuits can be specified at subcircuit level, at top level of the circuit hier-
archy, or by specifying the parameter when inserting and editing the subcircuit, see Fig. 5.21
on page 177. A parameter defined in this way overrides a parameter specified at top level or
subcircuit level. A parameter specified at subcircuit level overrides a parameter specified at top
level.

– If your subcircuit schematic is not included in the folder with your subcircuit symbol, LTspice
may not be able to open the parameter editing window shown in Fig. 5.21 on page 177. Instead,
a general ‘Component Attribute Editor’ is opened where you can enter parameters as shown
in Fig. 7.10 on page 226.

– ‘.include’ statements (e.g. a library file) can be specified at subcircuit level or at top level.
A specification at subcircuit level overrides a specification at top level.

– Internal node voltages and device currents in a subcircuit can be made visible by the command
‘Tools → Control Panel’ where you select the tab ‘Save Defaults’. Here you tick ‘Save Subcir-
cuit Node Voltages’ and ‘Save Subcircuit Device Currents’.
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Problems

5.1

Rs = 1 MΩ, VDD = 3 V,

C1 = 0.2 pF, Cc = 0.7 pF, CL = 1.5 pF.

Figure P5.1

An inverter as shown in Fig. 5.25
on page 181 may be used as an
inverting amplifier. Design a test
bench as shown in Fig. P5.1 using
a supply voltage of 3 V, a minimum
length of ‘ ’, a fanout of
‘ ’ and the BSIM3 transis-
tor model from Fig. 3.10 on page 86.
Find an input bias voltage VB which
gives an output bias voltage of 1.5 V.
With this value of VB, simulate the ac
response and find the dominant pole.
Also, use the Miller approximation
(Chan Carusone, Johns & Martin 2012)
to calculate the dominant pole and
compare to the simulated value.

5.2

Av(s) =
ω ta(1− s/ω z)

s(1+ s/ωp2)

ω ta = 2π ×120 MHz,

ω z = 2π ×200 MHz,

ωp2 = 2π ×76 MHz.

Figure P5.2

Simulate the ac response of the closed-
loop gain and the loop gain for the
opamp shown in Figs. 5.10 and 5.11
with C1 = 1 pF, C2 = 0.2 pF and CL =

1.5 pF using the generic filter blocks
from Table 5.3. Assume a transfer
function for the opamp as specified
in Fig. P5.2.
Find the phase margin and the closed-
loop bandwidth and compare to the re-
sults found in Example 5.2.
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5.3

Figure P5.3

Design subcircuits for a two-input
NAND gate and two-input and three-
input NOR gates similar to the logic
gate and inverter designs shown in Ex-
ample 5.4. Scale the PMOS transis-
tors relative to the NMOS transistors to
compensate for the difference in elec-
tron mobility and hole mobility, assum-
ing µn = 3 µp. Use the BSIM3 tran-
sistor models from Fig. 3.10 on page
86 with a channel length of Lmin =

0.35 µm and a minimum channel width
of 3Lmin for NMOS transistors and
9Lmin for PMOS transistors.
What are the transistor channel widths
used for the gates?

5.4

Figure P5.4

Use the inverter from Fig. 5.25 on page
181 to design a ring oscillator as shown
in Fig. P5.4. Use the BSIM3 tran-
sistor models from Fig. 3.10 on page
86 with a channel length of Lmin =

0.35 µm and a supply voltage of 3 V.
With ‘ ’ and CF = 0.2 pF,
find the frequency of oscillation. Also
find the inverter delay for an inverter
loaded with an identical inverter.
Repeat for ‘ ’ for all of the
inverters.
Hint: To start the oscillation, inject a
short current pulse in the output node.
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Answers

5.1: VB = 1.505 V; low-frequency gain: 24.9 dB; dominant pole, simulated: 12 kHz;
dominant pole, calculated: 12 kHz.

5.2: Phase margin: 70◦; Closed-loop bandwidth: 30.7 MHz.

5.3: NOR2: Wn = 3Lmin, Wp = 18Lmin; NOR3: Wn = 3Lmin, Wp = 27Lmin.
NAND2: Wn = 6Lmin, Wp = 9Lmin.

5.4: ‘ ’: fosc = 629 MHz, td = 72 ps; ‘ ’: fosc = 1076 MHz, td = 64 ps.
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Tutorial 6 – Process and Parameter Variations

This tutorial illustrates how process variations and parameter variations can be handled with LTspice
simulations. Normally, a design is required to work not only under some typical conditions but also
over a range of parameter variations such as voltage and temperature variations. Also, tolerance in the
manufacturing processes must be taken into account. This is a major challenge to the designer, involving
extensive simulation work during the design process. After having completed the tutorial, you should be
able to

– simulate a design in design corners with process, voltage and temperature (PVT) variations.

– design device models for slow, typical and fast process corners.

– evaluate target design parameters using the ‘.measure’ SPICE directive.

– perform a Monte Carlo simulation.

Often process and parameter variations are treated using a worst-case approach where the worst combi-
nations of process parameters and operating conditions are simulated in addition to a simulation under
typical conditions. For the process parameter variations, a standard method is to use device models for
‘typical’, ‘fast’ and ‘slow’ devices (Weste & Harris 2010). Thus, for each transistor type (NMOS and
PMOS) we have three different models, a typical model, a fast model and a slow model. This leads to
the process corners SS, FS, SF and FF where the first letter indicates the NMOS model and the second
letter indicates the PMOS model (F for fast, S for slow).

Figure 6.1: Design corners with slow and fast transistor models.

This is illustrated in Fig. 6.1, showing the four process corners for a design target in addition to the typical
set of parameters. Generally, it is assumed that for any combination of parameter variations, the design
target will fall within the shaded area shown in the figure. Also for resistors and capacitors, typically fast
and slow models or values must be considered.
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The process parameter variations may be combined with simulations taking operating conditions such as
supply voltage and temperature into account. This is often termed PVT variations (Chan Carusone, Johns
& Martin 2012). This can lead to a large number of combinations and simulations, so – if possible – it is
a good idea to identify the more critical combinations of process parameters and operating conditions in
order to limit the number of simulations.

Using the design corners with respect to process variations and operating conditions leads to simulation
of worst-case combinations so that a design can be made robust over a large span of variations. However,
it does not take into account the probability that the circuit will actually fall in a worst-case process
corner.

Another approach is to apply statistical variations rather than worst-case variations to some of the critical
parameters of a design and use Monte Carlo simulation for determining the influence on the final design.
This will be further investigated in Example 6.4.

Example 6.1: Model files for corner simulations.

A straightforward way of handling model files for different process corners is to use different models for
each simulation and run a separate simulation for each corner. Thus, for the BSIM transistor model used
in Tutorials 3 - 5 you could define a file for each corner, i.e. ‘ ’, ‘ ’,
‘ ’ etc. For the corners and the typical device parameters shown in Fig. 6.1, this implies
five different files, and you would just include the appropriate file for each simulation.

However, here we will show an approach where the corners are defined by a speed parameter ‘ ’ with a
value of 0 for the typical condition, −1 for the slow condition and +1 for the fast condition. With this ap-
proach, we can easily show results for simulations with different values of ‘ ’ using the ‘.step’ directive,
and we can even interpolate the process parameters between the typical value and the corner values. For
the transistors, we need a speed parameter ‘ ’ for the NMOS transistor and another parameter ‘ ’ for
the PMOS transistor. Obviously, we also need the values for the different model parameters for typical,
slow and fast transistors.

A general method: Assume that a certain parameter x is defined by a typical value xt , a slow value xs

and a fast value x f . We can define:

∆xs = xs − xt (6.1)

∆x f = x f − xt (6.2)

Using a speed parameter S (with S = 0 for the typical parameter, S = −1 for the slow parameter and
S = 1 for the fast parameter), we notice that the function (|S|+S)/2 is equal to S for S positive and 0 for
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S negative. Similarly, the function (|S| − S)/2 is equal to |S| = −S for S negative and 0 for S positive.
Using S, we then have a general expression for x:

x = xt +∆x f (|S|+S)/2+∆xs (|S|−S)/2

= xt (1−|S|)+ xs (|S|−S)/2+ x f (|S|+S)/2 (6.3)

With this expression, we achieve x = xt for S = 0, x = xs for S = −1 and x = x f for S = 1, and we
have a linear interpolation between typical, fast and slow values for (non-integer) values of |S| < 1. In
LTspice, |x| is given by ‘ ’ and also the function ‘ ’ is available. This function is defined
as ‘ = (| |+ )/2’ and using this, (6.3) would appear as

(6.4)

with the values for ‘ ’, ‘ ’ and ‘ ’ inserted in the expression.

Specific examples: The approach described above is generally applicable when you have the model
parameters given by specific values for typical, fast and slow conditions. Occasionally, the model para-
meters may be specified by a relative variation or an absolute variation instead. For instance, a capacitor
may be specified by a nominal value Cnom and a tolerance δ in percent, or a threshold voltage may be
specified by a nominal value Vth,nom and a tolerance ∆Vth in absolute value (volts).
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In such cases, the introduction of the speed parameter S is even simpler:

C =Cnom(1−S (δ/100)) (6.5)

assuming that a small value of C is the fast model, and

Vth =Vth,nom −S∆Vth (6.6)

for an NMOS transistor which is faster for smaller values of Vth.

An examination of the BSIM3 models for the 0.35 µm process from (Chan Carusone, Johns & Martin
2014) shows that only five parameters are different for typical, fast and slow transistor models. These
are:

The threshold voltage: The threshold-voltage parameter ‘ ’ is given by a nominal value and a
threshold-voltage shift of ±0.1 V, increasing the numeric value of the threshold voltage for slow
transistors and decreasing it for fast transistors.

The oxide thickness: The parameter for gate oxide thickness ‘ ’ is given by a nominal value which is
divided by 0.95 for the slow models and by 1.05 for the fast models.

The mobility: The mobility ‘ ’ is given by a nominal value which is multiplied by (0.95)2 for the slow
models and by (1.05)2 for the fast models.

The bulk junction bottom capacitance: The zero-bias bulk junction bottom capacitance per unit area
‘ ’ is given by a nominal value which is divided by 0.95 for the slow models and by 1.05 for the
fast models.

The bulk junction sidewall capacitance: The zero-bias bulk junction bottom capacitance per unit perime-
ter ‘ ’ is given by a nominal value which is divided by 0.95 for the slow models and by 1.05
for the fast models.

Using the speed parameters ‘ ’ for NMOS transistors and ‘ ’ for PMOS transistors, these relations
can be modeled as follows (with the nominal values inserted):

NMOS transistors:

VTH0 = {0.48−SN/10} (6.7)

TOX = {7.8E−9/(1+SN/20)} (6.8)

U0 = {360∗ (1+SN/20)∗∗2} (6.9)

CJ = {9e−4/(1+SN/20)} (6.10)

CJSW = {2.8e−10/(1+SN/20)} (6.11)
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PMOS transistors:

VTH0 = {−0.6+SP/10} (6.12)

TOX = {7.8E−9/(1+SP/20)} (6.13)

U0 = {150∗ (1+SP/20)∗∗2} (6.14)

CJ = {14e−4/(1+SP/20)} (6.15)

CJSW = {3.2e−10/(1+SP/20)} (6.16)

Inserting the expressions (6.7 - 6.16) in the models from Fig. 3.10 on page 86, we have the library file
BSIM3_035PVT.lib shown in Fig. 6.2.

Generic BSIM3 model for 0.35 µm CMOS process with speed parameters and to define process variations.

*BSIM3_035PVT.lib
.MODEL NMOS-BSIM NMOS LEVEL = 49
*Speed parameter SN
+VERSION = 3.1 TNOM = 27 TOX = {7.8E-9/(1+SN/20)}
+XJ = 1E-07 NCH = 2.18E+17 VTH0 = {0.48-SN/10}
+K1 = 6.07E-01 K2 = 1.24E-03 K3 = 9.68E+01
+K3B = -9.84E+00 W0 = 2.02E-05 NLX = 1.62E-07
+DVT0W = 0 DVT1W = 0 DVT2W = 0
+DVT0 = 2.87E+00 DVT1 = 5.86E-01 DVT2 = -1.26E-01
+U0 = {360*(1+SN/20)**2} UA = -8.48E-10 UB = 2.27E-18
+UC = 3.27E-11 VSAT = 1.87E+05 A0 = 1.22E+00
+AGS = 2.06E-01 B0 = 9.60E-07 B1 = 4.95E-06
+KETA = -1.67E-04 A1 = 0 A2 = 3.49E-01
+RDSW = 8.18E+02 PRWG = 2.35E-02 PRWB = -8.12E-02
+WR = 9.98E-01 WINT = 1.55E-07 LINT = 4.51E-10
+DWG = -4.27E-09
+DWB = 4.07E-09 VOFF = -4.14E-02 NFACTOR = 1.61E+00
+CIT = 0 CDSC = 2.39E-04 CDSCD = 0.00E+00
+CDSCB = 0 ETA0 = 1 ETAB = -1.99E-01
+DSUB = 1 PCLM = 1.32E+00 PDIBLC1 = 2.42E-04
+PDIBLC2 = 8.27E-03 PDIBLCB = -9.99E-04 DROUT = 9.72E-04
+PSCBE1 = 7.24E+08 PSCBE2 = 9.96E-04 PVAG = 1.00E-02
+DELTA = 1.01E-02 RSH = 3.33E+00 MOBMOD = 1
+PRT = 0 UTE = -1.5 KT1 = -1.11E-01
+KT1L = 0 KT2 = 2.22E-02 UA1 = 4.34E-09
+UB1 = -7.56E-18 UC1 = -5.62E-11 AT = 3.31E+04
+WL = 0 WLN = 9.95E-01 WW = 0
+WWN = 1.00E+00 WWL = 0 LL = 0
+LLN = 1 LW = 0 LWN = 1
+LWL = 0 CAPMOD = 2 XPART = 0.5
+CGDO = 2.76E-10 CGSO = 2.76E-10 CGBO = 1.00E-12
+CJ = {9e-4/(1+SN/20)} PB = 7.95E-01 MJ = 3.53E-01
+CJSW = {2.8e-10/(1+SN/20)} PBSW = 7.98E-01 MJSW = 1.73E-01
+CJSWG = 1.81E-10 PBSWG = 7.96E-01 MJSWG = 1.74E-01
+CF = 0 PVTH0 = -1.80E-02 PRDSW = -7.56E+01
+PK2 = 4.48E-05 WKETA = -1.33E-03 LKETA = -8.91E-03

.MODEL PMOS-BSIM PMOS LEVEL = 49
*Speed parameter SP
+VERSION = 3.1 TNOM = 2.69E+01 TOX = {7.8E-9/(1+SP/20)}
+XJ = 1.00E-07 NCH = 8.44E+16 VTH0 = {-0.6+SP/10}
+K1 = 4.82E-01 K2 = -2.13E-02 K3 = 8.27E+01
+K3B = -5 W0 = 5.24E-06 NLX = 2.49E-07
+DVT0W = 0.00E+00 DVT1W = 0 DVT2W = 0
+DVT0 = 3.54E-01 DVT1 = 7.52E-01 DVT2 = -2.98E-01
+U0 = {150*(1+SP/20)**2} UA = 1E-10 UB = 1.75E-18
+UC = -2.27E-11 VSAT = 2.01E+05 A0 = 1.04E+00
+AGS = 2.90E-01 B0 = 1.94E-06 B1 = 5.01E-06
+KETA = -3.85E-03 A1 = 4.20E-03 A2 = 1.00E+00
+RDSW = 4000 PRWG = -9.54E-02 PRWB = -1.92E-03
+WR = 1 WINT = 1.47E-07 LINT = 1.04E-10
+DWG = -1.09E-08
+DWB = 1.14E-08 VOFF = -1.29E-01 NFACTOR = 2.01E+00
+CIT = 0 CDSC = 2.40E-04 CDSCD = 0
+CDSCB = 0 ETA0 = 4.07E-02 ETAB = 6.84E-03
+DSUB = 3.21E-01 PCLM = 5.96E+00 PDIBLC1 = 2.89E-03
+PDIBLC2 = -1.45E-06 PDIBLCB = -1E-03 DROUT = 9.93E-04
+PSCBE1 = 7.88E+10 PSCBE2 = 5E-10 PVAG = 15
+DELTA = 9.96E-03 RSH = 2.6 MOBMOD = 1
+PRT = 0 UTE = -1.5 KT1 = -1.09E-01
+KT1L = 0 KT2 = 2.19E-02 UA1 = 4.34E-09
+UB1 = -7.62E-18 UC1 = -5.63E-11 AT = 3.28E+04
+WL = 0 WLN = 1 WW = 0
+WWN = 1.00E+00 WWL = 0 LL = 0
+LLN = 1 LW = 0 LWN = 1
+LWL = 0 CAPMOD = 2.01E+00 XPART = 0.5
+CGDO = 2.10E-10 CGSO = 2.12E-10 CGBO = 1.00E-12
+CJ = {14e-4/(1+SP/20)} PB = 9.83E-01 MJ = 5.79E-01
+CJSW = {3.2e-10/(1+SP/20)} PBSW = 9.92E-01 MJSW = 3.60E-01
+CJSWG = 4.41E-11 PBSWG = 9.85E-01 MJSWG = 3.58E-01
+CF = 0 PVTH0 = 2.58E-02 PRDSW = -3.98E+01
+PK2 = 2.02E-03 WKETA = 2.72E-03 LKETA = -7.14E-03

Figure 6.2: Library file with BSIM3 models for a generic 0.35 µm CMOS process with speed parameters SN and SP to define
process variations, adapted from (Chan Carusone, Johns & Martin 2014). Speed parameter is 0 for typical model, –1 for slow
model and +1 for fast model.

Combining the speed parameters into a single parameter: Sometimes it may be useful to combine
a set of speed parameters and/or temperature parameters into a single parameter by which you can step
through a desired sequence of combinations of the different parameters, rather than stepping each pa-
rameter individually. It reduces the number of ‘.step’ directives (LTspice can handle a maximum of three
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levels of nested ‘.step’ directives), and it reduces the total number of simulations to include only the PVT
corners of interest. This can be done by using the ‘.step’ directive in combination with the command
‘.param <param_name>=table(N,a,b,c,d,...)’. Assume for instance that we want to step through the pro-
cess corners shown in Fig. 6.1 in the sequence TT, SS, FS, SF, FF. This corresponds to the sequence
(SN,SP)=(0,0), (−1,−1), (1,−1), (−1,1), (1,1). Using a parameter ‘ ’ as step number to count the steps
from 1 to 5, this is accomplished by the following SPICE directives:

In the ‘.param’ definitions, the first table entry is the step number N, and this is followed by pairs of
N-values and SN/SP-parameter values.

Process and temperature variations for an NMOS transistor: As a very simple example of the use
of the speed parameter, we will examine the characteristics of an NMOS transistor. Figure 6.3 shows the
LTspice schematic for this, compare Fig. 3.13 on page 89. Using the ‘.step’ directive, the parameter ‘ ’
is stepped through the values −1, 0 and +1, corresponding to the slow, typical and fast NMOS transistor
model, respectively.
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Figure 6.3: LTspice schematic for simulation of transistor characteristics with slow, fast and typical BSIM3 models.

(a) (b)

Figure 6.4: Input characteristics (a) and output characteristics (b) for slow (green traces), fast (red traces) and typical (blue traces)
BSIM3 models.

Figure 6.4 shows the simulated input characteristics and output characteristics. The input characteristics
are simulated with VDS = 3.0 V so that the transistor is in the active region. The output characteristics
are simulated for VGS = 1, 2 and 3 V. For the output characteristics, the colors of the curves have been
changed to correspond to the colors used for fast, typical and slow models for the input characteristics.
This is done using the Color Palette Editor, ‘Tools → Color Preferences’.

It is evident that there is a significant difference in drain current between the fast and slow model, about
50%. For the transistor, often a design target is a specific value of the transconductance gm, see for in-
stance the design procedure for transistors M1 and M7 in Example 5.2 on page 165 - 176. The transcon-
ductance may be simulated as shown in Fig. 5.12 on page 170. In order to illustrate the variation in gm

caused by process variations, we can simulate the transistor with ID = 100 µA for three different values
of the speed parameter ‘ ’, corresponding to slow, typical and fast parameters. The results of this sim-
ulation are shown in Fig. 6.5 which may be compared with Fig. 5.12 on page 170. We notice that the
process variations cause a variation in gm of about ±8%.

195
Download free eBooks at bookboon.com



CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

196

Tutorial 6 – Process and Parameter Variations

Figure 6.5: Simulation showing gm versus W for an NMOS transistor with L = 1 µm and ID = 100 µA using the BSIM3 transistor
model with process variations (slow, typical and fast models).

Another cause of variation in gm is the temperature. The previous simulations are performed at a de-
fault temperature of 27◦C. By using the SPICE directive ‘.temp’, different values for the temperature
can be specified. The command ‘ ’ is equivalent to ‘ ’.
The parameter ‘temp’ is a parameter predefined in LTspice for temperature. Although it is possible,
it is not advisable to use the name ‘temp’ for another parameter. You may observe that there is a dif-
ference between ‘ ’ and ‘ ’. The
first command steps the temperature in three steps, −40◦C, 27◦C and 85◦C. The second defines a new
parameter, ‘temp’, which is stepped between the values −40, 27 and 85, not to be confused with the
temperature.

Figure 6.6: Simulation showing gm versus process variations and temperature for an NMOS transistor with L = 1 µm, W = 20 µm
and ID = 100 µA using the BSIM3 transistor model.

Figure 6.6 shows a simulation of gm with W = 20 µm, ID = 100 µA and at −40◦C, 27◦C and 85◦C,
corresponding to an industrial temperature range. For this simulation, also ‘ ’ is stepped from −1 to
+1, so the simulation shows the design corners for process and temperature variations, compare Fig. 6.1.
The shaded area in Fig. 6.6 shows the range of gm values for both process and temperature variations.
We see that gm decreases significantly with temperature. A small value of gm is critical, so the worst-case
corner is the high temperature corner with a slow process. In this corner, gm is only 0.65 mA/V whereas
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the design target in Example 5.2 was 0.80 mA/V. Clearly, a design iteration where the transistor channel
width is increased to give gm = 0.80 mA in the worst-case corner would be an obvious improvement
to the design. A simulation like the simulation shown in Fig. 6.5 but at 85◦C shows that W has to be
increased to 30 µm in order to ensure gm ≥ 0.80 mA/V.

Example 6.2: An inverter.

An inverter as shown in Fig. 5.25 on page 181 can be used both as a digital inverter and as an inverting
amplifier (see Problem 5.1 on page 186). For the inverter used as an amplifier, we would expect PVT
variations to cause a variation in several design parameters, including low-frequency gain, bandwidth,
unity-gain bandwidth, supply current, etc. For this example, we assume that the amplifier is capacitively
loaded and is driven from a voltage source providing an ac signal and a dc bias voltage VB, see Fig. 6.7.
With this configuration, the unity-gain bandwidth is GBW = (gm1 + gm2)/(2π CL), the low-frequency
gain is A0 = (gm1 + gm2)/(gds1 + gds2) and the bandwidth is BW = (gds1 + gds2)/(2π CL). These para-
meters are all small-signal parameters, and they depend on the bias point which in turn depends on the
process parameters, supply voltage and temperature.

DC Sweep: Also large signal properties such as dc transfer characteristics and peak supply current
exhibit PVT variations. As the first investigation, we show the dc transfer characteristics for the process
corners in Fig. 6.8. We observe that a fast NMOS transistor pulls the transfer characteristics to the left
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Figure 6.7: LTspice schematic of the inverting amplifier showing a selection of ‘.measure’ directives.

Figure 6.8: DC sweep, output voltage versus input voltage for the inverter from Fig. 6.7.

whereas a fast PMOS transistor pulls the characteristics to the right. The bias value VB of the input
voltage for an output quiescent value of about 1.5 V varies between 1.3 V and 1.7 V.

From the DC sweep, we can also find the low-frequency gain and the supply current by plotting ‘ ’
and ‘ ’, respectively, as shown in Fig. 6.9.
By using the ‘.measure’ (or ‘.meas’) SPICE directive, we can analyze gain and supply current in the
process corners. In Fig. 6.7, four different ‘.measure’ directives are shown.
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Figure 6.9: DC sweep, low-frequency gain versus input voltage (top) and peak current consumption versus input voltage (bottom)
for the inverter from Fig. 6.7.

– The first, ‘ ’, finds the required value ‘ ’ of the dc
bias voltage in each process corner.

– The second, ‘ ’, calculates the numeric
value of the slope of the transfer characteristics, ‘ ’, at an output voltage of 1.5 V.

– The third, ‘ ’, calculates the maximum numeric value
‘ ’ of the gain.

– The fourth, ‘ ’, finds the peak supply voltage ‘ ’.

Each of the ‘.measure’ directives are computed in the four process corners in the sequence SS, FS, SF,
FF and the results are given in the error log file (‘Ctrl-L’). Figure 6.10 shows the results from the error
log file. When right-clicking in the error log file, a small dialogue box opens and you can select ‘Plot
.step’ed .meas data’ which opens a window in the waveform viewer. Here, the traces to be displayed are
selected using ‘Plot Settings → Add trace’ or simply using ‘Pick Visible Traces’, . Figure 6.11 shows
the plots of ‘ ’, ‘ ’, ‘ ’ and ‘ ’. In each of the plots, the X-axis is ‘ ’ and the green
line corresponds to ‘ ’ = −1 (slow PMOS) while the blue line is for ‘ ’ = 1 (fast PMOS).

AC Analysis: For simulating bandwidth and unity-gain bandwidth, a ‘.ac’ simulation is obvious. How-
ever, in order to get correct results from a ‘.ac’ simulation, it is necessary to use the correct bias point.
For the circuit in Fig. 6.7, a suitable bias point would imply a dc value of VB resulting in an output volt-
age of about 1.5 V when the input signal is vIN = 0 V. From the ‘.dc’ simulation, we found the values
of VB required for an output voltage of 1.5 V, and they are listed in the error log file, Fig. 6.10. Thus, a
simple way of specifying VB is to use a parameter ‘ ’ to count through the four steps from the previous
simulations as explained on page 193.
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SPICE Error Log

Circuit: * M:\LTspice\ Tutorial06\Fig6_07.asc

.step sn=-1 sp=-1 

.step sn=1 sp=-1 

.step sn=-1 sp=1

.step sn=1 sp=1

Measurement: vb
step v(vout)=1.5

1 1.47817
2 1.33947
3 1.66893
4 1.53505

Measurement: gain
step D(-v(vout)) at

1 18.3992 1.47817
2 17.0934 1.33947
3 18.1569 1.66893
4 16.9492 1.53505

Measurement: maxgain
step MAX(-d(v(vout))) FROM TO

1 19.1021 0 3 
2 18.2456 0 3 
3 18.918 0 3 
4 18.0925 0 3 

Measurement: imax
step MAX(-i(vdd)) FROM TO

1 7.95096e-005 0 3 
2 0.000106626 0 3 
3 0.000105899 0 3 
4 0.000138436 0 3 

Figure 6.10: Error log file with results of ‘.measure’ directives.

Figure 6.11: Gain, maximum gain, input bias voltage and peak supply current versus process variations.
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Figure 6.12: LTspice schematic of the inverting amplifier with ‘.step’ and ‘.param’ directives for stepping through the four process
corners SS, FS, SF and FF.

Figure 6.12 shows the circuit from Fig. 6.7 with the required parameter definitions and also with ‘.mea-
sure’ directives for finding the low-frequency gain ‘ ’, the 3-dB bandwidth ‘ ’ and the unity-gain
bandwidth ‘ ’. The bias values are easily checked by a ‘.op’ simulation.

The result of the ‘.ac’ simulation is shown as a Bode plot of ‘ ’ in Fig. 6.13, and Fig. 6.14 shows
the GBW values from the error log file and the graphical plot of GBW (using a right-click in the error
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Figure 6.13: AC sweep, output voltage versus frequency for the inverter from Fig. 6.12.

SPICE Error Log

Circuit: * M:\LTspice\ Tutorial06\Fig6_12.asc

.step n=1

.step n=2

.step n=3

.step n=4

Measurement: gbw
step abs(v(vout))=1

1 4.83727e+008
2 5.47652e+008
3 5.72209e+008
4 6.33343e+008

Figure 6.14: Error log file and plot of ‘GBW’ for the inverter from Fig. 6.12.

log file). With the use of the step number ‘ ’ as a parameter rather than separate ‘.step’ directives for
‘ ’ and ‘ ’, we do not obtain a plot directly showing the process corners like in the plots in Fig. 6.11.

Often, a more flexible way of establishing the correct bias conditions for the ‘.ac’ simulation is to provide
a dc feedback from the output to the input. This will automatically adapt the input bias voltage when
process parameters, voltage or temperature are changed. Figure 6.15 shows two different ways of estab-

(a) (b)

Figure 6.15: Examples of dc feedback to provide a suitable dc bias point for the inverter from Fig. 6.12.
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Figure 6.16: LTspice schematic of the inverting amplifier with low pass feedback to establish a suitable dc bias point.

lishing a dc feedback. The basic concept is to provide a lowpass feedback path from the output to the
input. In Fig. 6.15(a), this is achieved by an inductive feedback directly to the gates of M1 and M2 and
a (highpass) ac coupling of the input voltage. This circuit ensures that both M1 and M2 are in the active
region as VGS =VDS but it does not ensure a bias value of the output voltage which is equal to VDD/2.

In the circuit in Fig. 6.15(b), the fixed dc bias voltage shown in Fig. 6.12 is replaced by a voltage con-
trolled by the output voltage at very low frequencies so that the bias value of the output voltage is almost
equal to VB if the gain K is � 1. As an example, Fig. 6.16 shows the LTspice schematic corresponding
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to Fig. 6.15(b). Here the step number parameter ‘ ’ is replaced by separate ‘.step’ directives for ‘ ’
and ‘SP’, and also a temperature step is inserted using a step number ‘ ’ and a ‘ ’
directive with the three temperatures 27◦C, −40◦C and 85◦C. The purpose of the ‘ ’ step number is to
arrange the temperature steps with 27◦C as the first step rather than −40◦C.

Using just ‘ ’ results in steps with the lowest temperature first, even with
27◦C listed as the first temperature.

Figure 6.17: Plot of ‘GBW’ for the inverter from Fig. 6.16 for different temperatures.

Figure 6.17 shows the resulting plot of GBW for the three temperatures. For the temperature 27◦C (green
and blue trace), this plot may be compared to the plot of GBW shown in Fig. 6.14.

In Fig. 6.16, there is also a ‘.step’ directive for the supply voltage VDD and for the capacitor CL but they
appear only as a comments.

LTspice does not support more than three levels of ‘.step’ directives in one simulation, so trying to use the
‘.step’ directive for the supply voltage or capacitor in combination with the other three ‘.step’ directives
in the schematic just results in an error message.

The digital inverter: The inverter shown in Fig. 6.7 is basically a digital inverter, so it is also of interest
to examine variations in its digital properties such as propagation delay, output rise time and fall time.
Figure 6.18 shows the digital inverter ‘ ’ driven by an identical inverter and driving another inverter
specified to have a fanout of 3 (see page 181). This implies that the inverter ‘ ’ has a capacitive load
corresponding to three standard inverters (or 2 NAND gate inputs (3-input NAND gates)).

Also shown in Fig. 6.18 is the result of a transient simulation with typical parameters. From the wave-
forms, we can define a rise time and a fall time for ‘ ’ (the green trace) from 0.3 V to 2.7 V, and
we can define a delay time from the rising edge of ‘ ’ to the falling edge of ‘ ’ and another
delay time from the falling edge of ‘ ’ to the rising edge of ‘ ’. The ‘.measure’ directives
for finding these are shown in the schematic.
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Figure 6.18: LTspice schematic of the inverter used as a digital inverter (top) and the result of a transient simulation (bottom).

Figure 6.19: Process corner simulation for rise time, fall time and delays for the digital inverter from Fig. 6.18 (top).

When running a simulation with the speed parameters ‘ ’ and ‘ ’ varied through the process corners,
we can find the process corners for the delay times and the rise and fall times. The result of this simulation
is shown in Fig. 6.19.
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Example 6.3: A test bench for the two-stage opamp.

When simulating PVT variations in the two-stage opamp from Example 5.2 on page 165, it is necessary
to define test benches which provide suitable bias conditions for the opamp, regardless of the PVT
variations. This implies that we cannot rely on a fixed value of the offset voltage as in Figs. 5.15 and
5.16 (page 172). Rather, we must ensure a dc feedback path to the inverting opamp input similar to the
dc feedback path used for the inverting amplifier in Fig. 6.15.

Figure 6.20: Test bench for simulation of loop gain of the two-stage opamp with PVT variations.
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Figure 6.21: Test bench for simulations of closed-loop response of the two-stage opamp with PVT variations.

Figures 6.20 and 6.21 show the test benches from Figs. 5.15 and 5.16 modified to include the required dc
feedback. Also shown are ‘.measure’ directives to find the phase margin and the bandwidth, respectively.

Figure 6.22 shows the results of simulations of phase margin and bandwidth with process variations
taken into account. Obviously, the amplifier does not fulfill the design requirements from page 166 in all
process corners. The optimization of the two-stage opamp for PVT variations is left as an exercise for
the reader.

Figure 6.22: Phase margin (from Fig. 6.20) and bandwidth (from Fig. 6.21) versus process variations for the two-stage opamp.

Example 6.4: Monte Carlo simulation.

The simulations shown in the previous examples are worst-case simulations considering process, voltage
and temperature limits. However, in practice, the process variations are not described by fixed limits
but rather by statistical variations of the parameter values. Often, a normal distribution around a nominal
value is assumed. For investigating such statistical variations, Monte Carlo simulations may be used. In a
Monte Carlo simulation, one or more device parameters are varied in a random fashion, and a number of
simulations are performed with randomly selected device parameters. As an example, we will investigate
the influence of variations in the transistor threshold voltage in a simple current mirror. For simplicity, we
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Figure 6.23: Current mirror for Monte Carlo simulation with threshold voltage mismatch.

assume a Shichman-Hodges transistor model. Figure 6.23 shows the current mirror with the Shichman-
Hodges models for transistor M1 and M2. For transistor M1, the model from Fig. 3.3 on page 80 is used,
but for M2, a statistical variation is added to the threshold voltage so that the two transistors no longer
match perfectly.

For M2, the threshold voltage is specified as the fixed value plus a statistical variation. LTspice has
different possibilities for specifying a statistical variation:

– ‘ ’ generates a random number from a normal (Gaussian) distribution with a standard
deviation of .

– ‘ ’ generates a random number between and with a uniform distribution.

– ‘ ’ generates a random number between and with a uniform distri-
bution.

For the purpose of this simulation, we assume that the threshold voltage has the nominal value of 0.57 V
as in Fig. 3.3, but in addition to this, the threshold voltage of M2 is given a statistical variation following
a normal distribution with a standard deviation of 10 mV.

In Fig. 6.23, also a parameter ‘ ’ has been specified. This is the step count for the Monte Carlo simula-
tion. With ‘ ’ counting from 1 to 50, a total of 50 simulations are run where the value of the threshold
voltage for M2 is varied randomly between the simulations. The value of the drain voltage for M2 has
been selected to be equal to the gate voltage for a drain current of 300 µA, so for this value of the drain
current, the current mirror provides a perfect match when the threshold voltages are identical. Also,
a ‘.measure’ directive has been specified for finding the drain current of M2 when the input current is
300 µA.

Figure 6.24 shows the result of the ‘.dc’ simulation. The spread of the output current is evident. In order
to investigate the spread in more detail, the ‘.measure’ directive provides a table in the error log file with
the output currents for each simulation and as in the previous examples, this can be displayed graphically
using a right-click in the error log file. The resulting graph is shown in Fig. 6.25. Obviously, the output
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current is about 300 µA but with variations of up to about ±25 µA. For further investigation of this result,
it is a good idea to copy and paste the table with the output current into an Excel spreadsheet. Doing so,
you find an average output current of 300 µA with a standard deviation of about 11 µA.

Figure 6.24: Output current versus input current with variations for the threshold voltage mismatch from Fig. 6.23.

Figure 6.25: Output current variation for the 50 simulations with random values for the threshold voltage of M2.

Statistical variation of the speed parameters: With the introduction of the speed parameters ‘ ’
and ‘ ’ providing interpolation of process parameters from slow to fast processes, it is easy to perform
Monte Carlo simulations where ‘ ’ and ‘ ’ are varied randomly. We conclude this tutorial by revi-
siting the inverting amplifier from Fig. 6.16 on page 203. This amplifier is shown again in Fig. 6.26
with statistical specifications for the speed parameters. Two sets of specifications are given, one with a
Gaussian distribution of ‘ ’ and ‘ ’ with a standard deviation of 0.4 and another (shown as a comment)
with a flat distribution of ‘ ’ and ‘ ’ between −1 and 1.The number of simulations is specified by the
parameter ‘ ’ to be 50.
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Figure 6.26: LTspice schematic of the inverting amplifier from Fig. 6.16 with stochastic specification of the speed parameters for
Monte Carlo simulation.

Figure 6.27 shows the unity-gain bandwidth both for the simulations with a flat distribution and with a
Gaussian distribution. This figure may be compared to Fig. 6.14 with the results of the worst-case corner
simulations. Apparently, assuming the Gaussian distribution, the SS corner and the FF corner are rather
unlikely worst-case situations.

Also shown in Fig. 6.26 (as a comment) is a stochastic specification of the capacitor CL, specifying a
tolerance of ±5%. An advantage of the Monte Carlo simulation is that varying values are specified
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Figure 6.27: Monte Carlo simulation of the unity-gain bandwidth of the inverting amplifier from Fig. 6.26.

without using ‘.step’ directives but with stochastic variables instead. Thus, the limitation of three nested
‘.step’ directives is relaxed.

The process parameters, including the capacitor variation, are normally to be considered as stochastic
variables. Conversely, temperature range and supply-voltage range are specified operating ranges for
which the circuit should be designed. Therefore, it makes sense to run simulations with the process

(a) (b)

(c)

Figure 6.28: Monte Carlo simulation of the unity-gain bandwidth of the inverting amplifier from Fig. 6.26 with stochastic variation
of process parameters and capacitor value and operating range limits for temperature (a) and supply voltage (b). Worst-case
combination is low supply voltage and high temperature (c).
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parameters specified as stochastic variables and temperature and/or supply voltage specified as minimum
and maximum limits. Figure 6.28 shows the results of Monte Carlo simulations for the inverting amplifier
from Fig. 6.26 for maximum and minimum temperature (6.28(a)) and maximum and minimum supply
voltage (6.28(b)). Evidently, the worst-case combination is a low supply voltage and a high temperature,
so the optimization may proceed by investigating this combination. Figure 6.28(c) shows the result
of a Monte Carlo simulation with this combination of supply voltage and temperature. The average
bandwidth is found to be 417 MHz with a standard deviation of 28 MHz. For comparison, the bandwidth
for the typical PVT combination is 560 MHz.
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Hints and pitfalls

– Process variations may be described by model files for slow, typical and fast components, lead-
ing to different process corners, temperature corners and voltage corners (PVT corners).

– In order to step between slow, typical and fast components in a single simulation, ‘speed’ pa-
rameters may be applied to distinguish the different process parameters.

– Stepping between different PVT corners can be achieved by stepping the relevant speed
parameters.

– Stepping between selected PVT corners can be customized using a ‘step count’ parameter and
a table specification of the selected corners, see example on page 201.

– Temperature is predefined as a parameter ‘ ’ in LTspice. Do not use this name for another
parameter.

– LTspice supports up to three levels of nested ‘.step’ directives.

– When more than one ‘.step’ SPICE Directive is present, they are executed in the sequence in
which they appear in the SPICE Netlist. This corresponds to the sequence in which they are
inserted in the schematic.

– The ‘.measure’ SPICE directive is very useful for calculating design parameters from
simulations.

– The results of ‘.measure’ SPICE directives are found in the error log file (‘Ctrl-L’).

– When using ‘.measure’ directives in combination with ‘.step’ directives, the resulting tables in
the error log file can be presented in the waveform viewer by using a right-click on the mouse
and selecting ‘Plot .step’ed .meas data’.

– A Monte Carlo simulation is useful for simulating stochastic variations. With a Monte Carlo
simulation, several design parameters can simultaneously be subject to variations in a single
simulation run.

– Monte Carlo simulations require a fairly large number of simulations, implying that they might
be slow or require a fast computer.
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Problems

6.1
Typical model:

Slow model:

Fast model:

Figure P6.1

For an NMOS transistor, assume that
typical, slow and fast models are given
by the Shichman-Hodges model pa-
rameters shown in Fig. P6.1. De-
sign a transistor model which com-
bines the three models into one, using
a speed parameter ‘ ’ with ‘ ’ =

−1 for the slow model, 0 for the typ-
ical model and 1 for the fast model.
Find the gate-source voltage, the
transconductance and the output con-
ductance for a transistor with VGS =

VDS, ID = 0.4 mA, W = 20 µm and
L = 1 µm for typical model parameters
and for slow and fast process corners.

6.2

.MODEL PMOS-BSIM PMOS LEVEL = 49
*Speed parameter SP
+VERSION = 3.1 TNOM = 2.69E+01 TOX = {7.8E-9/(1+SP/20)}
+XJ = 1.00E-07 NCH = 8.44E+16 VTH0 = {-0.6+SP/10}
+K1 = 4.82E-01 K2 = -2.13E-02 K3 = 8.27E+01
+K3B = -5 W0 = 5.24E-06 NLX = 2.49E-07
+DVT0W = 0.00E+00 DVT1W = 0 DVT2W = 0
+DVT0 = 3.54E-01 DVT1 = 7.52E-01 DVT2 = -2.98E-01
+U0 = {150*(1+SP/20)**2} UA = 1E-10 UB = 1.75E-18
+UC = -2.27E-11 VSAT = 2.01E+05 A0 = 1.04E+00
+AGS = 2.90E-01 B0 = 1.94E-06 B1 = 5.01E-06
+KETA = -3.85E-03 A1 = 4.20E-03 A2 = 1.00E+00
+RDSW = 4000 PRWG = -9.54E-02 PRWB = -1.92E-03
+WR = 1 WINT = 1.47E-07 LINT = 1.04E-10
+DWG = -1.09E-08
+DWB = 1.14E-08 VOFF = -1.29E-01 NFACTOR = 2.01E+00
+CIT = 0 CDSC = 2.40E-04 CDSCD = 0
+CDSCB = 0 ETA0 = 4.07E-02 ETAB = 6.84E-03
+DSUB = 3.21E-01 PCLM = 5.96E+00 PDIBLC1 = 2.89E-03
+PDIBLC2 = -1.45E-06 PDIBLCB = -1E-03 DROUT = 9.93E-04
+PSCBE1 = 7.88E+10 PSCBE2 = 5E-10 PVAG = 15
+DELTA = 9.96E-03 RSH = 2.6 MOBMOD = 1
+PRT = 0 UTE = -1.5 KT1 = -1.09E-01
+KT1L = 0 KT2 = 2.19E-02 UA1 = 4.34E-09
+UB1 = -7.62E-18 UC1 = -5.63E-11 AT = 3.28E+04
+WL = 0 WLN = 1 WW = 0
+WWN = 1.00E+00 WWL = 0 LL = 0
+LLN = 1 LW = 0 LWN = 1
+LWL = 0 CAPMOD = 2.01E+00 XPART = 0.5
+CGDO = 2.10E-10 CGSO = 2.12E-10 CGBO = 1.00E-12
+CJ = {14e-4/(1+SP/20)} PB = 9.83E-01 MJ = 5.79E-01
+CJSW = {3.2e-10/(1+SP/20)} PBSW = 9.92E-01 MJSW = 3.60E-01
+CJSWG = 4.41E-11 PBSWG = 9.85E-01 MJSWG = 3.58E-01
+CF = 0 PVTH0 = 2.58E-02 PRDSW = -3.98E+01
+PK2 = 2.02E-03 WKETA = 2.72E-03 LKETA = -7.14E-03

Figure P6.2

Design a PMOS transistor to provide a
gm of at least 0.48 mA/V with VGS =

VDS and ID = 30 µA using a worst-case
combination of temperature and pro-
cess variations. Assume the BSIM3
model shown in Fig. P6.2 and a tem-
perature range from −40◦C to 85◦C.
Use a channel length of L = 1 µm.
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6.3

Figure P6.3

For the common-source stage shown
in Fig. P6.3, assume L1 = L2 = L3 =

1 µm, W1 = 22 µm, W2 =W3 = 20 µm,
IB = 140 µA and VDD = 3 V. As-
sume the BSIM3 models shown in
Fig. 6.2 on page 193 and a tempera-
ture of 27◦C. Also assume that pro-
cess variations cause CL to have a
value in the range of 1.3 pF to 1.7 pF.
Find the process corners for the unity-
gain frequency.

6.4
For the digital inverter ‘ ’ in Fig. 6.18
on page 205, find the worst-case de-
lay time considering both process vari-
ations, temperature variations from
−40◦C to 85◦C and supply-voltage
variations from 2.7 V to 3.3 V.
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6.5

Figure P6.5

For the common-source stage shown
in Fig. P6.5, find the worst-case cor-
ner for unity-gain bandwidth (low-
est unity-gain bandwidth) for tem-
perature variations and supply-voltage
variations. Assume CL = 1.5 pF,
L1 = L2 = L3 = 1 µm, W1 = 22 µm,
W2 = W3 = 20 µm, VDD = 3 V
and IB = (VDD − 0.9 V)/(15 kΩ).
Assume the BSIM3 models shown
in Fig. 6.2 on page 193 with typical
process parameters, temperature varia-
tions from −40◦C to 85◦C and supply-
voltage variations from 2.7 V to 3.3 V.
Run a Monte Carlo simulation for the
worst-case combination of tempera-
ture and supply voltage with stochas-
tic variations of the process parame-
ters for the transistors and the capac-
itor CL. Assume a standard deviation
of 0.4 for the process speed parame-
ters and a capacitor tolerance of ±5%.
Estimate mean value and standard de-
viation of the unity-gain frequency for
the worst-case combination of tempe-
rature and supply voltage.
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Answers

6.1: Typical: VGS = 0.996 V; gm = 1.88 mA/V; gds = 55.2 µA/V.
Slow: VGS = 1.10 V; gm = 1.80 mA/V; gds = 57.3 µA/V.
Fast: VGS = 0.853 V; gm = 1.99 mA/V; gds = 50.0 µA/V.

6.2: Worst-case corner: slow process, high temperature. W = 280 µm.

6.3: Process corners: Step NMOS PMOS CL Unity-gain frequency

1 slow slow fast 109.8 MHz

2 fast slow fast 130.8 MHz

3 slow fast fast 110.8 MHz

4 fast fast fast 131.9 MHz

5 slow slow slow 84.6 MHz

6 fast slow slow 100.7 MHz

7 slow fast slow 85.3 MHz

8 fast fast slow 101.6 MHz

6.4: Worst case: falling output, low supply voltage, high temperature, slow NMOS transistor, fast
PMOS transistor: td = 199 ps.

6.5: Mean value of GBW: 85 MHz. Standard deviation: 4 MHz.
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Tutorial 7 – Importing and Exporting Files

This tutorial shows a few ways to import files to LTspice and export files from LTspice. The main file
format for this is the SPICE Netlist which describes the circuit to the simulator. But also output files from
simulations are available, see for instance Fig. 1.15 on page 25, and we have seen already in Tutorial 3
how model files can be imported to LTspice. After having completed the tutorial, you should be able to

– import a netlist file to LTspice and run simulations directly from the netlist.

– use a netlist input to define a subcircuit and create a symbol for the subcircuit.

– export output netlist files from schematics.

– export output files from simulations.

Example 7.1: Importing a netlist file describing a current conveyor.

A current conveyor is a generic combination of a voltage follower and a current follower or current
inverter. It is a three-terminal device with one input terminal, Y, one output terminal, Z, and one combined
input-output terminal, X, see Fig. 7.1.

Figure 7.1: Current conveyor terminal definition.

The more popular form of the current conveyor is the second-generation current conveyor referred to as
CCII (Sedra & Smith 1970). This device is described by the terminal relations





iY
vX

iZ




=




0 0 0
1 0 0
0 ±1 0







vY

iX
vZ




(7.1)

The definition incorporates a positive version and a negative version, corresponding to iZ = iX and iZ =

−iX , respectively.
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Figure 7.2: CMOS current conveyor, CCII+.

Current conveyor netlist description.

*CMOS Second Generation Current Conveyor
*Y-input: Node 1
*X-input: Node 2
*Z-output: Node 3
*Positive supply voltage: Node 10
*Negative supply voltage: Node 11
*Bias current: IB, from node 8 to node 9

*Circuit description
M1 5 4 2 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M2 7 6 2 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M3 4 4 1 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M4 6 6 1 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M5 4 8 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M6 8 8 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M7 6 9 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M8 9 9 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M9 5 5 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M10 7 7 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M11 3 5 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M12 3 7 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u

Figure 7.3: Netlist description of the current conveyor from Fig. 7.2.

A simple CMOS implementation of a CCII+ current conveyor is shown in Fig. 7.2 (Bruun 1994), and
a netlist corresponding to this schematic is shown in Fig. 7.3. In the schematic and in the netlist, nodes
have been labeled by numbers. This is the classic way of labeling nodes for Spice (Vladimirescu 1994).
However, with LTspice, you may use letters instead if you so wish.

The netlist file is named ‘ccii.net’ and can be opened in LTspice with the command ‘File → Open’ (or
on the toolbar) using ‘Files of type: Netlists’. In LTspice, a simulation can be executed directly from

the netlist file, but first the simulation must be specified. This is done by directly inserting the required
SPICE directive in the netlist file. Also, the transistor model file (‘bsim3_035.lib’) must be included, and
it should be in the same folder as the netlist file or in a folder to which a search path has been specified,
see page 87.
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SPICE Netlist from the LTspice file editor.

*CMOS Second Generation Current Conveyor
*Y-input: Node 1
*X-input: Node 2
*Z-output: Node 3
*Positive supply voltage: Node 10
*Negative supply voltage: Node 11
*Bias current: IB, from node 8 to node 9

*Circuit description
M1 5 4 2 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M2 7 6 2 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M3 4 4 1 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M4 6 6 1 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M5 4 8 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M6 8 8 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M7 6 9 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M8 9 9 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M9 5 5 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M10 7 7 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M11 3 5 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M12 3 7 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u

*Transistor models
.include bsim3_035.lib

*Supply voltages and bias current
VDD 10 0 1.5V
VSS 0 11 1.5V
IB 8 9 1u

*Input signals
VY 1 0 0
IX 0 2 0

*Output load
RL 3 0 10k

*Analysis
.dc ix -100u 100u 1u

.end

Figure 7.4: SPICE Netlist for running a ‘.dc’ simulation of the current conveyor from Fig. 7.2.

Figure 7.4 shows the netlist file edited in LTspice to include model file, supply voltages, bias current,
input signals vX and iY , output load RL and a simulation command for a dc sweep of the input current iX .
Also included is a ‘.end’ directive to mark the end of the netlist file. This is not required in order to run
a simulation, but it is good practice to mark the end of the file, and when LTspice generates netlist files
from a schematic, the ‘.end’ directive is also automatically inserted.

The simulation is run directly from the SPICE Netlist using the command ‘Simulate → Run’ or using the
‘Run’-symbol on the toolbar. Figure 7.5 shows the result of the simulation. The traces to be displayed
are selected in the plot window using the command ‘Plot Settings → Add trace’ or the command ‘Plot
Settings → Visible Traces’. The command ‘Visible Traces’ is also available with the netlist window
active (’View → Visible Traces’) and on the toolbar, symbol , also see page 23. Figure 7.5 shows the
input current iX and the output current iZ = −I(RL). The output current is almost the same as the input
current as expected from (7.1).
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Figure 7.5: Simulated output current iZ =−I(RL) for the current conveyor from the SPICE Netlist shown in Fig. 7.4.

Example 7.2: Creating a subcircuit from a netlist.

The current conveyor is a generic building block in analog circuit design, so it is of interest to have
it as a generic subcircuit with a symbol resembling the symbol shown in Fig. 7.1. For this, the netlist
from Fig. 7.4 must be modified so that it starts with a ‘.subckt’ directive and ends with a ‘.ends’ directive.

Figure 7.6 shows the netlist with a minimum of changes required to turn it into a subcircuit specification.
The ‘.subckt’ directive and the ‘.ends’ directive have been inserted and the simulation command has been
removed, but the file still contains both model specifications and specifications of supply voltages and
bias current. The ‘.subckt’ directive specifies the name of the subcircuit and the order of the terminals.
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SPICE Netlist, current conveyor subcircuit.

*CMOS Second Generation Current Conveyor
*Y-input: Node 1
*X-input: Node 2
*Z-output: Node 3
*Positive supply voltage: Node 10
*Negative supply voltage: Node 11
*Bias current: IB, from node 8 to node 9

.subckt CCII 1 2 3

*Circuit description
M1 5 4 2 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u 
M2 7 6 2 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M3 4 4 1 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u 
M4 6 6 1 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M5 4 8 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M6 8 8 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M7 6 9 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u 
M8 9 9 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u 
M9 5 5 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M10 7 7 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u 
M11 3 5 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M12 3 7 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u

*Transistor models
.include bsim3_035.lib

*Supply voltages and bias current
VDD 10 0 1.5V
VSS 0 11 1.5V
IB 8 9 1u 

.ends

Figure 7.6: SPICE Netlist specifying the current conveyor as a subcircuit including transistor models, supply voltages and bias
current.

(a) (b)

Figure 7.7: LTspice symbol for the current conveyor. Autogenerated from the netlist (a). Edited from the autogenerated symbol
(b).

Next, we need a symbol for the subcircuit. This is achieved from the netlist editor by placing the cursor
in the line ‘.subckt CCII 1 2 3’ and right-clicking. This opens a window where you can select ‘Create
Symbol’ and answer ‘Yes’ in the dialogue window which opens. The auto-generated symbol is shown
in Fig. 7.7(a). Using the symbol editor as described on page 161, this is easily modified into the symbol
shown in Fig. 7.7(b). When you save the symbol CCII.asy, it is by default saved in a folder for auto-
generated LTspice symbols, ‘Documents\LTspiceXVII\lib\sym\Autogenerated’, so when inserting the
symbol in a schematic using ‘Edit → Component’ or hotkey ‘F2’, you must select the folder ‘[Autogen-
erated]’ in the component selection window, see Fig. 1.3 on page 15. This folder remains unchanged
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when you install new versions of LTspice, so the symbols in the folder are not affected by LTspice up-
dates. You may also select to save the symbol in the same folder as your circuits using the symbol or in
a dedicated folder for symbols to which a search path has been specified, see page 29 and page 87.

Figure 7.8: LTspice schematic for running the same simulation as specified in the netlist in Fig. 7.4.

Figure 7.8 shows a schematic with the current conveyor symbol and input signals and load resistor. From
this schematic, we can run the same simulation as the simulation run from the netlist file in Fig. 7.4, and
the result is as shown in Fig. 7.5.

The subcircuit defined in Fig. 7.6 includes both a link to the transistor model file, the supply voltages and
the bias current. For added flexibility, it may be desirable to have the specification of transistor models,
supply voltages and bias current at the top level of the circuit hierarchy, similar to the Examples 5.1, 5.2
and 5.4. An easy way to achieve this is to specify the supply voltages and the bias current as parameters
and omit the transistor model specification in the subcircuit.
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SPICE Netlist, current conveyor subcircuit.

*CMOS Second Generation Current Conveyor
*Y-input: Node 1
*X-input: Node 2
*Z-output: Node 3
*Positive supply voltage: Node 10
*Negative supply voltage: Node 11
*Bias current: IB, from node 8 to node 9

.subckt CCII 1 2 3

*Circuit description
M1 5 4 2 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u 
M2 7 6 2 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M3 4 4 1 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u 
M4 6 6 1 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M5 4 8 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M6 8 8 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M7 6 9 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u 
M8 9 9 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u 
M9 5 5 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M10 7 7 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u 
M11 3 5 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u 
M12 3 7 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u

*Supply voltages and bias current
VDD 10 0 {VDD}
VSS 0 11 {VSS}
IB 8 9 {IB}
.param VDD=1.5 VSS=1.5 IB=1u

.ends

Figure 7.9: SPICE Netlist specifying the current conveyor as a subcircuit with supply voltages and bias current specified as
parameters with default values.

Figure 7.9 shows the netlist file for this. In this netlist file, default values for the supply voltages and the
bias current are specified. In order to override the default values, you must specify the parameters ‘ ’,
‘ ’ and ‘ ’ for the current conveyor symbol, rather than using a ‘.param’ SPICE directive. This
is done by a ‘Ctrl-right-click’ on the current conveyor symbol. This opens the ‘Component Attribute
Editor’ shown in Fig. 7.10, and new values for ‘ ’, ‘ ’ and ‘ ’ can be inserted in the ‘Value2’ line
as shown in Fig. 7.10. Also mark the ‘Value2’ line to be visible in the schematic by inserting a ‘x’ in the
rightmost column in the ‘Component Attribute Editor’.

Figure 7.11 shows the LTspice schematic including overriding parameter specifications and including
the transistor model file. Also shown is a ‘.op’ simulation command. Running the ‘.op’ simulation, the
bias conditions for the current conveyor can be verified if LTspice has been set up to save the subcircuit
voltages and currents. This is done by the command ‘Tools → Control Panel’ where you select the tab
‘Save Defaults’. Here you tick ‘Save Subcircuit Node Voltages’ and ‘Save Subcircuit Device Currents’.

In the specification of the supply voltages, you may use another parameter as shown in Fig. 7.12. Here,
the numeric value of the supply voltage is defined as a parameter ‘ ’, and this parameter is stepped
from 1.3 V to 1.7 V using a ‘.step param’ directive. Also the value of the load resistor has been changed
to 20 kΩ. With this value of RL, the Z-output cannot deliver an output current of 100 µA because the
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Figure 7.10: Component Attribute Editor for specifying parameters for the current conveyor subcircuit.

Figure 7.11: LTspice schematic for running simulations with specifications of subcircuit parameters.

Figure 7.12: LTspice schematic for running simulations with different values of supply voltage.

output voltage exceeds the supply rails for iZ = ±100 µA. This is shown in Fig. 7.13 where the output
current is plotted versus the input current for three different values of supply voltage.
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Figure 7.13: Simulation plot for the ‘.dc’ simulation specified in Fig. 7.12.

An alternative way for specifying supply voltages and bias current at top level of the circuit hierarchy
is by introducing terminals for the supply voltages and the bias current in the schematic symbol. This
is achieved by first specifying the terminals in the netlist description as shown in Fig. 7.14 and then
designing a symbol including these terminals in the same way as the symbol from Fig. 7.7.

Figure 7.15 shows a schematic with this definition of the conveyor symbol and with the bias current
source replaced by a resistor which controls the bias current for the conveyor. With the resistor shown
in Fig. 7.15, the bias current is about 1 µA for a supply voltage of ±1.5 V.
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SPICE Netlist, current conveyor subcircuit with terminals for supply voltages and bias current.

*CMOS Second Generation Current Conveyor
*Y-input: Node 1
*X-input: Node 2
*Z-output: Node 3
*Positive supply voltage: Node 10
*Negative supply voltage: Node 11
*Bias current: IB, from node 8 to node 9

*Connections: Y-input
*                      | X-input
*                      | | Z-output
*                       | | | Bias current out
*                       | | | | Bias current in
*                     | | | | | Positive supply voltage
*                       | | | | | |  Negative supply voltage
*                     | | | | | | |
.subckt CCII 1 2 3 8 9 10 11 

*Circuit description
M1 5 4 2 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M2 7 6 2 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M3 4 4 1 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M4 6 6 1 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M5 4 8 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M6 8 8 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M7 6 9 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M8 9 9 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M9 5 5 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M10 7 7 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u
M11 3 5 10 10 PMOS-BSIM L=1.0u W=90u AD=90e-12 AS=90e-12 PD=92u PS=92u
M12 3 7 11 11 NMOS-BSIM L=1.0u W=30u AD=30e-12 AS=30e-12 PD=32u PS=32u

.ends

Figure 7.14: SPICE Netlist specifying the current conveyor as a subcircuit with supply voltages and bias current connected to
separate terminals.

Figure 7.15: LTspice schematic using a current conveyor symbol with supply voltages and bias current connected to separate
terminals.
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Example 7.3: Exporting a netlist.

Sometimes you may wish to export a netlist to another design system for further processing. LTspice has
a tool for netlist export, ‘Tools → Export Netlist’, by which a netlist for a schematic can be exported to
a number of different file formats, typically for use by PCB layout editors. For integrated circuit design,
this feature is not so useful. You would rather need to export to IC design tools such as Cadence, Synopsis
or Tanner EDA. For this, you can often use the netlist which can be viewed in LTspice by the command
‘View → SPICE Netlist’. This netlist file is not by default automatically saved by LTspice, but from the
command ‘Tools → Control Panel’, you can select the tab ‘Operation’. Here you find ‘Automatically
delete .net files [*]:’ and change the selection from ‘Yes’ to ‘No’. This will cause the netlist file to be
saved automatically with the extension ‘.net’. The file format is the generic Spice format for netlists
(Vladimirescu 1994) with the addition of the command ‘.backanno’ used by LTspice.

The ‘.net’ file can also be opened and edited in LTspice with the command ‘File → Open’ (or on the
toolbar) using ‘Files of type: Netlists’.

As an example, Fig. 7.16 shows the netlist file for the schematic from in Fig. 7.12. This is a netlist
file containing both references to a transistor model file and to a subcircuit, so without these files, it
cannot be used by another Spice simulator. In order to obtain maximum portability to another system, an
expanded netlist can be generated: Right-click in the file and select ‘Generate Expanded Listing’ in the
window which opens. The expanded netlist file is saved as a new file with extension ‘.sp’. Figure 7.17
shows the expanded netlist file corresponding to the netlist from Fig. 7.16. We notice that the subcircuit
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SPICE Netlist from schematic.

* M:\LTspice\Tutorial07\fig7_12.asc
RL z 0 20k
VY y 0 0
IX 0 x 0
XU1 y x z CCII VDD={Vsup} VSS={Vsup} IB=1u
.dc ix -100u 100u 1u
.include BSIM3_035.lib
;op
.step param Vsup 1.3 1.7 0.2
.lib M:\LTspice\Tutorial07\ccii.net
.backanno
.end

Figure 7.16: SPICE Netlist for the circuit from Fig. 7.12.

Expanded SPICE Netlist from schematic.

* M:\LTspice\Tutorial07\fig7_12.asc
rl z 0 20k
vy y 0 0
ix 0 x 0
m:u1:1 u1:5 u1:4 x u1:11 nmos-bsim l=1.0u w=30u ad=30e-12 as=30e-12 pd=32u ps=32u
m:u1:2 u1:7 u1:6 x u1:10 pmos-bsim l=1.0u w=90u ad=90e-12 as=90e-12 pd=92u ps=92u
m:u1:3 u1:4 u1:4 y u1:11 nmos-bsim l=1.0u w=30u ad=30e-12 as=30e-12 pd=32u ps=32u
m:u1:4 u1:6 u1:6 y u1:10 pmos-bsim l=1.0u w=90u ad=90e-12 as=90e-12 pd=92u ps=92u
m:u1:5 u1:4 u1:8 u1:10 u1:10 pmos-bsim l=1.0u w=90u ad=90e-12 as=90e-12 pd=92u ps=92u
m:u1:6 u1:8 u1:8 u1:10 u1:10 pmos-bsim l=1.0u w=90u ad=90e-12 as=90e-12 pd=92u ps=92u
m:u1:7 u1:6 u1:9 u1:11 u1:11 nmos-bsim l=1.0u w=30u ad=30e-12 as=30e-12 pd=32u ps=32u
m:u1:8 u1:9 u1:9 u1:11 u1:11 nmos-bsim l=1.0u w=30u ad=30e-12 as=30e-12 pd=32u ps=32u
m:u1:9 u1:5 u1:5 u1:10 u1:10 pmos-bsim l=1.0u w=90u ad=90e-12 as=90e-12 pd=92u ps=92u
m:u1:10 u1:7 u1:7 u1:11 u1:11 nmos-bsim l=1.0u w=30u ad=30e-12 as=30e-12 pd=32u ps=32u
m:u1:11 z u1:5 u1:10 u1:10 pmos-bsim l=1.0u w=90u ad=90e-12 as=90e-12 pd=92u ps=92u
m:u1:12 z u1:7 u1:11 u1:11 nmos-bsim l=1.0u w=30u ad=30e-12 as=30e-12 pd=32u ps=32u
v:u1:dd u1:10 0 1.3 
v:u1:ss 0 u1:11 1.3 
i:u1:b u1:8 u1:9 1e-006
.model pmos-bsim pmos level=49 version=3.1 tnom=2.69e+01 tox=7.8e-9 xj=1.00e-07 nch=8.44e+16 vth0=-0.6 k1=4.82e-01 k2=-
.model nmos-bsim nmos level=49 version=3.1 tnom=27 tox=7.8e-9 xj=1e-07 nch=2.18e+17 vth0=0.48 k1=6.07e-01 k2=1.24e-03
.dc ix -100u 100u 1u
.end 

Figure 7.17: Expanded SPICE Netlist for the circuit from Fig. 7.12.

is expanded into the individual transistors, the supply voltages and the bias current. Also, the values for
supply voltages are replaced by the parameter values specified as the first step in the ‘.step’ directive.
Further, the ‘.include BSIM3_035.lib’ directive is expanded into the two transistor models. Each of the
models is collapsed into a single, very long line in the expanded netlist file, so in Fig. 7.17 only the start
of the model lines is shown. Finally, the ‘.backanno’ directive has been removed.

The expanded netlist also contains the simulation command, so a simulation can be run directly from
the netlist, but the ‘.step’ directive is not included. Instead, the parameter values for the first step are
inserted, and the simulation will show only the first step. Figure 7.18 shows the simulation run from the
netlist. It may be compared to the simulation shown in Fig. 7.13 run from the schematic.

Example 7.4: Exporting other files.

In this book, the command ‘Tools → Copy bitmap to Clipboard’ has been used extensively for copying
schematics and simulation plots into a graphics file format. The ‘Tools’ command also provides the

230
Download free eBooks at bookboon.com



CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

231

Tutorial 7 – Importing and Exporting Files

Figure 7.18: Simulation plot for the ‘.dc’ simulation run from the expanded netlist shown in Fig. 7.17.

option of writing to a ‘.wmf’ file. This is a graphics file format resulting in fairly small file sizes but less
flexible when used in combination with graphics editors.

For simulation plots, also the command ‘File → Export’ is available as explained on page 25. This is
very useful for exporting simulation result to other programs such as Microsoft Excel or Matlab but may
require some editing of the exported file in order to ensure compatible formats. Finally, some simulations
provide results in the error log file generated from every simulation and saved with the extension ‘.log’.
An important category is the bias point information for transistors available in the ‘.log’ file after running
a ‘.op’ simulation. For ‘.op’ simulations (without ‘.step’ directives), the simulation results (node voltages
and device currents) appear directly in a window with the operating point voltages and currents (see
page 18), and this information can be copied to the clipboard using ‘Ctrl-A’ and ‘Ctrl-C’. Also for a ‘.tf’
simulations, the simulation results appear directly in a window and can be copied to the clipboard.

It is beyond the scope of this book to go into details concerning how to proceed with the different output
files in other programs.
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Hints and pitfalls

– LTspice accepts Spice netlists which are compatible with the general syntax for Spice netlists.

– Simulations can be run directly from a netlist file.

– LTspice generates a Spice netlist format which is compatible with the general syntax for Spice
netlists.

– The SPICE Netlist for a schematic is automatically saved with a ‘.net’ file extension only if this
option has been selected in the ‘Tools → Control Panel’ tab for ‘Operation’.

– An expanded netlist file (with file extension ‘.sp’) including subcircuits and models can be
generated from a netlist file by selecting ‘Generate Expanded Listing’ when right-clicking in
the netlist file.

– An expanded netlist file ensures maximum portability to other systems.

– A subcircuit may be generated from a netlist file by inserting a ‘.subckt’ directive and a ‘.ends’
directive.

– A subcircuit symbol may be generated automatically from a netlist by right-clicking in the
‘.subckt’ line in the netlist.

– A subcircuit symbol generated from a netlist is by default saved in a folder for autogenerated
LTspice symbols, ‘Documents\LTspiceXVII\lib\sym\Autogenerated’.

– A subcircuit symbol generated automatically from a schematic is by default saved in the same
folder as the subcircuit schematic, see page 161.

– In both cases, you may select to save the symbols in your own folder for symbols if you have
specified a search path to this folder, see page 29 and page 87.

– Do not use the same filename for a subcircuit and a circuit at a higher level in the circuit
hierarchy.
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Problems

7.1

*Differential NMOS pair with 
*resistive load and differential output

*Noninverting input: Node 3
*Inverting input: Node 2
*Noninverting output: Node 4
*Inverting output: Node 5
*Supply voltage: Node 1
*Bias current: IB from node 6 to ground

*Circuit description
R1 1 4 2.7k
R2 1 5 2.7k
M1 4 2 6 0 NMOS-BSIM L=0.7u W=16u
M2 5 3 6 0 NMOS-BSIM L=0.7u W=16u

Figure P7.1

Figure P7.1 shows a netlist for a dif-
ferential NMOS pair with differential
output. Create a netlist file for LTspice
for simulating the circuit with a supply
voltage of 3 V, a bias current of 250 µA
and a common mode input voltage of
1.5 V. Use the BSIM3 transistor model
from Fig. 3.10 on page 86. Find the
bias values of the output voltages and
the small-signal differential gain.

7.2

Figure P7.2

Use the netlist from Fig. P7.1 to
design a subcircuit and a subcir-
cuit symbol for the differential
pair. Use the BSIM3 transistor
model from Fig. 3.10 on page 86.
Design the subcircuit to have separate
terminals for the supply voltage and
the bias current. Insert the diffe-
rential pair in a test bench as shown
in Fig. P7.2 and find the −3 dB
frequency for the differential gain.
Use VDD = 3 V, IB = 250 µA,
VCM = 1.5 V and CL = 3 pF.
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7.3
Redefine the subcircuit from Pro-
blem 7.2 to have the transistor chan-
nel width as a parameter which
can be defined at top level.
Use the testbench from Fig. P7.2 to
find the low frequency gain as a func-
tion of the channel width for 5 µm≤
W ≤ 30 µm. What is the value of the
low frequency gain for W = 5 µm and
W = 30 µm?
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Answers

7.1: Bias value of output voltages: 1.75 V; Gain: 9.12 V/V.

7.2: −3 dB frequency: 2.84 MHz.

7.3: W = 5 µm: Gain: 4.15 V/V; W = 30 µm: Gain: 12.9 V/V.
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Moving On

LTspice is is an excellent SPICE simulator, easy to use and with the major advantage of being freely
available from Linear Technology, http://www.linear.com/designtools/software/.

LTspice supports a large selection of models for standard components, and it supports output file formats
for several PCB design systems.
Also, LTspice has a large user community which is extremely helpful whenever questions and problems
related to LTspice occur: https://groups.yahoo.com/neo/groups/LTspice/info.

In this book, we have not covered all the possibilities of LTspice, far from. For instance, we have not
mentioned FFT analysis, distortion analysis or the generation of Nyquist plots. Nor have we treated
issues related to convergence problems in the simulations.
To move on with such issues, use the LTspice documentation from Linear Technology, the comprehensive
documentation from (Brocard 2013) or get help from the LTspice user group.

LTspice is not an integrated design tool for CMOS design. It includes a schematic editor and a simulator,
but it does not include a layout editor, a DRC program (Design Rule Check), an LVS program (Layout
Versus Schematic), or a parasitic extraction program. Also, the selection of transistor models supported
by LTspice is limited and design kits from the various foundries and MPW providers are not available.
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So in order to move on to full CMOS design, including layout and wafer fabrication, you will need to
turn to other EDA systems (Electronic Design Automation) such as Cadence or Tanner EDA.

But for educational purposes and for learning how CMOS circuits behave without having to invest time
and money in a design system with complete support, LTspice is second to none.

References
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Appendix A

Appendix A –
A beginner’s guide to components and simulation

commands in LTspice

1. Component selection.

The tables on the following pages give an overview of components typically used in an introductory
course in electronics or electrical engineering. In the tables, the LTspice name is the name used in the
‘Select Component Symbol’ window which is opened by the command ‘Edit → Components’, sym-
bol on the toolbar, or hotkey ‘F2’. (In the Mac version of LTspice by the command ‘Draft →
Components’.)
In the LTspice component symbols shown in the tables, the top letter and number is the name and number
of the component while the bottom letter is the value of the component or a specification such as type
number or reference to a ‘.model’ description.
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Name Symbol LTspice name and specification
Textbook LTspice LTspice name

and letter
Specification

resistor,
resistance

res, R value in ohm, Ω, see page 14

capacitor,
capacitance

cap, C value in farad, F, compare speci-
fication of resistor, page 14

coil,
inductor,
inductance

ind, L value in henry, H,
compare page 14

switch sw, S ‘.model’ specification,
see page 51

diode diode, D diode type number or ‘.model’
specification, see page 55

Zener diode zener, D diode type number or ‘.model’
specification, see page 55

bipolar npn
transistor

npn, Q transistor type number or
‘.model’ specification,
compare page 55

bipolar pnp
transistor

pnp, Q transistor type number or
‘.model’ specification,
compare page 55

n-channel
MOS transistor,
discrete type

nmos, M transistor type number,
see page 78

n-channel
MOS transistor,
monolitic

nmos4, M ‘.model’ specification,
see page 80
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Name Symbol LTspice name and specification
Textbook LTspice LTspice name

and letter
Specification

p-channel
MOS transistor,
discrete type

pmos, M transistor type number,
see page 78

p-channel
MOS transistor,
monolitic

pmos4, M ‘.model’ specification,
see page 80

independent
voltage source

voltage, V dc value in volt, V,
or ac value in volt, V,
or time-varying voltage,
see page 48 and 52

independent
current source

current, I dc value in ampere, A,
or ac value in ampere, A,
or time-varying current,
compare specification of
independent voltage

voltage-
controlled
current source

g, G

g2, G

value of transconductance
in ampere per volt, A/V,
see page 28

voltage-
controlled
voltage source

e, E

e2, E

value of voltage gain E
in volt per volt, V/V,
compare specification of
voltage-controlled current
source, see page 28
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Name Symbol LTspice name and specification
Textbook LTspice LTspice name

and letter
Specification

current-
controlled
current source

f, F A right-click on the symbol
opens the ‘Component Attribute
Editor’, compare Fig. 1.19 on
page 28 and Fig. 1.30 on page
34.
In ‘Value’, you specify the name
of a voltage source through
which the controlling current
flows.
In ‘Value2’, you specify the
current gain in A/A.

current-
controlled
voltage source

h, H A right-click on the symbol
opens the ‘Component Attribute
Editor’, compare Fig. 1.19 on
page 28 and Fig. 1.30 on page
34.
In ‘Value’, you specify the name
of a voltage source through
which the controlling current
flows.
In ‘Value2’, you specify the
transresistance in V/A.

arbitrary-
controlled
current source

bi, B

bi2, B

mathematical expression for the
current, compare Fig. 1.22 on
page 29 and Fig. 1.28 on page
33.

arbitrary-
controlled
voltage source

bv, B mathematical expression for the
voltage, e.g. ‘ ’
where ‘ ’ is a voltage gain,
or ‘ ’ where ‘ ’
is a transresistance and ‘ ’
is the current through a voltage
source ‘ ’, compare Fig. 1.28
on page 33.
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2. Overview of basic simulation commands.

The basic simulation commands used for simple circuits with dc voltages and currents, time varying
signals and ac signals are ‘DC op pnt’, ‘DC sweep’, ‘Transient’, ‘DC Transfer’ and ‘AC Analysis’,
compare page 16. In the Windows version of LTspice, these commands are inserted using ‘Simulate →
Edit Simulation Cmd’ which opens a window with help functions for each of the simulation commands,
see Fig. 1.5 on page 17. In the Mac version, the window shown in Fig. 1.5 is opened using ‘Draft →
SPICE Directives’ and a right-click in the field for typing in the SPICE directive.
A very useful command in combination with the simulation commands is the SPICE directive ‘.step
param’. By this command, parameter values can be swept over a specified range, so the command is
very useful for examining the properties of a circuit when component values are varied over a specified
range.

DC op pnt: This command computes dc currents and voltages in a circuit with capacitors treated as
open circuits and inductors as short circuits.
Syntax:
In the Windows version of LTspice, the simulation results in an output file with all node voltages and
device currents in the circuit. Additionally, the Spice Error Log provides a listing of small-signal pa-
rameters for transistors in the circuit. In the Mac version, the simulation results in a plot window where
voltages and currents can be displayed. Voltages and currents are selected by pointing at nodes or com-
ponents in the schematic, compare page 23. Alternatively, voltages and currents are available in the Spice
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Error Log file which is shown by ‘View → Spice Error Log’ or hotkey ‘ L’.
The simulation will run correctly only if dc voltages are defined in all nodes. If a node is connected
only to capacitors or inputs to ideal voltage-controlled sources, the node voltage is not defined and the
simulation may lead to erroneous results, and it may be necessary to define an initial voltage using a ‘.ic’
directive, compare for instance Fig. 2.14 on page 58.

DC sweep: This command computes dc currents and voltages over a range of values for one, two or
three independent current sources or voltage sources.
Syntax:
where is the name of an independent current source or voltage source, is the start
value and is the end value of the range of variation for the source. The step between each
simulation is specified by .
The command is good for finding for instance the output voltage versus the input voltage for an amplifier.
The simulation results in a plot window where voltages and currents can be displayed versus the (first)
independent source which is stepped. Voltages and currents are selected by pointing at nodes or compo-
nents in the schematic, see page 23.

Transient: This command computes currents and voltages as a function of time in a circuit with one
or more sources specified as time varying sources, see page 47.
Syntax:
where is the end time for the simulation. The command is good for analyzing for instance
charging or discharging of a capacitor or for finding time varying output signals versus time varying
input signals in a circuit with amplifiers, capacitors and/or inductors.
The command requires that the voltage is defined in all nodes at time t = 0. If a node is connected only
to capacitors or inputs to ideal voltage-controlled sources, the node voltage is not defined and it may be
necessary to define the voltage by a ‘.ic’ directive, see for instance Fig. 2.14 on page 58.
Likewise, the initial current in an inductor can be defined by a ‘.ic’ directive, see for instance Fig. 2.16
on page 59.
A ‘.ic’ directive is also very useful when analyzing charging or discharging of capacitors or inductors,
see for instance Example 2.5 on page 59.
The simulation results in a plot window where voltages and current are shown versus time. Voltages and
currents are selected by pointing at nodes or components in the schematic, see page 23.
For the transient simulation, a modifier may be specified after . This modifier causes
all dc sources in the circuit to ramp up linearly to the specified dc value during 20 µs. Use this modifier
only if you are absolutely sure of what you are doing. Rather, use a ‘.ic’ directive as shown in Example
2.5 on page 59 or a time varying voltage or current, see page 47.
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DC Transfer: This command computes the small-signal input resistance, output resistance and transfer
function from an (independent) input source to an output at a frequency of 0 Hz.
Syntax:
where is the voltage in the node labeled and is the name of an independent
voltage source or current source serving as the input signal.
Alternatively, the output may be specified as where is an
independent voltage source through which the output current flows.
In the Windows version of LTspice, the simulation results in an output file showing the transfer function,
the input resistance and the output resistance, see Fig. 1.25 on page 31. In the Mac version, the simulation
results in a plot window where the transfer function, the input resistance and the output resistance can be
selected using the command ‘Add Traces’.
Just like the ‘.op’ command, the ‘.tf’ command requires all dc node voltages to be defined.

AC Analysis: This command computes the small-signal ac behavior of the circuit linearized about its
dc operating point. This is used for finding the frequency response of a circuit, e.g., the Bode plot of a
gain function.
Syntax:
where and denote the start and the end of the frequency range being simulated
while and determine the number of points (per octave or decade if a log-
arithmic frequency scale is selected). Normally, you would want a logarithmic frequency scale in which
case you would use (the default) or and specify a suitable number of points per octave or
decade of frequency.
For this simulation, at least one independent source must be specified with an ac value, see for in-
stance Fig. 2.8 on page 53.
The simulation results in a plot window where voltages and current are shown versus frequency. Voltages
and currents are selected by pointing at nodes or components in the schematic, see page 23.

Noise: This command performs a stochastic noise analysis of the circuit linearized about its dc operat-
ing point. This is used for analyzing the noise performance of a circuit, e.g., finding thermal noise and
flicker noise in a gain stage with MOS transistors.
Syntax:
where is the node at which the total output noise is calculated and is the name of an
independent source to which input noise is referred. and denote the start and
the end of the frequency range being simulated while and determine the
number of points (per octave or decade if a logarithmic frequency scale is selected). The simulation
results in a plot window where the noise spectral density in V/

√
Hz of the output voltage can be plotted

by pointing to the output node in the schematic. Also, the noise contribution from each component can
be plotted by pointing to the component and left-clicking. All the noise contributions are noise spectral
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density at the specified output terminal. Also the input referred noise spectral density may be plotted. It
is selected using the command ‘Visible Traces’, toolbar symbol , and selecting ‘ ’.

Parameter Sweep: Combined with the simulation commands above, the SPICE directive ‘.step param’
may be used for analyzing the properties of a circuit when component values are varied over a specified
range.
Syntax:
where is the name of the parameter to be varied, is the start value of the parameter,

is the end value and is the step size of the parameter value between each simulation.
When specifying a component value as a parameter, curly brackets are used to indicate the name of the
parameter, for instance , compare Fig. 1.16 on page 26.
Up to three parameters may be stepped in one simulation. The ‘.step’ directives are executed in the
sequence in which they are inserted in the schematic. The syntax shown above is the simplest form of
the ‘.step’ directive. Alternative ‘.step’ specifications are shown in the LTspice ‘Help’ function.
A simulation with a parameter sweep results in a plot window. For a ‘.op’ or ‘.tf’ simulation, the x-axis is
the (first) parameter being stepped. For ‘.dc’, ‘.tran’ and ‘.ac’ simulations, the x-axis is the independent
source, the time and the frequency, respectively, and separate traces are shown for each value of the
parameter which is stepped. Voltages and currents are selected by pointing at nodes or components in
the schematic, see page 23.
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Appendix B –
BSIM transistor models for use in LTspice

The following pages give tables with BSIM transistor models adapted from (Chan Carusone, Johns &
Martin 2014) to be compatible with LTspice. The models have been modified to include the speed
parameters ‘ ’ and ‘ ’ defined in Example 6.1 on page 190. For typical parameters, use ‘ ’ = 0 and
‘ = 0’. The files include a command ‘ ’ but it is inserted as a comment. To use only
the typical models, just un-comment this command by deleting the ‘ ’ in the beginning of the command
line. Alternatively, include a command specifying and in your schematic. The use of the speed
parameters is described in Tutorial 6, Example 6.1 on page 190.

References

Chan Carusone, TC., Johns, D. & Martin, K. 2014, Analog Integrated Circuit Design, Netlist and model
files. Retrieved from http://analogicdesign.com/students/netlists-models/
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Models for 0.35 µm CMOS.

The file ‘ ’ is used extensively in this book. It is derived from the file ‘p35_model_card.inc’
contained in the zip archive ‘p35.zip’ which can be downloaded from (Chan Carusone, Johns & Martin
2014). A few of the parameters in ‘p35_model_card.inc’ are deleted since they are ignored by LTspice
anyway, and the parameters ‘ ’, ‘ ’, ‘ ’, ‘ ’, ‘ ’ in ‘p35_model_card.inc’ which depend on
process corners are given their nominal values for a typical process. The parameters which are deleted
will not influence the simulation results significantly for normal values of transistor geometries. Also, the
transistor models are named ‘NMOS-BSIM’ and ‘PMOS-BSIM’ rather than just ‘NMOS’ and ‘PMOS’
in order to emphasize that they are BSIM models, not just the default Spice models.

The following page shows the file ‘p35_model_card.inc’ with the modifications introduced for the model
file ‘ ’ used in this book.
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*p35 model cardBSIM_035.lib
.MODEL NMOS-BSIM NMOS  LEVEL   =   49
+VERSION  =   3.1 TNOM    =   27  TOX =   '7.8E-9/proc_delta'
+XJ =   1E-07   NCH =   2.18E+17    VTH0  =   '0.48+vt_shift'
+K1 =   6.07E-01   K2  =   1.24E-03    K3  =   9.68E+01
+K3B   = -9.84E+00   W0  =   2.02E-05  NLX =   1.62E-07
+DVT0W  =   0   DVT1W   =   0   DVT2W   =   0
+DVT0   =   2.87E+00   DVT1    =   5.86E-01  DVT2  =   -1.26E-01
+U0 =   '360*proc_delta*proc_delta' UA  =   -8.48E-10   UB  =   2.27E-18
+UC =   3.27E-11   VSAT  =   1.87E+05    A0  =   1.22E+00
+AGS  =   2.06E-01  B0  =   9.60E-07  B1  =   4.95E-06
+KETA   =   -1.67E-04   A1  =   0   A2  =   3.49E-01
+RDSW   =   8.18E+02   PRWG    =   2.35E-02  PRWB    =   -8.12E-02
+WR =   9.98E-01   WINT  =   1.55E-07  LINT  =   4.51E-10
+XL =   -5.00E-08   XW  =   1.50E-07   DWG =  -4.27E-09
+DWB  =   4.07E-09  VOFF  =   -4.14E-02   NFACTOR =   1.61E+00
+CIT  =   0   CDSC    =   2.39E-04    CDSCD   =   0.00E+00
+CDSCB  =   0   ETA0   =   1   ETAB    =   -1.99E-01
+DSUB   =   1   PCLM   =   1.32E+00    PDIBLC1 =   2.42E-04
+PDIBLC2  =   8.27E-03  PDIBLCB =  -9.99E-04   DROUT   =   9.72E-04
+PSCBE1 =   7.24E+08   PSCBE2  =   9.96E-04  PVAG  =   1.00E-02
+DELTA  =   1.01E-02  RSH =   3.33E+00    MOBMOD  =   1
+PRT  =   0   UTE = -1.5    KT1 =   -1.11E-01
+KT1L   =   0   KT2 =   2.22E-02    UA1 =   4.34E-09
+UB1   = -7.56E-18   UC1 =   -5.62E-11   AT  =   3.31E+04
+WL =   0   WLN =   9.95E-01    WW  =   0
+WWN  =   1.00E+00    WWL =   0   LL  =   0
+LLN   =   1   LW  =   0   LWN =   1
+LWL  =   0   CAPMOD  =   2   XPART   =   0.5
+CGDO   =   2.76E-10  CGSO  =   2.76E-10  CGBO  =   1.00E-12
+CJ =   '9e-4/proc_delta'   PB  =   7.95E-01  MJ  =   3.53E-01
+CJSW   =   '2.8e-10/proc_delta'    PBSW  =   7.98E-01   MJSW    =   1.73E-01
+CJSWG  =   1.81E-10  PBSWG   =   7.96E-01  MJSWG   =   1.74E-01
+CF =   0   PVTH0   =   -1.80E-02   PRDSW   =   -7.56E+01
+PK2    =   4.48E-05  WKETA   =  -1.33E-03   LKETA   =   -8.91E-03

.MODEL PMOS-BSIM PMOS   LEVEL   =   49
+VERSION  =   3.1 TNOM    =   2.69E+01  TOX =   '7.8E-9/proc_delta'
+XJ =   1.00E-07   NCH =   8.44E+16 VTH0    =   '-0.6+vt_shift'
+K1 =   4.82E-01   K2  =   -2.13E-02   K3  =   8.27E+01
+K3B   = -5  W0  =   5.24E-06    NLX =   2.49E-07
+DVT0W  =   0.00E+00   DVT1W   =   0   DVT2W   =   0
+DVT0   =   3.54E-01  DVT1  =   7.52E-01    DVT2    = -2.98E-01
+U0 =   '150*proc_delta*proc_delta' UA  =   1E-10   UB  =   1.75E-18
+UC =   -2.27E-11   VSAT    =   2.01E+05  A0  =   1.04E+00
+AGS  =   2.90E-01  B0  =   1.94E-06  B1  =   5.01E-06
+KETA   =   -3.85E-03   A1  =   4.20E-03   A2  =   1.00E+00
+RDSW   =   4000  PRWG    = -9.54E-02   PRWB  =   -1.92E-03
+WR =   1   WINT  =   1.47E-07    LINT  =   1.04E-10
+XL =   -4.98E-08   XW  =   1.51E-07   DWG =  -1.09E-08
+DWB  =   1.14E-08  VOFF  =  -1.29E-01   NFACTOR = 2.01E+00
+CIT  =   0   CDSC    =   2.40E-04    CDSCD   =   0
+CDSCB  =   0   ETA0   =   4.07E-02    ETAB  =   6.84E-03
+DSUB   =   3.21E-01   PCLM    =   5.96E+00  PDIBLC1 =   2.89E-03
+PDIBLC2   = -1.45E-06   PDIBLCB =   -1E-03  DROUT   = 9.93E-04
+PSCBE1 =   7.88E+10   PSCBE2  =   5E-10   PVAG  =   15
+DELTA  =   9.96E-03  RSH =   2.6 MOBMOD  =   1
+PRT  =   0   UTE = -1.5    KT1 =   -1.09E-01
+KT1L   =   0   KT2 =   2.19E-02    UA1 =   4.34E-09
+UB1   = -7.62E-18   UC1 =   -5.63E-11   AT  =   3.28E+04
+WL =   0   WLN =   1   WW  =   0
+WWN  =   1.00E+00    WWL =   0   LL  =   0
+LLN   =   1   LW  =   0   LWN =   1
+LWL  =   0   CAPMOD  =   2.01E+00    XPART   =   0.5
+CGDO   =   2.10E-10  CGSO  =   2.12E-10  CGBO  =   1.00E-12
+CJ =   '14e-4/proc_delta' PB  =   9.83E-01  MJ  =   5.79E-01
+CJSW   =   '3.2e-10/proc_delta'    PBSW  =   9.92E-01   MJSW    =   3.60E-01
+CJSWG  =   4.41E-11  PBSWG   =   9.85E-01  MJSWG   =   3.58E-01
+CF =   0  PVTH0   =   2.58E-02    PRDSW   =   -3.98E+01
+PK2  =   2.02E-03  WKETA   =   2.72E-03  LKETA   =   -7.14E-03
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In order to include the speed parameters ‘ ’ and ‘ ’ in the model file, the process dependent parameters
‘ ’, ‘ ’, ‘ ’, ‘ ’, ‘ ’ should be modified. The nominal values for typical process parameters
are replaced by the expressions given below.

NMOS transistors:
VTH0 = {0.48−SN/10}

TOX = {7.8E−9/(1+SN/20)}

U0 = {360∗ (1+SN/20)∗∗2}

CJ = {9e−4/(1+SN/20)}

CJSW = {2.8e−10/(1+SN/20)}

PMOS transistors:
VTH0 = {−0.6+SP/10}

TOX = {7.8E−9/(1+SP/20)}

U0 = {150∗ (1+SP/20)∗∗2}

CJ = {14e−4/(1+SP/20)}

CJSW = {3.2e−10/(1+SP/20)}

The resulting file is shown in the table below.

Generic BSIM3 model for 0.35 µm CMOS process with speed parameters and to define process variations.
To use without speed parameters and only with typical process parameters, un-comment the line
by deleting the .

*BSIM3_035.lib
*Speed parameters SN and SP
*.PARAM SN=0 SP=0; Un-comment this command for use with only typical models
.MODEL NMOS-BSIM NMOS LEVEL = 49
+VERSION = 3.1 TNOM = 27 TOX = {7.8E-9/(1+SN/20)}
+XJ = 1E-07 NCH = 2.18E+17 VTH0 = {0.48-SN/10}
+K1 = 6.07E-01 K2 = 1.24E-03 K3 = 9.68E+01
+K3B = -9.84E+00 W0 = 2.02E-05 NLX = 1.62E-07
+DVT0W = 0 DVT1W = 0 DVT2W = 0
+DVT0 = 2.87E+00 DVT1 = 5.86E-01 DVT2 = -1.26E-01
+U0 = {360*(1+SN/20)**2} UA = -8.48E-10 UB = 2.27E-18
+UC = 3.27E-11 VSAT = 1.87E+05 A0 = 1.22E+00
+AGS = 2.06E-01 B0 = 9.60E-07 B1 = 4.95E-06
+KETA = -1.67E-04 A1 = 0 A2 = 3.49E-01
+RDSW = 8.18E+02 PRWG = 2.35E-02 PRWB = -8.12E-02
+WR = 9.98E-01 WINT = 1.55E-07 LINT = 4.51E-10
+DWG = -4.27E-09
+DWB = 4.07E-09 VOFF = -4.14E-02 NFACTOR = 1.61E+00
+CIT = 0 CDSC = 2.39E-04 CDSCD = 0.00E+00
+CDSCB = 0 ETA0 = 1 ETAB = -1.99E-01
+DSUB = 1 PCLM = 1.32E+00 PDIBLC1 = 2.42E-04
+PDIBLC2 = 8.27E-03 PDIBLCB = -9.99E-04 DROUT = 9.72E-04
+PSCBE1 = 7.24E+08 PSCBE2 = 9.96E-04 PVAG = 1.00E-02
+DELTA = 1.01E-02 RSH = 3.33E+00 MOBMOD = 1
+PRT = 0 UTE = -1.5 KT1 = -1.11E-01
+KT1L = 0 KT2 = 2.22E-02 UA1 = 4.34E-09
+UB1 = -7.56E-18 UC1 = -5.62E-11 AT = 3.31E+04
+WL = 0 WLN = 9.95E-01 WW = 0
+WWN = 1.00E+00 WWL = 0 LL = 0
+LLN = 1 LW = 0 LWN = 1
+LWL = 0 CAPMOD = 2 XPART = 0.5
+CGDO = 2.76E-10 CGSO = 2.76E-10 CGBO = 1.00E-12
+CJ = {9e-4/(1+SN/20)} PB = 7.95E-01 MJ = 3.53E-01
+CJSW = {2.8e-10/(1+SN/20)} PBSW = 7.98E-01 MJSW = 1.73E-01
+CJSWG = 1.81E-10 PBSWG = 7.96E-01 MJSWG = 1.74E-01
+CF = 0 PVTH0 = -1.80E-02 PRDSW = -7.56E+01
+PK2 = 4.48E-05 WKETA = -1.33E-03 LKETA = -8.91E-03

.MODEL PMOS-BSIM PMOS LEVEL = 49
*Speed parameter SP
+VERSION = 3.1 TNOM = 2.69E+01 TOX = {7.8E-9/(1+SP/20)}
+XJ = 1.00E-07 NCH = 8.44E+16 VTH0 = {-0.6+SP/10}
+K1 = 4.82E-01 K2 = -2.13E-02 K3 = 8.27E+01
+K3B = -5 W0 = 5.24E-06 NLX = 2.49E-07
+DVT0W = 0.00E+00 DVT1W = 0 DVT2W = 0
+DVT0 = 3.54E-01 DVT1 = 7.52E-01 DVT2 = -2.98E-01
+U0 = {150*(1+SP/20)**2} UA = 1E-10 UB = 1.75E-18
+UC = -2.27E-11 VSAT = 2.01E+05 A0 = 1.04E+00
+AGS = 2.90E-01 B0 = 1.94E-06 B1 = 5.01E-06
+KETA = -3.85E-03 A1 = 4.20E-03 A2 = 1.00E+00
+RDSW = 4000 PRWG = -9.54E-02 PRWB = -1.92E-03
+WR = 1 WINT = 1.47E-07 LINT = 1.04E-10
+DWG = -1.09E-08
+DWB = 1.14E-08 VOFF = -1.29E-01 NFACTOR = 2.01E+00
+CIT = 0 CDSC = 2.40E-04 CDSCD = 0
+CDSCB = 0 ETA0 = 4.07E-02 ETAB = 6.84E-03
+DSUB = 3.21E-01 PCLM = 5.96E+00 PDIBLC1 = 2.89E-03
+PDIBLC2 = -1.45E-06 PDIBLCB = -1E-03 DROUT = 9.93E-04
+PSCBE1 = 7.88E+10 PSCBE2 = 5E-10 PVAG = 15
+DELTA = 9.96E-03 RSH = 2.6 MOBMOD = 1
+PRT = 0 UTE = -1.5 KT1 = -1.09E-01
+KT1L = 0 KT2 = 2.19E-02 UA1 = 4.34E-09
+UB1 = -7.62E-18 UC1 = -5.63E-11 AT = 3.28E+04
+WL = 0 WLN = 1 WW = 0
+WWN = 1.00E+00 WWL = 0 LL = 0
+LLN = 1 LW = 0 LWN = 1
+LWL = 0 CAPMOD = 2.01E+00 XPART = 0.5
+CGDO = 2.10E-10 CGSO = 2.12E-10 CGBO = 1.00E-12
+CJ = {14e-4/(1+SP/20)} PB = 9.83E-01 MJ = 5.79E-01
+CJSW = {3.2e-10/(1+SP/20)} PBSW = 9.92E-01 MJSW = 3.60E-01
+CJSWG = 4.41E-11 PBSWG = 9.85E-01 MJSWG = 3.58E-01
+CF = 0 PVTH0 = 2.58E-02 PRDSW = -3.98E+01
+PK2 = 2.02E-03 WKETA = 2.72E-03 LKETA = -7.14E-03

250

Download free eBooks at bookboon.com



CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE

251251

CMOS INTEGRATED CIRCUIT 
SIMULATION WITH LTSPICE APPENDIX B 

Models for 0.18 µm CMOS.

The file ‘ ’ contains BSIM3 models for 0.18 µm MOS transistors. It is derived from
the file ‘p35_model_card.inc’ contained in the zip archive ‘p18.zip’ which can be downloaded from
(Chan Carusone, Johns & Martin 2014). A few of the parameters in ‘p18_model_card.inc’ are deleted
since they are ignored by LTspice anyway, and the parameters ‘ ’, ‘ ’, ‘ ’, ‘ ’, ‘ ’ in
‘p35_model_card.inc’ which depend on process corners are given their nominal values for a typical pro-
cess. The parameters which are deleted will not influence the simulation results significantly for normal
values of transistor geometries. Also, the transistor models are named ‘NMOS-BSIM’ and ‘PMOS-
BSIM’ rather than just ‘NMOS’ and ‘PMOS’ in order to emphasize that they are BSIM models, not just
the default Spice models.

The following page shows the file ‘p18_model_card.inc’ with the modifications introduced for the model
file ‘ ’ which is compatible with LTspice.
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* p18 model cardBSIM_018.lib
.MODEL NMOS-BSIM NMOS
+ VERSION = 3.1 
+ LEVEL = 49 NOIMOD = 1 TNOM = 2.70E+01 
+ TOX = '4.1E-9/proc_delta' XJ = 1.00E-07 NCH = 2.33E+17 
+ VTH0 = '0.36+vt_shift' K1 = 5.84E-01 K2 = 4.14E-03 
+ K3 = 1.01E-03 K3B = 2.20E+00 W0 = 1.00E-07 
+ NLX = 1.81E-07 DVT0W = 0.00E+00 DVT1W = 0.00E+00 
+ DVT2W = 0.00E+00 DVT0 = 1.73E+00 DVT1 = 4.38E-01 
+ DVT2 = -3.70E-04 U0 = '260*proc_delta*proc_delta' UA = -1.38E-09
+ UB = 2.26E-18 UC = 5.46E-11 VSAT = 1.03E+05 
+ A0 = 1.92E+00 AGS = 4.20E-01 B0 = -1.52E-09
+ B1 = -9.92E-08 KETA = -7.16E-03 A1 = 6.61E-04
+ A2 = 8.89E-01 RDSW = 1.12E+02 PRWG = 4.92E-01 
+ PRWB = -2.02E-01 WR = 1.00E+00 WINT = 7.12E-09 
+ LINT = 1.12E-08 XL = -2.00E-08 XW = -1.00E-08
+ DWG = -3.82E-09 DWB = 8.63E-09 VOFF = -8.82E-02
+ NFACTOR= 2.30E+00 CIT = 0.00E+00 CDSC = 2.40E-04
+ CDSCD = 0.00E+00 CDSCB = 0.00E+00 ETA0 = 3.13E-03 
+ ETAB = 1.00E+00 DSUB = 2.25E-02 PCLM = 7.20E-01 
+ PDIBLC1 = 2.15E-01 PDIBLC2 = 2.23E-03 PDIBLCB = 1.00E-01 
+ DROUT = 8.01E-01 PSCBE1 = 5.44E+08 PSCBE2 = 1.00E-03 
+ PVAG = 1.00E-12 DELTA = 1.00E-02 RSH = 6.78E+00 
+ MOBMOD = 1.00E+00 PRT = 0.00E+00 UTE = -1.50E+00
+ KT1 = -1.10E-01 KT1L = 0.00E+00 KT2 = 2.19E-02 
+ UA1 = 4.28E-09 UB1 = -7.62E-18 UC1 = -5.57E-11
+ AT = 3.30E+04 WL = 0.00E+00 WLN = 1.00E+00 
+ WW = 0.00E+00 WWN = 1.00E+00 WWL = 0.00E+00 
+ LL = 0.00E+00 LLN = 1.00E+00 LW = 0.00E+00 
+ LWN = 1.00E+00 LWL = 0.00E+00 CAPMOD = 2.00E+00 
+ XPART = 5.00E-01 CGDO = 6.98E-10 CGSO = 7.03E-10 
+ CGBO = 1.00E-12 CJ = '9.8e-4/proc_delta' PB = 7.34E-01 
+ MJ = 3.63E-01 CJSW = '2.4e-10/proc_delta' PBSW = 4.71E-01 
+ MJSW = 1.00E-01 CJSWG = 3.29E-10 PBSWG = 4.66E-01 
+ MJSWG = 1.00E-01 CF = 0.00E+00 PVTH0 = -7.16E-04
+ PRDSW = -6.66E-01 PK2 = 5.92E-04 WKETA = 2.14E-04
+ LKETA = -1.51E-02 PU0 = 3.36E+00 PUA = -1.31E-11
+ PUB = 0.00E+00 PVSAT = 1.25E+03 PETA0 = 1.00E-04 
+ PKETA = 6.45E-04 KF = 4.46E-29  

.MODEL PMOS-BSIM PMOS  
+ VERSION = 3.1 
+ LEVEL = 49 NOIMOD = 1 
+ TNOM = 2.70E+01 TOX = '4.1E-9/proc_delta' XJ = 1.00E-07 
+ NCH = 4.12E+17 VTH0 = '-0.39-vt_shift' K1 = 5.50E-01 
+ K2 = 3.50E-02 K3 = 0.00E+00 K3B = 1.20E+01 
+ W0 = 1.00E-06 NLX = 1.25E-07 DVT0W = 0.00E+00 
+ DVT1W = 0.00E+00 DVT2W = 0.00E+00 DVT0 = 5.53E-01 
+ DVT1 = 2.46E-01 DVT2 = 1.00E-01 U0 = '110*proc_delta*proc_delta' 
+ UA = 1.44E-09 UB = 2.29E-21 UC = -1.00E-10
+ VSAT = 1.95E+05 A0 = 1.72E+00 AGS = 3.80E-01 
+ B0 = 5.87E-07 B1 = 1.44E-06 KETA = 2.21E-02 
+ A1 = 4.66E-01 A2 = 3.00E-01 RDSW = 3.11E+02 
+ PRWG = 5.00E-01 PRWB = 1.64E-02 WR = 1.00E+00 
+ WINT = 0.00E+00 LINT = 2.00E-08 XL = -2.00E-08
+ XW = -1.00E-08 DWG = -3.49E-08 DWB = 1.22E-09 
+ VOFF = -9.80E-02 NFACTOR = 2.00E+00 CIT = 0.00E+00 
+ CDSC = 2.40E-04 CDSCD = 0.00E+00 CDSCB = 0.00E+00 
+ ETA0 = 1.12E-03 ETAB = -4.79E-04 DSUB = 1.60E-03 
+ PCLM = 1.50E+00 PDIBLC1 = 3.00E-02 PDIBLC2 = -1.01E-05
+ PDIBLCB = 1.00E-01 DROUT = 1.56E-03 PSCBE1 = 4.91E+09
+ PSCBE2 = 1.64E-09 PVAG = 3.48E+00 DELTA = 1.00E-02 
+ RSH = 7.69E+00 MOBMOD = 1.00E+00 PRT = 0.00E+00 
+ UTE = -1.49E+00 KT1 = -1.09E-01 KT1L = 0.00E+00 
+ KT2 = 2.18E-02 UA1 = 4.27E-09 UB1 = -7.68E-18
+ UC1 = -5.57E-11 AT = 3.31E+04 WL = 0.00E+00 
+ WLN = 1.00E+00 WW = 0.00E+00 WWN = 1.00E+00 
+ WWL = 0.00E+00 LL = 0.00E+00 LLN = 1.00E+00 
+ LW = 0.00E+00 LWN = 1.00E+00 LWL = 0.00E+00 
+ CAPMOD = 2.00E+00 XPART = 5.00E-01 CGDO = 6.88E-10 
+ CGSO = 6.85E-10 CGBO = 1.00E-12 CJ = '1.2e-3/proc_delta' 
+ PB = 8.70E-01 MJ = 4.20E-01 CJSW = '2.4e-10/proc_delta' 
+ PBSW = 8.00E-01 MJSW = 3.57E-01 CJSWG = 4.24E-10 
+ PBSWG = 8.00E-01 MJSWG = 3.56E-01 CF = 0.00E+00 
+ PVTH0 = 3.53E-03 PRDSW = 1.02E+01 PK2 = 3.35E-03 
+ WKETA = 3.52E-02 LKETA = -2.06E-03 PU0 = -2.19E+00
+ PUA = -7.63E-11 PUB = 9.91E-22 PVSAT = 5.00E+01
+ PKETA = -6.41E-03 KF = 1.29E-29 PETA0 = 7.31E-05

Formatted: Top: 1,75 cm, Bottom:
2,25 cm, Width: 29,7 cm, Height: 42
cm
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In order to include the speed parameters ‘ ’ and ‘ ’ in the model file, the process dependent parameters
‘ ’, ‘ ’, ‘ ’, ‘ ’, ‘ ’ should be modified. The nominal values for typical process parameters
are replaced by the expressions given below.

NMOS transistors:
VTH0 = {0.36−SN/10}

TOX = {4.1E−9/(1+SN/20)}

U0 = {260∗ (1+SN/20)∗∗2}

CJ = {9.8e−4/(1+SN/20)}

CJSW = {2.4e−10/(1+SN/20)}

PMOS transistors:
VTH0 = {−0.39+SP/10}

TOX = {4.1E−9/(1+SP/20)}

U0 = {110∗ (1+SP/20)∗∗2}

CJ = {1.2e−3/(1+SP/20)}

CJSW = {2.4e−10/(1+SP/20)}

The resulting file is shown in the table on the following page.
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APPENDIX B

Generic BSIM3 model for 0.18 µm CMOS process with speed parameters and to define process variations.
To use without speed parameters and only with typical process parameters, un-comment the line
by deleting the .

*BSIM3_018.lib
*Speed parameters SN and SP
*.PARAM SN=0 SP=0; Un-comment this command for use with only typical models
.MODEL NMOS-BSIM NMOS    
+ VERSION = 3
+ LEVEL = 49 NOIMOD = 1 TNOM = 2.70E+01
+ TOX = {4.1E-9/(1+SN/20)} XJ = 1.00E-07 NCH = 2.33E+17
+ VTH0 = {0.36-SN/10} K1 = 5.84E-01 K2 = 4.14E-03
+ K3 = 1.01E-03 K3B = 2.20E+00 W0 = 1.00E-07
+ NLX = 1.81E-07DVT0W = 0.00E+00 DVT1W = 0.00E+00
+ DVT2W = 0.00E+00 DVT0 = 1.73E+00 DVT1 = 4.38E-01
+ DVT2 = -3.70E-04 U0 ={260*(1+SN/20)**2} UA = -1.38E-09
+ UB = 2.26E-18 UC = 5.46E-11 VSAT = 1.03E+05
+ A0 = 1.92E+00 AGS = 4.20E-01 B0 = -1.52E-09
+ B1 = -9.92E-08 KETA = -7.16E-03 A1 = 6.61E-04
+ A2 = 8.89E-01 RDSW = 1.12E+02 PRWG = 4.92E-01
+ PRWB = -2.02E-01 WR = 1.00E+00  
+ WINT = 7.12E-09 LINT = 1.12E-08
+ DWG = -3.82E-09 DWB = 8.63E-09 VOFF = -8.82E-02
+ NFACTOR = 2.30E+00 CIT = 0.00E+00 CDSC = 2.40E-04
+ CDSCD = 0.00E+00 CDSCB = 0.00E+00 ETA0 = 3.13E-03
+ ETAB = 1.00E+00 DSUB = 2.25E-02 PCLM = 7.20E-01
+ PDIBLC1 = 2.15E-01 PDIBLC2 = 2.23E-03 PDIBLCB  = 1.00E-01
+ DROUT = 8.01E-01 PSCBE1 = 5.44E+08 PSCBE2 = 1.00E-03
+ PVAG = 1.00E-12 DELTA = 1.00E-02 RSH = 6.78E+00
+ MOBMOD = 1.00E+00 PRT = 0.00E+00 UTE = -1.50E+00
+ KT1 = -1.10E-01 KT1L = 0.00E+00 KT2 = 2.19E-02
+ UA1 = 4.28E-09UB1 = -7.62E-18 UC1 = -5.57E-11
+ AT = 3.30E+04 WL = 0.00E+00 WLN = 1.00E+00
+ WW = 0.00E+00 WWN = 1.00E+00 WWL = 0.00E+00
+ LL = 0.00E+00 LLN = 1.00E+00 LW = 0.00E+00
+ LWN = 1.00E+00 LWL = 0.00E+00 CAPMOD = 2.00E+00
+ XPART = 5.00E-01 CGDO = 6.98E-10 CGSO = 7.03E-10
+ CGBO = 1.00E-12 CJ = {9.8e-4/(1+SN/20)} PB = 7.34E-01
+ MJ = 3.63E-01 CJSW = {2.4e-10/(1+SN/20)} PBSW = 4.71E-01
+ MJSW = 1.00E-01 CJSWG = 3.29E-10 PBSWG = 4.66E-01
+ MJSWG = 1.00E-01 CF = 0.00E+00 PVTH0 = -7.16E-04
+ PRDSW = -6.66E-01 PK2 = 5.92E-04 WKETA = 2.14E-04
+ LKETA = -1.51E-02 PU0 = 3.36E+00 PUA = -1.31E-11
+ PUB = 0.00E+00 PVSAT = 1.25E+03 PETA0 = 1.00E-04
+ PKETA = 6.45E-04 KF = 4.46E-29  

.MODEL PMOS-BSIM PMOS    
+ VERSION = 3.1  
+ LEVEL = 49 NOIMOD = 1  
+ TNOM = 2.70E+01 TOX = {4.1E-9/(1+SP/20)} XJ = 1.00E-07
+ NCH = 4.12E+17 VTH0 = {-0.39+SP/10} K1 = 5.50E-01
+ K2 = 3.50E-02 K3 = 0.00E+00 K3B = 1.20E+01
+ W0 = 1.00E-06 NLX = 1.25E-07 DVT0W = 0.00E+00
+ DVT1W = 0.00E+00 DVT2W = 0.00E+00 DVT0 = 5.53E-01
+ DVT1 = 2.46E-01 DVT2 = 1.00E-01 U0 = {110*(1+SP/20)**2}
+ UA = 1.44E-09 UB = 2.29E-21 UC = -1.00E-10
+ VSAT = 1.95E+05 A0 = 1.72E+00 AGS = 3.80E-01
+ B0 = 5.87E-07 B1 = 1.44E-06 KETA = 2.21E-02
+ A1 = 4.66E-01 A2 = 3.00E-01 RDSW = 3.11E+02
+ PRWG = 5.00E-01 PRWB = 1.64E-02 WR = 1.00E+00
+ WINT = 0.00E+00 LINT = 2.00E-08
+ DWG = -3.49E-08 DWB = 1.22E-09
+ VOFF = -9.80E-02 NFACTOR = 2.00E+00 CIT = 0.00E+00
+ CDSC = 2.40E-04 CDSCD = 0.00E+00 CDSCB = 0.00E+00
+ ETA0 = 1.12E-03 ETAB = -4.79E-04 DSUB = 1.60E-03
+ PCLM = 1.50E+00 PDIBLC1 = 3.00E-02 PDIBLC2 = -1.01E-05
+ PDIBLCB = 1.00E-01 DROUT = 1.56E-03 PSCBE1 = 4.91E+09
+ PSCBE2 = 1.64E-09 PVAG = 3.48E+00 DELTA = 1.00E-02
+ RSH = 7.69E+00 MOBMOD = 1.00E+00 PRT = 0.00E+00
+ UTE = -1.49E+00 KT1 = -1.09E-01KT1L = 0.00E+00
+ KT2 = 2.18E-02 UA1 = 4.27E-09 UB1 = -7.68E-18
+ UC1 = -5.57E-11 AT = 3.31E+04 WL = 0.00E+00
+ WLN = 1.00E+00 WW = 0.00E+00 WWN = 1.00E+00
+ WWL = 0.00E+00 LL = 0.00E+00 LLN = 1.00E+00
+ LW = 0.00E+00 LWN = 1.00E+00 LWL = 0.00E+00
+ CAPMOD = 2.00E+00 XPART = 5.00E-01 CGDO = 6.88E-10
+ CGSO = 6.85E-10 CGBO = 1.00E-12 CJ = {1.2e-3/(1+SP/20)}
+ PB = 8.70E-01 MJ = 4.20E-01 CJSW = {2.4e-10/(1+SP/20)}
+ PBSW = 8.00E-01 MJSW = 3.57E-01 CJSWG = 4.24E-10
+ PBSWG = 8.00E-01 MJSWG = 3.56E-01 CF = 0.00E+00
+ PVTH0 = 3.53E-03 PRDSW = 1.02E+01 PK2 = 3.35E-03
+ WKETA = 3.52E-02 LKETA = -2.06E-03 PU0 = -2.19E+00
+ PUA = -7.63E-11 PUB = 9.91E-22 PVSAT = 5.00E+01
+ PKETA = -6.41E-03 KF = 1.29E-29 PETA0 = 7.31E-05
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Models for 45 nm CMOS.

The models for 45 nm CMOS given in (Chan Carusone, Johns & Martin 2014) are slightly more com-
plicated to convert into a model file for LTspice. They are found in the files contained in the zip archive
‘p045.zip’ which can be downloaded from (Chan Carusone, Johns & Martin 2014).

This archive includes separate model files for NMOS transistors and PMOS transistors for typical, fast
and slow process corners.

The starting point for creating a model file for an NMOS transistor is the file ‘nmos_vtl_tt.inc’. This
is shown on the next page. You would notice that the parameters are separated into different sections,
‘ parameters related to the technology node’, ‘ parameters customized by the user’, and ‘ secondary
parameters’. Only the parameters customized by the user are related to the process corners, and this
section is highlighted in red on the following page. In the file shown on the next page, typical process
parameters are shown. The file ‘nmos_vtl_ff.inc’ contains the parameters for the fast process corner,
and the file ‘nmos_vtl_tt.inc’ contains the parameters for the slow process corner. The relation between
typical, fast and slow parameters are not given by equations similar to those of the 0.35 µm technology
and the 0.18 µm technology, so for the 45 nm technology, we will use the general approach described by
(6.4) on page 191.

Using this approach, the parameters customized by the user and containing the speed parameter ‘ ’
should be as shown below for the NMOS transistor:

You may notice that the parameter ‘ ’ has been omitted in the parameters given above. This is
because the LTspice error log file tells that it is ignored anyway.
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* Customized PTM 45 NMOS

.model  NMOS  nmos  level = 54 

+version = 4.0    binunit = 1    paramchk= 1    mobmod  = 0
+capmod  = 2      igcmod  = 1    igbmod  = 1    geomod  = 1
+diomod  = 1      rdsmod  = 0    rbodymod= 1    rgatemod= 1
+permod  = 1      acnqsmod= 0    trnqsmod= 0

* parameters related to the technology node
+tnom = 27    epsrox = 3.9
+eta0 = 0.0049    nfactor = 2.1    wint = 5e-09
+cgso = 1.1e-10    cgdo = 1.1e-10    xl = -2e-08

* parameters customized by the user
+toxe = 1.75e-09    toxp = 1.1e-09    toxm = 1.75e-09    toxref = 1.75e-09
+dtox = 6.5e-10    lint = 3.75e-09
+vth0 = 0.471    k1 = 0.53    u0 = 0.04359    vsat = 147390
+rdsw = 155    ndep = 3.3e+18    xj = 1.4e-08

* secondary parameters
+ll      = 0     wl      = 0    lln     = 1     wln     = 1   
+lw      = 0   ww      = 0   lwn     = 1     wwn     = 1   
+lwl     = 0  wwl     = 0   xpart   = 0   
+k2      = 0.01     k3    = 0 
+k3b     = 0   w0   = 2.5e-006     dvt0    = 1     dvt1    = 2  
+dvt2    = -0.032       dvt0w   = 0  dvt1w   = 0        dvt2w   = 0         
+dsub    = 0.1     minv    = 0.05     voffl   = 0    dvtp0   = 1.0e-009   
+dvtp1   = 0.1  lpe0    = 0     lpeb    = 0 
+ngate   = 2e+020       nsd     = 2e+020       phin    = 0
+cdsc    = 0.000  cdscb   = 0     cdscd   = 0    cit     = 0 
+voff    = -0.13   etab    = 0   
+vfb     = -0.55        ua      = 6e-010    ub      = 1.2e-018  
+uc      = 0  a0      = 1.0          ags     = 1e-020    
+a1      = 0    a2      = 1.0      b0  = 0     b1      = 0 
+keta    = 0.04    dwg     = 0     dwb     = 0     pclm    = 0.04 
+pdiblc1 = 0.001  pdiblc2 = 0.001        pdiblcb = -0.005       drout   = 0.5        
+pvag    = 1e-020       delta   = 0.01   pscbe1  = 8.14e+008    pscbe2  = 1e-007   
+fprout  = 0.2      pdits   = 0.08     pditsd  = 0.23    pditsl  = 2.3e+006 
+rsh     = 5    rsw     = 85           rdw     = 85   
+rdswmin = 0    rdwmin  = 0        rswmin  = 0       prwg    = 0 
+prwb    = 6.8e-011     wr      = 1  alpha0  = 0.074        alpha1  = 0.005  
+beta0   = 30   agidl   = 0.0002       bgidl   = 2.1e+009     cgidl   = 0.0002  
+egidl   = 0.8

+aigbacc = 0.012  bigbacc = 0.0028       cigbacc = 0.002   
+nigbacc = 1    aigbinv = 0.014     bigbinv = 0.004        cigbinv = 0.004    
+eigbinv = 1.1     nigbinv = 3            aigc    = 0.012        bigc    = 0.0028   
+cigc    = 0.002  aigsd   = 0.012        bigsd   = 0.0028       cigsd   = 0.002  
+nigc    = 1   poxedge = 1     pigcd   = 1            ntox    = 1       

+xrcrg1  = 12  xrcrg2  = 5 
+cgbo    = 2.56e-011    cgdl    = 2.653e-10
+cgsl    = 2.653e-10    ckappas = 0.03         ckappad = 0.03  acde    = 1    
+moin    = 15     noff    = 0.9   voffcv  = 0.02        

+kt1     = -0.11    kt1l    = 0     kt2     = 0.022    ute     = -1.5   
+ua1     = 4.31e-009    ub1     = 7.61e-018    uc1     = -5.6e-011    prt     = 0
+at      = 33000

+fnoimod = 1   tnoimod = 0    

+jss     = 0.0001       jsws    = 1e-011       jswgs   = 1e-010       njs     = 1
+ijthsfwd= 0.01  ijthsrev= 0.001     bvs     = 10     xjbvs   = 1 
+jsd     = 0.0001       jswd    = 1e-011       jswgd   = 1e-010       njd     = 1
+ijthdfwd= 0.01    ijthdrev= 0.001     bvd     = 10           xjbvd   = 1 
+pbs     = 1   cjs     = 0.0005       mjs     = 0.5  pbsws   = 1       
+cjsws   = 5e-010       mjsws   = 0.33     pbswgs  = 1      cjswgs  = 3e-010   
+mjswgs  = 0.33   pbd     = 1    cjd     = 0.0005      mjd     = 0.5 
+pbswd   = 1  cjswd   = 5e-010   mjswd   = 0.33         pbswgd  = 1 
+cjswgd  = 5e-010       mjswgd  = 0.33      tpb     = 0.005    tcj     = 0.001      
+tpbsw   = 0.005        tcjsw   = 0.001     tpbswg  = 0.005    tcjswg  = 0.001 
+xtis    = 3  xtid    = 3        

+dmcg    = 0e-006       dmci    = 0e-006       dmdg    = 0e-006       dmcgt   = 0e-007
+dwj     = 0.0e-008     xgw     = 0e-007       xgl     = 0e-008

+rshg    = 0.4  gbmin   = 1e-010       rbpb    = 5            rbpd    = 15  
+rbps    = 15   rbdb    = 15           rbsb    = 15       ngcon   = 1       
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In a similar way, a model file for the PMOS transistor can be derived from the file ‘pmos_vtl_tt.inc’
with the typical parameters. Using the files ‘pmos_vtl_ff.inc’ and ‘pmos_vtl_ss.inc’, the parameters
customized by the user can be modified to include the speed parameter ‘ ’:

Finally, the NMOS model and the PMOS model can be combined into a sing library file ‘BSIM4_0045.lib’
as shown in the figure on the next page. Here, the model names have been modified to NMOS-BSIM
and PMOS-BSIM, rather than the default names of NMOS and PMOS.
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Generic BSIM4 model for 45 nm CMOS process with speed parameters and to define process variations.
To use without speed parameters and only with typical process parameters, un-comment the line
by deleting the .

This file is derived from (Chan Carusone, Johns & Martin 2014) subject to Apache License version 2.0, http://apache.org/licenses/LICENSE-2.0

*BSIM4_0045.lib
*Speed parameters SN and SP
*.PARAM SN=0 SP=0; Un-comment this command for use with only typical models
.model  NMOS-BSIM  nmos  level = 54
+version = 4.0    binunit = 1    paramchk= 1    mobmod  = 0
+capmod  = 2      igcmod  = 1    igbmod = 1    geomod  = 1
+diomod  = 1      rdsmod  = 0    rbodymod= 1    rgatemod= 1
+permod  = 1      acnqsmod= 0    trnqsmod= 0
* parameters related to the technology node
+tnom = 27    epsrox = 3.9
+eta0 = 0.0049    nfactor = 2.1    wint = 5e-09
+cgso = 1.1e-10    cgdo = 1.1e-10    xl = -2e-08
* parameters customized by the user
+toxe = 1.75e-09    toxp = 1.1e-09    toxm = 1.75e-09    toxref = 1.75e-09
+lint = {3.75e-09*(1-abs(SN))+2.875e-09*uramp(-SN)+4.625e-09*uramp(SN)}
+vth0 = {0.471*(1-abs(SN))+0.5*uramp(-SN)+0.44*uramp(SN)}
+k1 = {0.53*(1-abs(SN))+0.555*uramp(-SN)+0.503*uramp(SN)}    
+u0 = {0.04359*(1-abs(SN))+0.04163*uramp(-SN)+0.04581*uramp(SN)}    
+vsat = 147390    rdsw = 155    ndep = 3.3e+18    
+xj = {1.4e-08*(1-abs(SN))+1.54e-08*uramp(-SN)+1.26e-08*uramp(SN)}
* secondary parameters
+ll      = 0            wl      = 0            lln     = 1            wln     = 1          
+lw      = 0            ww      = 0            lwn     = 1            wwn     = 1          
+lwl     = 0            wwl     = 0            xpart   = 0               
+k2      = 0.01         k3      = 0          
+k3b     = 0            w0      = 2.5e-006     dvt0    = 1            dvt1    = 2       
+dvt2    = -0.032       dvt0w   = 0            dvt1w   = 0            dvt2w   = 0          
+dsub    = 0.1          minv    = 0.05         voffl   = 0            dvtp0   = 1.0e-009     
+dvtp1   = 0.1          lpe0    = 0            lpeb    = 0               
+ngate   = 2e+020       nsd     = 2e+020       phin    = 0          
+cdsc    = 0.000        cdscb   = 0            cdscd   = 0            cit     = 0          
+voff    = -0.13        etab    = 0          
+vfb     = -0.55        ua      = 6e-010     ub      = 1.2e-018     
+uc      = 0            a0      = 1.0          ags     = 1e-020     
+a1      = 0            a2      = 1.0          b0      = 0            b1      = 0          
+keta    = 0.04         dwg     = 0            dwb     = 0           pclm    = 0.04       
+pdiblc1 = 0.001        pdiblc2 = 0.001        pdiblcb = -0.005       drout   = 0.5        
+pvag    = 1e-020       delta   = 0.01         pscbe1  = 8.14e+008    pscbe2  = 1e-007     
+fprout  = 0.2          pdits   = 0.08         pditsd  = 0.23         pditsl  = 2.3e+006   
+rsh     = 5            rsw     = 85           rdw     = 85        
+rdswmin = 0            rdwmin  = 0            rswmin  = 0            prwg    = 0          
+prwb    = 6.8e-011     wr      = 1            alpha0 = 0.074        alpha1  = 0.005      
+beta0   = 30           agidl   = 0.0002       bgidl   = 2.1e+009     cgidl   = 0.0002     
+egidl   = 0.8          
+aigbacc = 0.012        bigbacc = 0.0028       cigbacc = 0.002     
+nigbacc = 1            aigbinv = 0.014        bigbinv = 0.004        cigbinv = 0.004      
+eigbinv = 1.1          nigbinv = 3            aigc    = 0.012        bigc    = 0.0028     
+cigc    = 0.002        aigsd   = 0.012        bigsd   = 0.0028       cigsd   = 0.002     
+nigc    = 1            poxedge = 1            pigcd   = 1            ntox    = 1          
+xrcrg1  = 12           xrcrg2  = 5          
+cgbo    = 2.56e-011    cgdl    = 2.653e-10     
+cgsl    = 2.653e-10    ckappas = 0.03         ckappad = 0.03         acde    = 1          
+moin    = 15           noff    = 0.9          voffcv  = 0.02       
+kt1     = -0.11        kt1l    = 0            kt2     = 0.022        ute     = -1.5       
+ua1     = 4.31e-009    ub1     = 7.61e-018    uc1     = -5.6e-011    prt     = 0          
+at      = 33000      
+fnoimod = 1            tnoimod = 0          
+jss     = 0.0001       jsws    = 1e-011       jswgs   = 1e-010       njs     = 1          
+ijthsfwd= 0.01         ijthsrev= 0.001        bvs     = 10           xjbvs = 1          
+jsd     = 0.0001       jswd    = 1e-011       jswgd   = 1e-010       njd     = 1          
+ijthdfwd= 0.01         ijthdrev= 0.001        bvd     = 10           xjbvd   = 1          
+pbs     = 1            cjs     = 0.0005       mjs     = 0.5          pbsws   = 1          
+cjsws   = 5e-010       mjsws   = 0.33         pbswgs  = 1            cjswgs  = 3e-010     
+mjswgs  = 0.33         pbd     = 1            cjd     = 0.0005       mjd     = 0.5        
+pbswd   = 1            cjswd   = 5e-010       mjswd   = 0.33         pbswgd  = 1          
+cjswgd  = 5e-010       mjswgd  = 0.33         tpb     = 0.005        tcj     = 0.001      
+tpbsw   = 0.005        tcjsw   = 0.001        tpbswg  = 0.005        tcjswg  = 0.001      
+xtis    = 3            xtid    = 3          
+dmcg    = 0e-006       dmci    = 0e-006       dmdg    = 0e-006       dmcgt   = 0e-007     
+dwj     = 0.0e-008     xgw     = 0e-007       xgl     = 0e-008     
+rshg    = 0.4          gbmin   = 1e-010       rbpb    = 5            rbpd    = 15         
+rbps    = 15           rbdb    = 15           rbsb    = 15           ngcon   = 1          

.model  PMOS-BSIM pmos  level = 54
+version = 4.0    binunit = 1    paramchk= 1    mobmod  = 0
+capmod  = 2      igcmod  = 1    igbmod  = 1    geomod  = 1
+diomod  = 1      rdsmod  = 0    rbodymod= 1    rgatemod= 1
+permod  = 1      acnqsmod= 0    trnqsmod= 0
* parameters related to the technology node
+tnom = 27    epsrox = 3.9
+eta0 = 0.0049    nfactor = 2.1    wint = 5e-09
+cgso = 1.1e-10    cgdo = 1.1e-10    xl = -2e-08
* parameters customized by the user
+toxe = 1.85e-09    toxp = 1.1e-09    toxm = 1.85e-09    toxref = 1.85e-09
+lint = {3.75e-09*(1-abs(SP))+2.875e-09*uramp(-SP)+4.625e-09*uramp(SP)} 
+vth0 ={-0.423*(1-abs(SP))-0.452*uramp(-SP)-0.392*uramp(SP)}    
+k1 = {0.491*(1-abs(SP))+0.517*uramp(-SP)+0.465*uramp(SP)}       
+u0 = {0.00432*(1-abs(SP))+0.00389*uramp(-SP)+0.00482*uramp(SP)}    
+vsat = 70000 rdsw = 155    ndep = 2.54e+18    
+xj = {1.4e-08*(1-abs(SP))+1.54e-08*uramp(-SP)+1.26e-08*uramp(SP)} 
*secondary parameters
+ll      = 0            wl      = 0            lln     = 1            wln     = 1          
+lw      = 0            ww      = 0            lwn     = 1            wwn     = 1          
+lwl     = 0            wwl     = 0            xpart   = 0               
+k2      = -0.01        k3      = 0          
+k3b     = 0            w0      = 2.5e-006     dvt0    = 1            dvt1    = 2       
+dvt2    = -0.032       dvt0w   = 0            dvt1w   = 0            dvt2w   = 0          
+dsub    = 0.1          minv    = 0.05         voffl   = 0            dvtp0   = 1e-009     
+dvtp1   = 0.05         lpe0    = 0            lpeb    = 0               
+ngate   = 2e+020       nsd     = 2e+020       phin    = 0          
+cdsc    = 0.000        cdscb   = 0            cdscd   = 0            cit     = 0          
+voff    = -0.126       etab    = 0          
+vfb     = 0.55         ua      = 2.0e-009     ub      = 0.5e-018     
+uc      = 0            a0      = 1.0          ags     = 1e-020     
+a1      = 0            a2      = 1            b0      = -1e-020      b1      = 0          
+keta    = -0.047       dwg     = 0            dwb     = 0            pclm    = 0.12       
+pdiblc1 = 0.001        pdiblc2 = 0.001        pdiblcb = 3.4e-008     drout   = 0.56       
+pvag    = 1e-020       delta  = 0.01         pscbe1  = 8.14e+008    pscbe2  = 9.58e-007
+fprout  = 0.2          pdits   = 0.08         pditsd  = 0.23         pditsl  = 2.3e+006   
+rsh     = 5            rsw     = 85           rdw     = 85        
+rdswmin = 0            rdwmin  = 0            rswmin  = 0            prwg    = 3.22e-008
+prwb    = 6.8e-011     wr      = 1            alpha0  = 0.074        alpha1  = 0.005      
+beta0   = 30           agidl   = 0.0002       bgidl   = 2.1e+009     cgidl   = 0.0002     
+egidl   = 0.8          
+aigbacc = 0.012        bigbacc = 0.0028       cigbacc = 0.002     
+nigbacc = 1            aigbinv = 0.014        bigbinv = 0.004        cigbinv = 0.004      
+eigbinv = 1.1          nigbinv = 3            aigc    = 0.69         bigc    = 0.0012     
+cigc    = 0.0008       aigsd   = 0.0087       bigsd   = 0.0012       cigsd   = 0.0008     
+nigc    = 1            poxedge = 1            pigcd   = 1            ntox    = 1 
+xrcrg1  = 12           xrcrg2  = 5          
+cgbo    = 2.56e-011    cgdl    = 2.653e-10
+cgsl    = 2.653e-10    ckappas = 0.03         ckappad = 0.03         acde    = 1
+moin    = 15           noff    = 0.9          voffcv  = 0.02
+kt1     = -0.11        kt1l    = 0            kt2     = 0.022        ute     = -1.5       
+ua1     = 4.31e-009    ub1     = 7.61e-018    uc1     = -5.6e-011    prt     = 0          
+at      = 33000      
+fnoimod = 1            tnoimod = 0          
+jss     = 0.0001       jsws    = 1e-011       jswgs   = 1e-010       njs     = 1          
+ijthsfwd= 0.01         ijthsrev= 0.001        bvs     = 10           xjbvs   = 1          
+jsd     = 0.0001       jswd    = 1e-011       jswgd   = 1e-010       njd     = 1          
+ijthdfwd= 0.01         ijthdrev= 0.001        bvd     = 10           xjbvd   = 1          
+pbs     = 1            cjs     = 0.0005       mjs     = 0.5          pbsws   = 1          
+cjsws   = 5e-010       mjsws   = 0.33         pbswgs  = 1            cjswgs  = 3e-010     
+mjswgs  = 0.33         pbd     = 1            cjd   = 0.0005       mjd     = 0.5        
+pbswd   = 1            cjswd   = 5e-010       mjswd   = 0.33         pbswgd  = 1          
+cjswgd  = 5e-010       mjswgd  = 0.33         tpb     = 0.005        tcj     = 0.001      
+tpbsw   = 0.005        tcjsw   = 0.001        tpbswg  = 0.005        tcjswg  = 0.001      
+xtis    = 3            xtid    = 3          
+dmcg    = 0e-006       dmci    = 0e-006       dmdg    = 0e-006       dmcgt   = 0e-007     
+dwj     = 0.0e-008     xgw     = 0e-007       xgl     = 0e-008     
+rshg    = 0.4          gbmin   = 1e-010       rbpb    = 5            rbpd    = 15         
+rbps    = 15           rbdb    = 15           rbsb    = 15           ngcon   = 1          
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Index

Index

.ac, 16, 52, 245

.dc, 16, 22, 244

.end, 221

.ends, 222

.global, 179, 184

.ic, 57, 59, 70, 244

.inc, .include, 86

.meas, .measure, 61, 105, 198

.model, 51, 53, 77, 85, 247

.noise, 16, 139, 147, 245

.op, 16, 17, 243

.param, 26

.step, 25, 101, 193, 246

.subckt, 222

.temp, 196

.tf, 16, 31, 245

.tran, 16, 47, 244

Active load, 120
Amplifier

cascode, 136
common-drain, 127
common-gate, 134
common-source, 115
current, 32, 242
differential, 138
inverting, 26, 115
operational, 159
transconductance, 26, 241
transresistance, 33, 242
voltage, 241

Annotating
on schematics, 20, 89, 117
on waveform plots, 26, 49, 90

Bipolar transistor, 240

Bode plot, 52, 73
Bus wire, 181, 183

Capacitor, 47, 240
Capacitor charging, 47, 59
Capacitor discharging, 47, 59
Closed-loop gain, 173, 207
Color palette, 20, 195
Color preferences, 20, 24, 195
Common-mode rejection ratio, CMRR, 143
Component Attribute Editor, 28, 118, 225, 226
Ctrl-L, 18, 82, 107, 199
Current conveyor, 219
Current source

arbitrary behavioral, 28
arbitrary-controlled, 242
current-controlled, 32, 242
independent, 20, 241
voltage-controlled, 27, 28, 241

Cursor in plot window, 24, 49, 90, 107

Dc feedback path, 206
Diode, 53, 240
Drawing a schematic, 13

Error log file, 11, 18, 61, 82, 107, 199, 244
Exporting

files, 231
netlists, 229
schematics, 16
waveforms, 24, 25

Font size, 21, 26, 40, 51

Generic filter functions, 176
Ground, 15

Help me Edit, 11, 16, 25, 62
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Index

Hierarchical design, 159
Hotkey, 11, 15

Inductor, 58, 240
Inductor demagnetization, 58, 60
Inductor magnetization, 58, 60
Initial condition, 57, 59, 70, 244
Initial value, 57, 59, 70, 244

Keyboard shortcut, 11, 15

Label Net, 15, 160
Library search path, 86, 176, 220
Logic gates, 179
Loop gain, 172, 206

Mac computer, 10
MOS transistor, 77

Netlist, 19, 219
export, 229
import, 219

Noise, 147
Norton equivalent, 19

Power-supply rejection ratio, PSRR, 143
Process corners, 189
Process, voltage and temperature variations,

PVT, 190

RC network, 47
Rectifier, 53
Resistor, 13, 240

Simulation
AC Analysis, 16, 52, 245
DC op pnt, 16, 243
DC sweep, 16, 22, 244
DC Transfer, 16, 31, 245
Monte Carlo, 207
Noise, 16, 139, 147
Transient, 16, 47, 244

Slew rate, 147

Small-signal capacitance, 83, 102
Small-signal output conductance, 82, 94, 100
Small-signal transconductance, 82, 92, 100
Small-signal transistor parameters, 82, 95, 100, 102
Source follower, 127
Speed parameter, 190
SPICE Error Log, 18, 61, 82, 107, 199
Subcircuit, 160, 222
Subcircuit device currents, 163, 225
Subcircuit node voltages, 163, 225
Sweeping a component value, 25
Sweeping a dc current, 22
Sweeping a dc voltage, 22
Switch, 50, 240
Symbol editor, 29, 162, 223
Symbol folder, 29, 178
Symbol search path, 176, 224

Thévenin equivalent, 19
Transistor model

BSIM, 78, 85, 247
Shichman-Hodges, 78

Two-stage opamp, 159

Unexpected simulation results
AC analysis, 125, 150
DC operating point analysis, 18
DC transfer analysis, 32, 125, 150
Noise analysis, 150
Transient analysis, 126, 150

Voltage source
arbitrary-controlled, 242
current-controlled, 242
independent, 14, 241
voltage-controlled, 241

Waveform arithmetic, 31
Waveform viewer, 23
Windows computer, 10

Zener diode, 54, 240
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